# Table of Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction</td>
<td>7</td>
</tr>
<tr>
<td>System Requirements &amp; Product Support</td>
<td>7</td>
</tr>
<tr>
<td>About This User Guide</td>
<td>7</td>
</tr>
<tr>
<td>Important Notes</td>
<td>8</td>
</tr>
<tr>
<td>Setup</td>
<td>8</td>
</tr>
<tr>
<td>1. Connection</td>
<td>8</td>
</tr>
<tr>
<td>2. Installation</td>
<td>9</td>
</tr>
<tr>
<td>3. Getting Started</td>
<td>9</td>
</tr>
<tr>
<td>Features</td>
<td>10</td>
</tr>
<tr>
<td>MPC X</td>
<td>10</td>
</tr>
<tr>
<td>Top Panel</td>
<td>10</td>
</tr>
<tr>
<td>Navigation &amp; Data Entry Controls</td>
<td>10</td>
</tr>
<tr>
<td>Pad &amp; Q-Link Controls</td>
<td>11</td>
</tr>
<tr>
<td>Mode &amp; View Controls</td>
<td>12</td>
</tr>
<tr>
<td>Transport &amp; Recording Controls</td>
<td>13</td>
</tr>
<tr>
<td>I/O &amp; Level Controls</td>
<td>14</td>
</tr>
<tr>
<td>touchscreen</td>
<td>15</td>
</tr>
<tr>
<td>Front Panel</td>
<td>16</td>
</tr>
<tr>
<td>Rear Panel</td>
<td>17</td>
</tr>
<tr>
<td>MPC Live</td>
<td>18</td>
</tr>
<tr>
<td>Top Panel</td>
<td>18</td>
</tr>
<tr>
<td>touchscreen</td>
<td>20</td>
</tr>
<tr>
<td>Rear Panel</td>
<td>21</td>
</tr>
<tr>
<td>MPC Touch</td>
<td>22</td>
</tr>
<tr>
<td>Top Panel</td>
<td>22</td>
</tr>
<tr>
<td>touchscreen</td>
<td>24</td>
</tr>
<tr>
<td>Rear Panel</td>
<td>25</td>
</tr>
<tr>
<td>Basic Concepts</td>
<td>26</td>
</tr>
<tr>
<td>Tutorial</td>
<td>27</td>
</tr>
<tr>
<td>Starting Up</td>
<td>27</td>
</tr>
<tr>
<td>Creating a Drum Kit</td>
<td>27</td>
</tr>
<tr>
<td>Creating a Drum Sequence</td>
<td>29</td>
</tr>
<tr>
<td>Saving &amp; Renaming</td>
<td>30</td>
</tr>
<tr>
<td>Editing Note Events</td>
<td>32</td>
</tr>
<tr>
<td>Making Basic Sound Edits</td>
<td>34</td>
</tr>
<tr>
<td>Creating a Bass Track</td>
<td>36</td>
</tr>
<tr>
<td>Recording an Audio Track</td>
<td>39</td>
</tr>
<tr>
<td>Creating a Song</td>
<td>40</td>
</tr>
<tr>
<td>Exporting the Song</td>
<td>41</td>
</tr>
<tr>
<td>Other Features Explained</td>
<td>42</td>
</tr>
<tr>
<td>Step Sequencer</td>
<td>42</td>
</tr>
<tr>
<td>Drum Loops &amp; Chop Mode</td>
<td>43</td>
</tr>
<tr>
<td>Pad Muting &amp; Track Muting</td>
<td>45</td>
</tr>
<tr>
<td>Sampling (Recording)</td>
<td>47</td>
</tr>
<tr>
<td>Sample Editing</td>
<td>49</td>
</tr>
<tr>
<td>Recording Automation with the XY Pad</td>
<td>51</td>
</tr>
<tr>
<td>Using MPC X or MPC Live as a Controller</td>
<td>52</td>
</tr>
</tbody>
</table>
Updates in MPC 2.5 ................................. 373

New Features ........................................ 373
   Splice Integration ................................. 373
   Browser Audition Warp and Sync ............... 374

Updates in MPC 2.6 ................................. 375

New Features ........................................ 375
   Ableton Live Set Export ......................... 375
   Erase Parameters ................................. 375
   Grid Automation Lanes .......................... 376
   Step Automation .................................. 377
   Submixes ......................................... 378
   Workflow Enhancements ......................... 378
Introduction

Thank you for purchasing your MPC. At Akai Professional, we know how serious music is to you. That’s why we design our equipment with only one thing in mind—to make your performance the best it can be.

This user guide explains how to create music using MPC X, MPC Live, and MPC Touch. There is similar documentation available for MPC products that use an LCD and for the MPC software application. To view these user guides, click the Help menu in the MPC software, select MPC Help, and select an option.

Welcome to the MPC family.

Akai Professional

System Requirements & Product Support

For the latest information about this product (system requirements, compatibility information, etc.) and product registration, visit akaipro.com.

For additional support, visit akaipro.com/support.

About This User Guide

This manual should help you get familiar with using your MPC X, MPC Live, or MPC Touch. For consistency, the terminology throughout is based on the MPC nomenclature. We also used specific formatting to indicate particular topics of significance:

**Important/Note/Tip:** Important or helpful information on a given topic.

Names of buttons, controls, parameters, settings, and other options are written in **bold** characters throughout the manual.

**Examples:** Press the **Play Start** button.
- Turn **Q-Link Knob 4**.
- Tap the **Mute** button.
- The **Velocity** ranges from 0 to 127.
- Set the **Sample Play** selector to **One Shot**.
- Tap **BPM**, and then use the numeric keypad to enter 120 as the tempo.

Some parts of this manual refer to other relevant chapters or sections, which are cited in **bold, italic blue** characters. Click the text to skip immediately to that section.

**Examples:** Read the **Important Notes** section before proceeding.
- For more information about installing the necessary drivers and software, see **Setup > 2. Installation**.
- To learn more about using send effects, see **General Features > Effects > Send/Return Effects**.
Important Notes

Read the included safety & warranty manual before using your MPC hardware.

Before getting started and connecting devices to your MPC hardware or turning the hardware on/off, make sure all devices are switched off.

To use your MPC hardware in Controller Mode (to control the MPC software):

Before installing the MPC software, make sure your computer meets the system requirements described at akaipro.com. This applies whether you’ll use MPC software as your host software or as a plugin in another digital audio workstation (DAW).

Before connecting your MPC hardware to your computer, install the drivers and software. Visit akaipro.com to download the latest versions. Refer to the 2. Installation section for more information.

Setup

1. Connection

Here is just an example of how to use MPC X in your setup. Items not listed under Introduction > Box Contents of your included quickstart guide are sold separately.
Remember to remove the protective film from your MPC hardware touchscreen!

**To use your MPC hardware in Standalone Mode**, just connect it to a power outlet using the included power adapter, and power it on!

*Note:* We highly recommend checking akaipro.com for any available updates to the MPC software/firmware and/or drivers.

To use your MPC hardware in Controller Mode, continue to Step 2. **Installation.**

---

**2. Installation**

To use your MPC hardware in Controller Mode (to control the MPC software), **follow these steps to download and install the required drivers & software:**

1. Go to akaipro.com and register your product. If you don’t have an Akai Professional account yet, you will be prompted to create one.
2. In your Akai Professional account, download the MPC software package.
3. Open the file and double-click the installer application.
4. Follow the on-screen instructions to complete the installation.

   *Note:* By default, the MPC software will be installed in **[your hard drive]\Program Files\Akai Pro\MPC (Windows®)** or **Applications** (macOS®). You can also create a shortcut on your Desktop.

---

**3. Getting Started**

1. Power on your MPC hardware.
2. On your computer, open the MPC software.
3. Follow the on-screen instructions to authorize your version of MPC.
4. You will need an iLok account to complete this. You can create an account at ilok.com.

   Make a note of the PACE code in your account, and enter it when asked for it during the authorization/unlock process.
5. On your MPC hardware, check the upper-right corner of the touchscreen:
   - If there is a **monitor/cable icon**, then your MPC hardware is already in Controller Mode. Continue to Step 6.
   - If there is a **chip icon**, then your MPC hardware is in Standalone Mode. Follow these steps:
     i. Press **Menu** to enter the Menu.
     ii. Tap the **MPC chip icon** in the upper-right corner.
     iii. In the **Enter Controller Mode** window that appears, tap **Controller Mode**. **Looking for computer** may appear briefly on the screen before your MPC hardware recognizes the USB connection as a controller.
6. In the MPC software, click the **Edit** menu, and select **Preferences**. Click the **Audio** tab and select the sound card you want to use. Click **OK** when you are done.

**Important:**

We highly recommend using your MPC hardware’s sound card (**Akai Pro MPC X/Live/Touch ASIO**). If you need to use the internal sound card on a Windows computer, we recommend downloading the latest ASIO4ALL driver at asio4all.com.

To view the MPC software user guide, click the **Help** menu in the MPC software, select **MPC Help**, and select **MPC User Manual**.
Features

This chapter explains the features and functions of each MPC model with a touchscreen: MPC X, MPC Live, and MPC Touch.

MPC X

Top Panel

Navigation & Data Entry Controls

1. **Touchscreen**: This full-color multi-touch display shows information relevant to MPC X’s current operation. Touch the touchscreen (and use the hardware controls) to control the MPC interface. See the later Touchscreen section to learn how to use some basic functions.

   **Tip**: If you adjust the angle of the touchscreen, use the stand on its back panel to secure it in place.

2. **Cursors**: Press these buttons to navigate through the fields of menus and options shown on the screen. Press and hold **Shift** and press these buttons to zoom in or out of the Grid View or Audio Edit Mode. Press and hold **Shift** and press the **up** and **down cursors** simultaneously or the **left** and **right cursors** simultaneously to return to the default zoom setting.
3. **Data Dial**: Use this dial to scroll through the available menu options or adjust the parameter values of the selected field on the screen.

4. **–/+**: Press these buttons to increase or decrease the value of the selected field on the screen.

5. **Numeric Keypad**: If the selected field on the screen is a number, press these numbered buttons as you would on a standard numeric keypad to enter a value. Press the keypad’s **Enter** to enter it. (A numeric keypad with additional operations will appear on the screen, as well.)

6. **Undo/Redo**: Press this button to undo your last action.
   
   Press and hold **Shift** and press this button to redo the last action you undid.

7. **Shift**: Press and hold this button to access some buttons’ secondary functions (indicated by red writing).

   Double-press this button to see which buttons have secondary functions—the buttons will flash for a few seconds.

8. **F-Key**: Press this button to activate or deactivate the F-Key feature. When active, the six buttons under the touchscreen correspond to the options shown at the bottom edge of the screen. The F-Key button and those six buttons will be lit red when active. When inactive, the six buttons under the touchscreen will access their normal modes instead (*Menu*, *Browser*, *Step Seq*, *Sampler*, *XYFX*, and *Looper*).

**Pad & Q-Link Controls**

9. **Q-Link Knobs**: Turn these touch-sensitive knobs to adjust various parameters and settings. The display strip above each knob indicates the parameter it is controlling. If the display strip shows a meter to indicate its value, you can touch or turn its Q-Link knob to temporarily show its precise numerical value.

10. **Pads**: Press these pads to trigger drum hits or other samples in your software. The pads are velocity-sensitive and pressure-sensitive, which makes them very responsive and intuitive to play. The pads will light up different colors, depending on how hard you play them (ranging from yellow at a low velocity to red at the highest velocity). You can also customize their colors.

11. **Pad Bank**: Press these buttons to access Pad Banks A–D.

    Press and hold **Shift** while pressing these buttons to access Pad Banks E–H. Alternatively, double-press one of these buttons.

12. **Copy/Delete**: Press this button to copy one pad to another. When the **From Pad** field is selected, press the “source” pad (the pad you want to copy). When the **To Pad** graphic (of all pads) is selected, press the “destination” pad. You can select multiple destination pads, and you can select pads in different pad banks. Tap **Do It** to continue or **Close** to return to the previous screen.

    **Tip**: To quickly copy a pad, press and hold **Copy**, press the source pad, press the destination pad, and then release **Copy**.

    Press and hold **Shift** and press this button to delete a pad’s sample assignment. When the **Delete Pad** window is shown, press any pad/pads whose sample assignments you want to clear. Tap **Delete** to continue or **Cancel** to return to the previous screen.

13. **Full Level/Half Level**: Press this button to activate or deactivate the Full Level feature. When activated, the pads will always trigger their samples at the maximum velocity (127), regardless of how much force you use.

    Press and hold **Shift** and then press this button to activate or deactivate the Half Level feature. When activated, the pads will always trigger their samples at half-velocity (64).

14. **16 Level**: Press this button to activate/deactivate 16 Level. When activated, the last pad that was hit will be temporarily copied to all 16 pads. The pads will now output the same note number as the initial pad, but a selectable parameter will be fixed at values that increase as the pad numbers increase (e.g., Pad 1 is the minimum, Pad 16 is the maximum), regardless of how hard you press them. In the screen that appears, use the **Type** selector to choose the parameter: *Velocity*, *Tune*, *Filter*, *Layer*, *Attack*, or *Decay*. See **Operation > General Features > 16 Level** to learn more.

15. **Note Repeat/Latch**: Press and hold this button, and then press a pad to trigger that pad’s sample repeatedly. The rate is based on the current tempo and Time Correct settings.

    Press and hold **Shift** and then press this button to “latch” the Note Repeat feature. When latched, you do not have to hold the Note Repeat button for it to be activated. Press **Note Repeat** once more to unlatch it.
16. **Project**: Press this button to use the Q-Link knobs to adjust parameters related to the current project. Press and hold **Shift** and then press this button to enter the Project Q-Link Edit Mode directly. See **Operation > Modes > Q-Link Edit Mode > Project** to learn about this.

17. **Program**: Press this button to use the Q-Link knobs to adjust parameters of the currently selected program or audio track. Press and hold **Shift** and then press this button to enter the Program Q-Link Edit Mode directly. See **Operation > Modes > Q-Link Edit Mode > Program** to learn about this.

18. **Pad Scene**: Press this button to use the Q-Link knobs to adjust parameters that you have assigned for the currently selected pad. Press and hold **Shift** and then press this button to enter the Pad Scene Q-Link Edit Mode directly. See **Operation > Modes > Q-Link Edit Mode > Pad Scene** to learn about this.

19. **Pad Param**: Press this button to use the Q-Link knobs to adjust one parameter across all 16 pads. Each Q-Link knob corresponds to the pad with the same number and position in the 4-by-4 layout. Press and hold **Shift** and then press this button to enter the Pad Param Q-Link Edit Mode directly. See **Operation > Modes > Q-Link Edit Mode > Pad Parameter** to learn about this.

20. **Screen Control/Edit**: Press this button to use the Q-Link knobs to adjust parameters in the currently selected mode as shown on the screen. See **Operation > Modes > Q-Link Edit Mode > Screen** to learn about this.

21. **Menu**: Press this button to open the Menu. You can tap an option in the Menu to enter that mode, view, etc.

22. **Main/Track**: Press this button to enter Main Mode.

23. **Browse/Save**: Press this button to view the Browser. The Browser lets you navigate your computer’s internal and external hard disks to load samples, sequences, songs, etc. Using filter buttons and user-definable folders, you can easily adapt it to your workflow. You can also preview samples before loading them.

24. **Step Seq/List Edit**: Press this button to view the Step Sequencer where you can create or edit sequences by using the pads as “step buttons,” simulating the experience of a traditional step-sequencer-style drum machine.

25. **Sampler/Looper**: Press this button to view the Sampler where you can record audio samples to use in your projects.

26. **XYFX**: Press this button to view XYFX Mode, which turns the touchscreen into an XY pad where each axis represents the range of an effect parameter. As you move touch or move your finger on the screen, the current position will determine the current value of the two parameters. You can use this mode to create interesting effect automation on your tracks.

27. **Pad Perform**: Press this button to view Pad Perform Mode where you can assign musical scales/modes, chords, or progressions to the pads for creative performance options.

28. **Prog Edit**: Press this button to view Program Edit Mode, which contains all parameters for editing your programs.

29. **Sample Edit**: Press this button to view Sample Edit Mode where you can edit your samples using various functions and processes.

30. **Pad Mixer**: Press this button to view the Pad Mixer where you can set a program’s levels, stereo panning, routing, and effects.

31. **Ch. Mixer**: Press this button to view the Channel Mixer where you can set levels, stereo panning, and other settings for your tracks, programs, returns, submixes and masters.

**Mode & View Controls**

**Note**: See **Operation > Modes** to learn about the different modes you can access with these controls.

21. **Menu**: Press this button to open the Menu. You can tap an option in the Menu to enter that mode, view, etc.

22. **Main/Track**: Press this button to enter Main Mode.

23. **Browse/Save**: Press this button to view the Browser. The Browser lets you navigate your computer’s internal and external hard disks to load samples, sequences, songs, etc. Using filter buttons and user-definable folders, you can easily adapt it to your workflow. You can also preview samples before loading them.

24. **Step Seq/List Edit**: Press this button to view the Step Sequencer where you can create or edit sequences by using the pads as “step buttons,” simulating the experience of a traditional step-sequencer-style drum machine.

25. **Sampler/Looper**: Press this button to view the Sampler where you can record audio samples to use in your projects.

26. **XYFX**: Press this button to view XYFX Mode, which turns the touchscreen into an XY pad where each axis represents the range of an effect parameter. As you move touch or move your finger on the screen, the current position will determine the current value of the two parameters. You can use this mode to create interesting effect automation on your tracks.

27. **Pad Perform**: Press this button to view Pad Perform Mode where you can assign musical scales/modes, chords, or progressions to the pads for creative performance options.

28. **Prog Edit**: Press this button to view Program Edit Mode, which contains all parameters for editing your programs.

29. **Sample Edit**: Press this button to view Sample Edit Mode where you can edit your samples using various functions and processes.

30. **Pad Mixer**: Press this button to view the Pad Mixer where you can set a program’s levels, stereo panning, routing, and effects.

31. **Ch. Mixer**: Press this button to view the Channel Mixer where you can set levels, stereo panning, and other settings for your tracks, programs, returns, submixes and masters.
32. **Track Mute/Pad Mute**: Press this button to view Track Mute Mode where you can easily mute tracks within a sequence or set mute groups for each track.

Press and hold *Shift* and press this button to view Pad Mute Mode where you can easily mute pads within a program or set mute groups for each pad within a program.

33. **Next Seq/Song**: Press this button to view Next Sequence Mode where you can trigger different sequences simply by playing the pads. This is useful for live performances, letting you change a song’s structure in real time.

Press and hold *Shift* and press this button to view Song Mode where you can arrange sequences in a specific order and/or repetition to create songs. You can edit the structure of a song during playback for easy, on-the-fly composing.

---

**Transport & Recording Controls**

34. **Play**: Press this button to play the sequence from the audio pointer’s current position.

35. **Play Start**: Press this button to play the sequence from its start point.

36. **Stop**: Press this button to stop playback. You can double-press this button to silence audio that is still sounding once a note stops playing. Quickly pressing this button three times will act as a “MIDI panic” and shut off all voices and stop all audio processing.

37. **Rec**: Press this button to record-arm the sequence. Press *Play* or *Play Start* to start recording. Recording in this way (as opposed to using Overdub) erases the events of the current sequence. After the sequence plays through once while recording, Overdub will be enabled.

38. **Overdub**: Press this button to enable Overdub. When enabled, you can record events in a sequence without overwriting any previously recorded events. You can enable Overdub before or during recording.

39. **<> (Event)</>:** Use these buttons to move the audio pointer left or right, one step at a time.

Press and hold *Locate* and press one of these buttons to move the audio pointer to the previous/next event in the sequence grid.

40. **</>> (Start/End)**: Use these buttons to move the audio pointer left or right, one bar at a time.

Press and hold *Locate* and press one of these buttons to move the audio pointer to the start or end of the sequence grid.

41. **Locate**: Press and hold this button to activate the secondary functions of the <> and </>> buttons (i.e., Event [</or>] and Start/End, respectively).

42. **Erase**: As a sequence is playing, press and hold this button and then press a pad to delete the note event for that pad at the current playback position. This is a quick way to delete note events from your sequence without having to stop playback. See *Operation > General Features > Erase* to learn more.

43. **Tap/Master**: Press this button in time with the desired tempo to enter a new tempo (in BPM). You can set how many taps are required in the Preferences (see *Operation > General Features > Menu > Preferences* to learn how to do this).

Press and hold *Shift* and press this button to set whether the currently selected sequence follows its own tempo (the button will be lit red) or a master tempo (the button will be lit amber).
I/O & Level Controls

44. **Gain 1/2**: Use these knobs to adjust the gain of the incoming signal from **Input 1/2** on the rear panel or **Inst 1/2** on the front panel. Use the **Rear/Front** switches below the knobs to determine the input. Use the **level meter** to check the recording level. Be careful when setting this knob at higher levels, which can cause the signal to distort.

45. **Rear/Front**: Use each switch to set whether the **Gain 1/2** knob above it will control the gain of the input signal on the rear panel (**Input 1/2**) or on the front panel (**Inst 1/2**).

46. **Phantom Power (+48V)**: This switch activates and deactivates phantom power for **Input 1/2**. When activated, +48V of phantom power will be supplied to both inputs. Note that most dynamic microphones do **not** require phantom power, while most condenser microphones **do**. Refer to your microphone’s documentation to check if it needs phantom power.

47. **3/4 Rec Gain**: Use this knob to adjust the gain of the incoming signal from **Input 3/4** on the rear panel. Use the **level meter** to check the recording level. Be careful when setting this knob at higher levels, which can cause the signal to distort.

48. **Master**: Turn this knob to adjust the volume level of the **Main L/R outputs**.

49. **Direct/Main**: Turn this knob to adjust the balance between the input and output signals in the headphones.

   - **Direct** corresponds to the input signal—all devices connected to the inputs on the front and rear panels. While recording, you can turn this knob all the way to **Direct** for zero-latency direct monitoring.

   - **Main** corresponds to the output signal—the signal sent from the Main L/R outputs on the rear panel. When you are **not** recording, we recommend turning this knob all the way to the **Main** position to hear the full-volume playback signal.

50. **Stereo/Mono**: Use this switch to set whether the signal in the headphones is binaural (**Stereo**) or monaural (**Mono**). When set to **Stereo**, the headphone signal will be split so that the input signal (**Direct**) is heard in the left ear while the output signal (**Main**) is heard in the right ear. When set to **Mono**, the input and output signals are blended into a single, summed mix, which is heard in both ears.

51. **Rec Arm**: Press this button to arm or disarm recording for the currently selected audio track, shown in the display strip below the **level meters** (see **Operation > General Features > Menu > Preferences** to learn how to set what is shown in the level meters).

52. **Read/Write**: Press this button to set the automation state for the program on the current track or for the current audio track: **Off**, **Read** (green R), or **Write** (red W). The display strip below the **level meters** must show a program or audio track (see **Operation > General Features > Menu > Preferences** to learn how to set what is shown in the level meters).

53. **Mute**: Press this button to mute the program, audio track, or master output shown in the display strip below the **level meters** (see **Operation > General Features > Menu > Preferences** to learn how to set what is shown in the level meters).

54. **Solo**: Press this button to solo the currently selected program or audio track shown in the display strip below the **level meters** (see **Operation > General Features > Menu > Preferences** to learn how to set what is shown in the level meters).

55. **Level Meters**: These meters indicate the level of the audio signal shown in the display strip below them. See **Operation > General Features > Menu > Preferences** to learn how to set what is shown in the level meters.
Touchscreen

Here is some general information about how to use the MPC X touchscreen:

Tap a button or option to select it. Use the data dial or +/- buttons to change its setting or value.

Spread two fingers to zoom in (into a section of a waveform, for example). Pinch two fingers to zoom out.

Double-tap a button to access advanced editing options. In some cases, this will show a numeric keypad that you can use to enter a value (an alternative to the data dial or +/- buttons). Tap the upper-left part of the screen to return to the previous view.

The top of the screen shows the toolbar, which contains information about the current view (often the name of the current track, sequence, audio pointer position, etc.). Tap an item to select it.

The bottom of the screen shows various buttons that you can use in the current view. Tap a button to press it.

To return to a previous view, either tap outside of the window currently on the screen or tap the left arrow (←) in the upper-left part of the screen.
1. **SD Card Slot:** Insert a standard SD/SDHC card into this slot to access its files directly using MPC X.

2. **Footswitch Inputs (FS 1/2) (1/4” / 6.35 mm):** Connect optional 1/4” (6.35 mm) TS footswitches to these inputs.

3. **Instrument Inputs (Inst 1/2) (1/4” / 6.35 mm):** Use standard 1/4” (6.35 mm) TS cables to connect these inputs to audio sources (guitars, bass, etc.). To use each of these inputs, set the corresponding Rear/Front switch (below the Gain 1/2 knob on the top panel) to **Front**.

4. **Mix Knob:** Turn this knob to adjust the balance between the **Main** and 3/4 signals in your headphones. **Main** is the signal sent from the **Main L/R outputs**. 3/4 is the signal sent from the **Outputs 3/4**.

5. **Headphone Outputs (1/8” or 1/4” / 3.5 mm or 6.35 mm):** Connect your headphones (not included) to either or both of these standard stereo outputs. Use the **Mix Knob** to determine what signal is heard in the headphones. Turn the **Headphone Volume** knob to set the volume level.

6. **Headphone Volume:** Turn this knob to adjust the volume of the headphone outputs.
1. **Power Input**: Use the included power adapter to connect MPC X to a power outlet. This must be connected to a power outlet in order for MPC X to power on.

2. **Power Adapter Restraint**: Secure the power adapter cable to this restraint to prevent it from accidentally unplugging.

3. **Power Switch**: Press this button to turn MPC X’s power on or off. While powered on, press and hold this button for 5 seconds to force MPC X to power off (similar to a computer).

4. **USB-B Port**: Use the included USB cable to connect this USB 3.0 port to an available USB 3.0 port on your computer. This connection allows MPC X to send/receive MIDI and audio data to/from the MPC software on your computer. It also allows any connected USB drives, SD cards, and drives connected to the internal SATA port to mount on your computer if MPC X is in Controller Mode (i.e., your computer can access these storage devices that are connected to your MPC X).

5. **USB-A Ports**: Connect USB flash drives to these USB ports to access their files directly using MPC X. MPC X supports read and write capability for exFAT, FAT32, NTFS, and EXT4 file systems as well as read-only capability for HFS+ file systems. (We recommend using an exFAT file system as it is the most robust one supported by both Windows and macOS.) These USB ports supply power to connected USB devices and can also be used to receive MIDI messages from external USB MIDI devices.

6. **Inputs 1/2 (XLR or 1/4” / 6.35 mm)**: Use standard XLR or 1/4” (6.35 mm) TRS cables to connect these inputs to audio sources (microphone, mixer, synthesizer, etc.). To use each of these inputs, set the corresponding Rear/Front switch (below the Gain 1/2 knob on the top panel) to Rear. Turn the Gain 1/2 knobs to set the input level of each one.

   **Note**: When using the XLR connection, the mic pre-amp is automatically engaged. When using a 1/4” (6.35 mm) TRS cable, the mic pre-amp is bypassed.

7. **Inputs 3/4 (1/4” / 6.35 mm or RCA)**: Use standard 1/4” (6.35 mm) TRS cables or stereo RCA cables to connect these inputs to audio sources (mixer, turntable, synthesizer, etc.). To use the 1/4” (6.35 mm) inputs, set the Phono/Line switch to Line. To use the RCA inputs, set the Phono/Line switch to Phono. Turn the 3/4 Rec Gain knob to set their input levels.

8. **Phono/Line Switch**: Set this switch to the appropriate position, depending on which Input 3/4 connectors you want to use. If you are using the 1/4” (6.35 mm) inputs, set this switch to Line. If you are using the RCA inputs, set this switch to Phono to provide the additional amplification needed for phono-level signals.

9. **Grounding Terminal**: If you are sending a phono-level turntable signal to the Input 3/4 RCA connectors and are hearing a low hum or buzz, it could mean that the turntable is not grounded. If the turntable has a grounding wire, connect it to this terminal.

   **Note**: Some turntables have a grounding wire built into the RCA connection and, therefore, nothing needs to be connected to the grounding terminal.

10. **Main L/R Outputs (1/4” / 6.35 mm)**: Use standard 1/4” (6.35 mm) TRS cables to connect these outputs to your speaker system. The signal sent out of these outputs is the master mix. Turn the Master knob to set their volume.

   **Tip**: To route a program to these outputs, set its routing to Out 1,2 in the Channel Mixer when the Mixer field is set to Programs. See Operation > Modes > Channel Mixer to learn more about this.

11. **Outputs 3/4, 5/6, 7/8 (1/4” / 6.35 mm)**: Use standard 1/4” (6.35 mm) TRS cables to connect these outputs to an external mixer. The signal sent from these outputs is full-volume (0 dB).

   **Tip**: To route a program to these outputs, set its routing to Out 1,2, Out 5,6, or Out 7,8 (respectively) in the Channel Mixer when the Mixer field is set to Programs. See Operation > Modes > Channel Mixer to learn more about this.

12. **MIDI In**: Use standard 5-pin MIDI cables to connect these inputs to the MIDI outputs of optional external MIDI devices.

13. **MIDI Out**: Use standard 5-pin MIDI cables to connect these outputs to the MIDI inputs of optional external MIDI devices.

14. **CV/Gate Out**: Use standard 1/8” (3.5 mm) TS cables to connect these outputs to optional external sequencers. MPC X will send control voltage (CV) and/or Gate data over this connection.
1. **Touchscreen**: This full-color multi-touch display shows information relevant to MPC Live’s current operation. Touch the touchscreen (and use the hardware controls) to control the MPC interface. See the later Touchscreen section to learn how to use some basic functions.

2. **Data Dial**: Use this dial to scroll through the available menu options or adjust the parameter values of the selected field on the screen. Pressing the dial also functions as an Enter button.

3. **Q-Link Knobs**: Use these touch-sensitive knobs to adjust various parameters and settings. The knobs can control one group of parameters at a time. The lights below the Q-Link button indicate the currently selected column of Q-Link knobs. Press the Q-Link button to change which parameter or group of parameters they currently control.

4. **Q-Link Button**: Press this button to change which parameter or group of parameters the Q-Link knobs currently control (indicated by the lights above the Q-Link knobs). Each press will select the next column of Q-Link knobs. Press and hold Shift and then press this button to select the previous column of Q-Link knobs instead.

5. **Pads**: Press these pads to trigger drum hits or other samples in your software. The pads are velocity-sensitive and pressure-sensitive, which makes them very responsive and intuitive to play. The pads will light up different colors, depending on how hard you play them (ranging from yellow at a low velocity to red at the highest velocity). You can also customize their colors.

6. **Pad Bank**: Press any of these buttons to access Pad Banks A–D.

   Press and hold Shift while pressing any of these buttons to access Pad Banks E–H. Alternatively, double-press one of these buttons.

7. **Note Repeat/Latch**: Press and hold this button, and then press a pad to trigger that pad’s sample repeatedly. The rate is based on the current tempo and Time Correct settings.

   Press and hold Shift and then press this button to “latch” the Note Repeat feature. When latched, you do not have to hold the Note Repeat button for it to be activated. Press Note Repeat once more to unlatch it.
8. **Full Level/Half Level**: Press this button to activate or deactivate the Full Level feature. When activated, the pads will always trigger their samples at the maximum velocity (127), regardless of how much force you use.

Press and hold Shift and then press this button to activate or deactivate the Half Level feature. When activated, the pads will always trigger their samples at half-velocity (64).

9. **16 Level**: Press this button to activate/deactivate 16 Level. When activated, the last pad that was hit will be temporarily copied to all 16 pads. The pads will now output the same note number as the initial pad, but a selectable parameter will be fixed at values that increase as the pad numbers increase (e.g., Pad 1 is the minimum, Pad 16 is the maximum), regardless of how hard you press them. In the screen that appears, use the Type selector to choose the parameter: *Velocity*, *Tune*, *Filter*, *Layer*, *Attack*, or *Decay*. See *Operation > General Features > 16 Level* to learn more.

10. **Erase**: As a sequence is playing, press and hold this button and then press a pad to delete the note event for that pad at the current playback position. This is a quick way to delete note events from your sequence without having to stop playback. See *Operation > General Features > Erase* to learn more.

11. **Shift**: Press and hold this button to access some buttons’ secondary functions (indicated by gray writing).

   Double-press this button to see which buttons have secondary functions—the buttons will flash for a few seconds.

12. **Menu/Browse**: Press this button to open the Menu. You can tap an option in the Menu to enter that mode, view, etc.

   Press and hold Shift and then press this button to view the Browser. You can use the Browser to locate and select programs, samples, sequences, etc.

13. **Main/Track**: Press this button to enter Main Mode.

   Press and hold Shift and then press this button to enter the Track View.

14. **Undo/Redo**: Press this button to undo your last action.

   Press and hold Shift and press this button to redo the last action you undid.

15. **Copy/Delete**: Press this button to copy one pad to another. When the *From Pad* field is selected, press the “source” pad (the pad you want to copy). When the *To Pad* graphic (of all pads) is selected, press the “destination” pad. You can select multiple destination pads, and you can select pads in different pad banks. Tap **Do It** to continue or **Close** to return to the previous screen.

   **Tip**: To quickly copy a pad, press and hold **Copy**, press the source pad, press the destination pad, and then release **Copy**.

   Press and hold Shift and press this button to delete a pad’s sample assignment. When the *Delete Pad* window is shown, press any pad/pads whose sample assignments you want to clear. Tap **Delete** to continue or **Cancel** to return to the previous screen.

16. **–/+**: Press these buttons to increase or decrease the value of the selected field on the screen.

17. **Play**: Press this button to play the sequence from the audio pointer’s current position.

18. **Play Start**: Press this button to play the sequence from its start point.

19. **Stop**: Press this button to stop playback. You can double-press this button to silence audio that is still sounding once a note stops playing. Quickly pressing this button three times will act as a “MIDI panic” and shut off all voices and stop all audio processing.

20. **Rec**: Press this button to record-arm the sequence. Press **Play** or **Play Start** to start recording. Recording in this way (as opposed to using **Overdub**) erases the events of the current sequence. After the sequence plays through once while recording, Overdub will be enabled.

21. **Overdub**: Press this button to enable Overdub. When enabled, you can record events in a sequence without overwriting any previously recorded events. You can enable Overdub before or during recording.

22. **Tap/Master**: Press this button in time with the desired tempo to enter a new tempo (in BPM). You can set how many taps are required in the Preferences (see *Operation > General Features > Menu > Preferences* to learn how to do this).

   Press and hold Shift and press this button to set whether the currently selected sequence follows its own tempo (the button will be lit red) or a master tempo (the button will be lit amber).
Touchscreen

Here is some general information about how to use the MPC Live touchscreen:

Tap a button or option to select it. Use the **data dial** or +/- buttons to change its setting or value.

Double-tap a button to access advanced editing options. In some cases, this will show a numeric keypad that you can use to enter a value (an alternative to the **data dial** or +/- buttons). Tap the upper-left part of the screen to return to the previous view.

Spread two fingers to zoom in (into a section of a waveform, for example). Pinch two fingers to zoom out.

The top of the screen shows the toolbar, which contains information about the current view (often the name of the current track, sequence, audio playhead position, etc.). Tap an item to select it.

The bottom of the screen shows various buttons that you can use in the current view. Tap a button to press it.

**To return to a previous view**, either tap outside of the window currently on the screen or tap the left arrow (enerative) in the upper-left part of the screen.
1. **Power Input**: Use the included power adapter to connect MPC Live to a power outlet.

2. **Power Switch**: Turns MPC Live’s power on/off.

3. **Charging Indicator**: This light (behind the vent) will turn on when MPC Live’s internal battery is charging (when the power input is connected to a power outlet). When the battery is fully charged or when it is disconnected from a power outlet, then this light will turn off.

4. **USB-B Port**: Use the included USB cable to connect this USB 3.0 port to an available USB 3.0 port on your computer. This connection allows MPC Live to send/receive MIDI and audio data to/from the MPC software on your computer. It also allows any connected USB drives, SD cards, and drives connected to the internal SATA port to mount on your computer if MPC Live is in Controller Mode (i.e., your computer can access these storage devices that are connected to your MPC Live).

5. **USB-A Ports**: Connect USB flash drives to these USB ports to access their files directly using MPC Live. MPC Live supports read and write capability for exFAT, FAT32, NTFS, and EXT4 file systems as well as read-only capability for HFS+ file systems. (We recommend using an exFAT file system as it is the most robust one supported by both Windows and macOS.) These USB ports supply power to connected USB devices and can also be used to receive MIDI messages from external USB MIDI devices.

6. **SD Card Slot**: Insert a standard SD/SDHC card into this slot to access its files directly using MPC Live.

7. **Rec Vol**: Turn this knob to adjust the gain of the incoming signal from the 1/4” (6.35 mm) and RCA inputs. Be careful when setting this knob at higher levels, which can cause the signal to distort.

8. **Master Vol**: Turn this knob to adjust the volume of Output 1/2 and the phones output.

9. **Inputs (1/4” / 6.35 mm)**: Use standard 1/4” (6.35 mm) TRS cables to connect these inputs to audio sources (microphone, mixer, synthesizer, etc.). To use these inputs, set the **Line/Phono switch** to Line. Turn the **Rec Vol** knob to set their input levels.

10. **Inputs (RCA)**: Use a standard RCA stereo cable to connect these inputs to a phono-level audio source like a turntable. To use these inputs, set the **Line/Phono switch** to Phono. Turn the **Rec Vol** knob to set their input levels.

11. **Line/Phono Switch**: Set this switch to the appropriate position, depending on which inputs you want to use. If you are using the RCA inputs, set this switch to Phono to provide the additional amplification needed for phono-level signals. If you are using the 1/4” (6.35 mm) inputs, such as a keyboard or a sampler, set this switch to Line.

12. **Grounding Terminal**: If using phono-level turntables with a grounding wire, connect the grounding wire to these terminals. If you experience a low “hum” or “buzz”, this could mean that your turntables are not grounded.

   **Note**: Some turntables have a grounding wire built into the RCA connection and, therefore, nothing needs to be connected to the grounding terminal.

13. **Outputs (1/4” / 6.35 mm)**: Use standard 1/4” (6.35 mm) TRS cables to connect these outputs to your speaker system, external mixer, etc. The signal sent out of the **Master L/R** outputs is the master mix. Turn the **Master Vol** knob to set their volume. The signals sent from Outputs 3–6 are full-volume (0 dB).

   **Tip**: To route a program to these outputs, set its routing to Out 1,2, Out 3,4, or Out 5,6 (respectively) in the **Channel Mixer** when the **Mixer** field is set to **Programs**. See **Operation > Modes > Channel Mixer** to learn more about this.

14. **Phones (1/8” / 3.5 mm)**: Connect standard 1/8” (3.5 mm) stereo headphones to this output. Turn the **Master Vol** knob to set the volume level.

15. **MIDI In**: Use standard 5-pin MIDI cables to connect these inputs to the MIDI outputs of optional external MIDI devices.

16. **MIDI Out**: Use standard 5-pin MIDI cables to connect these outputs to the MIDI inputs of optional external MIDI devices.

17. **Kensington® Lock Slot**: You can use this slot to secure your MPC Live to a table or other surface.
1. **Touchscreen**: This full-color multi-touch display shows information relevant to MPC Touch’s current operation. Touch the touchscreen (and use the hardware controls) to control the MPC interface. See the later Touchscreen section to learn how to use some basic functions.

2. **Display Brightness +/-**: Use these buttons to increase/decrease the brightness of the touchscreen.

3. **Data Dial**: Use this dial to scroll through the available menu options or adjust the parameter values of the selected field in the screen.

4. **Q-Link Knobs**: Use these touch-sensitive knobs to adjust various parameters and settings. The knobs can control one group of parameters at a time. The lights below the Q-Link button indicate the currently selected column of Q-Link knobs. Press the Q-Link button to change which parameter or group of parameters they currently control.

5. **Q-Link Button**: Press this button to change which parameter or group of parameters the Q-Link knobs currently control (indicated by the lights above the Q-Link knobs). Each press will select the next column of Q-Link knobs.

   Press and hold Shift and then press this button to select the previous column of Q-Link knobs instead.

   Press and hold Shift and then press this button to show the QLink window over the touchscreen’s current contents. These are the same parameters and settings as what is shown in Q-Link Edit Mode. You can tap Q-Link Edit at the bottom of the window to enter Q-Link Edit Mode immediately (see **Operation > Modes > Q-Link Edit Mode** to learn about this).

6. **Pads**: Press these pads to trigger drum hits or other samples in your software. The pads are velocity-sensitive and pressure-sensitive, which makes them very responsive and intuitive to play. The pads will light up different colors, depending on how hard you play them (ranging from yellow at a low velocity to red at the highest velocity). You can also customize their colors.

7. **Pad Bank**: Press any of these buttons to access Pad Banks A–D.

   Press and hold Shift while pressing any of these buttons to access Pad Banks E–H. Alternatively, double-press one of these buttons.

8. **Note Repeat/Latch**: Press and hold this button, and then press a pad to trigger that pad's sample repeatedly. The rate is based on the current tempo and Time Correct settings.

   Press and hold Shift and then press this button to “latch” the Note Repeat feature. When latched, you do not have to hold the Note Repeat button for it to be activated. Press Note Repeat once more to unlatch it.
9. **Full Level/Half Level:** Press this button to activate or deactivate the Full Level feature. When activated, the pads will always trigger their samples at the maximum velocity (127), regardless of how much force you use.

Press and hold Shift and then press this button to activate or deactivate the Half Level feature. When activated, the pads will always trigger their samples at half-velocity (64).

10. **16 Level:** Press this button to activate/deactivate 16 Level. When activated, the last pad that was hit will be temporarily copied to all 16 pads. The pads will now output the same note number as the initial pad, but a selectable parameter will be fixed at values that increase as the pad numbers increase (e.g., Pad 1 is the minimum, Pad 16 is the maximum), regardless of how hard you press them. In the screen that appears, use the **Type** selector to choose the parameter: **Velocity, Tune, Filter, Layer, Attack,** or **Decay.** See **Operation > General Features > 16 Level** to learn more.

11. **Erase:** As a sequence is playing, press and hold this button and then press a pad to delete the note event for that pad at the current playback position. This is a quick way to delete note events from your sequence without having to stop playback. See **Operation > General Features > Erase** to learn more.

12. **Shift:** Press and hold this button to access some buttons’ secondary functions (indicated by **gray** writing).

Double-press this button to see which buttons have secondary functions—the buttons will flash for a few seconds.

13. **Menu/Browse:** Press this button to open the Menu. You can tap an option in the Menu to enter that mode, view, etc.

Press and hold Shift and then press this button to view the Browser. You can use the Browser to locate and select programs, samples, sequences, etc.

14. **Main/Track:** Press this button to enter Main Mode.

Press and hold Shift and then press this button to enter the Track View.

15. **Undo/Redo:** Press this button to undo your last action.

Press and hold Shift and press this button to redo the last action you undid.

16. **Copy/Delete:** Press this button to copy one pad to another. When the **From Pad** field is selected, press the “source” pad (the pad you want to copy). When the **To Pad** graphic (of all pads) is selected, press the “destination” pad. You can select multiple destination pads, and you can select pads in different pad banks. Tap **Do It** to continue or **Close** to return to the previous screen.

**Tip:** To quickly copy a pad, press and hold **Copy**, press the source pad, press the destination pad, and then release **Copy**.

Press and hold Shift and press this button to delete a pad’s sample assignment. When the **Delete Pad** window is shown, press any pad/pads whose sample assignments you want to clear. Tap **Delete** to continue or **Cancel** to return to the previous screen.

17. **+-:** Press these buttons to increase or decrease the value of the selected field in the screen.

18. **Play:** Press this button to play the sequence from the audio pointer’s current position.

19. **Play Start:** Press this button to play the sequence from its start point.

20. **Stop:** Press this button to stop playback. You can double-press this button to silence audio that is still sounding once a note stops playing. Quickly pressing this button three times will act as a “MIDI panic” and shut off all voices and stop all audio processing.

21. **Rec:** Press this button to record-arm the sequence. Press **Play** or **Play Start** to start recording. Recording in this way (as opposed to using **Overdub**) erases the events of the current sequence. After the sequence plays through once while recording, Overdub will be enabled.

22. **Overdub:** Press this button to enable Overdub. When enabled, you can record events in a sequence without overwriting any previously recorded events. You can enable Overdub before or during recording.

23. **Tap/Master:** Press this button in time with the desired tempo to enter a new tempo (in BPM). You can set how many taps are required in the Preferences (see **Operation > General Features > Menu > Preferences** to learn how to do this).

Press and hold Shift and press this button to set whether the currently selected sequence follows its own tempo (the button will be lit **red**) or a master tempo (the button will be lit **amber**).
**Touchscreen**

Here is some general information about how to use the MPC Touch touchscreen:

Tap a button or option to select it. Use the **data dial** or \(-/+/\) buttons to change its setting or value.

Double-tap a button to access advanced editing options. In some cases, this will show a numeric keypad that you can use to enter a value (an alternative to the **data dial** or \(-/+/\) buttons). Tap the upper-left part of the screen to return to the previous view.

Spread two fingers to zoom in (into a section of a waveform, for example). Pinch two fingers to zoom out.

The top of the screen shows the toolbar, which contains information about the current view (often the name of the current track, sequence, audio playhead position, etc.). Tap an item to select it.

The bottom of the screen shows various buttons that you can use in the current view. Tap a button to press it.

**To return to a previous view**, either tap outside of the window currently in the screen or tap the left arrow (\(\leftarrow\)) in the upper-left part of the screen.
1. **Power Input**: Use the included power adapter to connect MPC Touch to a power outlet. Alternatively, you can power MPC Touch via the USB port only, but the touchscreen will be disabled.

2. **Power Switch**: Turns MPC Touch’s power on/off.

3. **USB Port**: Use the included USB cable to connect this high-retention-force USB port to an available USB port on your computer. This connection allows MPC Touch to send/receive MIDI and audio data to/from the MPC software. You can power MPC Touch via the USB port only, but the touchscreen will be disabled.

4. **Rec Vol**: Turn this knob to adjust the gain of the incoming signal from the inputs. Be careful when setting this knob at higher levels, which can cause the signal to distort.

5. **Master Vol**: Turn this knob to adjust the volume of the outputs and phones output.

6. **Inputs** (1/4” / 6.35 mm): Use standard 1/4” (6.35 mm) TRS cables to connect these inputs to audio sources (microphone, mixer, synthesizer, etc.). Turn the Rec Vol knob to set their input levels.

7. **Outputs** (1/4” / 6.35 mm): Use standard 1/4” (6.35 mm) TRS cables to connect these outputs to your speaker system, external mixer, etc. The signal sent out of these outputs is the master mix. Turn the Master Vol knob to set the volume level.

   **Tip**: To route a program to these outputs, set its routing to Out 1,2 in the Channel Mixer when the Mixer field is set to Programs. See *Operation > Modes > Channel Mixer* to learn more about this.

8. **Phones** (1/8” / 3.5 mm): Connect standard 1/8” (3.5 mm) stereo headphones to this output. Turn the Master Vol knob to set the volume level.

9. **MIDI Out** (1/8” / 3.5 mm): Use the included 1/8”-to-5-pin adapter and a five-pin MIDI cable to connect this output to the MIDI input of an optional external MIDI device.

   **Important**: Do not connect audio devices (e.g., headphones, monitors, etc.) to the MIDI Out. Use the included 1/8”-to-5-pin adapters to connect MIDI devices only.

10. **MIDI In** (1/8” / 3.5 mm): Use the included 1/8”-to-5-pin adapter and a five-pin MIDI cable to connect this input to the MIDI output of an optional external MIDI device.

   **Important**: Do not connect audio devices (e.g., headphones, monitors, etc.) to the MIDI In. Use the included 1/8”-to-5-pin adapters to connect MIDI devices only.

11. **Kensington® Lock Slot**: You can use this slot to secure your MPC Touch to a table or other surface.
Basic Concepts

This chapter should help explain some fundamental aspects of the MPC universe.

The MPC workflow is quite different from traditional digital audio workstations (DAWs). In most typical DAWs, each track uses an instance of each instrument, and all tracks are always playing even if they don’t contain any audio or MIDI information. Furthermore, your entire project needs to be arranged just as the resulting song would be. This isn’t the case with MPC, which offers much more flexibility within your project. It’s important to understand some basic terms, though:

A sequence is a “building block” of a song. It contains multiple tracks that play at the same time like a normal DAW. In a project, you might create one sequence for your verse and another sequence for your chorus, alternating and/or repeating each one in a specific order to create the song. (A project can contain **128 sequences**.)

A track is a layer in a sequence. There are two types of tracks:

- **MIDI tracks** consist of MIDI data only, no audio data. These tracks produce sound by using programs, described below. Unlike a normal DAW, each MIDI track exists only in its sequence. The advantage of this is not having to manage empty or unwanted tracks across all of your sequences—each sequence contains only the tracks you want to use in it. If you want to use the same track across multiple sequences, you can copy the track from one sequence into another. (A sequence can contain **128 MIDI tracks**.)

- **Audio tracks** consist of a recorded audio signal, like a traditional DAW. These tracks do not use programs because the audio is already contained in the track. Also, unlike MIDI tracks, audio tracks are present in every sequence in the project, even if the tracks themselves are empty. (A sequence on your MPC hardware can contain **8 audio tracks**. A sequence in the MPC software can contain **128 audio tracks**.)

A program is a preset through which MIDI tracks are routed. Programs may contain audio samples that are triggered when tracks play through them, producing the sound you want on that track. Programs are independent of tracks and sequences, so you can set multiple tracks to use the same program (unlike normal DAWs where each track requires its own set of samples). Furthermore, you can use the same program/programs across multiple sequences. (A project can contain **128 programs**.)

Each program can be played using the **16 pads** (across eight pad banks, which gives you access to **128 pads in each program**). Each pad plays a MIDI note when you press it, but that MIDI note will trigger something different for each program. For instance, in drum programs, the pads are assigned to samples—one pad could trigger a kick drum sound and another could trigger a snare drum sound—whereas in keygroup programs, each pad triggers a MIDI note that plays the corresponding pitch of the sample assigned to its keygroup.

Here’s a diagram to illustrate an example of how these pieces could work together:

Please take a look at the following **Tutorial** chapter, as well. It will walk you through the creation of a short song to show you some of your MPC hardware’s most important features.
Tutorial

This chapter should familiarize you with some basic MPC features. We’ll create a short song to illustrate some of the most important features. To get the most out of this chapter, we recommend reproducing each of the described steps.

Starting Up

Make sure you have completed all of the steps described in Introduction > Setup. This includes:

- Installing the most current drivers and software.
- Connecting your MPC hardware to a power source using the included power adapter (if required) and powering it on.
- Opening and authorizing your MPC software (if you are using your MPC hardware as a controller).

Creating a Drum Kit

Let’s start by making a simple drum kit.

Press Browse (MPC X) or Shift+Menu/Browse (MPC Live, MPC Touch) to show the Browser. Then, use the touchscreen to navigate to where your drum sounds are located:

To browse your files by location, tap Places on the left side of the screen.

Internal is the internal drive of MPC X or MPC Live.

MPC Documents is a shortcut to the MPC Documents folder on the internal drive of MPC X or MPC Live.

If you have storage devices connected to USB ports or SD card slot of MPC X, MPC Live, or your computer (with MPC Touch), they will appear in this column, as well.

Important: MPC X and MPC Live support read and write capability for exFAT, FAT32, NTFS, and EXT4 file systems as well as read-only capability for HFS+ file systems. (We recommend using an exFAT file system as it is the most robust one supported by both Windows and macOS.)

To browse your files by type, tap Content and then tap the type of file: Drums, Instruments, Clips, Samples, Demos, or My Files.

To browse your MPC Expansions (MPC X or MPC Live only), tap Expansions (see Addenda > Updates for MPC 2.1 > New Features > Exporting Expansions to learn how to export MPC Expansions from your computer to your MPC X or MPC Live).

To move up one folder level, tap the folder/↑ icon in the upper-left corner.

To move through a list, swipe up or down, turn the data dial or use the ←/+ buttons.

To select a file or folder, tap it once.

To enter a folder, double-tap it or tap Open in the lower-right corner. Alternatively, press the center cursor or Enter (MPC X) or the data dial (MPC Live, MPC Touch) to enter a selected folder.
To load a selected file, double-tap it, tap Load, or press the center cursor or Enter (MPC X) or the data dial (MPC Live, MPC Touch). If the file is a sample, it will be loaded to the project’s sample pool. If the file is a project, it will be loaded in its entirety (you will be asked if you want to close your current project).

To load all files in a folder, select the folder (so it is highlighted in the list), press and hold Shift, and then tap Load All in the lower-right corner.

Important: Although you can load multiple files at once, any samples you load into a project will be automatically converted to full-quality uncompressed audio files, so they may use more storage space than they do on your external storage device. If you are unable to load multiple files at once due to this, select fewer files and try again.

To delete a selected file or folder, press and hold Shift and then tap Delete File at the bottom of the screen.

To preview a selected sound, tap and hold Play (▶) at the bottom of the screen.

To enable or disable the audition function and set its volume level, tap Audition at the bottom of the screen. In the screen that appears, tap Auto to enable or disable it, and tap and drag the level slider up or down to set the volume level. Tap Audition once more to hide the window.

To show the information for the current drive (MPC X, MPC Live), press and hold Shift and then tap Drive Info at the bottom of the screen. The drive’s information will appear in a new window. Tap OK to return to the previous screen.

After loading samples for a drum kit into the sample pool, use the Sample Assign tab to assign a kick drum sound to a pad:

1. Tap Sample Assign at the bottom of the screen. This lets you view the pads and project’s sample pool.
2. Press Pad 1 or tap Pad 1 on the screen to select it. The pad will be lit green.
3. Swipe the Sample Pool list up or down or use the data dial or +/- buttons to move through it.
4. To load a sample to the selected pad (Pad 1, in this case) tap it in the Sample Pool list, or press the center cursor or Enter (MPC X) or the data dial (MPC Live, MPC Touch). Now, you can press Pad 1 to play the kick drum sample.

To create a simple drum kit, repeat the above steps for other pads. We recommend loading a snare drum, a closed hi-hat, and an open hi-hat.
Creating a Drum Sequence

Now that your drum kit is set up, let’s record a drum sequence.

1. Press **Menu** to enter the Menu, and then tap **Grid View**.
2. Press **Tap** repeatedly at the speed you want to record your sequence. Your MPC hardware will detect the rate and adjust itself automatically.
3. Press the **Rec** button to record-arm the sequence.
4. Press the **Play** button to start the actual recording. You will hear the count-in for one measure before the recording starts. We recommend recording only one sound (pad) at a time, especially if you’re not familiar with playing drums on the pads.
5. Play a simple kick drum pattern. The note events you just recorded will automatically be placed in the grid (in this case, on 16th notes). The initial measure length is two bars. After the two bars, the recording will automatically activate Overdub; the sequence will play again from the beginning and keeps looping, allowing you to record further notes. Don’t stop the recording!
6. Play the snare drum part, then a hi-hat part.
7. When you’re done recording, press the **Stop** button.

If you start recording again on this sequence, keep in mind that the pads you play in your new recording will replace existing notes played with the same pads. To prevent this, press the **Overdub** button before recording instead of the Rec button. Overdub lets you record additional note events over the existing sequence.

The **Undo** button functions differently while recording. Normally, pressing **Undo** will undo just the last event. When there is an event to undo, the **Undo** button will be lit solid. While recording, the **Undo** button will flash. In this case, pressing **Undo** will erase all events from that recording (i.e., since **Play** or **Play Start** was pressed).
Saving & Renaming

We recommend doing some renaming of your programs and samples before going further.
The collection of drum samples you loaded earlier (and their respective pad assignments) are arranged into a program. When you load this program in the future, you will be able to use all of the samples that belong to it.
Let’s rename the existing program as we’ll want to create more programs later on.

To rename a program:
1. Press Main to enter Main Mode.
2. In the Program section in the lower part of the screen, tap the cursor icon on the right edge.
3. Use the virtual keyboard that appears to enter a new name (e.g., Drums), and then tap Do It.

To rename your samples:
1. Press Menu to enter the Menu, and then tap Sample Edit to enter Sample Edit Mode.
2. The Sample field at the top of the screen will show the name of a sample. Select a sample in one of the following ways:
   - When the Sample field is selected, use the data dial or −/+ buttons to change it.
   - Double-tap the Sample field and tap one in the list that appears.
3. Tap the keyboard icon next to it to rename the current sample.
4. Use the virtual keyboard that appears to enter a new name (e.g., Kick, Snare, etc.), and then tap Do It.
Repeat Steps 2–4 to rename other samples.
Now would be a good time to save your project.

To save your project, press Menu to show the Menu, and tap the disk icon at the top of the screen to open the Save window. Alternatively, press Shift+Browse/Save (MPC X). In the Save window, do any of the following:

To select the storage device you want to view, tap it in the Storage column on the left.

- **Internal** is the internal drive of MPC X or MPC Live.

- **MPC Documents** is a shortcut to the MPC Documents folder on the internal drive of MPC X or MPC Live.

  If you have storage devices connected to USB ports or SD card slot of MPC X, MPC Live, or your computer (with MPC Touch), they will appear in this column, as well.

To enter a folder, double-tap it. Alternatively, turn the data dial or use the +/- buttons to move through the list, and press the center cursor or Enter (MPC X) or the data dial (MPC Live, MPC Touch) to enter a folder. You can also tap one of the five folder buttons in the upper-right to jump immediately to those pre-assigned file paths (see Operation > Modes > Browser to learn how to do this).

To create a new folder, tap New Folder, use the virtual keyboard that appears to enter a name, and then tap Do It. You will immediately enter the new folder.

To move up one folder level, tap the folder/↑ icon in the upper-left corner.

To name the file, tap the File Name field at the bottom of the screen, and use the virtual keyboard that appears.

To save the file, tap Save.

To cancel and return to the Menu, tap Cancel. Alternatively, tap the ← icon in the upper-left corner.
Editing Note Events

In the grid, you can see your recorded notes (or note events) as a sequence.

To enter the Grid View, press Menu, and then tap Grid View.

In the Grid View, you can do any of the following:

- To zoom in or out, tap the magnifying-glass icon in the upper-right corner. Then, in the grid, spread two fingers apart or pinch two fingers together. You can do this for each axis, horizontal or vertical.

- To automatically set the grid to view one pad bank and two bars, tap the grid-and-magnifying-glass icon in the lower-left corner.

- To undo your last action, press Undo.

- To redo the last action you undid, press Shift+Undo/Redo.

- To enter a note, tap the pencil icon in the upper-right corner. Then, in the grid, tap a square.

- To delete a note, tap the eraser icon in the upper-right corner. Then, in the grid, tap a note.

- To select a single note, tap the select box in the upper-right corner. Then, in the grid, tap the note.

- To select all notes for a pad, press the desired pad.

- To move the selected notes, tap Nudge at the bottom of the screen, and then use the data dial or +/- buttons to shift the notes left or right. By default, you can position notes only by quantization values defined by the Time Correct value (learn about this feature in Operation > General Features > Timing Correct (TC)).

- To move the selected notes without restricting (“snapping”) them to the quantization grid, tap and hold Don’t Snap in the lower-left corner of the screen, and then use the data dial or +/- buttons to shift the notes. In this case, each nudge is equivalent to four ticks.

- To adjust the start point or end point of the selected notes (without changing their position), tap Edit Start or Edit End at the bottom of the screen, and then use the data dial or +/- buttons.

- To transpose the selected notes up or down, tap Transpose at the bottom of the screen, and then use the data dial or +/- buttons.

- To switch to the previous or next track, tap the Track field in the upper-left corner, and then use the data dial or +/- buttons.

- To mute or solo the track, press and hold Shift, and then tap Mute or Solo (respectively) at the bottom of the screen.
To open the Timing Correct window, press and hold Shift, and then tap TC at the bottom of the screen. See Operation > General Features > Timing Correct (TC) to learn about this.

To adjust the velocity of the selected notes, tap Velocity at the bottom of the screen, and then use the data dial or +/- buttons. The numeric value will appear on the screen.

To show or hide the velocity lane, tap the up arrow (∧) button in the lower-right corner of the screen to show the velocity lane below the grid. Each note’s velocity is represented by a vertical bar. The higher and more red the bar is, the higher the velocity is.

Tap the up arrow (∧) button once more to show a taller version of the velocity lane after which it will turn into a down arrow (∨) button, which you can then tap to hide the velocity lane.
Making Basic Sound Edits

Let’s make sure the samples are properly tuned and have good levels.

Press Menu, and then tap Program Edit to enter Program Edit Mode. Alternatively, press Prog Edit (MPC X).

Press a pad to show its parameters on the screen.

**To adjust its volume,** tap and drag the Volume knob up or down. Alternatively, use the data dial or +/- buttons. **To make finer adjustments,** double-tap the knob and adjust the larger version that appears. Tap anywhere else to return to the previous screen.

**To adjust its stereo panning,** tap and drag the Pan knob up or down. Alternatively, use the data dial or +/- buttons. **To make finer adjustments,** double-tap the knob and adjust the larger version that appears. Tap anywhere else to return to the previous screen.

Adjust the level of each pad to suit your taste. We recommend spreading the panning of the bright sounds (e.g., cymbals, snare drum) a little. Additionally, you can tune the kick drum sound—tap the Samples tab so the first square under it is lit, and then adjust the Semi and Fine knobs next to the sample name.
The snare drum may need some reverb to give it a more spatial sound.

Tap **Effects** at bottom of the screen to view the **Insert Effects** tab. Press the **pad** with your snare drum sound to select it.

To add an effect:
1. Double-tap the desired slot. A list of effects will appear.
2. Swipe up or down to move through the list.
3. **To load an effect**, double-tap it. Alternatively, tap it once and then tap **Select** or push the **data dial**. Let’s try **Reverb Medium**.
4. **To close the list**, tap **Close**.

**To adjust the effect’s parameters**, tap the **pencil icon**.

**To empty the effect slot**, tap the **trash can icon**. Switch the effect on or off by tapping the **On/Off** button for the slot.
Creating a Bass Track

Let’s try recording a bass line. Unlike a drum kit, it’s important to be able to play and record a bass sound chromatically, so this will be slightly different than setting up the drum kit.

Adding a bass line over the drum part means we need to work on a new track. A **track** is simply a layer of a sequence. Each track uses a program within your project. You can work with multiple tracks in a single sequence (e.g., a drum track, a bass track, a piano track, etc.). When you play the sequence, all of them will play simultaneously.

First, let’s make an empty track.

![MPC Project 001](image)

**To select a new track:**

1. Press **Main** to go back to Main Mode.
2. Double-tap the **Track** field in the center-left part of the screen, and then tap **Track 2 (unused)** in the list of tracks that appears.
   Alternatively, tap the **Track +** button at the bottom of the screen until **(unused)** appears in the **Track** field.

Let’s create a new program for this track to use.

![MPC Project 001](image)

**To create a new program:**

1. In the **Track** section in the middle of the screen, tap the **piano-keys icon**. This icon indicates a keygroup program, which is necessary to play the bass sound chromatically with the pads.
   A name for the new keygroup program will appear in the **Program** field in the lower part of the screen.
2. In the **Program** section in the lower part of the screen, tap the **cursor icon** on the right edge.
3. Use the virtual keyboard that appears to enter a new name, and then tap **Do It**.
To load and edit a bass sound:

1. Press Browse (MPC X) or Shift+Menu/Browse (MPC Live, MPC Touch) to show the Browser. Then, use the touchscreen to navigate to where your bass sounds are located, and load one to the project’s sample pool. (You can look at [this earlier section](#) if you forgot how to do this!)

2. After loading a bass sample to the sample pool, don't use the Sample Assign tab like you did when creating a drum program; keygroup programs are different.

   Instead, press Menu, and then tap Program Edit to enter Program Edit Mode. Alternatively, press Prog Edit (MPC X).

3. In Program Edit Mode, tap the Samples tab at the bottom of the screen to show the four layers of samples in the program.

4. Double-tap the first Layer field and then tap your bass sample in the list on the left. Because you're working with a keygroup program instead of a drum program, this sample is now playable across all pads.

   **Tip:** On your MPC hardware, press the Pad Bank D button to switch to Pad Bank D and press Pad 13. You should hear the bass sample played back with its original pitch. You can use the other pads to play your sample chromatically.

Let’s add a second layer and set the layers’ velocity ranges so the bass will sound different when played at a higher velocity (as a real bass would):

1. Press Browse (MPC X) or Shift+Menu/Browse (MPC Live, MPC Touch) to show the Browser, select a different bass sample that sounds similar but a little bit brighter, and load it to the project’s sample pool.

2. Return to Program Edit Mode, and in the Layer tab, double-tap the second Layer field, and select the new bass sample. Press a pad to hear both samples will sound at once. Maybe this new sound is interesting as it is, but let’s make some quick edits to get as close as we can to a real-life bass sound.

   **Tip:** On your MPC hardware, press the Pad Bank D button to switch to Pad Bank D and press Pad 13. You should hear the bass sample played back with its original pitch. You can use the other pads to play your sample chromatically.

3. Tap the Pan Velocity tab to show its parameters.

4. Tap Layer 1’s Vel End knob and turn the data dial to set it to 80. Do the same to set Layer 2’s Vel Start slider to 81.

   Now when you press a pad, the lower velocities (0–80) will trigger the Layer 1 sample only, while higher velocities (81–127) will trigger the Layer 2 sample only.
Let’s record that bass line now. Prepare your recording as described earlier, and record some bass notes. You can edit your recording just like we’ve done earlier.

Once you’ve recorded it, let’s tweak the sound a bit in the **Filter** section:

1. In Program Edit Mode, tap the **Filter/Env** tab to show its parameters.
2. Double-tap the **Type** drop-down menu, and select a filter. Let’s try working with **Lowpass 4 Pole**.
3. Tap the **Cutoff** or **Reso** (resonance) knob, and turn the **data dial** to adjust their settings until your bass sample sounds good to you.
4. In the **Amp Envelope** section, tap the **Attack** or **Release** knob, and turn the **data dial** to adjust their settings. These control the overall level characteristics of the sound.

Do you want to add an effect? Do this in the **Effects** tab:

1. Tap the **Effects** tab to show the insert effects.
2. Double-tap one of the **Inserts** slots to show a list of available effects.
3. Double-tap the effect you want to add to your bass line, or click **Close** to cancel.
   - **To adjust the settings of the effect**, click the pencil icon next to its slot to open a window that shows its parameters.
   - **To activate or deactivate all insert effects for that program**, click the **All On/All Off** button in the upper-right corner.

So far, we’ve created a simple drum sequence and a bass line to go with it. Repeat this process to create a second sequence.
Recording an Audio Track

We’ve already created some MIDI tracks, so let’s record some actual audio for our next track:

1. Press **Main** to go back to Main Mode.
2. Tap the **Audio** tab at the bottom of the screen. **Audio 001** will appear in the **Track** field.
3. If the channel strip is not already shown on the left side of the screen, tap **Input Config** (in the lower part of the screen) or the small **eye icon** (in the upper-left part of the screen) to show it.
4. Connect a synthesizer or other line-level audio source to the 1/4” (6.35 mm) **input/inputs** on your MPC hardware’s rear panel, and set the **Line/Phono** selector to **Line** (MPC X, MPC Live).
5. Double-tap the first field (**Input __**) and select **Input 1** or **Input 1,2** (depending on your audio source) as the input source.
6. If the second field is not set to **Out 1,2**, double-tap it and select that option as the output.
7. Tap the **Monitor** button to cycle through its three states until it reads **Auto** (you will hear incoming audio while the track is record-enabled only).
8. Turn the **3/4 Rec Gain** (MPC X) or **Rec Vol** (MPC Live, MPC Touch) knob to set the input level while playing your audio source. You should now see the level in the meter. Make sure it does not exceed the maximum level (the meter should not be “peaking” constantly).
9. If **Solo** and **Mute** are on, tap or press them so they are off. Also, tap the **automation button** so it is **off/gray** (not **green/Read [R]** or **red/Write [W]**). Alternatively, press Read/Write (MPC X).
10. Tap the **Record Arm** button to record-enable the track. Alternatively, press Rec Arm (MPC X).
11. Press **Rec** to record-arm the sequence.
12. **To start recording**, press **Play** or **Play Start**—then play your audio source! You should hear your existing sequence playing in the background.
   **To stop recording**, press **Stop**.

Record another audio track for your other sequence: Select the other sequence in Main Mode, and create another audio track (**Audio 002**) to go with that sequence.
Creating a Song

This section explains how to make a song out of your sequences. Before starting, make sure that you have recorded some sequences (which we described earlier).

To enter Song Mode, make sure playback is stopped, and then press Menu, and then tap Song to enter Song Mode. Alternatively, press Song (MPC X).

In Song Mode, each of the sequences you’ve created in this project assigned to a pad. The sequence playlist is to the left of the pads, showing the song’s structure.

As a song plays, it moves through each step of the sequence playlist. Each step contains a sequence you assigned. Each step can be repeated, determined by the value in the Repeat column (the repeat icon; a value of 1 means the sequence will play through only once). The Bars column on the right indicates the length of that sequence.

Each step can be set to play its sequence at an independent tempo, determined by the value in the BPM column.

Important: Each sequence has its own tempo, while the project itself may use a different master tempo. The BPM value for each sequence may be different from the master tempo. As long as playback is set to follow the master tempo, each sequence's individual tempo will be ignored. By default, each project is set to use the sequence tempo, which you set back in the Creating a Drum Sequence chapter. We recommend tapping the Seq/Mst button at the top of the screen (so the button displays Mst) and entering a master tempo to ensure all sequences use the same tempo.

To insert a step at the current position, tap Insert.

To delete the currently selected step, tap Delete.

To set which sequence plays for a step, tap the step’s Sequence field, and then turn the data dial to select a sequence.

To set how many times a sequence repeats, tap the step’s Repeat field (next to the sequence name), and then turn the data dial to select a number.
Exporting the Song

Want to share your new song? Just export it first.

To export a song:
1. While in Song Mode, tap Export at the bottom of the screen.
2. In the Audio Mixdown screen that appears, do the following:
   - Make sure the Start field is set to 1, and set the End field to the last bar of your song.
   - Tap the Audio Tail field and turn the data dial to set it to 2 seconds.
   - As you’ll likely share the song online, tap the mp3 file format option in the lower-left corner.
3. Tap Export. Choose where you want to save the song.

   To name the song, tap the File Name field, and use the virtual keyboard that appears to enter a new name, and then tap Save to start exporting.
Other Features Explained

This chapter describes various advanced features. For a fuller explanation of these features, please refer to their corresponding sections in the *Operation* chapter.

**Step Sequencer**

You’ve already learned how to record note events on a track, but you can quickly enter note events in the Step Sequencer by using the pads as “step buttons,” simulating the experience of a traditional step-sequencer-style drum machine.

**To enter the Step Sequencer**, press Menu, and then tap *Step Sequencer*. Alternatively, in some modes, you can tap the *steps icon* on the left edge of the screen. You can also press *Step Seq* (MPC X).

1. Let’s create a sequence on a new track. Tap the *Track* field in the upper-left corner, and then use the data dial or +/- buttons to select an *(unused)* track. Alternatively, double-tap the *Track* field, and then tap a track to select it.

2. Tap the *Track Length* field at the top of the screen to set a length for the track, and then use the data dial or the +/- buttons to select a length. If you select the minimum value, *Sequence*, the track will be however long your sequence is.

   **Tip:** This lets you maintain tracks of different lengths. For instance, you could play a 1-bar drum sequence repeatedly under a 4-bar bass line.

3. Tap the *Bar +/-* buttons at the bottom of the screen to select the bar whose steps you want to create or edit. The bar number will appear in the *Bar* field in the upper-left corner.

4. Tap the *Pad +/-* buttons at the bottom of the screen to select the pad whose steps want to create or edit. The pad number will appear in the *Pad* field in the upper-left corner.

5. Press *Play* to start your sequence.

6. Each pad represents a step in the bar. If the pad already has note events on the selected track, the corresponding pads (steps) will be lit with colors corresponding to their velocities.

   **To enter a note at a step**, press an *unlit pad*. The pad will light up with a color corresponding to its velocity.

   **To delete the note from a step**, press a *lit pad*. The pad will become unlit.

   **To delete all notes from the entire bar**, press and hold *Shift*, and then tap *Clear Bar* in the lower-right corner.

See *Operation > Modes > Step Sequencer* to learn more about this feature.
Drum Loops & Chop Mode

Modern music producers often use drum loops to add grit and nuance to programmed beats. This section explains how to use Sample Edit Mode to work with drum loops.

Use the Browser to locate a drum loop, and then double-tap it to add it to the current program. The loop does not have to match the tempo of anything in the project.

To enter Sample Edit Mode, press Menu, and then tap Sample Edit to enter Sample Edit Mode. Alternatively, press Sample Edit (MPC X).

1. Tap the Sample field at the top of the screen, and then use the data dial or −/+ buttons to select the loaded drum loop. You can scroll through all loaded samples in the project. Alternatively, double-tap the Sample field, and then tap a sample to select it.

2. Tap the Trim/Chop tab in the lower-left corner to switch between Trim Mode and Chop Mode. Select Chop Mode, which will let us cut the drum loop into slices.

3. Tap Threshold, and then tap the Threshold field to the right of it. Use the data dial, −/+ buttons, or numeric keypad (MPC X) to select a value. Alternatively, double-tap the Threshold field and use the numeric keypad on the screen. The lower the threshold, the more slices will be created. Be sure to select a value so that every transient peak of the drum loop has a corresponding a slice marker.

Tip: Each slice will be automatically assigned to a pad: Pad A01 plays Slice 1, Pad A02 plays Slice 2, etc. Press each pad to play the slice with the same number.
Let’s use this chopped sample to create a new program in which each of these slices is an individual sample. We can also automatically create corresponding note events to play back these slices sequentially.

1. Press and hold Shift and then tap Convert at the bottom of the screen to enter the Convert or Assign Slices window.
2. Tap the Convert To field, and then use the data dial or +/- buttons to select New Program with New Samples.
3. Make sure Crop Samples is checked. If it is not, tap it.
4. Make sure Create New Program is checked. If it is not, tap it.
5. Make sure Create Events is checked. If it is not, tap it.
6. Tap the Bars field, and then use the data dial or +/- buttons to select how many bars the entire sample should use in your program.
7. Tap Do It to proceed. Each slice will be assigned to a pad, and each pad will have a recorded note event in the track. When you play that track, it will play each pad (each slice) in the original order. Press Menu and then tap Grid View to see how the sample appears in your sequence.
8. Press Play and listen to how the drum loop matches your song tempo now.

You can also edit the note events of the drum loop slices—enter Main Mode to do this. A new track with the note events playing their corresponding slices has been automatically created. Tap the TC/clock icon at the top of the screen to use the Timing Correct window to quantize the note events so they fall on exact, even time intervals.

You can also rearrange the note events, thus creating a new playback order for the slices. You can also edit each slice or sample in Program Edit Mode. You can add effects for slices or use the filter function to change the frequency range of a selected slice. There are almost no limits to what you can do.

See Operation > Modes > Sample Edit Mode > Chop Mode to learn more about this feature.
Pad Muting & Track Muting

Pad Mute Mode and Track Mute Mode let you silence different pads and tracks to see what the sequence sounds like without those samples or parts.

To enter Pad Mute Mode, press Menu, and then tap Pad Mute to enter Pad Mute Mode. Alternatively, press Shift+Track Mute/Pad Mute (MPC X).

1. Press Play to play the sequence.
2. Tap the Program field at the top of the screen, and then use the data dial or –/+ buttons to select your drum program. Alternatively, double-tap the Program field, and then tap a program to select it.
3. Mute a pad by pressing it once or tapping it on the screen. The muted pad will be lit red. You can mute multiple pads at the same time.

See Operation > Modes > Pad Mute Mode to learn more about track mutes.
You can also mute entire tracks by using the similar Track Mute function.

**To enter Track Mute Mode**, press **Menu**, and then tap **Track Mute** to enter Track Mute Mode. Alternatively, press **Track Mute** (MPC X).

1. Press **Play** to play the sequence.
2. Tap the **Sequence** field at the top of the screen, and then use the **data dial** or −/+ buttons to select the desired sequence. Alternatively, double-tap the **Sequence** field, and then tap a sequence to select it.
3. Each pad is assigned to a track. Mute a track by pressing the corresponding pad or tapping it on the screen. The pad will be lit **red**. You can mute multiple tracks at the same time.

**Tip**: To mute a track only at precise note intervals (“quantizing” your mutes, essentially), tap **Time Division** to set a musical timing value. Tap the desired musical value (e.g., **1 Bar**). Alternatively, use the **data dial** or −/+ buttons. Tap **Close** to close the page. Now, when you press a pad in Track Mute Mode, the mute will occur precisely at the beginning of the following time division (in this example, one bar). This lets you test musical combinations of patterns—the preliminary stage to building a song structure.

See **Operation > Modes > Track Mute Mode** to learn more about track mutes.
Sampling (Recording)

This section describes recording new samples of your own, which you can use in your projects.

Important: To record any audio, you need to connect an audio source to your MPC hardware or to your computer’s audio interface.

To open the Sampler, press Menu, and then tap Sampler to enter Sampler Mode. Alternatively, press Sampler (MPC X).

1. Connect an audio source to the input/inputs of your MPC hardware.
2. The Input ___ menu in the upper-left corner should be set to Input 1,2 (the inputs of your MPC hardware). If it is not, then select Input 1,2.
3. Turn the 3/4 Rec Gain (MPC X) or Rec Vol (MPC Live, MPC Touch) knob to set the input level while playing your audio source. You should now see the level in the meter. Make sure it does not exceed the maximum level (the meter should not be “peaking” constantly).
4. Tap and drag threshold slider to set the threshold. Alternatively, use the data dial or +/- buttons. Set it to a fairly low level (e.g., -50 dB).
5. Tap Arm to record-arm the Sampler.
6. Play your audio source. The Sampler will start recording immediately when the input level reaches the threshold value. Alternatively, tap the round Record button to manually start recording.
7. To stop recording, tap the round Stop button. The Keep or Discard Sample window will appear.
In the **Keep or Discard Sample** window:

- **To name the new sample**, tap the **Edit Name** field and use the virtual keyboard to enter a name.

- **To assign the new sample to a program**, tap the **Program** field, and then use the data dial or –/+ buttons to select the desired program. Alternatively, double-tap the **Program** field, and then tap a program to select it.

- **To assign the sample to a pad in the program**, tap the **Assign to Pad** field, and then press the desired **pad**. Alternatively, use the data dial or –/+ buttons to select the desired pad number, or double-tap the **Pad** field, and then tap a pad number.

- **To set the Root Note for the sample**, tap the **Root Note** field, and then then use the data dial or –/+ buttons to select the desired note.

- **To save the sample**, tap the **Save** button at the bottom of the screen.

- **To play the recording**, tap the **Play** button at the bottom of the screen.

- **To discard the recording and return to the previous screen**, tap the **Discard** button at the bottom of the screen.

- **To confirm your selections**, tap **Keep** at the bottom of the screen.

- **To edit the sample in Sample Edit Mode**, tap the **Edit** button at the bottom of the screen.

See **Operation > Modes > Sampler** to learn more about this feature.
You may need to edit your newly recorded samples using Sample Edit Mode.

To enter Sample Edit Mode, press Menu, and then tap Sample Edit to enter Sample Edit Mode. Alternatively, press Sample Edit (MPC X).

In Sample Edit Mode:

To switch between Trim Mode and Chop Mode, tap the Trim/Chop tab at the bottom of the screen. In this example, use Trim Mode.

To set the sample's start point, use the first column of Q-Link knobs (when in the Screen Q-Link Edit Mode) to adjust the start point with varying degrees of resolution. Alternatively, tap and drag the S marker in the waveform. You can also double-tap the Start field and use the numeric keypad on the screen to enter a value (or tap the Start field and use the numeric keypad).

To set the sample's end point, use the second column of Q-Link knobs (when in the Screen Q-Link Edit Mode) to adjust the end point with varying degrees of resolution. Alternatively, tap and drag the E marker in the waveform. You can also double-tap the Start field and use the numeric keypad on the screen to enter a value (or tap the Start field and use the numeric keypad).

To hear your edits, press Pad 10 to play the sample from the start point to the end point.
Let’s apply some processing to the sample.

To open the Process Sample window, tap Process at the bottom of the screen.

1. Use the data dial or –/+ buttons to select the desired process in the Function field. Alternatively, tap Function or double-tap the Function field, and then tap the desired process. Let’s select Pitch Shift to change the overall pitch of your sample. This will transpose the sample without affecting its length.

2. To set the pitch shift amount, tap and drag the knob in the center of the window up or down. Alternatively, use the data dial or –/+ buttons.

   To make finer adjustments, double-tap the knob and adjust the larger version that appears. Tap anywhere else to return to the previous screen.

3. To confirm your selections, tap Do It.

   To cancel the process, tap Cancel.

See Operation > Modes > Sample Edit Mode to learn more.
Recording Automation with the XY Pad

Automating various parameters is a good way to add some motion and dynamism to your sequences.

1. Press Menu, and then tap XYFX to enter XYFX Mode. Alternatively, press XYFX (MPC X).
2. Double-tap the XYFX Location field, and select Program.
3. When you first enter this mode in a project, you will be prompted to “load” XYFX to the program. Tap Insert XYFX to do this.
4. Tap Setup to show the Setup panel, which controls how the XY pad behaves.
5. Double-tap the Preset field, and tap an effect to select it. (These are just the effects available in XYFX Mode, not all MPC effects.) Swipe up or down to view the entire list.
6. Tap and drag any of the knobs (Attack, Release, or Wet/Dry) up or down to set their values as desired. Below them, you can see what parameter the X axis and Y axis control.
   **Note:** XYFX uses an envelope to control how quickly the effect crossfades between the dry signal and wet signal. The Attack knob determines how long it takes the completely dry signal to reach the wet signal (determined by the Wet/Dry knob) after you touch the XY pad. The Release knob determines how long it takes the wet signal (determined by the Wet/Dry knob) to return to the completely dry signal after you touch the XY pad.
7. Tap the automation button or press Read/Write (MPC X) to cycle through the available automation modes. Make sure the button is red (the Write (W) option).
8. Press Play Start to start recording.
9. As you record, move your finger over the XY pad on the screen. The changes in the sound are being recorded as automation of both the X axis and Y axis parameters.
   **Tip:** While touching the XY pad, tap Latch in the lower-left corner to keep the marker on the XY pad even after you release it. The marker will remain there until you touch another part of the XY pad or until you tap Latch again.
10. When you are done recording, press Stop.
11. Tap the automation button or press Read/Write (MPC X) to select the green Read (R) option. This ensures your track uses the automation you just recorded when you play it back.

See Operation > Modes > XYFX Mode to learn more about using this feature.
Using MPC X or MPC Live as a Controller

If you are using the MPC software on your computer, you can switch MPC X or MPC Live into **Controller Mode**, allowing you to use it to control the software. MPC Touch already operates as a controller only.

The MPC software offers the same features and functionality as the MPC hardware in Standalone Mode but with some notable differences, which are discussed in *Operation > General Features > Standalone vs. Controller Mode.*
Operation

This chapter explains the complete features and functions of your MPC hardware.

**Important:**

- When accessing the secondary functions of buttons on your MPC hardware, you can do this one of two ways: (1) pressing and holding **Shift** and then pressing the desired button or (2) double-pressing the desired button. This manual describes these operations using only the first option, but both are acceptable.

- When the left-most button at the bottom of the screen shows an upward arrow (↑), it means there are additional buttons you can use when you press and hold **Shift**. Press and hold **Shift** to show the secondary buttons, and any of them, if desired. Release **Shift** to return to the previous buttons.

- Almost every mode shown on the screen has 1–6 buttons at the bottom. Each of these buttons selects a different tab in that mode or perform a specific function in that mode.

  - **MPC X:** You can press the **F-Key** button to activate or deactivate the F-Key feature. When active, the six buttons under the touchscreen correspond to the options shown at its bottom edge. The F-Key button and those six buttons will be lit red when active. When inactive, the six buttons under the touchscreen will access their normal modes instead (Menu, Browser, Step Seq, Sampler, XYFX, and Looper).

  - **MPC X:** As an alternative to tapping a control on the screen to select it, you can use the **cursors** to navigate through the controls on the screen. The **center cursor** acts as an **Enter** key.

  - **MPC Live, MPC Touch:** As an alternative to double-tapping an item on the screen to “enter” it, you can press the **data dial**.

- When a parameter is highlighted and has a red outline, this means that it is selected. You can then change it by turning the hardware’s **data dial** or using the −/+ buttons. If the parameter is a number, double-tap it to show a numeric keypad on the screen to enter a specific value, or use the **numeric keypad** (MPC X).

- **MPC Live, MPC Touch:** When the touchscreen shows a parameter or group of parameters with a **gold outline** (and sometimes a “Q” in the corner), this means that the current bank of **Q-Link knobs** will control those parameters or settings. Turn a **Q-Link knob** to adjust its corresponding parameter value or setting in that group. When the value has decimal places, you can sometimes press and hold **Shift** and then turn the **Q-Link knob** to adjust the value by smaller increments. You can also press the **Q-Link button** to select another group of four parameters.

- Press and hold any of the **Q-Link buttons** (Project, Program, Pad Scene, Pad Param, or Screen Control/Edit: MPC X) or the **Q-Link button** (MPC Live, MPC Touch) to see an overview of all 16 **Q-Link knobs** and their parameters in the **QLinks** window that appears. You can then tap a column or row of knobs to select those four **Q-Link knobs**, and then release the **Q-Link button.** See **Modes > Q-Link Edit Mode** to learn more about using the Q-Link knobs throughout your project.
General Features

Control Types

The MPC touchscreen uses the following types of control elements:

Knobs

To set the value for a knob, do any of the following:

- Tap and drag the knob up or down.
- Tap the knob to select it, and then use the data dial or −/+ buttons to adjust the value.
- Double-tap the knob to show it in a larger screen. Alternatively, press the center cursor or Enter (MPC X) or the data dial (MPC Live, MPC Touch) when the knob is selected.

Tap and drag the larger version that appears, or use the data dial or −/+ buttons to adjust the value.

If the knob is bipolar (has positive and negative values with the center as the default position), double-tap the larger version to reset it to the center/0 position.

Tap anywhere else to return to the previous screen.

- Press and hold Shift while turning the data dial to adjust a value by smaller increments.

Parameter Values

To set the value for a parameter, do either of the following:

- Tap the field to select it, and then use the data dial or −/+ buttons to adjust the value.

When the value has decimal places, you can sometimes press and hold Shift and then use the data dial or −/+ buttons to adjust the value by smaller increments.

- Double-tap the field or hold your finger on it for a second. In the screen that appears, use the numeric keypad, the data dial, or the −/+ buttons to adjust the value. Alternatively, tap and drag the value up or down.

You can also tap /2 to halve the value or x2 to double it.

To confirm the value and remain on this screen, tap Apply.

To confirm the value and return to the previous screen, tap Do It.

To return to the previous screen without changing anything, tap the gray area in the upper-left corner of the screen.
Drop-Down Menus / Lists

To select an option for a drop-down menu, do any of the following:

- Tap the field to select it, and then use the data dial or +/- buttons to select an option.
- Double-tap the field. In the list that appears (examples below), tap the desired option. Alternatively, use the data dial or the +/- buttons to select an option.

In some windows, tap the relevant button at the bottom of the screen to confirm your selection or to cancel without changing anything.

Selectors

Selectors show all available options. One of them is always selected. The selected option is highlighted while the others are dark.

To select an option, tap it.
Buttons

Buttons usually have two states: selected and deselected (active or inactive, respectively). Some may have more than two states.

To switch between or cycle through a button’s states, do either of the following:

- Tap it.
- If it is outlined in red (and is not a mute button), use the data dial or –/+ buttons.

Checkboxes

Checkboxes have two states: checked and unchecked (enabled or disabled, respectively).

To check or uncheck a checkbox, tap it.

Tabs

Some modes have buttons at the bottom of the screen that let you cycle through several similar tabs. For instance, you could view the send level that is routed to each of four returns—each level is shown on a separate tab. With each tap, you will move to the next tab, indicated by the squares below it.

To select a tab, tap it. Each time you tap it, it will select the next tab.

Sliders

To adjust the position of a slider, do any of the following:

- Tap and drag the slider to the desired position.
- Tap the desired position (this works only on some sliders).
- Tap the slider to select it, and then use the data dial or –/+ buttons to adjust the position (this works only on some sliders).
- Double-tap the slider, and then tap and drag the larger version that appears, or use the data dial or –/+ buttons to adjust the value. If the slider controls a volume level, double-tap the larger version to reset it to 0 dB. Tap anywhere else to return to the previous screen.
Envelopes

To set the stages of an envelope, do either of the following:

**Tip:** Tap the expand-rectangle icon above the envelope to show a close-up view.

- Tap and drag a “handle” of an envelope stage in the desired direction.
- Set the numeric value of an envelope stage by adjusting or entering it as a parameter value (described earlier).
Grid View Tools

In the Grid View, these four icons enable you to use different functions in the grid.

Tap one to select its mode:

**Pencil: Draw Mode:**

To enter a note in an empty grid square, tap the grid square.

To select a note, tap it.

To move a note, tap and drag it to another grid square.

To erase a note, double-tap it.

**Eraser: Erase Mode:**

To erase a note, tap it.

**Select Box: Select Mode:**

Note: Notes will remain selected if you switch to another mode. The selection will change, however, if you press a pad while Hitting Pad Selects All Events is set to On.

To select a note, tap it.

To select multiple notes, tap and drag across the grid to create a box around them.

To move a note, tap and drag it to another grid square.

To move multiple notes, select them as described above, and tap and drag them.

To erase multiple notes, select them as described above, and then select the eraser tool and tap any of the selected notes.

**Magnifying Glass: Navigation Mode:**

To move to another part of the grid, tap and drag it.

To zoom in or out, spread or pinch your fingers (respectively) on the grid. You can do this vertically, horizontally, or both at the same time.
Audio Edit Tools

In Audio Edit Mode, these six tool icons enable you to use different functions in the waveform.

Tap one to select its mode:

**Marquee:** Marquee Mode:
- **To select a track region,** tap the upper third of it.
- **To move a track region** (or multiple selected track regions), tap and drag the upper third of it left or right.
- **To split the track at two specific points** (creating a track region on either side and between them), tap and drag across the middle third of it to create a translucent white box, and then tap the upper third of that box.
- **To shorten or lengthen a track region** (or multiple selected track regions), tap and drag the lower third of it left or right.

**Arrow:** Selection Mode:
- **To select a track region,** tap it.
- **To select multiple track regions,** tap and drag across the grid to create a box that highlights them. Double-tap the selected track regions to deselect them.
- **To move a track region** (or multiple selected track regions), tap and drag the upper third of it left or right.
- **To shorten or lengthen a track region** (or multiple selected track regions), tap its edge and drag it.

**Eraser:** Erase Mode:
- **To select multiple track regions,** tap and drag across the grid to create a box that highlights them.
- **To erase a track region** (or multiple selected track regions), tap it.

**Scissors:** Split Mode:
- **To split the track at a specific point** (creating a track region on either side), tap that point in the track.
- **To select a track region,** tap its left-most edge.
- **To select multiple track regions,** tap and drag across the grid to create a box that highlights them. Double-tap the selected track regions to deselect them.

**Mute:** Mute Mode:
- **To select multiple track regions,** tap and drag across the grid to create a box that highlights them. Double-tap the selected track regions to deselect them.
- **To mute or unmute a track region** (or multiple selected track regions), tap it.

**Magnifying Glass:** Navigation Mode:
- **To move to another part of the track,** tap and drag it.
- **To zoom in or out,** spread or pinch your fingers (respectively) on the grid. You can do this vertically, horizontally, or both at the same time.
Programs

About Programs

Each track you create within a sequence is routed through a program. There are six types of programs, each of which determines how the track sounds or what it is used for. A single project can hold up to 128 programs.

This chapter covers how to create each program type.

To learn about editing your programs to your preference, see the Modes > Program Edit Mode chapter.

A **drum program** uses one or more samples as its sound source. It contains (1) a list of samples and (2) the settings for each sample (i.e., pad assignments, loop points, pitch tuning, effects, etc.). Drum programs are used mostly for creating drum parts and quickly and easily assigning samples to pads. See Drum Programs for more information.

A **keygroup program** uses one or more samples as its sound source. It contains (1) a list of samples and (2) the settings for each sample (i.e., pitch tuning, effects, etc.). Keygroup programs are used to play samples chromatically with a MIDI keyboard or the MPC pads. See Keygroup Programs for more information.

A **clip program** uses several samples that can be looped (clips). Each clip can be assigned to a pad, which you can press to trigger the clip according to a quantization setting. This lets you create intriguing, layered performances by launching different combinations of clips together. See Clip Programs for more information.

A **plugin program** contains an instance of a plugin through which you can send your track’s MIDI data. See Plugin Programs for more information.

**Important:** For MPC X and MPC Live, plugin programs are available only in Controller Mode with the desktop version of the MPC software. They are not available in Standalone Mode.

A **MIDI program** lets you send your track’s MIDI data to an external MIDI device like a synth or drum machine. See MIDI Programs for more information.

A **CV program** lets you send your track’s MIDI data to an external MIDI device that uses control voltage (CV), like a synth. See CV Programs for more information.
Drum Programs

A drum program uses one or more samples as its sound source. It contains (1) a list of samples and (2) the settings for each sample (i.e., pad assignments, loop points, pitch tuning, effects, etc.). Drum programs are used mostly for creating drum parts and quickly and easily assigning samples to pads.

To create a drum program:

1. Press Main to enter Main Mode.
2. Next to the Track field, tap the four-squares icon, which indicates a drum program.
3. If the project does not contain a drum program yet, a new drum program (named Program, appended with a number) will be added automatically to the project and appear in the Program field below.
   
   If the project already contains a drum program, the first one will be selected automatically and appear in the Program field below.

   To create another drum program, tap the + icon above the Program field. A new drum program will be created and appended with a number (e.g., Program 002).

   To rename the program, tap the cursor icon on the right edge of the Program section. Use the virtual keyboard that appears to enter a new name, and then tap Do It to confirm or the gray bar at the top of the screen to cancel.

To load a sample into a drum program:

1. Press Browse (MPC X) or Shift+Menu/Browse (MPC Live, MPC Touch) to show the Browser. Find and select a sample, and then tap Load to load it to the program. Repeat this for any other samples you want to load into the project. (See Modes > Browser to learn more about using the Browser specifically.)
2. Tap Sample Assign to view the pads and project's sample pool.
3. Press or tap a pad to select it. The pad will be lit green.
4. In the Sample Pool list, tap a sample to assign it to the pad. Alternatively, use the data dial or –/+ buttons to assign a sample and/or change the assigned sample.

   To clear the assigned sample from a selected pad, tap Clear Pad.

   To assign samples to additional pads, repeat Steps 3–4.

Tip: Remember that a drum program has 128 pads total—16 pads across eight banks.
Alternatively, assign samples in a drum program in Program Edit Mode in one of these two ways:

1. Press Menu, and then tap Program Edit to enter Program Edit Mode. Alternatively, press Prog Edit (MPC X).

2. Tap the Samples tab. This lets you view the samples assigned to all four layers of the current pad as well as tuning and level parameters for each layer.

3. Tap a pad to select it (and play its assigned samples, if any). The pad will be lit green.

4. Tap one of the Layer fields under the sample waveform to select a layer. Tap the Sample field, and then use the data dial or +/- buttons to select a sample. Alternatively, double-tap the field for a layer, and then tap a sample to select it.
Keygroup Programs

A keygroup program uses one or more samples as its sound source. It contains (1) a list of samples and (2) the settings for each sample (i.e., pitch tuning, effects, etc.). Keygroup programs are used to play samples chromatically with a MIDI keyboard or the MPC pads.

To create a keygroup program:

1. Press Main to enter Main Mode.
2. Next to the Track field, tap the piano-keys icon, which indicates a keygroup program.
3. If the project does not contain a keygroup program yet, a new keygroup program (named Program, appended with a number) will be added automatically to the project and appear in the Program field below.
   - If the project already contains a keygroup program, the first one will be selected automatically and appear in the Program field below.
   - To create another keygroup program, tap the + icon above the Program field. A new keygroup program will be created and appended with a number (e.g., Program 002).
   - To rename the program, tap the cursor icon on the right edge of the Program section. Use the virtual keyboard that appears to enter a new name, and then tap Do It to confirm or the gray bar at the top of the screen to cancel.

To assign samples in a keygroup program:

1. Press Menu, and then tap Program Edit to enter Program Edit Mode. Alternatively, press Prog Edit (MPC X).
2. Tap Samples. This lets you view the samples assigned to all four layers of the current keygroup as well as tuning and level parameters for each layer.
3. Tap the Number of KG field, and then use the data dial or +/- buttons to set the number of keygroups in the program (1–128). Alternatively, tap the Number of KG field, and then use the numeric keypad to enter a value (or double-tap the Number of KG field, and then use the numeric keypad on the screen).
4. Tap the Keygroup field, and then use the data dial or +/- buttons to select a keygroup. Alternatively, double-tap the Keygroup field, and then tap a keygroup to select it.
5. Tap a pad to play the sample in the keygroup. The pad will be lit green.
   - Tip: On your MPC hardware, press the Pad Bank D button to and press Pad 13. You should hear the sample played back with its original pitch. You can use the other pads to play your sample chromatically.
6. Tap the field for a layer, and then use the data dial or +/- buttons to select a sample. Alternatively, double-tap the field for a layer, and then tap a sample to select it.

To create complex keygroup programs, you can add more keygroups (up to 128). This is useful when working with multi-samples (e.g., when programming a real piano).

   Tip: Remember that a keygroup program offers up to 128 keygroups, and each keygroup can hold up to four samples (Layers 1–4). This is a total of 512 samples.
Clip Programs

A clip program uses several samples that can be looped (clips). Each clip can be assigned to a pad, which you can press to trigger the clip according to a quantization setting. This lets you create intriguing, layered performances by launching different combinations of clips together.

By default, the 16 pads are divided into four columns of four pads. Each column represents a mute group; when a pad is playing a clip, all other pads in that same mute group are turned off. This enables you to launch a clip without having to manually stop other clips that are similar. For instance, pressing Pad 2 may launch a bass clip. You could then press Pad 6, which launches another bass clip and stops the clip on Pad 2. This way, you’ll never be playing two bass clips simultaneously.

The four-columns pad configuration described above is just a default to make things easy (e.g., you could use the first column for drum clips, the second for bass clips, the third for keyboard clips, and the fourth for vocal clips). You can use Program Edit Mode to assign pads to any combination of mute groups you want.

To create a clip program:

1. Press Main to enter Main Mode.

2. Next to the Track field, tap the play-button icon, which indicates a clip program.

3. If the project does not contain a clip program yet, a new clip program (named Clip, appended with a number) will be added automatically to the project and appear in the Program field below.

   If the project already contains a clip program, it will be selected automatically and appear in the Program field below.

To create another clip program, tap the + icon above the Program field. A new clip program will be created and appended with a number (e.g., Clip 002).

To rename the program, tap the cursor icon on the right edge of the Program section. Use the virtual keyboard that appears to enter a new name, and then tap Do It to confirm or the gray bar at the top of the screen to cancel.
To load a clip into a clip program:

1. Press Main to enter Main Mode.
2. Tap Edit Clips to view the pads and clip settings.
3. Press or tap a pad to select it (and play its assigned samples, if any). The pad on the screen will be lit red, and its number will appear in the Pad field.
4. Tap the Sample field, and then use the data dial or −/+ buttons to select a clip. Alternatively, double-tap the Sample field, and then tap a clip to select it.

   To clear the assigned clip from a selected pad, repeat Step 4, but select None.

To assign clips to additional pads, repeat Steps 3–4.

Alternatively, assign clips in a clip program this way:

1. Press Browse (MPC X) or Shift+Menu/Browse (MPC Live, MPC Touch) to show the Browser. Find and select a clip, and then tap Load to load it to the program. Repeat this for any other clips you want to load into the project. (See Modes > Browser to learn more about using the Browser specifically.)
2. Tap Sample Assign to view the pads and project's sample pool.
3. Tap Assign Mode so it is selected (tapping an item in the sample pool will now assign it automatically to the current pad).
4. In the Sample Pool list, tap a clip to assign it to the pad. Alternatively, use the data dial or −/+ buttons to assign a clip and/or change the assigned clip.

   To clear the assigned clip from a selected pad, tap Clear Pad.

To assign clips to additional pads, repeat Steps 4–5.
Plugin Programs

A plugin program contains an instance of a plugin through which you can send your track's MIDI data. This lets you use the same instance of a plugin with multiple tracks (rather than load an instance of a plugin on every track, which can be cumbersome and CPU-intensive).

To create a plugin program:

1. Press Main to enter Main Mode.
2. Next to the Track field, tap the plug icon, which indicates a plugin program.
3. If the project does not contain a plugin program yet, a new plugin program (named Plugin, appended with a number) will be added automatically to the project and appear in the Program field below.
   
   If the project already contains a plugin program, the first one will be selected automatically and appear in the Program field below.
   
   To create another plugin program, tap the + icon above the Program field. A new plugin program will be created and appended with a number (e.g., Plugin 002).
4. Double-tap the Plugin field. In the list that appears, tap the desired plugin. Alternatively, use the data dial or the +/- buttons to select a plugin.
5. To sort your plugins by type or maker, tap Type or Manufacturer.
6. Tap Select to select the plugin, or tap Close to cancel.

Note: You have to specify the disk directory where your plugins are located. This can be done in the software's Preferences (in the Edit Menu). See the user guide in the MPC software to learn more: click the Help menu, select MPC Help, and select MPC User Manual.

To select the MIDI channel the program will use, double-tap the MIDI Ch field. In the list that appears, tap the desired channel. Alternatively, use the data dial or the +/- buttons to select a channel. Use this setting when you are working with a virtual instrument plugin that supports multi-mode.

To select a preset in your plugin (if any), double-tap the Preset field. In the list that appears, tap the desired preset. Alternatively, use the data dial or the +/- buttons to select a preset.

To rename the program, tap the cursor icon on the right edge of the Program section. Use the virtual keyboard that appears to enter a new name, and then tap Do It to confirm or the gray bar at the top of the screen to cancel.

To adjust the volume and panning of a track using the plugin program:

1. Press Menu, and then tap Channel Mixer to enter the Channel Mixer. Alternatively, press Ch. Mixer (MPC X).
2. Double-tap the Mixer field in the upper-left corner, and then tap Midi Tracks.
3. Tap the square that represents the track with the plugin program to select it.
4. Tap and drag the volume slider or pan knob up or down to adjust it. After you do this once, you can adjust the volume and panning of the plugin program normally.

Important:

If you copy a sequence, the volume and pan values will be copied with that sequence. This is also true if you move to a new sequence and put the same plugin program on a new track.

By default, some plugins do not support MIDI volume and pan. In this case, adjust volume levels and panning on the plugin program.
MIDI Programs

A MIDI program lets you send your track’s MIDI data to an external MIDI device like a synth or drum machine.

To create a MIDI program:
1. Press Main to enter Main Mode.
2. Next to the Track field, tap the MIDI-jack icon, which indicates a MIDI program.
3. If the project does not contain a MIDI program yet, a new MIDI program (named Midi, appended with a number) will be added automatically to the project and appear in the Program field below.
   If the project already contains a MIDI program, it will be selected automatically and appear in the Program field below.
   To create another MIDI program, tap the + icon above the Program field. A new MIDI program will be created and appended with a number (e.g., Midi 002).
4. There are five additional settings to configure for a MIDI program: the MIDI Port, program change message (Program Ch), MIDI channel (MIDI Ch), Most Significant Byte (Bank MSB), and Least Significant Byte (Bank LSB). See this section to learn more.
   To configure each setting, double-tap its field. In the list that appears, tap the desired option. Alternatively, use the data dial or the +/- buttons to select an option.

   **Note:** You also have to configure the MIDI ports in the software’s Preferences (in the Edit Menu). See the user guide in the MPC software to learn more: click the Help menu, select MPC Help, and select MPC User Manual.

   To rename the program, tap the cursor icon on the right edge of the Program section. Use the virtual keyboard that appears to enter a new name, and then tap Do It to confirm or the gray bar at the top of the screen to cancel.

To adjust the volume and panning of a track using the MIDI program:
1. Press Menu, and then tap Channel Mixer to enter the Channel Mixer. Alternatively, press Ch. Mixer (MPC X).
2. Double-tap the Mixer field in the upper-left corner, and then tap Midi Tracks.
3. Tap the square that represents the track with the MIDI program to select it.
4. Tap and drag the volume slider or pan knob up or down to adjust it. After you do this once, you can adjust the volume and panning of the MIDI program normally.

   **Important:** If you copy a sequence, the volume and pan values will be copied with that sequence. This is also true if you move to a new sequence and put the same MIDI program on a new track.
CV Programs

A CV program lets you send your control voltage (CV) signals to an external MIDI device like a synth or drum machine that uses CV.

To create a CV program:

1. Press Main to enter Main Mode.
2. Next to the Track field, tap the CV icon, which indicates a CV program.
3. If the project does not contain a CV program yet, a new CV program (named CV, appended with a number) will be added automatically to the project and appear in the Program field below.
   
   If the project already contains a CV program, it will be selected automatically and appear in the Program field below.

   To create another CV program, tap the + icon above the Program field. A new CV program will be created and appended with a number (e.g., CV 002).

4. There are five additional settings to configure for a CV program: the note tracking (Note), the CV Port, the Gate Port, the modulation wheel (Mod Wheel), and Velocity Port.

   To rename the program, tap the cursor icon on the right edge of the Program section. Use the virtual keyboard that appears to enter a new name, and then tap Do It to confirm or the gray bar at the top of the screen to cancel.
The Menu lets you select any of the 21 modes or save your project. On MPC X or MPC Live, you can also use it to set your preferences, switch between Standalone Mode and Controller Mode, or view your system resources.

To open the Menu, press Menu, or tap the icon in the upper-left corner of the screen while on the normal page of your current mode.

When viewing the Menu, do any of the following:

To enter a mode, tap it.

Important: If a sequence is currently playing, you will not be able to enter Song Mode. Stop playback before entering Song Mode.

To return to the previous mode, tap the gray area in the upper-left corner, or press Menu again.

You can also press and hold the Menu button and press a pad to select a menu mode. The pads follow the 4x4 layout of the Mode Menu.

Note: The Menu above is available when the currently selected track is a MIDI track. When an audio track is selected, it will show an icon for Audio Edit Mode instead of Grid View.

Click a part of the screen above to skip directly to that part of this user guide.
Save

To save the project, tap the disk icon at the top of the screen. Alternatively, press Shift+Browse/Save (MPC X). If you have already saved the project, your changes will be saved. If you have not saved the project yet, use the Save window to save the project:

To select the storage device you want to view, tap it in the Storage column on the left.

- Internal is the internal drive of MPC X or MPC Live.
- MPC Documents is a shortcut to the MPC Documents folder on the internal drive of MPC X or MPC Live.
- If you have storage devices connected to USB ports or SD card slot of MPC X, MPC Live, or your computer (with MPC Touch), they will appear in this column, as well.

To enter a folder, double-tap it. Alternatively, turn the data dial or use the −/+ buttons to move through the list, and press the center cursor or Enter (MPC X) or the data dial (MPC Live, MPC Touch) to enter a folder. You can also tap one of the five folder buttons in the upper-right to jump immediately to those pre-assigned file paths (see Modes > Browser to learn how to do this).

To create a new folder, tap New Folder, use the virtual keyboard that appears to enter a name, and then tap Do It. You will immediately enter the new folder.

To move up one folder level, tap the folder/↑ icon in the upper-left corner.

To name the file, tap the File Name field at the bottom of the screen, and use the virtual keyboard that appears.

To save the file, tap Save.

- To save the file as a project template file, tap the Save as Template checkbox to check it before tapping Save. (This file will be shown in the Template File field in the Preferences’ Project Load/Save tab.)

To cancel and return to the Menu, tap Cancel. Alternatively, tap the ← icon in the upper-left corner.
Preferences

To open the Preferences, tap the gear icon at the top of the screen.

To return to the Menu, tap the ← icon in the upper-left corner. Changes to the Preferences are saved automatically except for Vintage Mode (in the General tab) and Start Time (in the Sync tab).

To restore your MPC hardware’s default settings, tap Reset. In the screen that appears, tap OK to continue or Cancel to return to the Preferences. In the next window, tap Save to save your current project before restoring the default settings; tap Cancel to return to the Preferences; or tap Don’t Save to restore the default settings without saving your current project.

Important: For MPC X and MPC Live, the Preferences will appear differently in Controller Mode than in Standalone Mode. Some of the options described in this section may be available in only one of these modes or in a different order.

Info

This screen shows current information about your MPC hardware: its current firmware version, which includes its standalone operating system (MPC Firmware); its hardware Serial Number; and its current firmware for the Control Surface.

To view legal information relevant to MPC, tap Legal Info. For complete legal information, visit akaipro.com/product-legal.

To enter Update Mode, press and hold Shift and tap Update. In the screen that appears, tap Save to save your current project before entering Update Mode; tap Cancel to return to the Preferences; or tap Don’t Save to enter Update Mode without saving your current project.

Sequencer

The settings on this screen determine how sequencing works in the Grid View and in the Step Sequencer.

Display Resolution: This is the display resolution (in PPQN—pulses per quarter note) of pulse values in certain areas of the operating system. Please note that this setting affects the display resolution, not the timing.

Instant Track Mute: When disabled, if you mute a track, its Note On messages will be ignored, and samples and notes that are playing will finish playing their entire length (this is how legacy MPCs’ track-muting worked). This is useful if you are using loops and want a loop to play to the end of a bar but not play the next time the sequence loops. When enabled, if you mute a track, the MIDI track volume (0) will be sent. The loop will continue to play but at zero volume, allowing the loop to continue playing when the track is unmuted. This is useful when you want to have the track muted immediately.

Play Track Mute and Solo Events: When enabled, track mute and solo events are played back when you are in Track Mute Mode. When disabled, track mute and solo events will not be played back while in Track Mute Mode.

Record Track Mute and Solo Events: When enabled, track mute and solo events are recorded when you are in Track Mute Mode (timing correct settings will affect the recorded position events). When disabled, track mute and solo events will not be recorded while in Track Mute Mode. This feature is useful if you want to use Track Mute Mode to record track mutes or solos into your sequences as opposed to using Track Mute Mode for performance or listening purposes only.

Record Pad Aftertouch Events: When enabled, pad aftertouch data (from the MPC hardware’s pressure-sensitive pads) will be recorded. When disabled, pad aftertouch data will be ignored.
Place Events Recorded During Count-In at Start Point: When enabled, pressing a pad during the recording’s pre-count will record that note event at the start of the recording (this is how the MPC3000 worked). When disabled, no notes will be recorded until the pre-count is finished and recording has begun.

**Note:** This setting is ignored when recording with the Arpeggiator active.

Truncate Duration: This determines if/how events are cropped if they exceed the length of the current Sequence:

- **To Sequence Length:** If the length of an event exceeds the length of the sequence, it will be truncated. This ensures that the event will not overlap itself when the sequence loops.
- **To Sequence End:** If an event exceeds the length of the sequence, it will be truncated to the end of the current sequence. In other words, the event will stop playing when the sequence ends or loops.
- **As Played:** Events will play back exactly as they were recorded, even if they overlap themselves when the sequence loops.

For example, if you record a note starting on the second bar of a 4-bar loop and hold it for 5 bars, the note would end: at bar 7 (As Played), at bar 6 (To Sequence Length), or bar 4 (To Sequence End). See image for details.

Q-Link Swing Control Applies TC Settings on Release: When enabled, turning the Q-Link knob assigned to Swing and then releasing it will immediately apply that Swing setting. When disabled, you must use the Timing Correct window to apply the Swing setting.

**Sync**

The settings on this screen determine how your MPC hardware synchronizes with connected USB and MIDI devices.

- **Receive:** This determines whether your MPC hardware receives MIDI Clock information (**MIDI Clock**), MIDI Time Code information (**MIDI Time Code (MTC)**), communication from Ableton Link (**Ableton Link**), or none of these (**Off**).
- **Receive MMC:** When enabled, your MPC hardware will be able to receive MIDI Machine Control (MMC) information. When disabled, your MPC hardware will not receive this information. See Appendix > MIDI Machine Control (**MMC**) to learn about this.
- **Send:** This determines whether your MPC hardware sends MIDI Clock information (**MIDI Clock**), MIDI Time Code information (**MIDI Time Code (MTC)**), or neither (**Off**).
- **Send MMC:** When enabled, your MPC hardware will be able to send MIDI Machine Control (MMC) information. When disabled, your MPC hardware will not send this information. See Appendix > MIDI Machine Control (**MMC**) to learn about this.
- **MTC Frame Rate:** This determines the frame rate used by MIDI Time Code (MTC), which is important for correct timing, especially when working on film scoring projects. In most cases, you should select **25**.
- **Start Time:** This is the starting time that will be sent when **Send MIDI** is set to anything other than **Off**. The time is formatted in **hours:minutes:seconds:frames**.
- **Send Port 1–4:** These are the MIDI ports over which MIDI Clock or MTC information will be sent.

**Hardware**

The settings on this screen determine the behavior of your MPC hardware’s pads and touchscreen.

- **Pad Threshold:** This determines how much force is required to strike the pads for them to trigger.
- **Pad Sensitivity:** This determines how the pads respond to touch. At lower values, you need to use more force to generate a high-velocity note. At higher values, it is easier to generate high-velocity notes, even if you do not use much force while pressing a pad.
- **Pad Curve:** This determines how striking the pads translates into velocity values. The A curve is essentially linear, while the B, C, and D curves are exponential (see graphic here).
- **Velocity & Aftertouch:** View these meters when striking and pressing the pads to help gauge the force and pressure you are applying to them. These meters are useful when adjusting the Pad Threshold and Pad Sensitivity parameters (above).
- **Footswitch 1 & Footswitch 2:** These determine how connected footswitches will work. These options are available for MPC X only, not for MPC Live or MPC Touch, which do not have footswitch inputs.
- **MIDI Control Mode Output:** This determines which MIDI port the MPC hardware is using to send MIDI messages to external MIDI devices.
**Screen Dimming:** This determines how much time must pass before your MPC hardware automatically dims its touchscreen (if it uses a battery, this can help preserve battery life).

**Screen Brightness:** This determines the brightness of the screen during normal operation: normal brightness (Day) or dimmed (Night).

**Power On Screen** (MPC Live only): This determines if/when a special screen will appear when you power on your MPC Live. On this screen, you must tap and hold a button for a moment to begin using MPC Live or it will automatically power off. This feature prevents it from powering on accidentally and wasting battery life. You can set it to the following options:

- **Never:** The screen will never appear.
- **When On Battery:** The screen will appear only if you power on MPC Live while using battery power.
- **Always:** The screen will always appear.

**VU Meter Source** (MPC X only): This determines what audio signal level is shown in the level meters (on the right side of the screen). When set to **Master**, the level meters show the audio signal sent out of **Outputs 1/2** (the Main L/R outputs on the rear panel). When set to **Current Program**, the level meters show the audio signal of the currently selected program (i.e., the program used by the currently selected track and any other tracks that also use it).

**Date** (MPC X & MPC Live only): This is the current date, formatted as **Month / Day / Year**. When saving files on MPC X or MPC Live in Standalone Mode, the file will include the current date in its metadata. If you use MPC X or MPC Live in Controller Mode, this setting will be overwritten with the current date of the host computer.

**Time** (MPC X & MPC Live only): This is the current time, formatted as **Hour : Minute**. When saving files on MPC X or MPC Live in Standalone Mode, the file will include the current time in its metadata. If you use MPC X or MPC Live in Controller Mode, this setting will be overwritten with the current time of the host computer.

**Time Zone** (MPC X & MPC Live only): This is the current time zone, formatted as **Continent / City**, which you can change here.

**Project Defaults**

The settings on this screen determine various default values for any new project that you create.

- **New Project Dialog:** This determines what options you see when you start a new project. When set to **Off**, a new project will be empty with no preconfigured settings except for the project defaults shown here. When set to **Demo**, you can choose to load a demo project (from several different genres) as a starting point or an empty project. When set to **Demo/Template/Recent**, you can choose to load a demo project, a project template file, or an empty project. You must have a project in the **Template File** field of the **Project Load/Save** tab to select a template in this window.

- **Default Tempo:** This is the default tempo in BPM.
- **Default Master Tempo:** When enabled, the default tempo value will be used for the master tempo. When disabled, the default tempo will be used for sequences.
- **Default Sequence Bars:** This determines the default number of bars of a new sequence.
- **Default Time Signature Numerator:** This determines the number of beats per bar of a new sequence (the top number of a time signature).
- **Default Time Signature Denominator:** This determines the value of each beat of a new sequence (the bottom number of a time signature).
- **Default Pad Slice:** This determines how new samples will play when you load them or record them into a project. When set to **Pad**, the **Slice** menu in Program Edit Mode will be set to **Pad**, which lets you set the start point, end point, etc. for the layer. When set to **All**, the **Slice** menu in Program Edit Mode will be set to **All**, in which the entire sample plays.

- **Default Drum/Keygroup Filter:** This determines the default type of filter that drum and keygroup programs will use. See Appendix > Glossary > Filter to learn about this.
- **Default Plugin Synth:** This determines the default instrument plugin that a new plugin program will use. Use the window that appears to select it.
Project Load/Save
The settings on this screen determine if (and how) projects are automatically saved. If you are using MPC hardware as a controller, you can also define files to load automatically.

**Auto Load File:** Use this field to select a project (.xpj) or program (.xpm) to load automatically anytime you open the MPC software. (For MPC X and MPC Live, this option is available only when using your MPC hardware in Controller Mode.)

**Enabled:** When enabled, your project will automatically save after each **Timeout** interval. When disabled, your project will not be automatically saved; you may save only manually.

**Timeout:** Use this field to select how often your project will automatically save.

**Template File:** Use this field to select a project template that will load automatically when you select **User Template** in the **New Project Dialog** window. (If you select the **Save as Template** box when saving a file, it will be shown in this field.) In order for the **User Template** option to be available, **New Project Dialog** (in the **Project Defaults** tab) must be set to **Demo** or **Demo/Template/Recent**.

Record/Export
The settings on this screen determine the settings for recording and exporting.

**Recording Bit Depth:** This determines the bit depth of recorded audio.

**Include Program Volume/Pan Settings:** When enabled, the exported audio or MIDI file will include its volume and pan settings. When disabled, the volume and pan settings will be set to 0 dB and center (C), respectively.

**Bypass Program Effects Plugins:** When enabled, the exported audio or MIDI file will include any third-party effect plugins that are used with it, but those effects will be bypassed (deactivated). When disabled, those effects will be activated.

**Audio Tail Length:** This determines the length of an audio tail (silence) that will be applied to the exported audio file. When set to 0, the audio file will not have any additional audio tail.

**Audio Export:** This determines what part of the sequence is exported when you click the **Export Audio** icon.

- **Track:** When this is selected, **Export Audio** will export the currently shown track in the current sequence.
- **Program:** When this is selected, **Export Audio** will export all tracks in that sequence that use the currently shown program.
- **Master:** When this is selected, **Export Audio** will export all tracks in that sequence that use programs routed to master outputs.

**MIDI Export:** This determines what part of the sequence is exported when you click the **Export MIDI** icon.

- **Track:** When this is selected, **Export MIDI** will export the currently shown track in the current sequence.
- **Sequence:** When this is selected, **Export MIDI** will export all tracks in the current sequence.

**Bounce Bit Depth:** This determines bit depth of the audio file that is exported when you click the **Export Audio** icon: 16-bit or 24-bit.

General
The settings on this screen determine how other features work in the hardware and operating system.

**Tap Tempo:** This determines how many times you have to press the **Tap** button before the new tempo is recognized.

**Flash Tap Tempo Light:** When enabled, the **Tap** button’s light will flash in time with the tempo. When disabled, the **Tap** button’s light will be off.

**Filter ‘All Notes Off’ CC:** When enabled, “All Notes Off” (“MIDI panic”) messages will be ignored. This is useful if you are using an external MIDI device that can send these types of messages but you want to filter them out. When disabled, “All Notes Off” messages will be received normally.

**Program Change:** This determines what an incoming MIDI I program change message will change: a **Program**, **Sequence**, or **Track**.
**Vintage Mode**: This determines the type of emulation applied to the audio output. You can apply the particular sonic qualities of, for example, the MPC3000 or MPC60, or of course no emulation (**None**).

**Audition Auto Play**: This determines how long a sample will sound when auto-previewing it.

**Audition Outputs**: This determines which pair of outputs will play any auditioned sounds (Out 1,2–7,8 in Standalone Mode, Out 1,2–31,32 in Controller Mode; MPC Live does not use Out 7,8 in Standalone Mode but displays them to maintain compatibility with MPC X, which does use them). These sounds include: samples, programs, and projects in the Browser; sample playback, **Cue Preview**, and **Slice Preview** in Sample Edit Mode; and sample playback in the **Keep or Discard Sample** window in the Sampler.

**Cue Preview**: This determines if/how audio is played as you move the cue playhead. As you move the cue playhead through a sample waveform, you can set it to play the small part of the sample before the cue playhead (**Before**), play the small part of the sample after the cue playhead (**After**), or not play at all (**Off**). You can also set this in Sample Edit Mode (see **Modes > Sample Edit Mode > Settings**).

**Slice Preview**: This determines if/how audio is played as you move a slice marker. As you move the slice marker through a sample waveform, you can set it to play the small part of the sample before the slice marker (**Before**), play the small part of the sample after the slice marker (**After**), or not play at all (**Off**). You can also set this in Sample Edit Mode (see **Modes > Sample Edit Mode > Settings**).

**Threads**: This determines how many cores of your computer’s processor will be used to render audio. The available range depends on your processor. (For MPC X and MPC Live, this option is available only when using your MPC hardware in Controller Mode.)

**Audio Warp Algorithm**: This determines how a sample is “warped” when you adjust the length of a sample without changing its pitch (e.g., the **Warp** function in Audio Edit Mode for audio tracks or in Program Edit Mode for clip programs). (For MPC X and MPC Live, this option is available only when using your MPC hardware in Controller Mode.)

**Note**: The Warp algorithms are very CPU-intensive and can result in audio drop-outs during playback if used too freely. Be mindful of how (and how often) you use the warp function. You can reduce the CPU resources required by using a Warp algorithm other than Elastique Pro, which is very CPU-intensive.

**Audio Track Auto Warp**: This determines how recorded audio track regions are warped. When set to **On**, any audio track region that you record will be warped automatically to match the current sequence tempo. You can then adjust the sequence tempo while the audio track region remains in time.

**Note**: When you record an audio file, the current sequence tempo will be embedded with it. This information is stored within the sample file when you save the project. When you warp an audio track region, the warping algorithm uses this sequence tempo and the current value in the **BPM** field to generate the “stretch factor.”

**BPM Detection Range**: This defines the range of detectable BPM values when you use any automatic BPM detection function in the software or when you press the **Tap** button to enter a new tempo.

**Bank Button Press**: This determines how the **Pad Bank** buttons work.

- **Select A–D**: Pressing a **Pad Bank** button once will select the corresponding bank from Pad Banks A–D. Pressing and holding **Shift** while pressing a **Pad Bank** button will select the corresponding bank from Pad Banks E–H.

- **Select/toggle bank**: Pressing a **Pad Bank** button will alternate between the corresponding bank from Pad Bank A–D and Pad Bank E–H. In other words, you do not need to hold Shift to select one of Pad Banks E–H.

**Desktop Screensaver Disable**: This determines if/when your computer’s screensaver is disabled while using the MPC software (i.e., using your MPC hardware in Controller Mode):

- **Never**: Your computer’s screensaver will function normally.

- **When hardware used**: As long as your MPC hardware is connected to your computer and being used, your computer's screensaver will be disabled.

- **When hardware attached**: As long as your MPC hardware is connected to your computer and powered on, your computer's screensaver will be disabled. It will function normally again if you power off or disconnect your MPC hardware from your computer.

- **Always**: Your computer’s screensaver will be disabled as long as the MPC software is open (whether or not your MPC hardware is connected or powered on).

(For MPC X and MPC Live, this option is available only when using your MPC hardware in Controller Mode.)

**Collect Usage Statistics**: This determines whether or not your usage statistics will be sent occasionally to us, enabling us to improve the MPC experience. (For MPC X and MPC Live, this option is available only when using your MPC hardware in Controller Mode.)
Bluetooth
The settings on this screen will determine how your MPC hardware’s Bluetooth connection works, so you can use Bluetooth MIDI controllers (e.g., LPD8 Wireless or LPK25 Wireless) or a Bluetooth computer keyboard with it. These settings are available only for MPC X and MPC Live when used in Standalone Mode.

To activate or deactivate Bluetooth connectivity on your MPC hardware, tap the On/Off selector. The available Bluetooth devices will appear in the panel below it under Available Devices. The Bluetooth devices that have already paired to your MPC hardware will appear under Paired Devices.

To select a Bluetooth device, tap it.

To pair a selected Bluetooth device (in the Available Devices section), tap Pair.

To connect to a selected Bluetooth device (in the Paired Devices section), tap Connect.

To disconnect from a selected Bluetooth device (in the Paired Devices section), tap Disconnect.

To return an available Bluetooth device to its original state, tap Remove.

Wi-Fi
The settings on this screen will determine how your MPC hardware’s wireless connection works, so you can use Ableton Link, a new technology that synchronizes beat, phase and tempo of Ableton Live and Ableton Link-enabled applications over a wireless or wired network. These settings are available only for MPC X and MPC Live when used in Standalone Mode.

To activate or deactivate wireless connectivity on your MPC hardware, tap the On/Off selector. The available wireless networks will appear in the panel below it.

To select a wireless network, tap it.

To connect to a selected wireless network, tap Connect. If the Wi-Fi network is password-protected, use the virtual keyboard that appears to enter the correct password to connect to it.

To view the information of a selected wireless network, press and hold Shift and tap Info. The Network Information window that appears will show the network name, IPv4/IPv6 address (including the subnet mask and gateway), type of security, and signal strength (as a percentage).

To disconnect from a connected wireless network, tap Disconnect.

To clear the connection information (e.g., the password) from a selected wireless network, tap Forget.

Splice
The settings on this screen control integration with the Splice platform. See Addendum > Updates in MPC 2.5 for more information.
Sync

Tap the **Sync** field (in the center of the top of the screen) and then turn the **data dial** or use the −/+ buttons to set whether your MPC hardware receives MIDI Clock information (**MIDI Clock**), MIDI Time Code information (**MTC**), communication from **Ableton Link**, or none of these (**Off**). Alternatively, double-tap **Sync** and tap the desired option to select it.

This is the same setting as the **Receive** menu in **Sync** tab of your **Preferences**. See **Preferences > Sync** for more information.

**Important:** Your MPC hardware must be connected to a wireless network in order to receive these types of timing information. See **Preferences > Wi-Fi** to learn how to connect to a wireless network.

**Note:** Ableton Link is a new technology that synchronizes beat, phase and tempo of Ableton Live and Ableton Link-enabled applications over a wireless or wired network.

Mode

Tap this icon to switch MPC X or MPC Live between Standalone Mode and Controller Mode (MPC Touch already operates as a controller only). In the screen that appears, select whether you want to save your current project before switching (**Save**), switch without saving your project (**Don’t Save**), or stay in the current mode and project (**Cancel**).

You cannot freely switch between Standalone and Controller Modes without also closing your current project.

See **Standalone vs. Controller Mode** to learn more.
System Resources

Tap one of these icons to show the System Resources window for MPC X or MPC Live.

The indicators in this window show current usage statistics:

**Battery**: If you are using MPC Live powered by its internal battery, the first indicator shows the current battery life as a percentage. (See **Battery Usage** to learn more about MPC Live’s internal battery.)

**CPU**: The CPU indicator shows the current CPU as a percentage.

**RAM Usage**: The Mem indicator shows your MPC hardware’s current RAM usage.

**Important**: If you encounter a warning that there is not enough memory to complete an action while using your MPC hardware, do the following to make more memory available:

Make sure all audio tracks in your project are not record-armed.

Delete samples from your project’s sample pool that were there before the warning appeared.

If you are still seeing the warning, do the following:

1. **Manually** undo the last action you performed before seeing the warning (you may not be able to use the **Undo** button for this due to how the undo history is stored in RAM).
2. Save your project.
3. Do one of the following, and then load your saved project again.
   - In **Main Mode**, tap the folder icon at the top of the screen, and then tap **New** at the bottom of the screen.
   - Power your MPC hardware off and then on again.
   - Press **Menu** and then tap the gear icon to open the **Preferences**. In the Preferences, tap **Reset** at the bottom of the screen, tap **OK**, and then tap **Restart** to reset the Preferences.
   - Enter Controller Mode and then reenter Standalone Mode.

**Important**: Although you can load multiple files at once, any samples you load into a project will be automatically converted to full-quality uncompressed audio files, so they may use more storage space than they do on your external storage device. If you are unable to load multiple files at once due to this, select fewer files and try again.

**Drives**: The **Drives** indicator shows the available storage space on any detected external storage devices or the internal drive of MPC X or MPC Live.

To delete samples from the project (to create more free RAM space for sampling time, audio recording, etc.), tap **Purge**. In the screen that appears, tap **Unused Samples** to delete all unused samples from the project, tap **All Samples** to delete all samples from the project (from all programs, sequences, and audio or MIDI tracks), or tap **Cancel** to return to the previous screen.

To close the System Resources window, tap **OK**, the X in the upper-right corner, or anywhere outside the window.
In most of the available modes, there is a time counter at the top of the screen. This indicates the current playhead position.

**To adjust the position**, tap it, and then use the use the **data dial** or the −/+ buttons.

**To open the Locate screen and adjust its settings**, double-tap the **time counter**.
**To close the Locate screen**, tap the X in the upper-right corner or anywhere outside the window.

**To move forward or backward a step**, tap the Step < or Step > button, respectively.

**To move forward or backward a bar**, tap the Bar << or Bar >> button, respectively.

**To configure your auto record settings**, use the **Auto Record** selector and adjacent fields:
- **Auto Record selector**: Tap the desired option to select it:
  - **Off**: Auto recording is disabled.
  - **Punch In**: You can auto record using punch-in and punch-out markers, enabling you to record over a specified length of time in the track. While recording, the entire sequence will play, but you will record over only the area between the **Punch In** and **Punch Out** markers. Any part of the sequence before the Punch In marker or after the Punch Out marker will remain untouched, even if you perform over it during recording.
  - **Record Start**: After you record-arm the track and start playback, you will start recording once the sequence loops back to its start. This is essentially a punch-in feature for the entire track, enabling you to start playing a record-armed track while allowing more time than the usual count-in to prepare for the actual recording to start.
  - **Punch In**: Use these fields to set the location of the Punch In marker, which is where recording will start (when the **Auto Record selector** is set to **Punch In**).
  - **Punch Out**: Use these fields to set the location of the Punch Out marker, which is where recording will stop (when the **Auto Record selector** is set to **Punch In**).
You can use this screen to set time markers, allowing you to jump automatically to precise locations in a sequence. You can set up to six time markers.

To set a time marker, tap the time counter at the top of the screen, find the desired time, and then tap Set next to the desired time marker. The time will appear next to that marker.

To jump to a time marker, tap the number next to it (1–6).
The Timing Correct window contains various settings to help quantize the events in your sequence. You can quantize note events on MIDI tracks or track regions on audio tracks (though you cannot apply all types of quantization to audio tracks).

To open the Timing Correct settings:

- In Main Mode or List Edit Mode: Tap the TC/clock icon at the top of the screen.
- In the Grid View: Press and hold Shift and tap TC at the bottom of the screen.
- In the Track View or the Step Sequencer: Tap TC at the bottom of the screen.

Note: The TC button in Pad Mute Mode and Track Mute Mode contain Timing Correct settings, but they do not open this window. See Modes > Pad Mute Mode and Track Mute Mode to learn about those settings.

To apply the settings you selected to the current track, tap Do It.

To apply the settings you selected to all tracks, tap All Tracks.

To cancel and return to the previous screen, tap Close.

Use the Type selector to set how timing corrections are applied.

**Start:** The entire note event or audio track region will be nudged forward or backward so the start point aligns with the closest time division marker in the grid. You can apply this to MIDI tracks or audio tracks.

**End:** The end points of note events will be extended or shortened to align with the closest time division marker in the grid. The start points will remain untouched. You can apply this to MIDI tracks only.

**Length:** The end points of note events will be extended or shortened so that each event’s length is a multiple of the time division, regardless of where it is in the grid. The start points will remain untouched. You can apply this to MIDI tracks only.

**Legato:** The end points of note events will be extended or shortened to create a long, unbroken phrase from the first note event’s start point to the last note event’s end point. Each note event will sustain until another note event starts. If multiple note events start at the same time (and are not the last note events), their lengths will become identical. Selecting Legato disables all other options in this window. You can apply this to MIDI tracks only.
Use the **Time Division** selector to set the quantization value. Events will “snap” to these time divisions on the grid. The T indicates a triplet-based value.

Alternatively, press and hold **Note Repeat** while in Main Mode, and then use the six buttons at the bottom of the screen.

Use the **Swing** field to set the amount of swing from 50% to 75%. Swing lets you “shuffle” your beats—from subtle to extreme.

Use the **Shift Timing** field to shift all events by clock ticks.

Use the **Window** field to set how many events around a quantize value will be quantized. Any events outside this range will not be quantized; events inside will.

Use the **Strength** field to set how strictly events will be quantized (i.e., shifted toward the quantize value). Lower values move events a little bit towards the closest quantize value, resulting in a less mechanical feel than a strict quantization (a higher value).

Use the **Events** selector to set the target range for the time correction. You can apply the time correction to All note events or to just the **Selected** ones.

To select note events to which to apply time correction, either use the various tools in Grid View or press the pad with the desired events (while **Hitting Pad Selects All Events** is set to **On**). You must do this **before** opening the Timing Correct window.

When **Range** is selected, you can define the locations (From and To) as well as the pads or keys that will be quantized.
The **Click/Metro** window contains all settings regarding the metronome (click track).

**To open the metronome settings:**
- **In Main Mode or List Edit Mode:** Tap the **Metro/metronome icon** at the top of the screen.
- **In the Grid View:** Press and hold **Shift** and tap **Click** at the bottom of the screen.
- **In the Track View:** Tap **Click** at the bottom of the screen.

Tap the **Metro/metronome icon** at the top of the screen.

![MPC Click/Metro Window](image)

Use the **Count-In** field to set if/when the metronome counts before recording.
- **Off** disables the metronome pre-count.
- **Record** enables the pre-count during recording only.
- **Record + Play** enables pre-count in both Record and Playback Modes.

Use the **Enable** field to set if/when the metronome is enabled.
- **Off** disables the metronome.
- **Play** enables the metronome sound during playback only.
- **Record** enables the metronome sound during recording only.
- **Record + Play** enables the metronome to happen in both Record and Playback Modes.

Use the **Rate** field to select the metronome click’s time division: **1/4, 1/4T, 1/8, 1/8T, 1/16, 1/16T, 1/32, or 1/32T**. **T** indicates a triplet-based time division.

Use the **Sound** field to select the sound that you want to hear for the metronome: **Sidestick 1, Sidestick 2, Clap, Metroclick, Shake, Tambourine, or MPC Click**.

Use the **Volume** knob to set the volume of your metronome click.

Tap the **On/Off** button to enable or disable the metronome.

Use the **Output** field to set which pair of outputs will play the metronome click: **Out 1,2–7,8 in Standalone Mode, Out 1,2–31,32 in Controller Mode** (MPC Live does not use Out 7,8 in Standalone Mode but displays them to maintain compatibility with MPC X, which does use them).
Automation

You can set the automation for programs and audio tracks to be “written,” “read,” or disabled entirely. You can do this globally or for individual programs and audio tracks.

Global

In several modes, there is a button in the upper-right corner that controls the global automation. When you tap this button to change its state, it will change the automation state for all programs in the project.

This is available in Main Mode, XYFX Mode, Pad Mute Mode, the Pad Mixer, the Channel Mixer, and Q-Link Edit Mode.

Tap the global automation button to cycle through its three states:

- **When off**, automation data will be ignored. If you have already recorded or entered automation, tapping this will switch between Read (R) and Write (W) only, but you can override this and turn it off by pressing and holding Shift while tapping the button.

  **Important:** If you have already recorded automation and turn it off, the track will still use the effect and its parameter values at the point where you turned it off.

- When set to Read (R), automation data will be read but not recorded. (Think of this as a protective feature to prevent accidental changes to your automation while recording.)

- When set to Write (W), automation can be recorded and will overwrite any existing automation. (Make sure not to touch the XY pad accidentally while you are recording.)

Programs & Audio Tracks

You can also set the automation for each program or audio track by using the program automation button in the channel strip on the left side of the screen in Main Mode and the Channel Mixer. Program automation is available for all program types except MIDI programs.

**Note:** Remember that tapping the global automation button will change the automation state for all programs in the project; if they were originally different, all of them will then match the global automation state.

In Main Mode, if the channel strip is not already shown, tap the small eye icon below the Project field to show it.

In the Channel Mixer, if you do not see a program automation button in the channel strip, make sure the Mixer field is set to Audio Tracks or Programs.

Tap the program automation button or press Read/Write (MPC X) to cycle through its three states:

- **When off**, the program will ignore automation data. If you have already recorded or entered automation, tapping this will switch between Read (R) and Write (W) only, but you can override this and turn it off by pressing and holding Shift while pressing or tapping the button.

  **Important:** If you have already recorded automation and turn it off, the track will still use the effect and its parameter values at the point where you turned it off.

- When set to Read (R), the program will read automation data but will not record any additional automation over it. (Think of this as a protective feature to prevent accidental changes to your automation while recording.)

- When set to Write (W), the program can record automation. (If you have any Q-Link knobs assigned to automatable parameters, make sure not to touch any accidentally while you are recording.)
16 Level

Press the 16 Level button on your MPC hardware to activate or deactivate 16 Level.

When first activated, the selected pad (Pad A01 by default) will be temporarily copied to all 16 pads. The pads will now output the same note number as the initial pad, but a selectable parameter will be fixed at values that increase as the pad numbers increase (e.g., Pad 1 is the minimum, Pad 16 is the maximum), regardless of how hard you press them.

In the 16 Levels screen that appears, use the Type selector to choose the parameter: Velocity, Tune, Filter, Layer, Attack, or Decay.

To select a pad, do any of the following (while the 16 Levels window is open):

- Press and hold 16 Level, and then press the desired pad.
- Tap the 16 Levels checkbox to uncheck it (temporarily disabling the feature), press the desired pad, and then tap the 16 Levels checkbox again to check it.
- Tap the Pad field, and use the data dial or +/- buttons.
- Double-tap the Pad field, and tap the desired pad in the list that appears.

If Type is set to Tune, use the Original Pad field to select which you pad you want to use the original pitch of the sample/samples. Alternatively, hold Shift and press the desired pad.

When Type is set to Layer, pads with multiple samples will play back each layer according to the Velocity Start and Velocity End settings for each layer.
Erase

The Erase function erases all or part of a track in a specific sequence.

To open the Erase window, press the Erase button. Alternatively, while in Main Mode, tap the pencil icon on the right edge of the section, and then tap Erase in the screen that appears.

To select the sequence you want to erase, use the Sequence field.

To select the track you want to erase within the sequence, use the Track field.

To set the time range of the sequence you want to erase, use the Bar, Beat, and Tick fields. The left fields set the start of the time range, and the right fields set the end of the time range.

To select what types of events you erase, select one of the Erase options:

- **All** erases all pad events from the designated time range and reset all of its settings.
- **Automation** erases only automation from the designated time range. Use the Parameter field to select what type of automation is erased.
- **Note** erases only specific pad events from the designated time range. In the diagram of the eight pad banks that appears, press each pad in each bank to select or deselect its notes.
- **Except Note** erases everything except pad events from the designated time range.

To confirm your choice, tap Do It.

To cancel and return to the previous screen, tap the X, Cancel, or anywhere outside the window.
Effects

You can apply various effects to the pads, keygroups, audio tracks, programs, submixes, and master outputs, using **insert** and **send/return** effects. This chapter can help you get a good overall understanding of how the effects work.

See **Appendix > Effects & Parameters** for a list of all available effects (with a brief description of each) and their editable parameters.

**Overview**

In a program, each **pad** or **keygroup** can have up to **four insert effects** applied to it. See **Insert Effects > Pads** or **Keygroups** to learn more about this.

An entire **program** or **audio track** can also have up to **four insert effects** applied to it, as well. See **Insert Effects > Programs** or **Audio Tracks** to learn more about this.

For even further flexibility, each **submix** can have up to **four insert effects** applied to it. You can route pads, keygroups, audio tracks, or programs to a submix, which is then routed to a master output. See **Insert Effects > Submixes** to learn more about this.

Additionally, each **pad**, **keygroup**, **audio track**, **program**, and **submix** can each be sent to (up to) **four return channels**, each of which can have up to **four insert effects** of their own. Their audio will be routed through the insert effects on those returns, and the processed audio will be sent to a master output. See **Send/Return Effects** to learn more about this.

Finally, you can apply up to **four insert effects** to each master output (a stereo pair of channels: **Outputs 1/2**, **Outputs 3/4**, etc.). See **Insert Effects > Masters** to learn more about this.

When you create an audio mixdown of a sequence or song, you can choose whether or not master insert effects are included or send/return effects are included, depending on what you are mixing down:

- If you are creating an audio mixdown of a pair of **master outputs**, you can choose whether or not **master insert effects** will be included in the mixdown.
- If you are creating an audio mixdown of **separate programs** or **exploded tracks**, you can choose whether or not **send/return effects** will be included in the mixdown.

See **Audio Mixdown** to learn about these options.

There are three other modes that handle effects differently:

- The **Sampler** can use up to **four insert effects**, which are applied to the audio as you record it. This means that the effects cannot be “removed” from the sound later. Learn more about the Sampler in the **Modes > Sampler** chapter.
- Similarly, the **Looper** can use up to **four insert effects**, which are applied to the audio as you record it. This means that the effects cannot be “removed” from the sound later. Learn more about the Looper in the **Modes > Looper** chapter.
- In **XYFX Mode**, the effects act like a single insert effect on that program. In fact, **XYFX** is the name of the insert effect you have to load to the program before you can use this mode. Learn more about XYFX Mode in the **Modes > XYFX Mode** chapter.
To view, load, edit, or clear effects, tap the area under the Inserts field. This usually appears in a channel strip (next to a level slider and pan knob).

When viewing loaded effects, you will see this window:

To select an effect, use the field for each insert slot. A window (described below) will appear.

- To edit the parameters of a loaded effect, tap the pencil icon next to the insert slot.
- To clear the insert slot, tap the trash can icon next to it.
- To enable or disable an effect slot, tap the On/Off button next to it.
- To disable all four effect slots, tap the All On/All Off button in the upper-right corner. Tap it again to reactivate the previously active effects.

When selecting an effect, you will see this window:

To move through the list, swipe up or down. Alternatively, use the data dial or +/- buttons.

- To sort or unsort the effects by type or manufacturer, tap Type or Manufacturer in the lower-left corner.
- To load an effect, double-tap it. Alternatively, tap Select, or press the center cursor or Enter (MPC X) or the data dial (MPC Live, MPC Touch).
- To cancel, tap Close or anywhere outside the list.

When you edit an effect, you will see this window:

- To adjust a parameter, tap and drag its slider. Alternatively, use the data dial or +/- buttons. To make finer adjustments, double-tap the pad and adjust the larger version of the slider that appears.

**Tip:** Turn the Q-Link knobs to quickly adjust the corresponding four parameters.

- To select an effect preset, use the dropdown menu at the top of the screen.
- To load a saved preset, tap the folder icon at the top of the screen.
- To save a preset, tap the disk icon at the top of the screen.
- To select another page of parameters, tap the Parameters +/- buttons at the top of the screen.
- To enable or disable the effect, tap the On/Off button in the upper-right corner.
- To edit parameters for another insert effect on the same pad, program, etc., tap a different Insert tab at the bottom of the screen to select it.
- To close the window, tap Close or the upper part of the screen.
**Insert Effects**

**Pads**

You can load up to four insert effects to each pad. You can do this in Main Mode, the Pad Mixer, or Program Edit Mode.

**Tip:** When using pad insert effects, they will be applied to the selected pad only. This means that you could apply unique combinations of effects to each pad within a program. If you want to apply the same effect to all pads, do this with a program insert effect (see *Insert Effects > Programs*).

---

**To load a pad insert effect in Main Mode:**

1. When the **MIDI** tab is selected (in the lower-left corner), use the **Track** field to select the track that uses the program with the desired pad—the program it uses will be selected automatically.
2. If the channel strip is not already shown, tap the small **eye icon** below the **Project** field to show it.
3. Tap the **single-pad icon** at the top of the channel strip. The channel strip will now show settings for the current pad.
4. Press the desired **pad** to select it. Alternatively, use the **Pad** field at the top of the channel strip.
5. Tap the area under **Inserts**, and then use the screen that appears to load or edit effects.
To load a pad insert effect in the Pad Mixer:

1. Use the Program field at the top of the screen to select the desired program. Alternatively, use the Track field at the top of the screen to select the desired track—the program it uses will be selected automatically.

2. Press the desired pad to select it, or tap it on the screen. Alternatively, double-tap the Pad field below the Program field.

3. Tap the area under Inserts, and then use the screen that appears to load or edit effects. Alternatively, tap the Insert tab at the bottom of the screen (tap it multiple times to select a different insert slot), and then double-tap the desired pad on the screen. You could also use the data dial or +/– buttons to select an effect immediately.

To load a pad insert effect in Program Edit Mode:

1. While using the desired program, press the desired pad to select it.

2. Tap the Effects tab in the lower-right corner, and use it to load or edit effects.
Keygroups

You can load up to four insert effects to each keygroup. You can do this in Main Mode, the Pad Mixer, or Program Edit Mode.

**Important**: When using keygroup insert effects, they will be applied to that keygroup only. Keep this in mind if you load insert effects to multiple keygroups with overlapping note ranges—the effects will overlap in that range as well.

**To load a keygroup insert effect in Main Mode:**

1. When the **MIDI** tab is selected (in the lower-left corner), use the **Track** field to select the track that uses the program with the desired pad—the program it uses will be selected automatically.

2. If the channel strip is not already shown, tap the small **eye icon** below the **Project** field to show it.

3. Tap the **single-pad icon** at the top of the channel strip. The channel strip will now show settings for the current keygroup.

4. Press a **pad** to select its corresponding keygroup, or tap it on the screen. Alternatively, use the **Keygroup** field at the top of the channel strip.

   **Important**: Remember that the effect will be applied to that keygroup only.

5. Tap the area under **Inserts**, and then use the screen that appears to load or edit effects.
To load a keygroup insert effect in the Pad Mixer:

1. Use the **Program** field at the top of the screen to select the desired program. Alternatively, use the **Track** field at the top of the screen to select the desired track—the program it uses will be selected automatically.

2. Press a **pad** to select its corresponding keygroup, or tap it on the screen. Alternatively, use the **Keygroup** field below the **Program** field.

   **Important**: Remember that the effect will be applied to that keygroup only.

3. Tap the area under **Inserts**, and then use the screen that appears to load or edit effects. Alternatively, double-tap the desired **pad** on the screen. You could also select one of the four **Insert** tabs at the bottom of the screen, and then use the **data dial** or –/+ buttons to select an effect immediately.

To load a keygroup insert effect in Program Edit Mode:

1. While using the desired program, press the desired **pad** to select its keygroup. Alternatively, use the **Keygroup** field at the top of the screen.

2. Tap the **Effects** tab in the lower-right corner, and use it to load or edit effects.
Audio Tracks

You can load up to four insert effects to each audio track. You can do this in Main Mode and the Channel Mixer.

To load an audio track insert effect in Main Mode:
1. When the Audio tab is selected (in the lower-left corner), use the Track field to select the audio track.
2. If the channel strip is not already shown, tap the small eye icon below the Project field to show it.
3. Tap the waveform icon at the top of the channel strip. The channel strip will now show settings for the current audio track.
4. Tap the area under Inserts, and then use the screen that appears to load or edit effects.

To load an audio track insert effect in the Channel Mixer:
1. Use the Mixer field in the upper-left corner to select Audio Tracks.
2. In the touchscreen, tap the pad that corresponds to the desired audio track.
3. Tap the area under Inserts, and then use the screen that appears to load or edit effects. Alternatively, tap the Insert tab at the bottom of the screen (tap it multiple times to select a different insert slot), and then double-tap the desired pad on the screen. You could also use the data dial or +/- buttons to select an effect immediately.
Programs

You can load up to four insert effects to each program. You can do this in Main Mode, XYFX Mode, and the Channel Mixer.

**Note:** In XYFX Mode, the effects act like a single insert effect on that program. In fact, **XYFX** is the name of the insert effect that is loaded when use this mode.

To load a program insert effect in Main Mode:

1. When the **MIDI** tab is selected (in the lower-left corner), use the **Track** field to select the track that uses the program with the desired pad—the program it uses will be selected automatically.

2. If the channel strip is not already shown, tap the small **eye icon** below the **Project** field to show it.

3. Tap the **four-pads icon** at the top of the channel strip. The channel strip will now show settings for the current program.

4. Tap the area under **Inserts**, and then use the screen that appears to load or edit effects.
To load XYFX for a program in XYFX Mode:

1. Select the desired program in another mode, and then enter XYFX Mode.
2. If you have not yet used XYFX Mode for this program, tap Insert XYFX on the screen to load it and show the XY pad.

   **Note:** If you already have four insert effects loaded, you will need to clear one of the insert effect slots before doing this.

   If you have already used XYFX Mode for this program, the XY pad will appear.
3. Tap XYFX Location in the upper-left corner, and select Program.
4. If the Setup panel is not shown, tap Setup in the lower-right corner to show it.
5. Use the Preset field to load an effect. Use the controls below the Preset field to edit the effect.

To load a program insert effect in the Channel Mixer:

1. Use the Mixer field in the upper-left corner to select Programs.
2. In the touchscreen, tap the pad that corresponds to the desired program. Alternatively, double-tap the Program field below the Mixer field and tap the desired program.
3. Tap the area under Inserts, and then use the screen that appears to load or edit effects. Alternatively, tap the Insert tab at the bottom of the screen (tap it multiple times to select a different insert slot), and then double-tap the desired pad on the screen. You could also use the data dial or +/- buttons to select an effect immediately.
Submixes
You can load up to four insert effects to each submix. You can do this in the Channel Mixer only.

To load a submix insert effect:
1. Use the Mixer field in the upper-left corner to select Submixes.
2. In the touchscreen, tap the pad that corresponds to the desired program. Alternatively, double-tap the Submix field below the Mixer field and tap the desired program.
3. Tap the area under Inserts, and then use the screen that appears to load or edit effects. Alternatively, tap the Insert tab at the bottom of the screen (tap it multiple times to select a different insert slot), and then double-tap the desired pad on the screen. You could also use the data dial or +/- buttons to select an effect immediately.
Masters

You can load up to four insert effects to each master output (a stereo pair of channels: Outputs 1/2, Outputs 3/4, etc.). You can do this in Main Mode or the Channel Mixer.

To load a master insert effect in Main Mode:
1. If the channel strip is not already shown, tap the small eye icon below the Project field to show it.
2. Tap the crown icon at the top of the channel strip. The channel strip will now show settings for the current master output.
3. Use the Outputs field at the top of the channel strip to select the desired master output (Outputs 1/2, Outputs 3/4, etc.).
4. Tap the area under Inserts, and then use the screen that appears to load or edit effects.

To load a master insert effect in the Channel Mixer:
1. Use the Mixer field in the upper-left corner to select Masters.
2. In the touchscreen, tap the pad that corresponds to the desired master output (Outputs 1/2, Outputs 3/4, etc.). Alternatively, double-tap the Outputs field below the Mixer field.
3. Tap the area under Inserts, and then use the screen that appears to load or edit effects. Alternatively, tap the Insert tab at the bottom of the screen (tap it multiple times to select a different insert slot), and then double-tap the desired pad on the screen. You could also use the data dial or +/- buttons to select an effect immediately.
Send/Return Effects

Send/return effects work in the following way:

1. A pad, keygroup, audio track, program, or submix sends its audio to a return at a designated send level.
2. That audio is processed by the effects on the return. Each return can have up to four insert effects loaded and activated.
3. The processed audio is sent to a pair of master outputs (stereo) or a single master output (mono).

You can load send/return effects and set return levels only in the Channel Mixer, described below. The rest of this section describes the different ways to set the desired send levels for pads, keygroups, programs, or submixes.

To load a send/return effect to a return:

1. In the Channel Mixer, use the Mixer field in the upper-left corner to select Returns.
2. In the touchscreen, tap the pad that corresponds to the desired return. Alternatively, double-tap the Return field below the Mixer field.
3. Tap the area under Inserts, and then use the screen that appears to load or edit effects. Alternatively, tap the Insert tab at the bottom of the screen (tap it multiple times to select a different insert slot), and then double-tap the desired pad on the screen. You could also use the data dial or −/+ buttons to select an effect immediately.

To set the return level:

1. In the Channel Mixer, use the Mixer field in the upper-left corner to select Returns.
2. Tap the Level tab in the lower-left corner.
3. In the touchscreen, tap the pad that corresponds to the desired return. Alternatively, double-tap the Return field below the Mixer field.
4. To adjust the level of the currently selected return, use the data dial or −/+ buttons. Alternatively, use the level slider in the channel strip, or turn the corresponding Q-Link knob. To make finer adjustments, double-tap the pad on the screen and adjust the larger version of the slider that appears.
Pads
You can set the send levels for pads in Program Edit Mode or the Pad Mixer.

To set the send levels for a pad in Program Edit Mode:
1. While editing the desired program in Program Edit Mode, press the desired pad to select it.
2. Tap the Effects tab in the lower-right corner.
3. Use the Send knobs to set the send level for each return.

To set the send levels for a pad in the Pad Mixer:
1. Use the Program field at the top of the screen to select the desired program. Alternatively, use the Track field at the top of the screen to select the desired track—the program it uses will be selected automatically.
2. Tap the Send tab at the bottom of the screen (tap it multiple times to select a different send level).
3. Press the desired pad to select it, or tap it on the screen. Alternatively, double-tap the Pad field below the Program field.
4. To set the send level, use the data dial or +/- buttons. To make finer adjustments, double-tap the pad on the screen and adjust the larger version of the slider that appears.
Keygroups

You can set the send levels for keygroups in Program Edit Mode or the Pad Mixer.

To set the send levels for a keygroup in Program Edit Mode:
1. While using the desired program, press the desired pad to select its keygroup. Alternatively, use the Keygroup field at the top of the screen.
2. Tap the Effects tab in the lower-right corner.
3. Use the Send knobs to set the send level for each return.

To set the send levels for a keygroup in the Pad Mixer:
1. Use the Program field at the top of the screen to select the desired program. Alternatively, use the Track field at the top of the screen to select the desired track—the program it uses will be selected automatically.
2. Tap the Send tab at the bottom of the screen (tap it multiple times to select a different send level).
3. Press the desired pad to select its corresponding keygroup, or tap it on the screen. Alternatively, double-tap the Keygroup field below the Program field.
4. To set the send level, use the data dial or +/- buttons. To make finer adjustments, double-tap the pad on the screen and adjust the larger version of the slider that appears.
Audio Tracks

You can set the send levels for audio tracks in the Channel Mixer only.

To set the send levels for an audio track:
1. In the Channel Mixer, use the Mixer field in the upper-left corner to select Audio Tracks.
2. Tap the Send tab at the bottom of the screen (tap it multiple times to select a different send level).
3. In the touchscreen, tap the pad that corresponds to the desired audio track. Alternatively, double-tap the Audio Track field below the Mixer field.
4. To set the send level, use the data dial or –/+ buttons. To make finer adjustments, double-tap the pad on the screen and adjust the larger version of the slider that appears.

Programs

You can set the send levels for programs in the Channel Mixer only.

To set the send levels for a program:
1. In the Channel Mixer, use the Mixer field in the upper-left corner to select Programs.
2. Tap the Send tab at the bottom of the screen (tap it multiple times to select a different send level).
3. In the touchscreen, tap the pad that corresponds to the desired program. Alternatively, double-tap the Program field below the Mixer field.
4. To set the send level, use the data dial or –/+ buttons. To make finer adjustments, double-tap the pad on the screen and adjust the larger version of the slider that appears.
Submixes

You can set the send levels for submixes in the Channel Mixer only.

To set the send levels for a submix:
1. In the Channel Mixer, use the Mixer field in the upper-left corner to select Submixes.
2. Tap the Send tab at the bottom of the screen (tap it multiple times to select a different send level).
3. In the touchscreen, tap the pad that corresponds to the desired submix. Alternatively, double-tap the Submix field below the Mixer field.
4. To set the send level, use the data dial or +/- buttons. To make finer adjustments, double-tap the pad on the screen and adjust the larger version of the slider that appears.
Audio Mixdown

The Audio Mixdown screen lets you render and export either the current sequence or song as an audio file. In Song Mode, this will export the entire song. In Main Mode, this will export the current sequence only.

To open the Audio Mixdown screen in Song Mode, tap Export at the bottom edge of the screen.

To open the Audio Mixdown screen in Main Mode, tap the Project field in the upper-left corner of the screen, and then tap Export.

Audio Length

Use the Start Bar and End Bar fields to define where the resulting audio file will start and end, respectively.

Use the Audio Tail field to add extra seconds to the end of the resulting audio file. This is useful if you are using effects or samples whose sounds exceed the defined audio length (e.g., long reverb or delay, one-shot samples with long decays, etc.). We recommend using an audio tail of at least a couple of seconds.

Render Source

Check Stereo Output and use the adjacent field to select a pair of outputs (Out 1,2–7,8 and Submix 1–8 in Standalone Mode, or Out 1,2–31,32 in Controller Mode; MPC Live does not use Out 7,8 in Standalone Mode but displays them to maintain compatibility with MPC X, which does use them). The mixdown will be taken from these outputs.

Check Separate Programs to create a mixdown of each program used in the sequence or song.

Check Explode Tracks to create a mixdown of each track used in the sequence (you cannot use this option for an entire song).

Important: Each pad or keygroup must have their output routed to Program to be included in the mixdown. This is the typical (and default) setting. See Modes > Pad Mixer > Routing to learn about this.

Render Options

If your Render Source is set to Stereo Output, check Master Inserts to include master insert effects in the mixdown.

If your Render Source is set to Separate Programs or Explode Tracks, check Export Returns to export the return channel signals as separate files.

If your Render Source is set to Stereo Output, tap Save as Project Preview to save the sequence or song as a project preview file (which you can play for reference in the Browser). If you check this box, Stereo Output will automatically be checked, as well.
File Formats

Tap WAV, AIFF, MP3, FLAC or OGG to select the file format of the mixdown.

For WAV and AIFF files, use the Bit Depth field to select a bit depth of 8, 16, or 24 bits, or 32 bits, floating point (32 F). For FLAC files, you can select a bit depth of 16 or 24 bits. For MP3 and OGG files, you can select a Bitrate of 128, 160, 192, or 320 kbps.

Use the Sample Rate field to select a sample rate of 44.1 kHz, 48 kHz, 88.2 kHz, or 96 kHz. In most cases, we recommend selecting 44.1 kHz.

Tap Export to enter the Save screen where you can select a name and location to save your audio mixdown.

Tap Cancel or the ← icon in the upper-left corner to return to the previous screen.

Battery Usage

**Important:** Only MPC Live may use battery power. MPC X and MPC Touch must be connected to a power outlet.

Although you can power MPC Live from a power outlet (using the included power adapter), you can use its internal battery, which typically has four hours of life, depending on CPU and how you’re using MPC Live.

While powering MPC Live from its internal battery, the battery icon in upper-right corner of the touchscreen will show its current battery life. (The icon below it indicates whether MPC Live is in Standalone Mode or Controller Mode.)

To view MPC Live’s system resources (battery life, CPU, and RAM usage), tap the battery icon in upper-right corner of the touchscreen. The System Resources window will appear, showing percentages to indicate the current battery life, CPU, RAM usage (Mem), and storage device space usage.

See System Resources to learn more about the information shown in this window.

To charge MPC Live’s internal battery, connect its power input to a power outlet using the included power adapter. The charging indicator light (behind the vent on the rear panel) will turn on while charging. When the battery is fully charged or when it is disconnected from a power outlet, then this light will turn off.
Standalone vs. Controller Mode

MPC X and MPC Live can function in two ways: **Standalone Mode** and **Controller Mode**. (MPC Touch already operates as a controller only.)

**To enter Standalone Mode**, do one of the following:

- If MPC X or MPC Live is **not** connected to a computer, simply press the **power switch** to power it on.

- If MPC X or MPC Live is connected to your computer and you want to keep your MPC software open, press **Menu** to enter the Menu, and then tap the **monitor/cable icon** in the upper-right corner. When the **Switch to Standalone Mode** window appears, tap **Standalone** to continue. Your project will remain open on your computer, and you can continue to work on it independently from the project shown on the screen. (If you tap **Cancel**, you can continue using your MPC hardware in Controller Mode.)

- If MPC X or MPC Live is connected to your computer and you want to close the MPC software, simply close the MPC software on your computer. When **Looking for computer** appears on your MPC hardware’s touchscreen, tap **Standalone**. If the **Restart as Standalone** window appears, tap **Yes** to continue. (If you tap **Cancel**, you can reopen your MPC software and continue using your MPC hardware in Controller Mode.)

In Standalone Mode:

- An **MPC chip icon** will appear in the upper-right corner.

- The MPC hardware is **not** communicating with a computer over a USB connection.

- Any files (projects, samples, etc.) that you save or load are in the internal hard drive on your MPC X or MPC Live or a connected USB drive or SD card.

- Plugin programs are disabled.
To enter Controller Mode:

1. Make sure the **USB-B Port** on your MPC X or MPC Live is connected to your computer.

2. On your computer, open the MPC software.

3. If MPC X or MPC Live is powered off, press the **power switch** to power it on.

4. If MPC X or MPC Live is currently in Standalone Mode, press **Menu** to enter the Menu, and then tap the **MPC chip icon** in the upper-right corner. When the **Enter Controller Mode** window appears, tap **Controller Mode** to continue. (If you tap **Cancel**, you can continue using your MPC hardware in Standalone Mode.)

Looking for computer may appear briefly on the screen before the MPC hardware recognizes the USB connection as a controller.

In Controller Mode:

- A **monitor/cable icon** will appear in the upper-right corner.

- The MPC hardware is communicating with a computer over a USB connection.

- You can save or load files (projects, samples, etc.) to or from your computer as well as the internal hard drive on your MPC X or MPC Live or a connected USB drive or SD card.

- Plugin programs are enabled. Remember to specify the disk directory where your plugins are located. This can be done in the software’s **Preferences** (in the **Edit** Menu). See the user guide in the MPC software to learn more: click the **Help** menu, select **MPC Help**, and select **MPC User Manual**.

- The touchscreen on your MPC hardware reflects what it is controlling in the software, but due to space and character limitations, the layout on the screen is different (e.g., parameter names may be abbreviated, the layout may be different or spread across multiple tabs, etc.).
The MPC hardware has a Menu page that lets you select any one of several modes. This chapter describes the various features and functions of each one.

Click a button below to skip directly to that chapter.

Note: The Menu above is available when the currently selected track is a MIDI track. When an audio track is selected, it will show an icon for Audio Edit Mode instead of Grid View.

While in Main Mode, the Grid View, Audio Edit Mode, the Track View, the Step Sequencer, or XYFX Mode, the left edge contains icons to quickly enter one of five modes. Using this strip of icons, you can easily jump between them:

To enter Main Mode, tap the house icon.
To enter the Grid View, tap the grid icon. The MIDI tab in the lower-left corner of the screen in Main Mode must be selected for this icon to be shown.
To enter Audio Edit Mode, tap the waveform-and-box icon. This Audio tab in the lower-left corner of the screen in Main Mode must be selected for this icon to be shown.
To enter the Track View, tap the bars-and-magnifying-glass icon.
To enter the Step Sequencer, tap the vertical-bars icon.
To enter XYFX Mode, tap the XY icon.
Main Mode gives you an overview of the most-used functions.

To enter Main Mode, do one of the following:

- Press **Main**.
- Press **Menu**, and then tap **Main**.

The top of the screen shows the project name and timing information.

The **Project** field shows the name of the current project.

To view the **Project window**, tap the **Project** field. The Project window will appear, showing a list of available programs, sequences, and samples in the project.

In the **Project** window, in addition to typical functions you can perform in lists, you can do any of the following:

- **To move through a list**, swipe up or down.
- **To expand or collapse the list of programs or sequences**, tap the arrow (≠ or >) to its left.
- **To select a program, sequence, or sample**, tap it.
- **To immediately select a sample and enter Sample Edit Mode**, double-tap it.
- **To save the project**, tap **Save**.
- **To save the project with another name**, tap **Save As**. Use the **Save** window that appears to save the project.
- **To return to the previous screen**, tap the X in the upper-right corner or anywhere outside the window.
- **To delete samples from the project** (to create more free RAM space for sampling time, audio recording, etc.), tap **Purge**. In the screen that appears, tap **Unused Samples** to delete all unused samples from the project, tap **All Samples** to delete all samples from the project (from all programs, sequences, and audio or MIDI tracks), or tap **Cancel** to return to the previous screen.
- **To export the current sequence**, tap **Export**. Use the **Audio Mixdown** screen that appears to export a song (see **General Features > Audio Mixdown** to learn about the settings in this window). To export the song instead, see the **Song Mode** chapter.
- **To export the current sequence as an Ableton Live Set**, tap **ALS Export**. See **Appendix > Updates in v2.6 > New Features > Ableton Live Set Export** for more information.
The In and Out boxes indicate your MPC hardware is receiving or sending (respectively) MIDI messages from or to your computer.

The time counter at the top of the screen the current playhead position. This is shown in most of the modes. See General Features > Time Counter/Locate to learn about this.

The TC icon opens the Timing Correct window, which contains various settings to help quantize the note events in your sequence. See General Features > Timing Correct (TC) to learn about this.

The Metro/metronome icon opens the Click/Metro menu, which contains all settings regarding the metronome (click track). See General Features > Metronome (Click/Metro) to learn about this.

The automation button indicates the global automation state. This is shown in several modes. See General Features > Automation to learn about this.

In Main Mode, these are the buttons at the bottom of the screen:

- **MIDI**: Tap this button to view only MIDI tracks in the Track section.
- **Audio**: Tap this button to view only audio tracks in the Track section.
- **Track +/-**: Tap one of these buttons to switch to the previous or next track, respectively.
- **Mute**: Tap this button to mute the current track.
- **Solo**: Tap this button to solo the current track.
On the left edge of the screen, next to the five mode icons, there are two small icons that control the channel strip.

To show or hide the channel strip, tap the eye icon.

The icon below the eye icon indicates the type of channel strip (see next description).

The channel strip contains some important settings for the current pad, program, track, or master output, depending on the currently selected icon:

To view the pad channel strip, tap the single-pad icon.

To view the program channel strip, tap the four-squares icon.

To view the track channel strip, tap the bars icon (when the MIDI tab is selected) or the waveform icon (when the Audio tab is selected).

To view the master channel strip, tap the crown icon.

When viewing the pad channel strip while using a drum program, keygroup program, or clip program:

The first field shows the current pad number. Press a pad or tap the field to select a different pad.

Tip: This is useful for mixing your pads without having to enter the Pad Mixer.

The second field shows where the pad is routed, which you can change: Program (the usual setting); Out 1,2–7,8, Out 1–8 or Sub 1–8 in Standalone Mode; and Out 1,2–31,32 or Out 1–32 in Controller Mode.

Note: When set to a mono channel, the left and right channels are summed post-pan knob. If the pan knob is set to the center position, the left and right channels will be summed and padded. If the pan knob is set to the maximum left or right positions, only the respective channel will be sent to the output.

The Inserts field shows any enabled or disabled effects for that pad. Tap the area under Inserts to open a window where you can load, change, and enable or disable the effects.

Tap Solo or Mute to solo or mute the pad (respectively).

Adjust the pan knob or level slider to change the panning or level of the pad. The green level meter next to the slider shows the pad's current volume level in dB.
When viewing the **program channel strip** while using a drum program, keygroup program, clip program, or plugin program:

The first field shows the current program number and name (which you can change).

The second field shows where the program is routed, which you can change:
- **Out 1,2–7,8**, **Out 1–8** or **Sub 1–8** in Standalone Mode; and **Out 1,2–31,32** or **Out 1–32** in Controller Mode.

**Note:** When set to a mono channel, the left and right channels are summed post-pan knob. If the pan knob is set to the center position, the left and right channels will be summed and padded. If the pan knob is set to the maximum left or right positions, only the respective channel will be sent to the output.

The **Inerts** field shows any enabled or disabled effects for that program. Tap the area under **Inerts** to open a window where you can load, change, and enable or disable the effects.

Tap **Solo** or **Mute** to solo or mute the program (respectively). Alternatively, press **Solo** or **Mute** under the LED meters (MPC X).

**To change the program’s automation**, tap the **program automation button** or press **Read/Write** (MPC X) to cycle through its three states:

- When **off**, the program will ignore automation data. If you have already recorded or entered automation, tapping this will switch between **Read (R)** and **Write (W)** only, but you can override this and turn it off by pressing and holding **Shift** while tapping the button.

  **Important:** If you have already recorded automation and turn it off, the track will still use the effect and its parameter values at the point where you turned it off.

- When set to **Read (R)**, the program will read automation data but will not record any additional automation over it. (Think of this as a protective feature to prevent accidental changes to your automation while recording.)

- When set to **Write (W)**, the program can record automation. (If you have any Q-Link knobs assigned to automatable parameters, make sure not to touch any accidentally while you are recording.)

  **Tip:** You can quickly set all programs and audio tracks to the same automation by tapping the global automation button in the upper-right corner of the screen. See **General Features > Automation** to learn about this.

Adjust the **pan knob** or **level slider** to change the panning or level of the program. The **green** level meter next to the slider shows the program's current volume level in dB.

When viewing the **track channel strip** while using a MIDI track:

The first field shows the current track (which you can change) and its name.

The second field shows the name of the program the track is using.

Tap **Solo** or **Mute** to solo or mute the track (respectively).

Adjust the **pan knob** or **level slider** to change the panning or level of the track. The **blue** level meter next to the slider shows the track’s current velocity level.

**Note:** If the track is using a plugin program, then the slider will send **CC #7 (Volume)** and the knob will send **CC #10 (Pan)** to your instrument plugin. The plugin will then handle these messages as it normally would.
When viewing the **track channel strip** while using an audio track:

The first field defines the input source of the external audio signal, which you can set to a pair of inputs (Input 1,2–3,4 in Standalone Mode, Input 1,2–31,32 in Controller Mode) or a single input (Input 1–4 in Standalone Mode, Input 1–32 in Controller Mode).

The second field shows where the track is routed, which you can change: Out 1,2–7,8, Out 1–8 or Sub 1–8 in Standalone Mode; and Out 1,2–31,32 or Out 1–32 in Controller Mode.

**Note:** When set to a mono channel, the left and right channels are summed post-pan knob. If the pan knob is set to the center position, the left and right channels will be summed and padded. If the pan knob is set to the maximum left or right positions, only the respective channel will be sent to the output.

The **Inserts** field shows any enabled or disabled effects for that track. Tap the area under **Inserts** to open a window where you can load, change, and enable or disable the effects.

Tap **Solo** or **Mute** to solo or mute the track (respectively). Alternatively, press **Solo** or **Mute** under the LED meters (MPC X).

**To change the audio track’s automation**, tap the **track automation button** or press **Read/Write** (MPC X) to cycle through its three states:

When **off**, the audio track will ignore automation data. If you have already recorded or entered automation, tapping this will switch between Read (R) and Write (W) only, but you can override this and turn it off by pressing and holding Shift while pressing or tapping the button.

**Important:** If you have already recorded automation and turn it off, the track will still use the effect and its parameter values at the point where you turned it off.

When set to **Read** (R), the audio track will read automation data but will not record any additional automation over it. (Think of this as a protective feature to prevent accidental changes to your automation while recording.)

When set to **Write** (W), the audio track can record automation. (If you have any Q-Link knobs assigned to automatable parameters, make sure not to touch any accidentally while you are recording.)

**Tip:** You can quickly set all programs and audio tracks to the same automation by tapping the global automation button in the upper-right corner of the screen. See **General Features > Automation** to learn about this.

Adjust the **pan knob** or **level slider** to change the panning or level of the track. The **green** level meter next to the slider shows the track’s current volume level in **dB**.

**To record-enable the track**, tap the **Record Arm** button or press **Rec Arm** (MPC X). When you begin audio recording, the audio signal will be recorded to this track.

**Tip:** You can select multiple tracks in the Track View by pressing and holding Shift while tapping the **Arm** button to each track.

When viewing the **master channel strip**:

The first field shows the current master output as a stereo pair (which you can change).

The **Inserts** field shows any enabled or disabled effects for that pair of outputs. Tap the area under **Inserts** to open a window where you can load, change, and enable or disable the effects.

Tap **Mute** to mute the master output.

Adjust the **pan knob** or **level slider** to change the panning or level of the master output. The **green** level meter next to the slider shows the outputs’ current volume level in **dB**.
Sequence Section

The **Sequence** section shows the current sequence and its information.

![Sequence Section](image)

Use **Sequence** field to select a sequence.

**To edit the name of the sequence**, tap the cursor icon on the right edge of the section, and use the virtual keyboard that appears.

Use the **BPM** field to adjust the tempo of the sequence.

**To set whether the sequence follows its own tempo (Sequence) or a master tempo (Master)**, tap the **Sequence/Master** button under the **BPM** field. Alternatively, press and hold **Shift+Tap**.

Use the **Bars** field to adjust the length of the sequence in bars.

The **Loop** button shows whether the sequence (or a part of it) will loop or not.

**To enable or disable looping**, tap the button.

**To set the start point and end point of loop**, tap the **Start** or **End** field (respectively) and then use the **data dial** or the "+/-" buttons, or double-tap the field and use the numeric keyboard that appears.

**Note**: The **Last Bar** value of the **Delete Bars** and **Copy Bars** processes depends on the total length of the sequence.

Use the **Transpose** field to set the transposition (in semitones) of the entire sequence.
To edit the sequence, tap the pencil icon on the right edge of the section. The Sequence Edit/Copy window will open.

You can use any of these functions as described below, though there are fewer options for audio tracks than for MIDI tracks.

To return to Main Mode, tap Cancel or the left arrow (↩) in the upper-left corner of the screen. Alternatively, press Main.

To edit the name of the sequence, tap the top of the screen and use the virtual keyboard that appears.
The **Erase** function erases all or part of a track in a specific sequence.

- **To select the sequence you want to erase**, use the **Sequence** field.
- **To select the track you want to erase within the sequence**, use the **Track** field.
- **To set the time range of the sequence you want to erase**, use the **Bar**, **Beat**, and **Tick** fields. The left fields set the start of the time range, and the right fields set the end of the time range.
- **To select what types of events you erase**, select one of the **Erase** options:
  - **All** erases all pad events from the designated time range and reset all of its settings.
  - **Automation** erases only automation from the designated time range.
  - **Note** erases only specific pad events from the designated time range. In the diagram of the eight pad banks that appears, press each pad in each bank to select or deselect its notes. This option is available only for MIDI tracks, not audio tracks.
  - **Except Note** erases everything except pad events from the designated time range. This option is available only for MIDI tracks, not audio tracks.

- **To confirm your choice**, tap **Do It**.
- **To return to the previous screen**, tap **Back** or anywhere outside the window.
- **To cancel and return to Main Mode**, tap **Cancel**.

The **Clear** function erases all events from the sequence and resets all of its settings.

- **To confirm your choice**, tap **Clear**.
- **To return to the previous screen**, tap **Cancel**.
The **Transpose** function transposes a range of events on a track in a sequence. The events within that range will shift accordingly in the Grid View. This option is available for MIDI tracks only.

**To select the sequence you want to transpose**, use the **Sequence** field.

**To select the track you want to transpose within the sequence**, use the **Track** field.

**To set the time range of the sequence you want to transpose**, use the two sets of **Bar**, **Beat**, and **Tick** fields. The left fields set the start of the time range, and the right fields set the end of the time range.

For **drum programs**, use the two **Pad** fields to select the “source” pad (whose events you want to move) and “destination” pad (where the events will be placed). Tap each field and then press the desired pad.

For **keygroup programs**, **plugin programs**, and **MIDI programs**, set the range and amount of transposition:

- **Range**: Use the two **Note** fields to set the range of notes of the events you want to transpose. Note events within this range will be transposed, while note events outside of this range will remain unchanged.

- **Transpose**: Use this field to set how many semitones up or down you want to transpose the note events.

**To confirm your choice**, tap **Do It**.

**To return to the previous screen**, tap ← **Back** or anywhere outside the window.

**To cancel and return to Main Mode**, tap **Cancel**.

The **Bounce to Sample** function **immediately** renders the sequence (all of its tracks) as an audio sample and places it in the project's sample pool. By default, it will be named **Bounce -** and appended with the sequence name.

If you have already used this function on this sequence, then you will be asked if you want to overwrite the existing sample with this new one or cancel.

**To continue and save the sequence over the existing one**, tap **Replace**.

**To cancel**, tap **Cancel**.
The **Delete Bars** function removes a range of bars from a sequence.

To select the sequence whose bars you want to delete, use the **Sequence** field.

To set the range of bars you want to delete, use the **First Bar** and **Last Bar** fields. The bar in each field and all bars in between them will be deleted.

To confirm your choice, tap **Do It**.

To return to the previous screen, tap ← **Back** or anywhere outside the window.

To cancel and return to Main Mode, tap **Cancel**.

The **Insert Bars** function adds empty bars to a sequence at a specified point.

To select the desired sequence, use the **Sequence** field.

To set how many bars you will insert, use the **# of Bars** field.

To set the time signature of the inserted bars, use the two **Time Sig** fields.

To set where you will insert the bars, use the **Before Bar** field. The bars will be inserted before this one.

To confirm your choice, tap **Do It**.

To return to the previous screen, tap ← **Back** or anywhere outside the window.

To cancel and return to Main Mode, tap **Cancel**.

The **Half Length** function will immediately halve the length of the sequence (without deleting any note events).

The **Double Length** function will immediately double the sequence and copy all events from the first half to the second half.
The Copy Sequence function copies the contents of one sequence to another.

To select the “source” sequence, use the Copy Contents of Sequence field. This is the sequence whose events you want to copy.

To select the “destination” sequence, use the Over Contents of Sequence field. This is the sequence where the source sequence will be copied.

To confirm your choice, tap Do It.

To return to the previous screen, tap Back or anywhere outside the window.

To cancel and return to Main Mode, tap Cancel.

The Copy Bars function copies a range of bars from a sequence and adds them to another at a specified point.

To select the “source” sequence, use the From Sequence field. This is the sequence whose bars you want to copy.

To set the range of bars to copy in the source sequence, use the First Bar and Last Bar fields.

To select the “destination” sequence, use the To Sequence field. This is the sequence where the source sequence bars will be copied.

To set where you want to add the copied bars, use the After Bar field. The copied bars will be inserted after this one.

To set how many instances of the copied bars you want to add, use the Copies field.

To overwrite the destination sequence, tap Replace.

To add the events to the destination sequence without erasing anything, tap Merge.

To return to the previous screen, tap Back or anywhere outside the window.

To cancel and return to Main Mode, tap Cancel.
The Copy Events function copies a range of events or selected audio track regions from a sequence and adds them to another at a specified point.

To select the “source” sequence, use the From Sequence field. This is the sequence whose content you want to copy.

To select the “source” track, use the From Track field. This is the track whose content you want to copy.

To specify the pads or notes to copy events from, use the Pads or Notes field. By default, this will be set to All to copy all events in the current track.

To set the time range of the events or the audio track you want to copy, use the Bar, Beat, and Tick fields. The left fields set the start of the time range, and the right fields set the end of the time range.

To set what content is copied, use the field below the dotted arrow. Copy All Events will copy and paste all events in the track. Copy Only Selected Events will copy and paste only the events that are currently selected.

To select the “destination” sequence, use the To Sequence field. This is the sequence where the content of the source sequence will be copied.

To select the “destination” track, use the To Track field. This is the track where the content of the source track will be copied.

To set where you want to add the copied events or audio track, use the Bar, Beat, and Tick fields. The events or audio track will be added after this point.

To set how many instances of the copied events or audio track you want to add, use the Copies field.

To set whether you want to copy the events in the time range or the selected notes in the Grid View or List Edit Mode, use the Selection field. Set this to All events to copy the notes in the time range determined by the Bar, Beat, and Tick fields above, or set this to Selected events to copy only the events currently selected in the Grid View or List Edit Mode. This field is available for MIDI tracks only.

To overwrite the destination sequence, tap Replace.

To add the events to the destination sequence without erasing anything, tap Merge.

To return to the previous screen, tap ← Back or anywhere outside the window.

To cancel and return to Main Mode, tap Cancel.
The **Save Current Sequence** function saves the current sequence to an external storage device or the internal drive of MPC X or MPC Live.

To select the storage device you want to view, tap it in the **Storage** column on the left.

**Internal** is the internal drive of MPC X or MPC Live.

**MPC Documents** is a shortcut to the **MPC Documents** folder on the internal drive of MPC X or MPC Live.

If you have storage devices connected to USB ports or SD card slot of MPC X, MPC Live, or your computer (with MPC Touch), they will appear in this column, as well.

To enter a folder, double-tap it. Alternatively, turn the **data dial** or use the −/+ buttons to move through the list, and press the **center cursor** or **Enter** (MPC X) or the **data dial** (MPC Live, MPC Touch) to enter a folder. You can also tap one of the five **folder buttons** in the upper-right to jump immediately to those pre-assigned file paths (see **Browser** to learn how to do this).

To create a new folder, tap **New Folder**, use the virtual keyboard that appears to enter a name, and then tap **Do It**. You will immediately enter the new folder.

To move up one folder level, tap the **folder/↵ icon** in the upper-left corner.

To name the file, tap the **File Name** field at the bottom of the screen, and use the virtual keyboard that appears.

To save the file, tap **Save**.

To cancel and return to the Menu, tap **Cancel**. Alternatively, tap the **← icon** in the upper-left corner.
Track Section

The Track section shows the current track, program type, and its information.

![Track section while using a MIDI track.](image)

The Track section while using an audio track.

The Track field shows the track number and its name.

To edit the name of the track, tap the cursor icon on the right edge of the section and use the virtual keyboard that appears.

While using a MIDI track:

![Track section while using a MIDI track.](image)

The program selector indicates the type of program through which the track is being routed. The specific program name is displayed below in the Program section. You can use the program selector to change program type (and then select a specific program of that type in the Program section below it).

- To select a drum program, tap the four-squares icon.
- To select a keygroup program, tap the piano-keys icon.
- To select a clip program, tap the play-button icon.
- To select a MIDI program, tap the bars icon.
- To select a CV program, tap the CV icon.
- To select a plugin program, tap the plug icon. For MPC X and MPC Live, plugin programs are available only in Controller Mode with the desktop version of the MPC software.

Use the Length field to set how long the track is in beats. If you select the minimum value, Seq or 0 (if you use the numeric keypad), the track will be the exact same length as its sequence.

Tip: This feature lets you maintain tracks of different lengths. For instance, you could play a 1-bar drum sequence repeatedly under a 4-bar bass line.

Use the Velocity field to set how loudly or quietly a track plays relative to its recorded levels. When set to 50%, the track will be played with half the velocity it was originally played. When set to 200%, the track will play twice as loud. The maximum velocity level is still 127, though.

Use the Transpose field to set the transposition (in semitones) of the entire track.
While using an audio track:

Tap the **Record Arm** button to record-enable the track. When you begin audio recording, the audio signal will be recorded to this track.

**Tip:** You can select multiple tracks in the Track View by pressing and holding **Shift** while tapping the **Arm** button to each track.

Use the **Monitor** button to set how your audio track will be monitored. Tapping it will cycle through its three states:

- **Auto**, you will hear incoming audio while the track is record-enabled only.
- **On**, you will hear incoming audio whether or not the track is record-enabled.
- **Off**, you will never hear any incoming audio.

To **edit the track**, tap the **pencil icon** on the right edge of the section. The Track Edit window will open.

![Track Editor](image.png)

While using MIDI tracks, you can use any of these functions as described below.

To **return to Main Mode**, tap **Cancel** or the left arrow (←) in the upper-left corner of the screen. Alternatively, press **Main**.

To **edit the name of the track**, tap the top of the screen and use the virtual keyboard that appears.
The **Clear** function erases all events from the track and resets all of its settings.

To confirm your choice, tap **Clear**.

To return to the previous screen, tap **Cancel**.

The **Explode** function immediately splits the current track into multiple tracks—one for each distinct pad or note (pitch, not event). The current track also remains present and intact, while each track created from it is labeled with the track name and pad name or number.

The **Double-Speed Events** function immediately halves the lengths of all note events on the track as well as the distance between them. In other words, the track’s notes are pressed closer together so the track sounds like it is playing at twice the previous speed. This does not actually affect the pitches of notes or the tempo.

The **Half-Speed Events** function immediately doubles the lengths of all note events on the track as well as the distance between them. In other words, the track’s notes are spread further apart so the track sounds like it is playing at half of the previous speed. This does not actually affect the pitches of notes or the tempo.

The **Copy Track** function copies the contents of one track to another.

To select the “source” track, tap the **Copy Contents of Track** field. This is the track whose events you want to copy.

To select the “destination” track, tap the **Over Contents of Track** field. This is the track where the source track will be copied.

To confirm your choice, tap **Do It**.

To cancel and return to Main Mode, tap **Cancel**.

The **Split Events** function divides note events to create new rhythms and patterns.

To select the how many events to create, use the **Into** slider. Select 2 to 32 events.

To apply the split to selected events, tap the **Only selected events** field. Leave this unchecked to split all note events in the track.

To confirm your choice, tap **Do It**.

To cancel and return to Main Mode, tap **Cancel**.
The **Pitch Quantize** function forces the pitches of note events into a specific scale.

To select the desired root note of the scale, use the **Root Note** field.

To select a type of scale, use the **Scale** field.

To determine which note events will be quantized, tap the **Only apply to selected events** checkbox.

- When on, only the currently selected note events will be quantized.
- When off, all pitches in the current track will be quantized.

To set lowest-possible and highest-possible pitches where the quantized note events will be placed, use the **Start Note** and **End Note** fields (respectively). If a note event is originally outside of this range, it will be forced to the nearest pitch (within the scale) inside the range.

To continue and quantize the note events, tap **Do It**.

To cancel, tap **Close**.

The **Humanize** function applies randomization to the timing, length, and/or velocity of MIDI note events.

To select whether or not humanization will be applied to the timing of MIDI events, tap the **Humanize Time** checkbox.

To select the maximum number of pulses by which the timing of an event will be adjusted, use the **Amount (Pulses)** slider.

To set how dramatically the humanization effect is applied to the timing, use the **Eagerness** slider. Negative values correspond to playing “ahead of the beat” while positive values correspond to playing “behind the beat.”

To set whether or not humanization will be applied to the duration of MIDI note events, tap the **Humanize Note Length** checkbox.

To set how dramatically the humanization effect is applied to note lengths, use the **Length (%)** slider.

To set whether or not humanization will be applied to the velocities of MIDI note events, tap the **Humanize Velocity** checkbox.

To set how dramatically the humanization effect is applied to note velocities, use the **Strength (%)** slider.

To determine which notes will use these humanization values, tap the **Only apply to Selected Events** checkbox.

- When on, just the currently selected notes will be humanized.
- When off, all notes in the track will be humanized.

To apply humanization and keep this window open, tap **Apply**.

To apply humanization and close the window, tap **Do It**.

To close the window without making any changes, tap **Close**.
The **Generate Random Events** function creates random melodic or drum patterns on the current MIDI track.

**To select the type of events you want to create**, use the **Event Type** field to select **Drum Events** or **Melodic Events**.

**To select how the events will be created relative to the existing events on the track**, use the **Replace** field:

- **Replace All Events**: Select this option to replace all events on the track with the randomly generated ones.
- **Replace Events in Note Range**: Select this option to replace all events in the designated note range on the track with the randomly generated ones. Use the **Bank** or **Start Pad** and **End Pad** menus to set the note range for drum events or the **Start Note** and **End Note** menus to set the note range for melodic events.
- **Add to Existing Events**: Select this option to add the randomly generated events to the track without replacing or overwriting the existing ones.

**To set how many bars the events will use**, use the **Pattern Size (Bars)** field. The highest possible value is the number of bars in the current sequence.

**To select the duration of the events**, use the **Note Length** field. (This feature is nonfunctional if **Legato** is enabled while generating melodic events.)

To generate the events and keep this window open, tap **Apply**.

To generate the events and close the window, tap **Do It**.

To close the window without generating any events, tap **Close**.

If **Event Type** is set to **Drum Events**:

- **To select the pad bank that will be used to generate the events**, use the **Bank** field or select **Range** to use the **Start Pad** and **End Pad** menus to define a specific pad range instead.

- **To define a specific pad range over which the events will be generated**, use the **Start Pad** or **End Pad** fields. You can use these fields only if the **Bank** menu is set to **Range**.

- **To set how closely together the events will be placed in the track**, use the **Density (%)** slider.

- **To set how widely or narrowly the rhythmic patterns of the generated notes vary**, use the **Rhythm Variation** slider.
If **Event Type** is set to **Melodic Events**:

- **To define a specific note range over which the events will be generated**, use the **Start Note** or **End Note** fields.

- **To enable or disable legato**, tap the **Legato** checkbox.

  When **on**, the generated notes will be extended or shortened to create a long, unbroken phrase from the first note event’s start point to the last note event’s end point. Each note event will sustain until another note event starts. If multiple note events start at the same time (and are not the last note events), their lengths will become identical.

  When **off**, the generated notes will use the duration set by the **Note Length** menu.

- **To set the maximum number of note events that can be sounding simultaneously in the track**, use the **Polyphony** field to select 1–8.

- **To determine whether or not the notes will use a scale**, tap the **Constrain Notes to Scale** checkbox.

  When **on**, the notes will be within the scale determined by the **Scale** menu.

  When **off**, the notes will be chromatic.

- **To set how closely together the events will be placed in the track**, use the **Density (%)** slider.

- **To set the root note of the scale that the notes will use**, use the **Root Note** field.

- **To select the scale or mode that the generated notes will use**, use the **Scale** field.

The **Bounce to Sample** function **immediately** renders the track (for the current sequence only) as an audio sample and places it in the project’s sample pool. By default, it will be named **Bounce** - and appended with the track name. This function does not work for tracks that use MIDI programs or CV programs.

If you have already used this function on this track, then you will be asked if you want to overwrite the existing sample with this new one or cancel.

- **To continue and save the track over the existing one**, tap **Replace**.

- **To cancel**, tap **Cancel**.
The **Bounce to Audio Track** function immediately renders the track (for the current sequence only) as an audio track in the project. The Main Mode will automatically switch to the **Audio** tab. By default, it will be named **Audio** and appended with a number (e.g., **Audio 002**). This function does not work for tracks that use MIDI programs or CV programs.

If you have already used this function on this track, then you will be asked if you want to overwrite the existing sample with this new one or cancel.

- **To continue and save the track over the existing one**, tap **Replace**.
- **To cancel**, tap **Cancel**.

The **Export as Pattern** function saves the track (for the current sequence only) as a pattern (.mpcppattern) to an external storage device or the internal drive of MPC X or MPC Live.

- **To select the storage device you want to view**, tap it in the **Storage** column on the left.
  - **Internal** is the internal drive of MPC X or MPC Live.
  - **MPC Documents** is a shortcut to the **MPC Documents** folder on the internal drive of MPC X or MPC Live.
  - If you have storage devices connected to USB ports or SD card slot of MPC X, MPC Live, or your computer (with MPC Touch), they will appear in this column, as well.

- **To enter a folder**, double-tap it. Alternatively, turn the **data dial** or use the –/+ buttons to move through the list, and press the **center cursor** or **Enter** (MPC X) or the **data dial** (MPC Live, MPC Touch) to enter a folder. You can also tap one of the five **folder buttons** in the upper-right to jump immediately to those pre-assigned file paths (see **Browser** to learn how to do this).

- **To create a new folder**, tap **New Folder**, use the virtual keyboard that appears to enter a name, and then tap **Do It**. You will immediately enter the new folder.

- **To move up one folder level**, tap the **folder/↑** icon in the upper-left corner.

- **To name the file**, tap the **File Name** field at the bottom of the screen, and use the virtual keyboard that appears.

- **To save the file**, tap **Save**.

- **To cancel and return to the Menu**, tap **Cancel**. Alternatively, tap the **←** icon in the upper-left corner.
While using audio tracks, you can use any of these functions as described below.

To return to Main Mode, tap Cancel or the left arrow (↩) in the upper-left corner of the screen. Alternatively, press Main.

To edit the name of the track, tap the top of the screen and use the virtual keyboard that appears.

The Delete function erases the entire audio track.

To confirm your choice, tap Clear.
To return to the previous screen, tap Cancel.

The Clear Regions function erases all regions from the audio track without erasing the track itself.

The Reset Channel Strip function:
- clears all Insert effect slots;
- turns Mute, Solo, automation, and Monitor off;
- resets the pan knob to the center;
- resets the level slider to 0.00 dB; and
- turns the Record Arm button off.

It does not change the track’s inputs or outputs.
The **Copy Track** function copies the contents of one track to another.

**To select the “source” track**, tap the **Copy Contents of Track** field. This is the track whose events you want to copy.

**To select the “destination” track**, tap the **Over Contents of Track** field. This is the track where the source track will be copied.

**To rename the "destination" track**, use the **Track Name** field.

**To confirm your choice**, tap **Do It**.

**To cancel and return to Main Mode**, tap **Cancel** or anywhere outside the window.

The **Save Current Channel Strip** function saves the current settings of the track channel strip (for the current audio track) to an external storage device or the internal drive of MPC X or MPC Live.

**To select the storage device you want to view**, tap it in the **Storage** column on the left.

- **Internal** is the internal drive of MPC X or MPC Live.
- **MPC Documents** is a shortcut to the MPC Documents folder on the internal drive of MPC X or MPC Live.

If you have storage devices connected to USB ports or SD card slot of MPC X, MPC Live, or your computer (with MPC Touch), they will appear in this column, as well.

**To enter a folder**, double-tap it. Alternatively, turn the **data dial** or use the −/+ buttons to move through the list, and press the **center cursor** or **Enter** (MPC X) or the **data dial** (MPC Live, MPC Touch) to enter a folder. You can also tap one of the five **folder buttons** in the upper-right to jump immediately to those pre-assigned file paths (see **Browser** to learn how to do this).

**To create a new folder**, tap **New Folder**, use the virtual keyboard that appears to enter a name, and then tap **Do It**. You will immediately enter the new folder.

**To move up one folder level**, tap the **folder/↑ icon** in the upper-left corner.

**To name the file**, tap the **File Name** field at the bottom of the screen, and use the virtual keyboard that appears.

**To save the file**, tap **Save**.

**To cancel and return to the Menu**, tap **Cancel**. Alternatively, tap the ← icon in the upper-left corner.
Program Section

The Program section shows the current program. This section will appear differently depending on the type of program selected in the Track section above it.

For all program types while using MIDI tracks, you can do the following:
- **To edit the name of the program**, tap the cursor icon on the right edge of the section. Use the virtual keyboard that appears to enter a new name, and then tap Do It.
- **To create a new program of the currently selected type**, tap the + icon. A new program of the same type will be created and appended with a number (e.g., Program 002).

For all program types while using audio tracks, you can do the following:
- **To change the input source**, tap Input Config. This will show or hide the track channel strip. If you are viewing the audio track channel strip (not the master channel strip), the first field will be automatically selected.
- **To enter Audio Edit Mode**, tap Edit Audio. This is the same as tapping the waveform-and-box icon on the left edge of the screen.

While viewing drum programs, the **Drum Program** field shows the name of the program.
- Tap Warp Samples to enter the first Sample tab in Program Edit Mode immediately (see Program Edit Mode > Drum Programs to learn about this).
- Tap Assign Samples to enter the Sample Assign tab in the Browser immediately (see Browser to learn about this).
- Tap Edit Samples to enter Program Mode in Sample Edit Mode immediately (see Sample Edit Mode > Program Mode to learn about this). The sample shown will be the one in the top layer of the last pad you pressed.

While viewing keygroup programs, the **Keygroup Program** field shows the name of the program.

While viewing clip programs, the **Clip Program** field shows the name of the program.
- Tap Edit Clips to enter Program Edit Mode, where you can assign samples (clips) to pads, edit each clip, and configure how each clip plays when launched (see Program Edit Mode > Clip Programs to learn about this).
While viewing plugin programs, the **Plugin Program** field shows the name of the program.

**Important:** For MPC X and MPC Live, plugin programs are available only in Controller Mode with the desktop version of the MPC software.

Use the **Plugin** field to select the plugin the program is using. In the screen that appears, you can tap the **Type** or **Manufacturer** button at the bottom of the screen to enable or disable sorting of your plugins by type or maker.

**Note:** You have to specify the disk directory where your plugins are located. This can be done in the software’s **Preferences**. See user guide in the MPC software to learn how to do this: click the **Help** menu, select **MPC Help**, and select **MPC User Manual**.

Use the **MIDI Ch** field to select the MIDI channel the program uses. Use this setting when you are working with a virtual instrument plugin that supports multi-mode.

Use the **Preset** field to select a preset (if any) within the plugin the program is using.

While viewing MIDI programs, the **MIDI Program** field shows the name of the program.

Use the **MIDI Port** field to select the port over which the program sends its MIDI data.

**Note:** You also have to configure the MIDI ports in the **Preferences**. See the user guide in the MPC software to learn how to do this: click the **Help** menu, select **MPC Help**, and select **MPC User Manual**.

Use the **Program Ch** field to select the program change message the program sends out.

Use the **MIDI Ch** field to select the MIDI channel over which the program sends its MIDI data.

Use the **Bank MSB** and **Bank LSB** fields to select the messages for Most Significant Byte and Least Significant Byte (respectively) that the program sends out.

While viewing CV programs, the **CV Program** field shows the name of the program.

Use the **Note** field to select the note tracking—the program’s note track: **Lowest**, **Highest**, or **Last**.

Use the **CV Port** field to select the CV port the program is using.

Use the **Gate Port** field to select the Gate port the program is using.

Use the **Mod Wheel** field to select the CV port used by a modulation wheel on an external controller.

Use the **Velocity Port** field to select CV port the program will use to transmit velocity values.
To edit the program, tap the pencil icon on the right edge of the section. The Program Edit/Copy window will open.

You can use any of these functions as described below.

- To return to Main Mode, tap Cancel or the left arrow (엇) in the upper-left corner of the screen. Alternatively, press Main.

- To edit the name of the program, tap the top of the screen and use the virtual keyboard that appears.

The Delete function erases all events from the track and resets all of its settings.

- To confirm your choice, tap Clear.

- To return to the previous screen, tap Cancel.

The Duplicate function immediately creates an identical program. The duplicate program will use the same name but appended with a number (e.g., Program 002).
The **Duplicate to Track** function immediately creates an identical program on a new track. The duplicate program will use the same name but appended with a number (e.g., *Program 002*). The new track will be named **Track** and appended with a number (e.g., *Track 06*).

The **Bounce to Sample** function immediately renders all tracks that use that program (for the current sequence only) as an audio sample and places it in the project’s sample pool. By default, it will be named **Bounce** - and appended with the program name. This function does not work for MIDI programs or CV programs.

If you have already used this function on this program, then you will be asked if you want to overwrite the existing sample with this new one or cancel.

**To continue and save the program over the existing one**, tap **Replace**.

**To cancel**, tap **Cancel**.

The **Bounce to Audio Track** function immediately renders that program (for the current sequence only) as an audio track in the project. The Main Mode will automatically switch to the **Audio** tab. By default, it will be named **Audio** and appended with a number (e.g., *Audio 002*). This function does not work for MIDI programs or CV programs.

If you have already used this function on this track, then you will be asked if you want to overwrite the existing sample with this new one or cancel.

**To continue and save the track over the existing one**, tap **Replace**.

**To cancel**, tap **Cancel**.

The **Flatten Pad** function renders all samples on a pad as an audio sample and places it on the first layer of that pad. The resulting sample is the audio signal produced by that pad at full velocity (127) after the pad channel strip, which means that it includes any assigned pad insert effects and the results of warping the sample. This function is useful if you need to reduce how CPU-intensive a pad or program is by essentially “embedding” the warping and effects in the sample itself. By default, it will use the name of the first sample. This function works for drum programs only. (This is the same as the **Flatten Pad** button shown at the top of the screen in Program Edit Mode.)

**To select the pad**, press it or use the **Pad** menu.

**To set the length of the audio tail**, use the **Audio Tail** field. This will add extra seconds to the end of the resulting audio file. This is useful if you are using effects or samples whose sounds exceed the defined audio length (e.g., long reverb or delay, one-shot samples with long decays, etc.). We recommend using an audio tail of at least a couple of seconds.

**To name the new sample**, tap the **Edit Name** field, and use the virtual keyboard that appears.

**To confirm your choice**, tap **Do It**.

**To cancel**, tap **Cancel**.
The Save Current Program or Save Current Sample function saves the current program or sample (the top layer of the last pad you pressed) (respectively) to an external storage device or the internal drive of MPC X or MPC Live.

To select the storage device you want to view, tap it in the Storage column on the left.

- **Internal** is the internal drive of MPC X or MPC Live.
- **MPC Documents** is a shortcut to the MPC Documents folder on the internal drive of MPC X or MPC Live.

If you have storage devices connected to USB ports or SD card slot of MPC X, MPC Live, or your computer (with MPC Touch), they will appear in this column, as well.

**To enter a folder**, double-tap it. Alternatively, turn the data dial or use the −/+ buttons to move through the list, and press the center cursor or Enter (MPC X) or the data dial (MPC Live, MPC Touch) to enter a folder. You can also tap one of the five folder buttons in the upper-right to jump immediately to those pre-assigned file paths (see **Browser** to learn how to do this).

**To create a new folder**, tap New Folder, use the virtual keyboard that appears to enter a name, and then tap Do It. You will immediately enter the new folder.

**To move up one folder level**, tap the folder/↑ icon in the upper-left corner.

**To name the file**, tap the File Name field at the bottom of the screen, and use the virtual keyboard that appears.

**To save the file**, tap Save.

**To cancel and return to the Menu**, tap Cancel. Alternatively, tap the ← icon in the upper-left corner.
The Grid View lets you view and edit the note events of each track of a sequence in a project and their velocities. This mode has two different appearances: one for drum programs and one for keygroup programs, MIDI programs, and plugin programs.

For drum programs, the left column shows you all available pads in a vertical view with their corresponding data.

For keygroup programs, plugin programs, and MIDI programs, the left column shows a vertical “piano roll” keyboard.

To enter the Grid View, press Menu, and then tap Grid View.

Note: The Grid View option is available when the currently selected track is a MIDI track. When an audio track is selected, it will show an icon for Audio Edit Mode instead of Grid View. To select a MIDI track (and enable Grid View), press Main to enter Main Mode, and then tap MIDI in the lower-left corner.

The top of the screen shows the track name, sequence and timing information, and editing tools.

Use the Track field to select which track of the current sequence you want to show in the grid.

Use the Bars field to set the length of the sequence.

The time counter at the top of the screen indicates the current playhead position. This is shown in most of the modes. See General Features > Time Counter/Locate to learn about this.
In the Grid View, these four tool icons enable you to use different functions in the grid.

Tap one to select its mode:

**Pencil**: Draw Mode:
- **To enter a note in an empty grid square**, tap the grid square.
- **To select a note**, tap it.
- **To move a note**, tap and drag it to another grid square.
- **To erase a note**, double-tap it.

**Eraser**: Erase Mode:
- **To erase a note**, tap it.

**Select Box**: Select Mode:
- **Note**: Notes will remain selected if you switch to another mode. The selection will change, however, if you press a pad while *Hitting Pad Selects All Events* is set to **On**.

  - **To select a note**, tap it.
  - **To select multiple notes**, tap and drag across the grid to create a box around them.
  - **To move a note**, tap and drag it to another grid square.
  - **To move multiple notes**, select them as described above, and tap and drag them.
  - **To erase multiple notes**, select them as described above, and then select the **eraser tool** and tap any of the selected notes.

**Magnifying Glass**: Navigation Mode:
- **To move to another part of the grid**, tap and drag it.
- **To zoom in or out**, spread or pinch your fingers (respectively) on the grid. You can do this vertically, horizontally, or both at the same time.
The **Settings** window lets you configure certain Grid View settings.

**To view the Settings**, tap the **gear icon**.

Use the **Snap Mode** selector to set how events “snap” to the grid.

- **Absolute**: Events will “snap” to the nearest time division on the grid (as determined by the **TC field** or **Time Correct** window). This is the typical and traditional method of using the snap/quantization feature.

- **Relative**: Events will “snap” to the nearest time division on the grid (as determined by the **TC field** or **Time Correct** window) plus the original time position of the event (e.g., an event that is originally three ticks past a time division on the grid will snap only to positions that are three ticks past every time division).

Use the **Hitting Pad Selects All Events** selector to turn the feature on or off. When on, pressing a pad will automatically select all note events for that pad in the sequence on that track. When off, pressing a pad will simply play its sound without selecting any note events.

Use the **Auto-Scroll** selector to set how the screen behaves relative to the audio playhead.

- **Follow**: Depending on the zoom setting, the grid will scroll along in the background while keeping the audio playhead centered.

- **Page**: The grid will move to the “next page” to follow the audio playhead.

- **Off**: The grid will not move at all.

These functions also apply to Audio Edit Mode, List Edit Mode, and Sample Edit Mode.

Use the **Link Zoom and Scroll** selector to turn the feature on or off. When on, the zoom and scroll levels in the MPC software and your MPC hardware will always be the same. When off, the grid views can be adjusted separately using the MPC software and your MPC hardware.

**Note**: This setting is only available when connected to MPC software in controller mode.

Use the **Q-Link Playhead Increment** selector to set the how turning **Q-Link Knob 2 (Playhead)** in Q-Link Screen Mode moves the playhead. Select 1/16th-note increments (**1/16 Note**) or according to the time division (**TC Division**).
Regardless of which tool is selected, you can do any of the following to move, lengthen, shorten, or transpose any selected note/notes.

To automatically set the grid to view one pad bank and two bars, tap the grid-and-magnifying-glass icon in the lower-left corner.

To undo your last action, press Undo.

To redo the last action you undid, press Shift+Undo/Redo.

To select all notes for a pad, press the desired pad.

To move the selected notes, tap Nudge at the bottom of the screen, and then use the data dial or −/+ buttons to shift the notes left or right. By default, you can position notes only by quantization values defined by the Time Correct value (see General Features > Timing Correct (TC) to learn about this).

To move the selected notes without restricting (“snapping”) them to the quantization grid, tap and hold Don’t Snap in the lower-left corner of the screen, and then use the data dial or −/+ buttons to shift the notes. In this case, each nudge is equivalent to four ticks.

To adjust the start point or end point of the selected notes (without changing their position), tap Edit Start at the bottom of the screen, and then use the data dial or −/+ buttons.

To transpose the selected notes up or down, tap Transpose at the bottom of the screen, and then use the data dial or −/+ buttons.

To copy the selected notes instantly, press Copy. The selected notes will be duplicated and start immediately after the end of the last selected note. Nudge will be automatically selected so you can immediately use the data dial to move the copied notes.

To switch to the previous or next track, press and hold Shift, and then tap Track – or Track + (respectively) at the bottom of the screen.

To mute or solo the track, press and hold Shift, and then tap Mute or Solo (respectively) at the bottom of the screen.
To open the Timing Correct window, press and hold Shift, and then tap TC at the bottom of the screen. See General Features > Timing Correct (TC) to learn about this.

To select a time division directly, double-tap the down arrow (▼) in the upper-left corner of the grid and select a time division.

To adjust the metronome settings, press and hold Shift, and then tap Click at the bottom of the screen. See General Features > Metronome (Click/Metro) to learn about this.

The Grid View also contains a velocity/automation lane where you can easily adjust note velocities and automation parameters.

The velocity lane in the Grid View.

To show or hide the velocity/automation lane:
1. Tap the up arrow (▲) button in the lower-right corner to show the velocity/automation lane.
2. Tap the down arrow (▼) to hide the velocity/automation lane.

When viewing velocity in the lane, a vertical bar represents each note’s velocity. The higher and more red the bar is, the higher the velocity is. Yellow bars indicate a lower velocity. Bars with a gray line at the top indicate a currently selected note.

To adjust the velocity of the selected notes, tap Velocity at the bottom of the screen, and then use the data dial or –/+ buttons. The numeric value will appear on the screen.

See Appendix > Updates in v2.6 > New Features > Grid Automation Lanes for more information on editing automation parameters.
Audio Edit Mode

Audio Edit Mode lets you view and edit the audio tracks of a sequence in a project.

To enter Audio Edit Mode, press Menu, and then tap Audio Edit Mode.

Note: The Audio Edit option is available when the currently selected track is an audio track. When a MIDI track is selected, it will show an icon for Grid View instead of Audio Edit Mode. To select an audio track (and enable Audio Edit Mode), press Main to enter Main Mode, and then tap Audio in the lower-left corner.
Below is a brief step-by-step process so you can get started recording audio tracks quickly. Continue reading the rest of this chapter to learn how to use Audio Edit Mode in different cases.

**To record in Audio Edit Mode (or Main Mode):**

1. If the channel strip is not already shown on the left side of the screen, tap the small **eye icon** to show it.
2. Connect a synthesizer or other line-level audio source to the appropriate input/inputs of your MPC hardware. Set the **Line/Phono selector** appropriately, too.
3. Double-tap the first field to select the input source of the external audio signal, which you can set to a pair of inputs (Input 1,2–3,4 in Standalone Mode, Input 1,2–31,32 in Controller Mode) or a single input (Input 1–4 in Standalone Mode, Input 1–32 in Controller Mode).
4. Double-tap the second field to select where the track is routed (Out 1,2–7,8 in Standalone Mode, Out 1,2–31,32 in Controller Mode; MPC Live does not use Out 7,8 in Standalone Mode but displays them to maintain compatibility with MPC X, which does use them).
5. Tap the **Monitor** button to set how your audio track will be monitored. Tapping it will cycle through its three states:
   - When set to **Auto**, you will hear incoming audio while the track is record-enabled only.
   - When **on**, you will hear incoming audio whether or not the track is record-enabled.
   - When **off**, you will never hear any incoming audio.
6. Turn the **3/4 Rec Gain** knob (MPC X) or **Rec Vol** knob (MPC Live, MPC Touch) to set the input level while sending an audio signal into your MPC hardware. You should now see the level in the meter. Make sure it does not exceed the maximum level (the meter should not be “peaking” constantly).
7. If **Mute** and **Solo** are on, tap or press them so they are **off**. We also recommend tapping the automation button so it is **off/gray** (not **green/Read [R]** or **red/Write [W]**). Alternatively, press **Read/Write** so it is off (MPC X).
8. Tap the **Rec Arm** button next to the **pan knob** or press **Rec Arm** (MPC X) to record-enable the track.
9. Press **Rec** to record-arm the sequence.
10. **To start recording**, press **Play** or **Play Start**—then play your audio source. You should hear your existing sequence playing in the background. You’ll see the waveform appear as a single “track region” as you record.
11. **To stop recording**, press **Stop**.
The top of the screen shows the track name, sequence and timing information, and editing tools.

Use the **Track** field to select which track of the current sequence you want to show in the grid.

Use the **Bars** field to set the length of the sequence.

The time counter at the top of the screen indicates the current playhead position. This is shown in most of the modes. See **General Features > Time Counter/Locate** to learn about this.

In Audio Edit Mode, these six tool icons enable you to use different functions in the track.

Tap one to select its mode:

**Marquee:** Marquee Mode:
- **To select a track region,** tap the upper third of it.
- **To move a track region** (or multiple selected track regions), tap and drag the upper third of it left or right.
- **To split the track at two specific points** (creating a track region on either side and between them), tap and drag across the middle third of it to create a translucent white box, and then tap the upper third of that box.
- **To shorten or lengthen a track region** (or multiple selected track regions), tap and drag the lower third of it left or right.

**Arrow:** Selection Mode:
- **To select a track region,** tap it.
- **To select multiple track regions,** tap and drag across the grid to create a box that highlights them. Double-tap the selected track regions to deselect them.
- **To move a track region** (or multiple selected track regions), tap and drag the upper third of it left or right.
- **To shorten or lengthen a track region** (or multiple selected track regions), tap its edge and drag it.

**Eraser:** Erase Mode:
- **To select multiple track regions,** tap and drag across the grid to create a box that highlights them.
- **To erase a track region** (or multiple selected track regions), tap it.
**Scissors:** Split Mode:

*To split the track at a specific point* (creating a track region on either side), tap that point in the track.

*To select a track region,* tap its left-most edge.

*To select multiple track regions,* tap and drag across the grid to create a box that highlights them. Double-tap the selected track regions to deselect them.

**Mute:** Mute Mode:

*To select multiple track regions,* tap and drag across the grid to create a box that highlights them. Double-tap the selected track regions to deselect them.

*To mute or unmute a track region* (or multiple selected track regions), tap it.

**Magnifying Glass:** Navigation Mode:

*To move to another part of the track,* tap and drag it.

*To zoom in or out,* spread or pinch your fingers (respectively) on the grid. You can do this vertically, horizontally, or both at the same time.

The Settings window lets you configure certain Audio Edit Mode settings.

*To view the Settings,* tap the gear icon.

![Settings window](image)

Use the **Snap Mode** selector to set how events "snap" to the grid.

- **Absolute:** Events will “snap” to the nearest time division on the grid (as determined by the TC field or Time Correct window). This is the typical and traditional method of using the snap/quantization feature.

- **Relative:** Events will “snap” to the nearest time division on the grid (as determined by the TC field or Time Correct window) plus the original time position of the event (e.g., an event that is originally three ticks past a time division on the grid will snap only to positions that are three ticks past every time division).

Use the **Auto-Scroll** selector to set how the screen behaves relative to the audio playhead.

- **Follow:** Depending on the zoom setting, the waveform display will scroll along in the background while keeping the audio playhead centered.

- **Page:** The waveform display will move to the “next page” to follow the audio playhead.

- **Off:** The waveform display will not move at all.

These functions also apply to the sample waveform in Sample Edit Mode.
On the left edge of the screen, next to the five mode icons, there are two small icons that control the channel strip.

**To show or hide the channel strip, tap the eye icon.**

The icon below the eye icon indicates the type of channel strip (see next description).

The channel strip contains some important settings for the audio track or master output, depending on the currently selected icon:

**To view the track channel strip, tap the waveform icon.**

**To view the master channel strip, tap the crown icon.**

When viewing the **track channel strip** while using an audio track:

The first field defines the input source of the external audio signal, which you can set to a pair of inputs (**Input 1,2–3,4** in Standalone Mode, **Input 1,2–31,32** in Controller Mode) or a single input (**Input 1–4** in Standalone Mode, **Input 1–32** in Controller Mode).

The second field shows where the track is routed, which you can change: **Out 1,2–7,8, Out 1–8** or **Sub 1–8** in Standalone Mode; and **Out 1,2–31,32** or **Out 1–32** in Controller Mode.

**Note:** When set to a mono channel, the left and right channels are summed post-pan knob. If the pan knob is set to the center position, the left and right channels will be summed and padded. If the pan knob is set to the maximum left or right positions, only the respective channel will be sent to the output.

The **Inserts** field shows any enabled or disabled effects for that track. Tap the area under **Inserts** to open a window where you can load, change, and enable or disable the effects.

Tap **Solo** or **Mute** to solo or mute the track (respectively).

Tap the **Monitor** button to set how your audio track will be monitored. Tapping it will cycle through its three states:

- **When set to Auto,** you will hear incoming audio while the track is record-enabled only.
- **When on,** you will hear incoming audio whether or not the track is record-enabled.
- **When off,** you will never hear any incoming audio.
Tap the track automation button or press Read/Write (MPC X) to cycle through its three states:

When off, the audio track will ignore automation data. If you have already recorded or entered automation, tapping this will switch between Read (R) and Write (W) only, but you can override this and turn it off by pressing and holding Shift while pressing or tapping the button.

**Important:** If you have already recorded automation and turn it off, the track will still use the effect and its parameter values at the point where you turned it off.

When set to Read (R), the audio track will read automation data but will not record any additional automation over it. (Think of this as a protective feature to prevent accidental changes to your automation while recording.)

When set to Write (W), the audio track can record automation. (If you have any Q-Link knobs assigned to automatable parameters, make sure not to touch any accidentally while you are recording.)

**Tip:** You can quickly set all programs and audio tracks to the same automation by tapping the global automation button in the upper-right corner of the screen. See General Features > Automation to learn about this.

To change the panning or level of the track, adjust the pan knob or level slider.

To record-enable the track, tap the Record Arm button or press Rec Arm (on MPC X when the track name is shown in the display strip below the level meters). When you begin audio recording, the audio signal will be recorded to this track.

**Tip:** You can select multiple tracks in the Track View by pressing and holding Shift while tapping the Arm button to each track.

When viewing the master channel strip:

The first field shows the current master output as a stereo pair (which you can change).

The Inserts field shows any enabled or disabled effects for that pair of outputs. Tap the area under Inserts to open a window where you can load, change, and enable or disable the effects.

Tap Mute to mute the master output.

Adjust the pan knob or level slider to change the panning or level of the master output.
Regardless of which tool is selected, you can do any of the following to edit the selected audio track regions.

**Tip:** If you want to hear only the audio track while editing, use the Solo button in the track channel strip to solo it.

To select a track region, tap the arrow icon to enter Selection Mode and tap a track region. When a track region is selected, all region parameters will be available to edit.

To undo your last action, press Undo.

To redo the last action you undid, press Shift+Undo/Redo.

To move the selected track region, tap Nudge at the bottom of the screen, and then use the data dial or +/- buttons to shift the track region left or right. Alternatively, if the arrow tool or marquee tool are selected, tap and drag the upper third of the selected track region left or right. By default, you can move a track region only by quantization values defined by the Time Correct value (see General Features > Timing Correct (TC) to learn about this).

To move the selected track region without restricting (“snapping”) it to the quantization grid, tap and hold Don’t Snap in the lower-left corner of the screen, and then use the data dial or +/- buttons to shift the track region. In this case, each nudge is equivalent to four ticks.

To adjust the start point or end point of the selected track region (without changing its position), tap Edit Start at the bottom of the screen, and then use the data dial or +/- buttons.

To split the track at the current playhead position (creating a track region on either side), tap Split at the bottom of the screen.

To copy, cut, or paste the selected track region, press Copy or press and hold Shift, and then tap Copy or Cut. Turn the data dial to move the highlighted track region, and then press the center cursor or Enter (MPC X) or the data dial (MPC Live, MPC Touch) to paste it at its current location. Alternatively, press and hold Shift, and then tap Paste (respectively).

To cut, copy, or paste the selected track region, press and hold Shift, and then tap Cut, Copy, or Paste (respectively) at the bottom of the screen.

To duplicate the selected track region, tap Duplicate at the bottom of the screen. The duplicate track region will appear immediately after the original one.

To create a fade-in or fade out for the selected track region, use the Fade In or Fade Out fields, respectively. The fades will be shown as a sloped line at the start or end of the track region.

To set the level of the selected track region, use the Level field. The waveform amplitude will change accordingly.
To reverse the selected track region, tap Reverse.

To mute the selected track region, tap Mute.

To lengthen or shorten the selected track region without changing its pitch, tap Warp, which will enable the Semi, Fine, and BPM fields next to it. Use the BPM field to change the tempo, which will change the length of the track region accordingly. Use the Semi and Fine fields if you want to change the pitch (this is useful for matching the durations of two samples with different pitches).

**Tip:** You can configure audio track recording to ensure the resulting track region is warped automatically. You can then adjust the sequence tempo while track region remains in time. See *Menu > Preferences > General* to learn about this.

**Note:** When you record an audio file, the current sequence tempo will be embedded with it. This information is stored within the sample file when you save the project. When you warp an audio track region, the warping algorithm uses this sequence tempo and the current value in the BPM field to generate the “stretch factor.”

**Note:** The Warp algorithms are very CPU-intensive and can result in audio drop-outs during playback if used too freely. Be mindful of how (and how often) you use the warp function. You can reduce the CPU resources required by doing any/all of the following:

- Minimize the amount of pitch adjustment (e.g., the Semi and Fine fields).
- Avoid warping very small track regions.
- Warp as few tracks or track regions as possible (i.e., reduce the number of total number of voices [of the polyphonic limit] that use the warp algorithm at a given time), especially instances where the warped regions start at the same time.
- If you have warped samples used in a drum program, consider using the Flatten Pad function to consolidate the affected pad’s layers into one audio sample (see *here* to learn about this). After you flatten the pad, its sample/samples no longer need to be warped.

To open the Timing Correct window, press and hold Shift, and then tap TC at the bottom of the screen. See *General Features > Timing Correct (TC)* to learn about this.

To switch to the previous or next track, press and hold Shift, and then tap Track – or Track + (respectively) at the bottom of the screen.

To mute or solo the track, press and hold Shift, and then tap Mute or Solo (respectively) at the bottom of the screen.

To edit automation for the track, open the automation lane. See *Appendix > Updates in v2.6 > New Features > Grid Automation Lanes* for more information.
**Track View**

Track View gives you an overview of the tracks of each sequence. Use this mode to edit tracks and sequences simultaneously.

**To enter the Track View**, do either of the following:

- Press **Shift+Main/Track**.
- Press **Menu**, and then tap **Track View**.

![Track View Screenshot](image)

Each horizontal strip represents a track in the current sequence. MIDI tracks and audio tracks are grouped together. MIDI tracks are listed first, audio tracks are listed second.

**To move through the list of tracks**, swipe up or down.

**To collapse or expand each group of tracks**, tap the **up arrow** (▲) or **down arrow** (▼) icon above the first track’s **Mute** button.

The top of the screen shows the sequence name and timing information.

![Sequence 01 Screenshot](image)

Use the **Sequence** field to select which sequence contains the tracks you want to show below.

The time counter at the top of the screen indicates the current playhead position. This is shown in most of the modes. See **General Features > Time Counter/Locate** to learn about this.
The Settings window lets you configure certain Track View settings.

To view the Settings, tap the gear icon.

Use the Show Unused Tracks selector to turn this feature on or off. When on, tracks with a sequence, program, etc. will still appear in the Track View. When off, only tracks with a sequence, program, etc. will appear.

To open the Timing Correct settings, tap TC at the bottom of the screen. See General Features > Timing Correct (TC) to learn about this.

To open the metronome settings, tap Click at the bottom of the screen. See General Features > Metronome (Click/Metro) to learn about this.

To select the previous or next track of the same type (MIDI or audio), tap Track – or Track + (respectively) at the bottom of the screen. Alternatively, tap the track in the main part of the screen.
MIDI Tracks

All MIDI tracks in the project are grouped together in the upper half of the Track View.

To show or hide them, tap the ▲ or ▼ arrow icon.

Use the Program field to select the program that the track will use.

Use the Length field to set how long the track is. If you select the minimum value, Seq or 0 (if you use the numeric keypad), the track will be the exact same length as its sequence.

Tip: This feature lets you maintain tracks of different lengths. For instance, you could play a 1-bar drum sequence repeatedly under a 4-bar bass line.

Use the Velocity field to set how loudly or quietly a track plays relative to its recorded levels. When set to 50%, the track will be played with half the velocity it was originally played. When set to 200%, the track will play twice as loud. The maximum velocity level is still 127, though.

Use the Transpose field to set the transposition (in semitones) of the entire track.

Use the level slider to change the level of the track. The level meter above the slider shows the track’s current level.

Use the pan knob to change the panning of the track.

Use the Solo and Mute buttons to solo or mute the track (respectively).
Alternatively, tap Mute or Solo (respectively) at the bottom of the screen to mute the currently selected track.
Audio Tracks

All audio tracks in the project are grouped together in the lower half of the Track View.

**To show or hide them**, tap the ▲ or ◀ arrow icon.

![Audio Track Interface]

Use the **Input** field to set the track’s input/inputs.

Use the **Arm** button to record-enable the track. When you begin audio recording, the audio signal will be recorded to this track. You can select multiple tracks by pressing and holding **Shift** while tapping the **Arm** button to each track.

Use the **Monitor** button to set how your audio track will be monitored. Tapping it will cycle through its three states:
- **Auto**: You will hear incoming audio while the track is record-enabled only.
- **on**: You will hear incoming audio whether or not the track is record-enabled.
- **off**: You will never hear any incoming audio.

Use the **level slider** to change the level of the track. The level meter above the slider shows the track’s current level.

Use the **pan knob** to change the panning of the track.

Use the **Solo** and **Mute** buttons to solo or mute the track (respectively). Alternatively, tap **Mute** or **Solo** (respectively) at the bottom of the screen to mute the currently selected track.

Use the **Add new audio track** button to create a new audio track.
The Step Sequencer lets you create or edit sequences by using the pads as “step buttons,” simulating the experience of a traditional step-sequencer-style drum machine. This is available for MIDI tracks only, not audio tracks.

You can also create and edit automation using the Step Sequencer. See Appendix > Updates in v2.6 > New Features > Step Automation for more information.

To enter the Step Sequencer, do either of the following:

- Press Menu, and then tap Step Sequencer.
- Press Step Seq (MPC X).

The top of the screen shows the track name and information as well as sequence and timing information.

The Track field shows the name of the current track.

Use the Track Length field to set how long the track is. If you select the minimum value, Sequence or 0 (if you use the numeric keypad), the track will be the exact same length as its sequence.

Tip: This feature lets you maintain tracks of different lengths. For instance, you could play a 1-bar drum sequence repeatedly under a 4-bar bass line.

Use the Bars field to adjust the length of the sequence in bars.
Use the BPM field to adjust the tempo of the sequence.

To set whether the sequence follows its own tempo (Seq) or a master tempo (Mst), tap the Seq/Mst button next to the BPM field. Alternatively, press Shift+Tap/Master.

The time counter at the top of the screen indicates the current playhead position. This is shown in most of the modes. See General Features > Time Counter/Locate to learn about this.

Use the Time Division selector to set the value that determines how many steps each bar of the sequence will have. The T indicates a triplet-based value.

Alternatively, tap TC at the bottom of the screen to open the Timing Correct window. See General Features > Timing Correct (TC) to learn about this.

To enter or delete steps in a sequence:

1. Use the Pad +/- buttons at the bottom of the screen to select the pad whose steps you want to enter or delete. The current pad number is shown in the upper-left corner.
   Alternatively, use the Pad Select feature: Tap and hold Pad Sel, press the desired pad, and then release Pad Sel. You can also use Pad Select as a “latching” feature: tap Pad Sel so it is activated, press the desired pad, and then tap Pad Sel once more so it is deactivated.

2. Use the Bar +/- buttons at the bottom of the screen to select the bar of the sequence whose steps you want to enter or delete. The current bar number is shown in the upper-left corner.

3. Press the pads of your MPC hardware, or tap a button at the bottom of the sequencer. Each pad corresponds to a step in the bar and will light with a color corresponding to its velocity.
   Keep in mind that for time divisions larger than 16, the bar’s steps will be represented by multiple pad banks. In this case, use Pad Bank Buttons A and B to view all the steps within a bar.

For time divisions larger than 16, the bar’s steps will be represented by multiple pad banks. In this case, use the left and right arrows (< and >) by the step numbers (1–16, 17–32, etc.) to change which steps are shown in the sequencer.

Alternatively, use Pad Bank Buttons A and B.
To adjust the velocities of the steps, do any of the following:

- Tap anywhere on the velocity bar of a step. The top of the velocity bar will jump to that point.
- Use the slider on the right edge of the screen to increase or decrease the velocities of all steps.
- Turn the Q-Link knob that corresponds to that step (the Q-Link knobs must be in the Screen edit mode). Setting a value of 0 (Off) will delete the step.

Use the Nudge < and Nudge > arrows to shift each step left or right (respectively) one step. This is useful for experimenting with different rhythmic permutations.

Use the slider on the right edge of the screen to increase or decrease the velocities of all steps.

Use the Flip Steps button to switch which steps have notes entered and which do not have notes. Steps that previously had no notes will now have notes at full velocity (127). Steps that previously had notes will now be empty.

Tap Presets to show or hide the preset sequence controls. These controls let you manipulate and transform the velocities of the current bar in the sequence.

The first button will apply ascending or descending velocities to the steps. Each time you tap it, it will cycle through these options:

- The velocities will ascend to a single peak at the end of the bar.
- The velocities will ascend to two peaks—one after each half of the bar.
- The velocities will ascend to four peaks—one after each quarter of the bar.
- The velocities will descend from a single peak at the start of the bar.
- The velocities will descend from two peaks—one after each half of the bar.
- The velocities will descend from four peaks—one at the start each quarter of the bar.

The second button will set the velocities of the steps to be at the maximum value (127) or minimum values (1), depending on their position in the bar. Each time you tap it, it will cycle through these options:

- The velocities of the first half of the bar will be set to 1. The velocities of the second half will be set to 127.
- The velocities of the first and third quarters of the bar will be set to 1. The velocities of the second and fourth quarters will be set to 127.
- The velocities of the first, third, fifth, and seventh eighths of the bar will be set to 1. The velocities of the second, fourth, sixth, and eighth eighths will be set to 127.
- The velocities of the first half of the bar will be set to 127. The velocities of the second half will be set to 1.
- The velocities of the first and third quarters of the bar will be set to 127. The velocities of the second and fourth quarters will be set to 127.
- The velocities of the first, third, fifth, and seventh eighths of the bar will be set to 127. The velocities of the second, fourth, sixth, and eighth eighths will be set to 1.
The third button will apply ascending or descending velocities to the steps. Each time you tap it, it will cycle through these options:

- Across the entire bar, the velocities will ascend to a peak and then descend from it.
- In each half of the bar, the velocities will ascend to a peak and then descend from it.
- In each quarter of the bar, the velocities will ascend to a peak and then descend from it.
- Across the entire bar, the velocities will descend from a peak into a valley and then ascend back up to the peak.
- In each half of the bar, the velocities will descend from a peak into a valley and then ascend back up to the peak.
- In each quarter of the bar, the velocities will descend from a peak into a valley and then ascend back up to the peak.

The fourth button will swap the first half and second half of the bar. In other words, the first half of the bar will become a mirrored image of the second half, and vice versa.

The fifth button will invert the velocities of all steps with entered notes. The sum of the old and new velocities will equal 127. The exception is a velocity of 127 or 1 as a step with a note cannot have a velocity of 0.

Examples:

Steps with velocities of 40 will now have velocities of 87, and vice versa.

Steps with velocities of 75 will now have velocities of 52, and vice versa.

Steps with velocities of 127 will now have velocities of 1, and vice versa.
XYFX Mode

XYFX Mode turns the touchscreen into an XY pad where each axis represents the range of an effect parameter. As you move your finger on the XY pad, the current position will determine the current value of the two parameters. You can use this mode to create interesting effect automation on your tracks.

The effect you control in XYFX Mode acts like an insert effect on that program. In fact, **XYFX** is the name of the insert effect you have to load to the program before you can use this mode. Learn more about this in *General Features > Effects*.

**To enter XYFX Mode**, do either of the following:

- Press Menu, and then tap XYFX.
- Press XYFX (MPC X).

When you first enter this mode in a project, you may be prompted to load XYFX to the program. Tap Insert XYFX to do this.

**Note**: If you already have four insert effects loaded, you will need to clear one of the insert effect slots before doing this.

Use the **XYFX Location** field to select the signal to which the effects will be applied: the current program (Program) or a master output (a stereo pair of channels: **Output 1/2**, **Output 3/4**, etc.).

The time counter in the upper-right corner the current playhead position. This is shown in most of the modes. See *General Features > Time Counter/Locate* to learn about this.

The automation button indicates the global automation state. This is shown in several modes. See *General Features > Automation* to learn about this.
Touch or move your finger on the gridded part of the screen. A marker will follow your finger to indicate the current position. The X axis is the horizontal axis, increasing in value as you move right. The Y axis is the vertical axis, increasing in value as you move up. Each axis is labeled with its assigned parameter.

When an effect has a beat division parameter, the current division will be highlighted as an entire column.

Effects are differently colored for easy visual distinction: beat-synchronized effects are **blue**, while manually controlled effects are **green**.

![XY Mode with a beat-synchronized effect.](image)

While touching the **XY pad**, tap **Latch** in the lower-left corner to keep the marker on the XY pad even after you release it. The marker will remain there until you touch another part of the XY pad or until you tap **Latch** again.

Use the **Setup** button to show or hide the Setup panel, which controls how the XY pad behaves.

Use the **Preset** field to select the effect you want to use in XYFX Mode.
XY Mode with a manually controlled effect.

Use the **Attack** knob to set the length of the attack phase of the envelope, which is triggered when you touch the XY pad. In other words, this determines how long it takes the effect to fully respond to your touch.

Use the **Release** knob to set the length of the release phase of the envelope, which is triggered when you release the XY pad. In other words, this determines how long it takes the effect to fully deactivate after you stopping touching the XY pad.

Use the **Wet/Dry** knob to set the blend the original signal (dry) and the effect signal (wet).

The **X Axis** and **Y Axis** fields show which parameters are controlled by each axis. This varies depending on the effect you are using.
Sample Edit Mode

Sample Edit Mode lets you edit samples using various functions.

To enter Sample Edit Mode, do either of the following:

- Press Menu, and then tap Sample Edit.
- Press Sample Edit (MPC X).

To select a sample to edit, do any of the following:

- Use the Sample field at the top of the screen.
- In Main Mode, tap the Project field at the top of the screen, and then double-tap a sample in the list on the right side.
- In the Browser, tap the Project button with the P/page icon at the bottom of the screen, and then double-tap a sample in the list on the right side.

To edit the name of the sample, tap the keyboard icon next to the name at the top of the screen, and use the virtual keyboard that appears.

To delete the sample, tap the trash-can icon next to the name at the top of the screen. In the screen that appears, you will see the programs that use this sample within your project. Tap Delete Sample to continue, or tap Cancel to return to the previous screen.
The upper half of the screen shows the waveform. The lower half shows the editing controls.

The waveform display shows the “active” section of the sample waveform. Swipe left or right on the waveform to move through it.

Above the waveform is the timeline, shown in Samples, Time (in seconds and milliseconds), or Beats. You can select the measurement units you want to show in the Settings.

To zoom in or out, do any of the following:

- When the magnifying-glass icon (in the upper-right corner) is selected, spread or pinch your fingers (respectively) on the waveform.
- Tap the Zoom + or Zoom – buttons (respectively) at the bottom of the screen.
- Turn Q-Link Knob 4 (Zoom on MPC X) or the fourth Q-Link knob in the fourth column (MPC Live, MPC Touch).

To scroll through the waveform, do either of the following:

- When the magnifying-glass icon (in the upper-right corner) is selected, swipe the waveform left or right.
- Turn Q-Link Knob 8 (Scroll on MPC X) or the third Q-Link knob in the fourth column (MPC Live, MPC Touch).

The green marker and red marker are the start point and end point (respectively). These two points define the region of the sample that will be played.

To move the start point or end point of the selected region, do any of the following:

- Tap and drag its marker left or right.
- Use the Start or End fields shown below the waveform.
- Use the first column of Q-Link knobs (Start X1__) to adjust the start point or the second column of Q-Link knobs (End X1__) to adjust the end point. The top-most Q-Link knobs (13 and 14) provide coarse adjustment. The bottom-most Q-Link knobs (1 and 2) provide fine adjustment.

Tip: A recorded sample may have some silence at the beginning or end, which makes it difficult to time it correctly in a musical context. Fix this by adjusting the start point. You can also adjust end point to remove any extra silence or unwanted audio at the end. In addition to making your workflow easier, having a “tight,” well-edited sample can enhance your production or performance.

You can use Sample Edit Mode in three different ways: Trim Mode, Chop Mode, or Program Mode. The options for each mode are slightly different. Please refer to the following Trim Mode, Chop Mode, and Program Mode parts of this chapter to learn how each works. Before using these modes, though, you may want to configure your settings—see the following Settings chapter to do this.
Settings

The Settings window lets you configure certain Sample Edit Mode settings.

To view the Settings, tap the gear icon.

Use the Cue Play Mode selector to set how the cue playhead will play audio.

  **One Shot:** Tapping Play Cue will play the entire sample from the cue playhead.

  **Toggle:** Tapping Play Cue once will start playback from cue playhead. Tapping it once more will stop playback.

Use the Cue Preview selector to set if any audio plays as you move the cue playhead. As you move the cue playhead through the sample waveform, you can set it to play the small part of the sample before the cue playhead (Before), play the small part of the sample after the cue playhead (After), or not play at all (Off). You can also set this in your overall Preferences (see General Features > Menu > Preferences > General).

Use the Slice Preview selector to set if any audio plays as you move a slice marker. As you move the slice marker through the sample waveform, you can set it to play the small part of the sample before the slice marker (Before), play the small part of the sample after the slice marker (After), or not play at all (Off). You can also set this in your overall Preferences (see General Features > Menu > Preferences > General).

Use the Auto-Scroll selector to set how the screen behaves relative to the audio playhead.

  **Follow:** Depending on the zoom setting, the waveform will scroll along in the background, keeping the audio playhead centered.

  **Page:** The waveform display will move to the “next page” to follow the audio playhead.

  **Off:** The waveform display will not move at all.

These functions also apply to the sample waveform in the Grid View.

Use the Timeline Units selector to set the measurement units shown above the sample waveform. You can select one of the following options:

  **Time:** hours:minutes:seconds:frames

  **Samples:** number of samples

  **Beats:** bars:beats:ticks
Trim Mode

We recommend using Trim Mode to crop the start and/or ends from a sample.

To enter Trim Mode, tap the Trim/Chop button in the lower-left corner so it says Trim.

![Trim Mode Interface]

Use the Start and End fields to set the position of the start point and end point of the sample (respectively). Alternatively, tap and drag the start (S) or end (E) marker left or right, or use the first column of Q-Link knobs (Start X1__) to adjust the start point or the second column of Q-Link knobs (End X1__) to adjust the end point.

Trim Mode includes a loop function. When on, the region of the sample between the loop point and end point will repeat. This is useful when trying to find an ideal spot to begin the sample. The loop cannot be earlier than the start point.

To adjust the loop point, do any of the following:

- Use the Loop field.
- Tap and drag the start (S) marker (if Loop Lock is on) or the loop marker (if Loop Lock is off).
- Use the first column of Q-Link knobs (Start X1__; if Loop Lock is on) or the third column of Q-Link knobs (Loop X1__; if Loop Lock is off). The top-most Q-Link knobs (13 and 15) provide coarse adjustment. The bottom-most Q-Link knobs (1 and 3) provide fine adjustment.

To turn Loop Lock on or off, tap the Loop Lock button. When on, the loop point is the same as the start point. When off, the loop point is independent from the start point and indicated by a separate loop marker.

To turn the loop function on or off, tap the Loop button to cycle between the four modes:

- **Off**: The sample will not loop.
- **Forward**: When the loop reaches its end point, it will start playing again from the loop point.
- **Reverse**: When the loop reaches its end point, it will play in reverse. When it reaches the loop point again, it will return to the end point and continue playing in reverse.
- **Alternating**: When the loop reaches its end point, it will play in reverse. When it reaches the loop point again, it will start playing forward again from the loop point.

To switch between Forward and off, press and hold Shift, and then tap Loop at the bottom of the screen.

Use the X-Fade button to apply a crossfade to a looping sample. See Addenda > Updates in MPC 2.3 > New Features > Crossfade Looping for more information about this.
Use your MPC hardware pads to play certain parts of the selected sample:

Play Loop Continuous (Pad 16) plays the sample repeatedly using the mode set by the Loop button (Forward, Reverse, or Alternating; if the Loop button is off, the sample will loop forward repeatedly).

Play Loop (Pad 13) plays the sample repeatedly using the mode set by the Loop button (Forward, Reverse, or Alternating; if the Loop button is off, the sample will loop forward repeatedly). Press and hold the pad to play it, and release the pad to stop playing it.

Play to Loop Start (Pad 14) plays the part of the sample just before the loop point. Press and hold the pad to play it, and release the pad to stop playing it.

Play from Loop Start (Pad 15) plays the sample from the loop point to the end of the sample regardless of the end point. Press and hold the pad to play it, and release the pad to stop playing it.

Play All (Pad 9) plays the entire sample.

Pads 1–4 have the same respective functions as Pads 5–8, but Pads 1–4 play the sample part as “One Shots” (pressing the pad once will play the entire part) while Pads 5–8 play the sample part as “Note Ons” (pressing the pad and holding it will play the part; releasing it will stop playback):

Play from Start (Pad 1, Pad 5) plays the sample from the start point to the end point.

Play to Start (Pad 2, Pad 6) plays the part of the sample just before the start point to the start point.

Play to End (Pad 3, Pad 7) plays the part of the sample just before the end point to the end point.

Play from End (Pad 4, Pad 8) plays the part of the sample from the end point to the end of the sample.
Use the **Tune** field to transpose the sample up or down from its original pitch.

![Edit Tuning Window](image)

Tap **From BPM** to open the **Edit Tuning** window, which lets you tune a sample to the current sequence.

Use the **Beats** field to match the number of beats in the sequence.

- **To tune the sample to the sequence**, tap **Match**. The **Tune** field will adjust automatically and close the window. The sample is now tuned to the sequence.
- **To tune the sample to the sequence and adjust the sequence tempo**, tap **To Sequence**. This is the same as tapping Match but it also changes the sequence’s tempo to the BPM shown in the Tempo field on the right.
- **To close the window**, tap **Close**.

![Edit BPM Window](image)

**To enter a tempo manually**, use the **BPM** field.

**To detect the tempo automatically**, tap **Detect**. In the **Edit BPM** window that appears, you can do any of the following:

- Use the **BPM** field to enter a tempo manually.
- Tap **Detect** to detect the tempo automatically.
- Tap **Tap Tempo** at the bottom of the screen at the desired rate to use it as the tempo. You can play a sequence in the background to help with your timing.
- Tap **Close**, the **X**, or anywhere outside the window to close it.

**Note:** Before detecting tempo, it is recommended that you **Normalize** samples for best results.
Use the **Root Note** field to set the root note of the sample. This defines which note will play the sample at its original pitch when in a keygroup program.

**To select a slice to edit**, do either of the following (after you have created slices in Chop Mode):

- Use the **Slice** field.
- Turn **Q-Link Knob 16 (Select Slice on MPC X)** or the **fourth Q-Link knob in the fourth column** (MPC Live, MPC Touch).

When **Link Slices** is enabled (after you have created slices in Chop Mode), changing the start point of a slice will also change the end point of the previous slice. Similarly, changing the end point of a slice will also change the start point of the next slice. Disable **Link Slices** if you are trying to create slices that use non-contiguous parts of the sample.

**To enable or disable this feature**, tap the **Link Slices** button.

**Important**: **Link Slices** must be disabled to make slices nonsequential, noncontiguous, or overlapping.

**0 Snap** forces start points, end points, and loop points to occur only at the waveform’s “zero-crossings.” This can help to avoid clicks and glitches when playing a sample.

**To enable or disable 0 Snap**, press and hold **Shift**, and then tap **0 Snap** at the bottom of the screen.

**To enable or disable the loop function**, press and hold **Shift**, and then tap **Loop** at the bottom of the screen. This switches the loop function between **Forward** and **off**. The loop function is described earlier.

**Tip**: You can use Trim Mode for a specific slice of the sample, previously created and selected in Chop Mode. This allows for a more detailed view of a single slice than in Chop Mode and gives you more options for auditioning the slice. You can easily switch between Trim Mode and Chop Mode while doing this.

**To use both Trim Mode and Chop Mode to edit a sample slice**:

1. Tap **Trim/Chop** at the bottom of the screen so it says **Chop**.
2. Set all fields as desired to create your sample slices.
3. Select the desired slice.
4. Tap **Trim/Chop** at the bottom of the screen so it says **Trim**. The region you are now editing is indicated by the normal start point and end point markers rather than slice markers.
5. Tap **Trim/Chop** at any time to return to Chop Mode.
Assigning Samples

You can assign your new sample directly to a pad from Trim Mode.

To assign a sample, tap Assign at the bottom of the screen to open the Assign Sample window.

Important: Assigning a sample to a pad in this way will replace the sample on the first layer of the pad.

If you set the Assign To field to Assign slice to a pad, the pad will simply refer to the slice in this sample instead of creating a new sample. This is useful for reducing clutter in your project.

Use the Pad field to select the desired pad. Alternatively, press the desired pad.

Use the Slice Type field to select how the pad’s layer settings will be set when the slice is assigned to it (see Program Edit Mode to learn more about the parameters mentioned below):

- **Non-Destructive Slice**: The pad’s Slice setting will be set to the slice number.
- **Pad Parameters**: The pad’s Slice setting will be set to Pad. The Pad Start and Pad End will be set to the slice’s start point and end point values, and the Loop Position will be set to the slice’s start point but with Pad Loop deactivated.

Use the Program field to specify the program to which you want to add the slice.

To assign the sample, tap Do It.

To cancel the operation, tap Close, the X, or anywhere outside the window.
If you set the **Assign To** field to **Make new sample**, this will create a new sample in your project. (The original sample will remain as it is.)

Use the **Pad** field to select the desired pad. Alternatively, press the desired pad.

Check the **Crop Sample** box to delete the unused parts from the sample when it’s created and assigned. This feature is destructive, though the project will still contain your original sample.

Leave this box unchecked to keep the unused parts of the sample when it is created and assigned. This way, you will still be able to edit the entire sample further even though you are using only part of it at the moment.

Use the **Program** field to specify the program to which you want to add the slice.

**To assign the sample**, tap **Do It**.

**To cancel the operation**, tap **Close**, the X, or anywhere outside the window.
Processing Slices & Samples

Tap the **Process** button to open the Process window, where you can select an editing option for the sample.

Use the **Function** field to select an editing process. Double-tap it or tap **Function** at the bottom of the screen to open the Function window, which displays an overview of all available editing processes.

You can use any of these functions as described below.

**To return to Sample Edit Mode**, tap **Cancel**.

**To return to the Process window**, tap the top of the screen.

**Note**: All **Slice** processes will affect only the part of the sample between the start point and the end point. The **Sample** processes (**Bit Reduce** and **Stereo -> Mono**) will affect the **entire** sample regardless of its start point or end point.

The **Discard** process deletes the regions before the start point and after the end point.
The **Delete** process deletes the region between the start point and end point and closes the gap between them.

The **Silence** process replaces the region between the start point and end point with silence.

The **Extract** process deletes the regions before the start point and after the end point and saves it as a new sample in your current project.

Use the **Edit Name** field (and the virtual keyboard that appears) to name the new sample.

**Tip:** This is useful if you recorded a drum loop and wanted to remove just a snare drum hit, a kick drum hit, etc. to use separately in the project.

The **Normalize** process increases a sample’s level to the highest level possible without distortion. This is essentially a kind of digital gain optimization, so you do not have to worry about excessive level settings when working with samples with a wide range of amplitudes.
The **Reverse** process reverses the region between the start point and end point.

The **Fade In** process sets a fade-in between the start point and end point. The following types are available:

- **Linear** fades the audio in with a linear curve—a straight line between the start and end.
- **Log** fades the audio in with a logarithmic curve—quickly rising at the start and flattening out towards the end.
- **Exp** fades the audio in with an exponential curve—slowly rising in the beginning and growing steeper towards the end.

The **Fade Out** process sets a fade-out between the start point and end point. The following types are available:

- **Linear** fades the audio out with a linear curve—a straight line between the start and end.
- **Log** fades the audio out with a logarithmic curve—quickly rising at the start and flattening out towards the end.
- **Exp** fades the audio out with an exponential curve—slowly rising in the beginning and growing steeper towards the end.

The **Pitch Shift** process changes the pitch of the sample without changing its length. This lets you set the sample’s pitch to your sequence without affecting the sample’s tempo or duration. You can adjust it up to 12 semitones, up or down. Keep in mind that the audio quality may decrease at more extreme settings.
The **Time Stretch** process lengthens or shortens the sample without changing its pitch. This is useful for matching the durations of two samples with different pitches. You can enter the original tempo of the sample and the desired tempo after processing.

Use the **Beat** field to set the desired value number of beats.

Use the **New Tempo** field to set the new tempo. The **Ratio** field will then automatically show the time stretch factor.

Alternatively, to adjust the ratio instead, use the **Ratio** field to set the desired ratio. The **New Tempo** field will then change automatically based on the new time stretch factor.

The **Gain Change** process raises or lowers the volume of the sample. You can adjust it up to 18 dB, higher or lower. This function is different than Normalize because it will allow volumes beyond clipping level. This may be a desired effect, but remember to watch your output level!

The **Copy** process saves a copy of the sample.

Use the **Edit Name** field (and the virtual keyboard that appears) to name the new sample. Otherwise, the process will add a consecutive number after the sample name.
The **Bit Reduce** process lowers the bit resolution of a sample, effectively reducing its degree of faithful reproduction. You can reduce it down to **1 bit**. (The sound is similar to the Resampler effect, but Bit Reduce will permanently alter the sample.)

**Tip:** Use this on drum loops to get a dirty, “old-school” sizzle but with a digital “edge.”

**Note:** This process affects the **entire** sample regardless of its start point or end point.

The **Stereo -> Mono** process converts a stereo sample to a new mono sample and saves it as a new sample.

Use the **Edit Name** field (and the virtual keyboard that appears) to name the new sample. Otherwise, the process will add a consecutive number after the sample name.

The following options are available:

- **Left** will convert the left channel only.
- **Right** will convert the right channel only.
- **Sum** will combine the left and right audio channels to a single mono channel.

**Note:** This process affects the **entire** sample regardless of its start point or end point.
Chop Mode

Whereas Trim Mode crops only the start and/or end off of a sample, Chop Mode divides the sample into multiple regions called slices. We recommend using Chop Mode when working with a long sample with different sounds throughout (e.g., a drum loop or a long melodic or harmonic passage).

To enter Chop Mode, tap the Trim/Chop button in the lower-left corner so it says Chop.

Use the Start and End fields to set the position of the start point and end point (respectively) of the currently selected slice. Alternatively, tap and drag the start (S) or end (E) marker left or right, or use the first column of Q-Link knobs (Start X1__) to adjust the start point or the second column of Q-Link knobs (End X1__) to adjust the end point.

Use the selector in the lower-left corner of the screen to choose how you want to use Chop Mode:

**Manual**
This method lets you insert slices at locations you select.

**Threshold**
This method uses an adjustable detection algorithm that derives the number of slices created from the volume levels present in the sample.

Use the Threshold field to set the threshold level. Alternatively, turn Q-Link Knob 11 (Threshold on MPC X) or the second Q-Link knob in the third column (MPC Live, MPC Touch). The higher the selected value, the more slices will be created.

Use the Min Time field to set the minimum length of a slice in milliseconds.

**Regions**
This method divides a sample into several slices of equal length.

Use the Regions field to set how many regions the sample will be divided into. Alternatively, turn Q-Link Knob 11 (Num Regions on MPC X) or the second Q-Link knob in the third column (MPC Live, MPC Touch). The higher the selected value, the more slices will be created.

**BPM**
This method divides a sample into several slices based on the tempo (beats per minute).

Use the Bars field to set how many bars are in the sample. Alternatively, turn Q-Link Knob 11 (Bars on MPC X) or the second Q-Link knob in the third column (MPC Live, MPC Touch).

Use the Beats field to set how many beats are in each bar. Alternatively, turn Q-Link Knob 7 (Beats on MPC X) or the third Q-Link knob in the third column (MPC Live, MPC Touch).

Use the Time Div field to set a note division. Alternatively, turn Q-Link Knob 3 (Time Div on MPC X) or the fourth Q-Link knob in the third column (MPC Live, MPC Touch). The slice markers will be placed according to this setting. You can select 1/4, 1/8, 1/16, or 1/32. (In most cases, you should set this parameter to 1/16.)
To play a slice, do either of the following:

- Press the pad that corresponds to the slice. If your sample has more than 16 slices, use the additional pad banks.
- When the headphones icon (in the upper-right corner) is selected, tap a slice in the waveform.

When the One Shot feature is enabled, you can press a pad once to play the entire slice. When this is disabled, pressing the pad and holding it will play the slice; releasing it will stop playback.

To enable or disable One Shot, press and hold Shift, and then tap One Shot.

To select a slice to edit, do any of the following:

- Use the Slice field.
- Turn Q-Link Knob 16 (Select Slice on MPC X) or the first Q-Link knob in the fourth column (MPC Live, MPC Touch).
- When the headphones icon (in the upper-right corner) is selected, tap a slice in the waveform.

To add a slice at the current playhead position, tap Slice+ at the bottom of the screen. You can do this at any point during sample playback.

To insert a slice marker during sample playback, press an unlit pad (usually Pad 1) to start playback of the sample, and then press an unlit pad during playback to place a slice marker at each location of the playhead. (If you press a lit pad, playback will restart from that pad’s corresponding slice marker.) The number of the pad that is lit green is the number of the most-recently inserted slice marker. The numbers of the pads that are lit yellow are the numbers of the slice markers that are already inserted.

To split or combine slices, tap the glue-and-scissors icon. In the Split/Combine Region screen that appears, tap one of the following buttons:

- Split: This splits the currently selected region into two equal slices.
- Combine: This combines the currently selected region with the one before it.
- Back: This closes the window.
When **Link Slices** is enabled, changing the start point of a slice will also change the end point of the previous slice. Similarly, changing the end point of a slice will also change the start point of the next slice. Disable **Link Slices** if you are trying to create slices that use non-contiguous parts of the sample.

**To enable or disable this feature**, tap the **Link Slices** button.

**Important:** **Link Slices** must be disabled to make slices nonsequential, noncontiguous, or overlapping.

**To remove all slices from a sample**, press and hold **Shift** and tap **Clear All**.

The cue playhead is useful when manually inserting slice markers. You can set its position and behavior to suit your workflow.

Use the **Cue** field to adjust the position of the cue playhead. Alternatively, tap and drag the translucent marker with the triangle (▶).

**To play the sample from the cue playhead**, tap **Play Cue** at the bottom of the screen.

**To create a slice marker at the cue playhead position**, tap **Slice+** at the bottom of the screen.

**To set how the cue playhead behaves**, use the **Settings** window (described earlier).

**0 Snap** forces start points and end points to occur only at the waveform's “zero-crossings.” This can help to avoid clicks and glitches when playing a sample.

**To enable or disable 0 Snap**, press and hold **Shift**, and then tap **0 Snap** at the bottom of the screen.
Converting or Assigning Slices

You can assign your new sample directly to a pad from Chop Mode. You can also convert it into a new program or patched phrase.

To convert or assign a sample, press and hold Shift, and then tap Convert at the bottom of the screen to open the Convert or Assign Slices window.

If you set the Convert To field to New [program type] program using slices, this will create a new program and assign the sample’s slices to its pads. The pads will simply refer to the slices in this sample instead of creating new samples. This is useful for reducing clutter in your project. The new program will be named after the sample and appended with ch.

Use the Slice Type field to select how each pad’s layer settings will be set when the slices are assigned to them (see Program Edit Mode to learn more about the parameters mentioned below):

- **Non-Destructive Slice**: Each pad’s Slice setting will be set to the slice number.
- **Pad Parameters**: Each pad’s Slice setting will be set to Pad. The Pad Start and Pad End parameters will be set to the slice’s start point and end point values, and the Loop Pos parameter will be set to the slice’s start point but with Pad Loop deactivated.

Check the Create Events box to automatically create a new track for the new program in which each pad plays its corresponding slice in ascending sequence by pad number.

If Create Events is checked, use the Bars field to set how many bars the slices’ events will occupy.

To convert the sample, tap Do It.
To cancel the operation, tap Close.
If you set the Convert To field to **New clip program**, this will create a new clip program and assign the sample’s slices to its pads as clips. The pads will simply refer to the slices in this sample instead of creating new samples. This is useful for reducing clutter in your project. The new program will be named after the sample and appended with **ch**.

Use the **Tempo** field to enter the tempo of the clips in the new program.

Check the **Create Events** box to automatically create a new track for the new program in which each pad plays its corresponding slice in ascending sequence by pad number.

If **Create Events** is checked, use the **Bars** field to set how many bars the slices’ events will occupy.

To convert the sample, tap **Do It**.
To cancel the operation, tap **Close**.

If you set the Convert To field to **New program with new samples**, this will create a new sample from each slice and assign them to pads in a new program.

The new program will be named after the sample and appended with **ch**. The new samples will be appended with **SI-#** (where # is a consecutive number).

Check the **Crop Samples** box to delete the unused parts from the sample when they are created and assigned. This feature is destructive, though the project will still contain your original sample.

Leave this box unchecked to keep the unused parts of the samples when they’re created and assigned. This way, you will still be able to edit the entire samples further even though you are using only part of them at the moment.

By default, this option already will create a new program. You can **uncheck** the **Create New Program** box to convert each slice into a sample that is placed in the project’s sample pool but not assigned to a program or pad.

If **Create New Program** is checked, check the **Create Events** box to automatically create a new track in which each pad plays its corresponding slice in ascending sequence by pad number.

If **Create Events** is checked, use the **Bars** field to set how many bars the slices’ events will occupy.

To convert the sample, tap **Do It**.
To cancel the operation, tap **Close**.
If you set the **Convert To** field to **Assign slice to a pad**, the pad will simply refer to the slice in this sample instead of creating a new sample. This is useful for reducing clutter in your project.

**Important:** Assigning a sample to a pad in this way will replace the sample on the first layer of the pad.

Use the **Pad** field to select the desired pad. Alternatively, press the desired pad.

Use the **Slice Type** field to select how the pad’s layer settings will be set when the slice is assigned to it (see **Program Edit Mode** to learn more about the parameters mentioned below):

- **Non-Destructive Slice:** The pad’s **Slice** setting will be set to the slice number.
- **Pad Parameters:** The pad’s **Slice** setting will be set to **Pad**. The **Pad Start** and **Pad End** will be set to the slice’s start point and end point values, and the **Loop Position** will be set to the slice’s start point but with **Pad Loop** deactivated.

Use the **Program** field to specify the program to which you want to add the slice.

**To convert the sample**, tap **Do It**.
**To cancel the operation**, tap **Close**.

If you set the **Convert To** field to **Make new sample**, this will create a new sample in your project. (The original sample will remain as it is.)

**Important:** Assigning a sample to a pad in this way will replace the sample on the first layer of the pad.

Use the **Pad** field to select the desired pad. Alternatively, press the desired pad.

Check the **Crop Sample** box to delete the unused parts from the sample when it’s created and assigned. This feature is destructive, though the project will still contain your original sample.

Leave this box unchecked to keep the unused parts of the sample when it is created and assigned. This way, you will still be able to edit the entire sample further even though you are using only part of it at the moment.

Use the **Program** field to specify the program to which you want to add the slice.

**To convert the sample**, tap **Do It**.
**To cancel the operation**, tap **Close**.
If you set the **Convert To** field to **Patched phrase**, this will create a new sample that will play based on the tempo of your Sequence, and places it in the current project. The patched phrase will have the same name as the original sample but appended with **pp** and will use a different icon when viewing your project information.

Use the **Bars** field to set how many bars long the patched phrase is meant to be.

### Processing Slices

Press and hold **Shift**, and then tap the **Process** button to open the Process window, where you can select an editing option for the currently selected slice. (This has fewer options than Trim Mode. Unavailable ones are darkened.)

Use the **Function** field to select an editing process. Double-tap it or tap **Function** at the bottom of the screen to open the Function window, which displays an overview of all available editing processes.

**Important**: Chop Mode is non-destructive: You can choose the slice/edit behavior without destroying your original sample, giving you more control over sample playback; you can save your sliced sample and but also reuse all of the slice data in another project. See the **Program Edit Mode** chapter to learn more about setting a pad to play the entire sample, a specific slice of a sample, or a specific region of the sample (independent of its slice markers).

You can use any of these functions as described below.

**To return to Sample Edit Mode**, tap **Cancel**.

**To return to the Process window**, tap the top of the screen.

**Note**: All processes here will affect only the currently selected slice.
The **Silence** process replaces the region between the start point and end point with silence.

The **Extract** process deletes the regions before the start point and after the end point and saves it as a new sample (with a name you enter) in your current project.

**Tip:** This is useful if you recorded a drum loop and wanted to remove just a snare drum hit, a kick drum hit, etc. to use separately in the project.

The **Normalize** process increases a sample's level to the highest level possible without distortion. This is essentially a kind of digital gain optimization, so you do not have to worry about excessive level settings when working with samples with a wide range of amplitudes.

The **Reverse** process reverses the region between the start point and end point.
The **Fade In** process sets a fade-in between the start point and end point. The following types are available:

- **Linear** fades the audio in with a linear curve—a straight line between the start and end.
- **Log** fades the audio in with a logarithmic curve—quickly rising at the start and flattening out towards the end.
- **Exp** fades the audio in with an exponential curve—slowly rising in the beginning and growing steeper towards the end.

The **Fade Out** process sets a fade-out between the start point and end point. The following types are available:

- **Linear** fades the audio out with a linear curve—a straight line between the start and end.
- **Log** fades the audio out with a logarithmic curve—quickly rising at the start and flattening out towards the end.
- **Exp** fades the audio out with an exponential curve—slowly rising in the beginning and growing steeper towards the end.

The **Pitch Shift** process changes the pitch of the sample without changing its length. This lets you set the sample’s pitch to your sequence without affecting the sample’s tempo or duration. You can adjust it up to 12 semitones, up or down. Keep in mind that the audio quality may decrease at more extreme settings.

The **Gain Change** process raises or lowers the volume of the sample. You can adjust it up to 18 dB, higher or lower. This function is different than Normalize because it will allow volumes beyond clipping level. This may be a desired effect, but remember to watch your output level!
**Program Mode**

Program Mode lets you edit a sample in the context of the program in which you’ll use it. You can adjust the pad parameters as though you were in Program Edit Mode, auditioning and hearing how it will sound in the program’s audio path.

To enter Program Mode, tap the **Program** button at the bottom of the screen. The pads will show their assigned samples in the current Program.

Use the **Start** and **End** fields to set the position of the start point and end point of the sample (respectively). Alternatively, tap and drag the start (S) or end (E) marker left or right, or use the first column of Q-Link knobs (**Start X1__**) to adjust the start point or the second column of Q-Link knobs (**End X1__**) to adjust the end point.

Program Mode includes a loop function. When on, the region of the sample between the loop point and end point will repeat. This is useful when trying to find an ideal spot to begin the sample. The loop cannot be earlier than the start point.

To adjust the loop point, do any of the following:
- Use the **Loop** field.
- Tap and drag the start (S) marker (if **Loop Lock** is on) or the loop marker (if **Loop Lock** is off).
- Use the first column of Q-Link knobs (**Start X1__**; if **Loop Lock** is on) or the third column of Q-Link knobs (**Loop X1__**; if **Loop Lock** is off). The top-most Q-Link knobs (13 and 15) provide coarse adjustment. The bottom-most Q-Link knobs (1 and 3) provide fine adjustment.

To turn **Loop Lock** on or off, tap the **Loop Lock** button. When on, the loop point is the same as the start point. When off, the loop point is independent from the start point.

To turn the loop function on or off, tap the **Loop** button to cycle between the four modes:
- **Off**: The sample will not loop.
- **Forward**: When the loop reaches its end point, it will start playing again from the loop point.
- **Reverse**: When the loop reaches its end point, it will play in reverse. When it reaches the loop point again, it will return to the end point and continue playing in reverse.
- **Alternating**: When the loop reaches its end point, it will play in reverse. When it reaches the loop point again, it will start playing forward again from the loop point.

To switch between **Forward** and off, press and hold **Shift**, and then tap **Loop** at the bottom of the screen.
Tap each **pad** to hear its sample/samples. The sample on its first layer will automatically appear in the waveform display for editing.

Use the **Tune** field to transpose the sample up or down from its original pitch.

Tap **From BPM** to open the **Edit Tuning** window, which lets you tune a sample to the current sequence.

Use the **Number of Beats** field to match the number of beats in the sequence.

- **To tune the sample to the sequence**, tap **Match**. The **Tune** field will adjust automatically and close the window. The sample is now tuned to the sequence.
- **To tune the sample to the sequence and adjust the sequence tempo**, tap **To Seq**. This is the same as tapping Match but it also changes the sequence’s tempo to the BPM shown in the **Tempo** field on the right.
- **To close the window**, tap **Close**.

Use the **Root Note** field to set the root note of the sample. This defines which note will play the sample at its original pitch when in a keygroup program.

Use the **Slice** field to display either the sample as it has been edited (**Pad**) or the entire sample (**All**).

If the **Slice** field is set to **All**, you can display the sample as it has been edited but keep the start point and end point. **To do this**, press and hold **Shift**, and then tap **To Pad** at the bottom of the screen. The **Slice** field will change to **Pad**, but the start point and end point will remain in their current locations.
The **Link Slices** button does not have a function in Program Mode.

**0 Snap** forces start points, end points, and loop points to occur only at the waveform’s “zero-crossings.” This can help to avoid clicks and glitches when playing a sample.

To enable or disable **0 Snap**, press and hold **Shift**, and then tap **0 Snap** at the bottom of the screen.

To enable or disable the loop function, press and hold **Shift**, and then tap **Loop** at the bottom of the screen. This switches the loop function between **Forward** and **off**. The loop function is described earlier.
Assigning Samples

You can assign your new sample directly to a pad from Program Mode.

To assign a sample, tap Assign at the bottom of the screen to open the Assign Sample window.

Important: Assigning a sample to a pad in this way will replace the sample on the first layer of the pad.

If you set the Assign To field to Assign slice to a pad, the pad will simply refer to the slice in this sample instead of creating a new sample. This is useful for reducing clutter in your project.

Use the Pad field to select the desired pad. Alternatively, press the desired pad.

Use the Slice Type field to select how the pad’s layer settings will be set when the slice is assigned to it (see Program Edit Mode to learn more about the parameters mentioned below):

- **Non-Destructive Slice**: The pad’s Slice setting will be set to the slice number.
- **Pad Parameters**: The pad’s Slice setting will be set to Pad. The Pad Start and Pad End will be set to the slice’s start point and end point values, and the Loop Position will be set to the slice’s start point but with Pad Loop deactivated.

Use the Program field to specify the program to which you want to add the slice.

To assign the sample, tap Do It.
To cancel the operation, tap Close.

If you set the Assign To field to Make new sample, this will create a new sample in your project. (The original sample will remain as it is.)

Use the Pad field to select the desired pad. Alternatively, press the desired pad.

Check the Crop Sample box to delete the unused parts from the sample when it’s created and assigned. This feature is destructive, though the project will still contain your original sample.

Leave this box unchecked to keep the unused parts of the sample when it is created and assigned. This way, you will still be able to edit the entire sample further even though you are using only part of it at the moment.

Use the Program field to specify the program to which you want to add the slice.

To assign the sample, tap Do It.
To cancel the operation, tap Close.
Processing Slices

Press and hold Shift, and then tap the Process button to open the Process window, where you can select an editing option for the currently selected slice. (This has fewer options than Trim Mode. Unavailable ones are darkened.)

Use the Function field to select an editing process. Double-tap it or tap Function at the bottom of the screen to open the Function window, which displays an overview of all available editing processes.

Important: Program Mode is non-destructive: You can choose the slice/edit behavior without destroying your original sample, giving you more control over sample playback; you can save your sliced sample and but also reuse all of the slice data in another project. See the Program Edit Mode chapter to learn more about setting a pad to play the entire sample, a specific slice of a sample, or a specific region of the sample (independent of its slice markers).

You can use any of these functions as described below.

To return to Sample Edit Mode, tap Cancel.

To return to the Process window, tap the top of the screen.

Note: All processes here will affect only the currently selected slice.
The **Silence** process replaces the region between the start point and end point with silence.

The **Extract** process deletes the regions before the start point and after the end point and saves it as a new sample (with a name you enter) in your current project.

**Tip:** This is useful if you recorded a drum loop and wanted to remove just a snare drum hit, a kick drum hit, etc. to use separately in the project.

The **Normalize** process increases a sample’s level to the highest level possible without distortion. This is essentially a kind of digital gain optimization, so you do not have to worry about excessive level settings when working with samples with a wide range of amplitudes.

The **Reverse** process reverses the region between the start point and end point.
The **Fade In** process sets a fade-in between the start point and end point. The following types are available:

- **Linear** fades the audio in with a linear curve—a straight line between the start and end.
- **Log** fades the audio in with a logarithmic curve—quickly rising at the start and flattening out towards the end.
- **Exp** fades the audio in with an exponential curve—slowly rising in the beginning and growing steeper towards the end.

The **Fade Out** process sets a fade-out between the start point and end point. The following types are available:

- **Linear** fades the audio out with a linear curve—a straight line between the start and end.
- **Log** fades the audio out with a logarithmic curve—quickly rising at the start and flattening out towards the end.
- **Exp** fades the audio out with an exponential curve—slowly rising in the beginning and growing steeper towards the end.

The **Pitch Shift** process changes the pitch of the sample without changing its length. This lets you set the sample’s pitch to your sequence without affecting the sample’s tempo or duration. You can adjust it up to 12 semitones, up or down. Keep in mind that the audio quality may decrease at more extreme settings.

The **Gain Change** process raises or lowers the volume of the sample. You can adjust it up to 18 dB, higher or lower. This function is different than Normalize because it will allow volumes beyond clipping level. This may be a desired effect, but remember to watch your output level!
Program Edit Mode contains all parameters for editing your Programs.

For **drum programs**, this mode includes the parameters of four layers as well as all synthesis parameters and insert effect settings. See the **Drum Programs** section to learn more.

For **keygroup programs**, this mode contains slightly more parameters than drum programs. See the **Keygroup Programs** section to learn more.

For **clip programs**, this mode looks very different from that of other programs due to how clip launching works. See the **Clip Programs** section to learn more.

For **plugin programs**, skip to **Plugin Programs** to learn more. For MPC X and MPC Live, these are available only while in Controller Mode.

For **MIDI programs** and **CV programs**, skip to **MIDI Programs** and **CV Programs** to learn more.

For more general information on the differences between the types of programs, please see **General Features > Programs**.

To enter Program Edit Mode, do either of the following:

- Press **Menu**, and then tap **Program Edit**.
- Press **Prog Edit** (MPC X).

### Drum Programs

When using drum programs, Program Edit Mode lets you edit the parameters for each pad.

**To select a pad**, press it. Its parameters will appear on the screen immediately.

**To view a specific tab of parameters**, tap the **Master**, **Samples**, **Pan Velocity**, **Filter/Env**, **LFO Modulation**, or **Effects** button at the bottom of the screen. You can tap the **Samples** button multiple times to cycle through its three available tabs.
Tap the location icon at the top of the screen (between the Program and Pad fields) to open the Edit Zones window, which is a feature for drum programs and clip programs. This window displays an overview of any selected pads. Use the Mode selector to set how the selected pads will be edited:

- **Current**: Only the currently selected pad can be edited.
- **Multiple**: All selected pads can be edited simultaneously.
- **All**: All pads can be edited simultaneously.

To close the window, tap Close, the X, or anywhere outside the window.

**Tip**: You can immediately select multiple pads while on any tab in Program Edit Mode (regardless of the current Edit Zones setting) by pressing and holding the Shift button and pressing each desired pad. The Edit Zones setting will automatically change to **Multiple**.
Tap the **down-arrow icon** at the top of the screen (next to the **Program** field) to open the **Flatten Pad** window, which renders all samples on a pad as an audio sample and places it on the first layer of that pad. The resulting sample is the audio signal produced by that pad at full velocity (127) after the pad channel strip, which means that it includes any assigned pad insert effects and the results of warping the sample.

This function is useful if you need to reduce how CPU-intensive a pad or program is by essentially “embedding” the warping and effects in the sample itself. By default, it will use the name of the first sample. This function works for drum programs only. (This is the same as the **Flatten Pad** process shown in the program editing functions in Main Mode.)

**To select the pad**, press it or use the **Pad** menu.

**To set the length of the audio tail**, use the **Audio Tail** field. This will add extra seconds to the end of the resulting audio file. This is useful if you are using effects or samples whose sounds exceed the defined audio length (e.g., long reverb or delay, one-shot samples with long decays, etc.). We recommend using an audio tail of at least a couple of seconds.

**To name the new sample**, tap the **Edit Name** field, and use the virtual keyboard that appears.

**To confirm your choice**, tap **Do It**.

**To cancel**, tap **Cancel**.

The automation button indicates the global automation state. This is shown in several modes. See **General Features > Automation** to learn about this.
Master

In the Master tab, you can set the playback mode and tuning for the overall Program.

**Polyphony** sets the playback mode for the program’s pads. In Mono Mode, only one pad will sound at a time. If a pad is played while another (or the same one) is still playing its sample/samples, the new pad will immediately mute all other currently playing pads in that program. In Poly Mode, several pads can be triggered at the same time (limited only by the total number of voices available).

**Semi** lets you transpose the program up to 36 semitones up or down.

**Fine** provides fine-tuning of the program up to 99 cents up or down.

**Volume** controls the overall volume level of the loaded sample/samples.

**Pan** controls the overall panning of the loaded sample/samples in the stereo field.

The **Simultaneous Play** section lets you set up to four pads that can be triggered by pressing one pad only. This function is useful for triggering a stack of sounds (e.g., layered kick drums). Use each **Pad** field to select the desired pad.

The **Mute Targets** tab lets you select up to four pads (in the same program) for the currently selected pad. When the currently selected pad is played, it will immediately silence its mute targets. Use each **Pad** field to select the desired mute target.

**Tips:**
This feature is useful for programming realistic hi-hats, especially if only the open or closed hat should be heard.
This feature is similar to the mute group feature, available for both drum programs and keygroup programs.
Samples
Each pad can trigger up to four samples, which are assigned in four individual layers. Each layer has identical, independently assignable parameters.
Tap Samples to cycle through its three available tabs.

On all three sections, you can access the Settings window, which lets you configure certain settings in the Samples tab.
To view the Settings, tap the gear icon.
To close the Settings, tap Close, the X in the upper-right corner, or anywhere outside the window.

Use the Link Slices selector to set how the start point and end point of a slice in a larger sample is set. You can create these slices in Sample Edit Mode (Chop Mode).
When on, changing the start point of a slice will also change the end point of the previous slice. Similarly, changing the end point of a slice will also change the start point of the next slice. Disable Link Slices if you are trying to create slices that use non-contiguous parts of the sample. This is the same as the Link Slices button in Sample Edit Mode.

Use the Loop Lock selector to “link” or “unlink” the loop point from the start point. When on, the loop point is the same as the start point. When off, the loop point is independent from the start point and indicated by a separate loop marker. This is the same as the Loop Lock button in Sample Edit Mode.

Use the Zero Snap selector to enable or disable the Zero Snap feature, which forces start points, end points, and loop points to occur only at the waveform’s “zero-crossings.” This can help to avoid clicks and glitches when playing a sample. This is the same as the 0 Snap button in Sample Edit Mode.
The first **Samples** tab contains the sample waveform for each layer and controls for its pitch, timing, and playback.

The upper half of the screen shows the waveform of the sample on the currently selected layer. The lower half shows the editing controls.

The waveform display shows the “active” section of the sample waveform. Swipe left or right on the waveform to move through it.

Above the waveform is the timeline, shown in bars, beats, and ticks.

Use the bottom-most **Q-Link knob** in the fourth bank to zoom in or out of the sample waveform.

Tap each layer number (**Layer 1–4**) under the waveform to select it. When selected, its sample waveform will be shown in the upper half of the screen and its settings will be shown in the lower half.

Use the **Sample** field to select the sample file for that layer. Remember that the sample has to be loaded into the project’s sample pool beforehand. For information on how to load samples into a project, please see the **Browser** chapter.

**Important:** The parameters in the **Samples** tabs work in conjunction with Chop Mode (in Sample Edit Mode). Here’s how it works:

When working in Sample Edit Mode and using Chop Mode to divide a sample into slices for your pads, you can convert a slice using **Non-Destructive Slice** or **Pad Parameters**.

A **Non-Destructive Slice** will let its pad to refer to that slice when you press it; the original sample remains intact and each slice marker is like a “bookmark” for a pad. In Program Edit Mode, you’ll see that the pad/layer to which it’s assigned has its **Slice** drop-down menu set to the corresponding **slice number** in the original sample. Playing that pad will cause it to refer to that slice marker like a “bookmark” instead of creating an entirely new sample of that slice. This means that you no longer have to clutter your project with a new sample for every slice (though you can still use this earlier method, if you prefer).

A slice converted using **Pad Parameters** is very similar to a non-destructive slice described above. The difference is that in Program Edit Mode, the pads/layers they’re assigned to have their **Slice** drop-down menus set to **Pad** (instead of the slice number), and the **start** and **end points** will correspond to the slice markers in the original sample.
The green/S marker and red/E marker are the start point and end point (respectively). These two points define the region of the sample that will be played.

**To move the start point or end point**, do any of the following:

- Tap and drag the S or E marker left or right.
- Use the Start or End fields shown below the waveform.
- Use the first bank of Q-Link knobs to adjust the start point or the second bank of Q-Link knobs to adjust the end point. The top-most Q-Link knob provides coarse adjustment. The bottom-most Q-Link knob provides fine adjustment.

**Note:** When Loop Lock is on, the loop position (as determined by the Loop field, if enabled) is the same as the sample’s start point. When off, the loop position is independent from the start point.

Use the Loop field to determine the position where the sample’s playback will repeat when Pad Loop is activated. Alternatively, use the third bank of Q-Link knobs to adjust the loop point. The top-most Q-Link knob provides coarse adjustment. The bottom-most Q-Link knob provides fine adjustment.

**Note:** When Loop Lock is on, the loop position is the same as the sample’s start point. When off, the loop position is independent from the start point.

Use the Slice field to select what part/parts of the sample will play:

- **All**: The entire sample will play.
- **Pad**: The sample will play from the Pad Start position to the Pad End position, described earlier. This also lets you activate Pad Loop (if the Sample Play field in the LFO Modulation tab is set to Note On).
- **Slice 1, 2, 3, etc.**: If you have sliced the sample in Chop Mode, you can select which slice will play when you trigger the pad.

**Semi** lets you transpose the selected layer 36 up to semitones up or down. This will affect the length of the sample (if Warp is off). This is the same as the Semi knob on the second Samples tab.

**Fine** provides fine-tuning of each layer by cents. This will affect the length of the sample (if Warp is off). This is the same as the Fine knob on the second Samples tab.
Use the **Reverse** button to select in which direction the sample will play. When on, the sample will play in reverse. When off, the sample will play in the normal forward direction.

Use the **Pad Loop** button to cycle through the available Pad Loop modes.

**Important:** For Pad Loop to work, you must (1) set the **Sample Play** field (in the LFO Modulation tab) to **Note On** instead of One Shot and (2) set the **Slice** field (in the first Samples tab) to **Pad** instead of All or a slice number.

- **Off:** The sample will not loop.
- **Forward:** You can hold down the **pad** to cause that sample to repeat from the **Loop Position** to the end of the sample. Release the **pad** to stop the repeating playback.
- **Reverse:** You can hold down the **pad** to cause that sample to play in reverse, repeating from the end of the sample to the **Loop Position**. Release the **pad** to stop the repeating playback.
- **Alternating:** You can hold down the **pad** to cause that sample to play from the **Loop Position** to the end of the sample and then play in reverse until it reaches the **Loop Position** again. This will repeat as long as you are holding the pad down. Release the **pad** to stop the repeating playback.
Tap **Warp** to enable or disable warping of the sample.

When enabled, lengthening or shortening the sample (based on the BPM) will not change its pitch.

When disabled, lengthening or shortening the sample will also change its pitch and vice versa.

Use the **Stretch** field to set the “stretch factor,” which affects how the sample is warped (if **Warp** is on).

Use the **BPM** field to enter a tempo, which affects how the sample is warped (if **Warp** is on).

Tap **BPM Sync** to enable or disable BPM Sync.

When BPM Sync and **Warp** are both enabled, the sample’s BPM will be “locked” to the tempo of the sequence.

When BPM Sync is disabled but **Warp** is enabled, the sample will be independent of the tempo of your sequence—use the **Stretch** field to lengthen or shorten a sample.

**Note**: The Warp algorithms are very CPU-intensive and can result in audio drop-outs during playback if used too freely. Be mindful of how (and how often) you use the warp function. You can reduce the CPU resources required by doing any/all of the following:

- Avoid using extreme **Stretch** values.
- Minimize the amount of pitch adjustment (e.g., the **Semi** and **Fine** parameters) of warped audio.
- Avoid warping very small track regions.
- Warp as few tracks or track regions as possible (i.e., reduce the number of total number of voices of the polyphonic limit that use the Warp algorithm at a given time), especially instances where the warped regions start at the same time.
- Avoid rapidly triggering samples that are warped.

If you have warped samples used in a drum program, consider using the **Flatten Pad** function to consolidate the affected pad’s layers into one audio sample (see [here](#) to learn about this). After you flatten the pad, its sample/samples no longer need to be warped.
The **second Samples** tab contains controls for its pitch and volume level.

![Sample Control Panel](image)

- **Semi** lets you transpose the selected layer 36 up to semitones up or down. This will affect the length of the sample (if **Warp** is off). This is the same as the **Semi** field on the first Samples tab.

- **Fine** provides fine-tuning of each layer by cents. This will affect the length of the sample (if **Warp** is off). This is the same as the **Fine** field on the first Samples tab.

- **Level** lets you adjust each layer’s volume, letting you control the “balance” of the samples assigned to the pad.
The **third Samples** tab contains the control for its offset.

Use the **Offset** slider to determine a time offset for the sample's playback.

**Positive values** (right of center): When the pad is played, playback will start immediately but at a later point in the sample specified by the offset value.

**Negative values** (left of center): When the pad is played, playback will be delayed by the amount specified by the offset value.
Pan Velocity

Use the **pan knob** to adjust the stereo placement of the respective layer.

Use the **Vel Start** and **Vel End** knobs to define the velocity range of each layer.

A range from 0 to 127 lets the layer respond to the entire velocity range which is input from the respective pad while, for example, a range from 100 to 127 lets the layer respond only to higher velocity levels. By assigning several samples of one instrument, you can create a realistic-sounding “multi-sample” by adjusting the velocity ranges of each layer accordingly.

For example, you may have three samples of a drum hit with low force, medium force, and high force. You can set each sample to a layer and set the Velocity ranges so only low velocities trigger the low-force sample, only mid-range velocities trigger the medium-force sample, and only high velocities trigger the high-force sample.
Filter/Envelope

Use the **Type** field to select a filter for the selected pad. See *Appendix > Glossary > Filter* for an explanation of the available filter types.

Use the **Cutoff** knob to set the cutoff frequency for low-pass and high-pass filter types or the center frequency for band-pass and band-stop filter types.

Use the **Reso** knob to set the resonance/emphasis of the frequencies around the cutoff point.

**Tip:** Use values lower than 80 to give more brilliance to the sound. At values higher than 80, the sound will result in a strong audible boost around the cutoff frequency.

Use the **Env** to determine the amount of influence the filter envelope has on the cutoff frequency. Higher settings will increase the modulation of the filter by the envelope; lower settings will result in only subtle changes of the filter Cutoff over time.

**Tip:** To give a sound a more distinctive attack, increase the Env setting and set low Atk and Decay values as well as a medium-low Sust value of the Filter Envelope. This will start a sound with the filter opened and close it shortly afterward, giving it a bright start followed by a darker sustain. String sounds, on the other hand, can sound much more “alive” with low Env settings and a high Atk value, resulting in a slight fade-in-of the higher frequencies.

Use the **Modulation Sources** knobs to set how much velocity is required to modulate certain other parameters:

- **Vel>Sta** (Velocity ➔ Start) sets how much velocity is needed (for a triggered pad) to modulate the sample start point.
- **Vel>Atk** (Velocity ➔ Attack) sets how much velocity is needed (for a triggered pad) to modulate the Attack phase for the Amp envelope.
- **Vel>Env** (Velocity ➔ Envelope) enables velocity information to control the amount of the filter envelope’s effect on the cutoff frequency.
- **Vel>Fit** (Velocity ➔ Filter) uses the velocity of a pad to modulate the cutoff frequency directly.
The **Filter Envelope** controls affect the filter frequency. Use the fields or tap and drag the “handles” of the envelope to shape the envelope or time-variant modulation output. Adjust the envelope’s influence on the filter frequency with the **Env** knob. See the later **Anatomy of an Envelope** section to learn about the envelope parameters.

The **Amp Envelope** controls affect level changes over time. Use the fields or tap and drag the “handles” of the envelope to shape the envelope or time-variant modulation output. Adjust the envelope’s influence on the filter frequency with the **Env** knob. See the later **Anatomy of an Envelope** section to learn about the envelope parameters.

**LFO Modulation**

![LFO Modulation Interface](image)

The **Modes** controls let you set the behavior for each pad’s samples in a drum program.

Use the **Mute Group** field to assign the selected pad to one of the 32 available groups. When pads assigned to the same mute group receive MIDI notes, the last pad played will silence all other pads in that mute group. A mute group affects pads within that program only; mute groups do not affect pads in other programs.

**Tip:** This feature is useful for programming realistic hi-hats, especially if only the open or closed hat should be heard.

Use the **Layer Play** selector to determine how multiple samples assigned to the same pad are played:

- **Cycle (Cyc):** Each time the pad is played, it will play the next layer’s sample. In other words, the samples will cycle through the layers as follows: 1, 2, 3, 4, 1, 2, 3, 4… etc.
- **Velocity (Vel):** The pad will switch between layers depending on how hard you press a pad.
- **Random (Ran):** Each time the pad is played, it will play one of its layer’s samples at random.

Use the **Sample Play** selector to determine how much of the sample is played.

- **One Shot:** The entire sample will play from start to end. Use this when you want to play short sounds.
- **Note On:** The sample will play only as long as the pad is held. This is better for longer samples so you can control a sound’s duration by pressing and holding its corresponding pad.
Use the **Pad Polyphony** field to determine how the pad’s sound behaves when multiple hits are registered. When set to **Mono**, only one pad will sound at a time. If a pad is played while another (or the same one) is still playing its sample/samples, the new pad will immediately mute all other currently playing pads in that program. When set to **Poly**, several pads can be triggered at the same time (limited only by the total number of voices available). You can also select a specific number of pads (2–32) so that you can trigger up to this many pads at the same time (unless they exceed the total number of voices available).

The **Velocity Sensitivity** controls determine how much the velocity affects the pitch of the sound (**Pitch**), the attack of the filter envelope (**Attack**), the volume level of the filter envelope (**Amp**) and or the panning of the sound (**Pan**).

When you press a pad softly, only minimal modulation is applied. When you press it harder, the modulation amount also gets stronger depending on the setting of the corresponding knob.

A low-frequency oscillator (LFO) generates a periodic waveform with an adjustable frequency and shape which can be used for modulation purposes.

Use the **Wave** field to select the LFO waveform type:
- **Sine** (best suited for smooth modulations)
- **Triangle** (best suited for smooth modulations)
- **S&H** (samples a random value and holds it until the next value is generated)
- **Saw** (can generate interesting filter or volume changes)
- **Saw Down** (can generate interesting filter or volume changes)
- **Square** (interesting results with hard-panning modulations)
- **Noise** (generates random values and glides)

Use the **Rate** field to determine the LFO frequency. At lower values, it might take some time for the LFO to complete a cycle, while higher values will come closer to audible range.

Use the **Sync** field to set if the LFO’s rate is synchronized with the tempo. You can select one of several time divisions (**a .** indicates a dotted note; **a T** indicates a triplet-based time division). When **None** is selected, **Sync** is off.

Use the **Destinations** sliders to determine how much the LFO affects the pitch of the sound (**Pitch**), the cutoff frequency of the filter (**Filter**), the volume level of the sound (**Amp**) and panning of the sound (**Pan**).
Effects

Inserts
You can select up to four insert effects for each pad. To learn how to use insert effects, please see General Features > Effects > Insert Effects.

To add an effect:
1. Double-tap the desired Inserts slot. A list of effects will appear.
2. Swipe up or down to move through the list.
   You can tap the Type and Manufacturer buttons to sort your effects by those categories.
3. To load an effect, double-tap it, or tap Select.
   To close the list, tap Close.

To remove an effect from its slot, tap the trash can icon.

To enable or disable the effect, tap the On/Off button for the slot.
To enable or disable all four insert effects, tap the All On/Off button in the upper-right corner.
To adjust the effect’s parameters, tap the pencil icon. Use the sliders to set the value of each parameter. These values affect only this instance of the effect; insert effects are not global.

Sends
The audio of the pad will be routed to send effects (if you have any loaded) at their designated send levels. The return channels will then send the audio to an assigned master output at the designated return levels.

Use the Send knobs to set the volume level of the signal the pad will route to each send effect.

Important: To set the send level, use, you have to load an effect into the corresponding send effect slot in the Channel Mixer. See Channel Mixer > Returns to learn more how to do this. To learn about send effects, please see General Features > Effects > Send/Return Effects.
Keygroup Programs

When using keygroup programs, Program Edit Mode lets you edit the parameters for each keygroup.

**To select a keygroup**, press a pad within that keygroup. Its parameters will appear on the screen immediately. Alternatively, use the Keygroup field at the top of the screen.

**To view a specific tab of parameters**, tap the Master, Samples, Pan Velocity, Filter/Env, LFO Modulation, or Effects button at the bottom of the screen. You can tap the Samples button multiple times to cycle through its three available tabs.

**Number of KG** (keygroups) lets you create up to 128 keygroups within a keygroup program. This is useful when working with multi-samples. For example, if you want to create a realistic piano, you can use different keygroups (e.g., 88 for a grand piano) with every keygroup containing its own sampled note (with up to four possible velocity layers).

Tap the Keygroup field to select a keygroup to edit. You can also select All to edit all keygroups simultaneously.

Tap the piano-keys icon to edit the note range of the current keygroup. This will open the Set Keygroup Note Range window. This lets you restrict the key range used for a sample’s playback. Only notes with a key number higher or equal (Low Key) or lower and equal (High Key) to the selected value will trigger a sound.

**Tips:**

Alternatively, you can set the current keygroup’s note range by using the Lo and Hi fields under Note Range in the Master tab.

Set the Lo parameter to A0 and the Hi parameter to C8 to emulate the range of a standard 88-key piano.

The automation button indicates the global automation state. This is shown in several modes. See General Features > Automation to learn about this.
Master

In the Master tab, you can set the playback mode and tuning for the overall program.

**Polyphony** sets the playback mode for the program’s keygroups. In **Mono** Mode, only one keygroup will sound at a time. If a keygroup is played while another (or the same one) is still playing its sample/samples, the new keygroup will immediately mute all other currently playing keygroups in that program. In **Poly** Mode, several keygroups can be triggered at the same time (limited only by the total number of voices available).

**Semi** lets you tune the program up to 36 semitones up or down.

**Fine** provides fine-tuning of the program up to 99 cents up or down.

**Transpose** shifts the pitch of the MIDI notes sent to the program up to 36 semitones up or down.

**KG Select** (Keygroup Select) lets you select a specific keygroup for editing. This parameter works in conjunction with the **Number of KG** (keygroups) parameter at the top of the screen, which lets you create up to 128 keygroups within one keygroup program. A default keygroup program contains only one single keygroup. When you have created more than one keygroup with **Number of KG**, use **KG Select** to select any keygroup for editing. **All** selects all available keygroups of a keygroup program for simultaneous editing.

**Key Track** allows you to switch a sample’s automatic transposition on or off. If this is off, you will always hear the same pitch of the sample, no matter which note is triggered by pads or a connected MIDI keyboard.
**Level** controls the overall volume level of the loaded sample/samples.

**Pan** controls the overall panning of the loaded sample/samples in the stereo field.

**Note Range** lets you restrict the key range used for a sample’s playback. Only notes with a key number higher or equal (Lo) or lower and equal (Hi) to the selected value will trigger a sound. The settings for Lo and Hi are also shown in the virtual keyboard in the **Edit Layers** section. Alternatively, tap the piano-keys icon to open the **Set Keygroup Note Range** window.

**Tip:** Set the Lo parameter to A0 and the Hi parameter to C8 to emulate the range of a standard 88-key piano.

**Semi** lets you transpose the sample 36 semitones up or down, while **Fine** provides fine-tuning of each layer up to 99 cents up or down.

**Tip:** The **Edit Layers** section has some parameters similar to those in this section (**Level**, **Pan**, **Semi**, **Fine**, **Note Range**). Remember that **Key Group** parameters control the overall settings for the sample, while **Edit Layer** parameters control the settings for each layer (up to 4).

Use the **KG Polyphony** (keygroup polyphony) field to determine how the keygroup will play. When set to **Mono**, only one pad will sound at a time. If a pad is played while another (or the same one) is still playing its sample/samples, the new pad will immediately mute all other currently playing pads in that program. When set to **Poly**, several pads can be triggered at the same time, limited only by the total number of voices available. You can also select a specific number of pads (2–32) so that you can play up to this many pads at the same time (unless they exceed the total number of voices available).

Use the **Mute Group** field to assign the selected pad to one of the 32 available groups. When pads assigned to the same mute group receive MIDI notes, the last pad played will silence all other pads in that mute group. A mute group affects pads within that program only; mute groups do not affect pads in other programs.
Layer Play determines how multiple samples assigned to the same pad are played:

- **Cycle (Cyc):** Each time the pad is played, it will play the next layer’s sample. In other words, the samples will cycle through the layers as follows: 1, 2, 3, 4, 1, 2, 3, 4… etc.
- **Velocity (Vel):** The pad will switch between layers depending on how hard you press a pad.
- **Random (Ran):** Each time the pad is played, it will play one of its layer’s samples at random.

Sample Play determines how much of the sample is played:

- **One Shot:** The entire sample will play from start to end. Use this when you want to play short sounds.
- **Note On:** The sample will play only as long as the pad is held. This is better for longer samples so you can control a sound’s duration by pressing and holding its corresponding pad.
Samples
Each keygroup can trigger up to four samples, which are assigned in four individual layers. Each layer has identical, independently assignable parameters.
Tap Samples to cycle through its three available tabs.

On all three sections, you can access the Settings window, which lets you configure certain settings in the Samples tab.
To view the Settings, tap the gear icon.
To close the Settings, tap Close, the X in the upper-right corner, or anywhere outside the window.

Use the Link Slices selector to set how the start point and end point of a slice in a larger sample is set. You can create these slices in Sample Edit Mode (Chop Mode).
When on, changing the start point of a slice will also change the end point of the previous slice. Similarly, changing the end point of a slice will also change the start point of the next slice. Disable Link Slices if you are trying to create slices that use non-contiguous parts of the sample. This is the same as the Link Slices button in Sample Edit Mode.

Use the Loop Lock selector to “link” or “unlink” the loop point from the start point. When on, the loop point is the same as the start point. When off, the loop point is independent from the start point and indicated by a separate loop marker. This is the same as the Loop Lock button in Sample Edit Mode.

Use the Zero Snap selector to enable or disable the Zero Snap feature, which forces start points, end points, and loop points to occur only at the waveform’s “zero-crossings.” This can help to avoid clicks and glitches when playing a sample. This is the same as the 0 Snap button in Sample Edit Mode.
The **first Samples** tab contains the sample waveform for each layer and controls for its pitch, timing, and playback.

The upper half of the screen shows the waveform of the sample on the currently selected layer. The lower half shows the editing controls.

The waveform display shows the “active” section of the clip waveform. Swipe left or right on the waveform to move through it.

Above the waveform is the timeline, shown in bars, beats, and ticks.

Use the bottom-most **Q-Link knob** in the fourth bank to zoom in or out of the sample waveform.

Tap each layer number (**Layer 1–4**) under the waveform to select it. When selected, its sample waveform will be shown in the upper half of the screen and its settings will be shown in the lower half.

Use the **Sample** field to select the sample file for that layer. Remember that the sample has to be loaded into the project’s sample pool beforehand. For information on how to load samples into a project, please see the **Browser** chapter.

**Important**: The parameters in the **Samples** tabs work in conjunction with Chop Mode (in Sample Edit Mode). Here’s how it works:

When working in Sample Edit Mode and using Chop Mode to divide a sample into slices for your pads (keygroups), you can convert a slice using **Non-Destructive Slice** or **Pad Parameters**.

A **Non-Destructive Slice** will let its keygroup to refer to that slice when you press a pad in that keygroup; the original sample remains intact and each slice marker is like a “bookmark” for a keygroup. In Program Edit Mode, you’ll see that the layer to which it’s assigned has its **Slice** drop-down menu set to the corresponding **slice number** in the original sample. Playing that keygroup will cause it to refer to that slice marker like a “bookmark” instead of creating an entirely new sample of that slice. This means that you no longer have to clutter your project with a new sample for every slice (though you can still use this earlier method, if you prefer).

A slice converted using **Pad Parameters** is very similar to a non-destructive slice described above. The difference is that in Program Edit Mode, the layers they’re assigned to have their **Slice** drop-down menus set to **Pad** (instead of the slice number), and the **start** and **end points** will correspond to the slice markers in the original sample.
The green/S marker and red/E marker are the start point and end point (respectively). These two points define the region of the sample that will be played.

To move the start point or end point, do any of the following:

- Tap and drag the S or E marker left or right.
- Use the Start or End fields shown below the waveform.
- Use the first column of Q-Link knobs to adjust the start point or the second column of Q-Link knobs to adjust the end point. The top-most Q-Link knob provides coarse adjustment. The bottom-most Q-Link knob provides fine adjustment.

Note: When Loop Lock is on, the loop position (as determined by the Loop field, if enabled) is the same as the sample’s start point. When off, the loop position is independent from the start point.

Use the Loop field to determine the position where the sample’s playback will repeat when Pad Loop is activated. Alternatively, use the third column of Q-Link knobs to adjust the loop point. The top-most Q-Link knob provides coarse adjustment. The bottom-most Q-Link knob provides fine adjustment.

Note: When Loop Lock is on, the loop position is the same as the sample’s start point. When off, the loop position is independent from the start point.

Use the Slice field to select what part/parts of the sample will play:

All: The entire sample will play.

Pad: The sample will play from the Pad Start position to the Pad End position, described earlier. This also lets you activate Pad Loop (if the Sample Play field in the Master tab is set to Note On).

Slice 1, 2, 3, etc.: If you have sliced the sample in Chop Mode, you can select which slice will play when you trigger the pad.

Semi lets you transpose the selected layer 36 up to semitones up or down. This is the same as the Semi knob on the second Samples tab.

Fine provides fine-tuning of each layer by cents. This is the same as the Fine knob on the second Samples tab.
Use the **Reverse** button to select in which direction the sample will play. When on, the sample will play in reverse. When off, the sample will play in the normal forward direction.

Use the **Pad Loop** button to cycle through the available Pad Loop modes.

**Important**: For Pad Loop to work, you must (1) set the **Sample Play** field (in the Master tab) to **Note On** instead of One Shot and (2) set the **Slice** field (in the first Samples tab) to **Pad** instead of All or a slice number.

- **Off**: The sample will not loop.
- **Forward**: You can hold down the **pad** to cause that sample to repeat from the **Loop Position** to the end of the sample. Release the **pad** to stop the repeating playback.
- **Reverse**: You can hold down the **pad** to cause that sample to play in reverse, repeating from the end of the sample to the **Loop Position**. Release the **pad** to stop the repeating playback.
- **Alternating**: You can hold down the **pad** to cause that sample to play from the **Loop Position** to the end of the sample and then play in reverse until it reaches the **Loop Position** again. This will repeat as long as you are holding the pad down. Release the **pad** to stop the repeating playback.
The **second Samples** tab contains controls for its pitch and volume level.

**Semi** lets you transpose the selected layer 36 up to semitones up or down. This will affect the length of the sample (if **Warp** is off). This is the same as the **Semi** field on the first Samples tab.

**Fine** provides fine-tuning of each layer by cents. This will affect the length of the sample (if **Warp** is off). This is the same as the **Fine** field on the first Samples tab.

**Level** lets you adjust each layer’s volume, letting you control the “balance” of the samples assigned to the pad.
The **third Samples** tab contains the control for its offset.

Use the **Offset** slider to determine a time offset for the sample’s playback.

**Positive values** (right of center): When the pad is played, playback will start immediately but at a later point in the sample specified by the offset value.

**Negative values** (left of center): When the pad is played, playback will be delayed by the amount specified by the offset value.
Pan Velocity

Use the **Pan knob** to adjust the stereo placement of the respective layer.

Use the **Vel Start** and **Vel End** knobs to define the velocity range of each layer.

A range from 0 to 127 lets the layer respond to the entire velocity range which is input from the respective pad while, for example, a range from 100 to 127 lets the layer respond only to higher velocity levels. By assigning several samples of one instrument, you can create a realistic-sounding "multi-sample" by adjusting the velocity ranges of each layer accordingly.

For example, you may have three samples of a piano key with low force, medium force, and high force. You can set each sample to a layer and set the Velocity ranges so only low velocities trigger the low-force sample, only mid-range velocities trigger the medium-force sample, and only high velocities trigger the high-force sample.

Use the **Root Note** menu to set the starting note of each loaded sample. **Smp** denotes the sample's default pitch.
Filter/Envelope

Use the **Type** field to select a filter for the selected pad. See *Appendix > Glossary > Filter* for an explanation of the available filter types.

Use the **Cutoff** knob to set the cutoff frequency for low-pass and high-pass filter types or the center frequency for band-pass and band-stop filter types.

Use the **Reso** knob to set the resonance/emphasis of the frequencies around the cutoff point.

**Tip**: Use values lower than 80 to give more brilliance to the sound. At values higher than 80, the sound will result in a strong audible boost around the cutoff frequency.

Use the **Env** to determine the amount of influence the filter envelope has on the cutoff frequency. Higher settings will increase the modulation of the filter by the envelope; lower settings will result in only subtle changes of the filter Cutoff over time.

**Tip**: To give a sound a more distinctive attack, increase the **Env** setting and set low **Atk** and **Decay** values as well as a medium-low **Sust** value of the Filter Envelope. This will start a sound with the filter opened and close it shortly afterward, giving it a bright start followed by a darker sustain. String sounds, on the other hand, can sound much more “alive” with low **Env** settings and a high **Atk** value, resulting in a slight fade-in of the higher frequencies.

Use the **Modulation Sources** knobs to set how much velocity is required to modulate certain other parameters:

- **Kbd>Flt** (Keyboard ➤ Filter) sets how much the note value will be added to the filter cutoff. This allows higher notes to sound brighter.
- **Vel>Atk** (Velocity ➤ Attack) sets how much velocity is needed (for a triggered pad) to modulate the Attack phase for the Amp envelope.
- **Vel>Env** (Velocity ➤ Envelope) enables velocity information to control the amount of the filter envelope’s effect on the cutoff frequency.
- **Vel>Fit** (Velocity ➤ Filter) uses the velocity of a pad to modulate the cutoff frequency directly.
The Filter Envelope controls affect the filter frequency. Use the fields or tap and drag the “handles” of the envelope to shape the envelope or time-variant modulation output. Adjust the envelope’s influence on the filter frequency with the Env knob. See Anatomy of an Envelope to learn about the envelope parameters.

The Amp Envelope controls affect level changes over time. Use the fields or tap and drag the “handles” of the envelope to shape the envelope or time-variant modulation output. Adjust the envelope’s influence on the filter frequency with the Env knob. See Anatomy of an Envelope to learn about the envelope parameters.

### LFO Modulation

The Velocity Sensitivity controls determine how much the velocity affects the pitch of the sound (Pitch), the attack of the filter envelope (Attack), the volume level of the sound (Amp), and the panning of the sound (Pan).

When you press a pad softly, only minimal modulation is applied. When you press it harder, the modulation amount also gets stronger depending on the setting of the corresponding knob.

A low-frequency oscillator (LFO) generates a periodic waveform with an adjustable frequency and shape which can be used for modulation purposes.

Use the Wave field to select the LFO waveform type:

- **Sine** (best suited for smooth modulations)
- **Triangle** (best suited for smooth modulations)
- **S&H** (samples a random value and holds it until the next value is generated)
- **Saw** (can generate interesting filter or volume changes)
- **Saw Down** (can generate interesting filter or volume changes)
- **Square** (interesting results with hard-panning modulations)
- **Noise** (generates random values and glides)
Use the **Rate** field to determine the LFO frequency. At lower values, it might take some time for the LFO to complete a cycle, while higher values will come closer to audible range.

Use the **Sync** field to set if the LFO’s rate is synchronized with the tempo. You can select one of several time divisions (a . indicates a dotted note; a T indicates a triplet-based time division). When **None** is selected, **Sync** is off.

Use the **Destinations** sliders to determine how much the LFO affects the pitch of the sound (**Pitch**), the cutoff frequency of the filter (**Filter**), the volume level of the sound (**Amp**) and the panning of the sound (**Pan**).

The **Controller Mod** section determines the influence of additional play controllers on various sound parameters. **Important**: To use these parameters, make sure that a connected MIDI device can send pitch bend messages as well as aftertouch and modulation wheel data.

**Pitch Bend** sets the range (in semitones) of a connected MIDI keyboard’s pitch-bend wheel.

**Wheel>LFO** determines how much a connected MIDI keyboard’s modulation wheel affects the LFO intensity.

**Aft>Filt** (Aftertouch▶Filter Cutoff) determines how much a connected MIDI keyboard’s aftertouch data affects the filter cutoff.
### Effects

**Inserts**

You can select up to four insert effects for each keygroup. To learn how to use insert effects, please see [General Features > Effects > Insert Effects](#).

**Important:** When using keygroup insert effects, they will be applied to that keygroup only. Keep this in mind if you load insert effects to multiple keygroups with overlapping note ranges—the effects will overlap in that range as well.

**To add an effect:**

1. Double-tap the desired **Inserts** slot. A list of effects will appear.
2. Swipe up or down to move through the list.
   - You can tap the **Type** and **Manufacturer** buttons to sort your effects by those categories.
3. **To load an effect,** double-tap it, or tap **Select**.
   - To close the list, tap **Close**.

**To remove an effect from its slot,** tap the trash can icon.

**To enable or disable the effect,** tap the **On/Off** button for the slot.

**To enable or disable all four insert effects,** tap the **All On/Off** button in the upper-right corner.
To adjust the effect's parameters, tap the pencil icon. Use the user interface or sliders to set the value of each parameter. These values affect only this instance of the effect; insert effects are not global.

Sends

The audio of the program will be routed to send effects (if you have any loaded) at their designated send levels. The return channels will then send the audio to an assigned master output at the designated return levels.

Use the Send knobs to set the volume level of the signal the program will route to each send effect.

You can select up to four send effects for each keygroup, but remember that they will be applied to that keygroup only. Keep this in mind if you load insert effects to multiple keygroups with overlapping note ranges—the effects will overlap in that range as well.

Important: To use a send effect, you have to load an effect into the corresponding send effect slot in the Channel Mixer. See Channel Mixer > Returns to learn more how to do this. To learn about send effects, please see General Features > Effects > Send/Return Effects.
Clip Programs

When using clip programs, Program Edit Mode lets you assign a sample (a loop called a clip) to each pad in a single bank. You can also edit various settings to determine how each pad launches its assigned clip.

To select a pad, press it. Its parameters will appear on the screen immediately.

To view a specific tab of parameters, tap Program or Pad the bottom of the screen. The Program tab is where you assign clips to pads (see Program below). The Pad tab is where you determine how each pad plays its clip (see Pad below).

Tap the location icon at the top of the screen (between the Program and Pad fields) to open the Edit Zones window, which is a feature for drum programs and clip programs. This window displays an overview of any selected pads. Use the Mode selector to set how the selected pads will be edited:

- **Current**: Only the currently selected pad can be edited.
- **Multiple**: All selected pads can be edited simultaneously.
- **All**: All pads can be edited simultaneously.

To close the window, tap Close, the X, or anywhere outside the window.
The automation button indicates the global automation state. This is shown in several modes. See General Features > Automation to learn about this.

The Settings window lets you configure certain Audio Edit Mode settings.

To view the Settings, tap the gear icon.

![Settings Window](image)

Use the Auto-Scroll selector to set how the screen behaves relative to the audio playhead while viewing the Pad tab.

- **Follow**: Depending on the zoom setting, the waveform display will scroll along in the background while keeping the audio playhead centered.
- **Page**: The waveform display will move to the “next page” to follow the audio playhead.
- **Off**: The waveform display will not move at all.

These functions also apply to the Grid View, Audio Edit Mode, List Edit Mode, and Sample Edit Mode.
Program
This tab is where you can assign clips to each pad and adjust the program’s overall tuning and quantization.

To assign a sample to a pad, press or tap a pad to select it (it will play its assigned samples, if any). Tap the Sample field, and then use the data dial or -/+ buttons to select a clip. Alternatively, double-tap the Sample field, and then tap a clip to select it.

To clear the assigned clip from a selected pad, assign a sample to a pad, but select None.

Coarse lets you transpose the program up to 36 semitones up or down.

Fine provides fine-tuning of the program up to 99 cents up or down.

Use the Launch Quantize field to set the quantization of the program in bars (or subdivisions of a bar).
The upper half of the screen shows the clip waveform. The lower half shows the editing controls.

The waveform display shows the “active” section of the clip waveform. Swipe left or right on the waveform to move through it.

Above the waveform is the timeline, shown in bars, beats, and ticks.

The green marker and red marker are the start point and end point (respectively). These two points define the region of the sample that will be played.

**To move the start point or end point of the selected region,** do any of the following:

- Tap and drag the **S** or **E** marker left or right.
- Use the **Start** or **End** fields shown below the waveform.
- Use the **first** row of **Q-Link knobs (Layer 1 Start)** to adjust the start point or the **second** row of **Q-Link knobs (Layer 1 End)** to adjust the end point. The right-most **Q-Link knobs** (12 and 16) provide coarse adjustment. The left-most **Q-Link knobs** (9 and 13) provide fine adjustment.

Use the **Zoom +** or **Zoom –** buttons at the bottom of the screen to zoom in or out (respectively) of the waveform.
Below is a brief step-by-step process so you can get familiar with setting up a clip. Continue reading the rest of this chapter to learn how to use the parameters in this window.

To assign and edit a clip:

1. Assign a sample to a pad using the **Program** tab (described earlier). For example, start with a four-bar drum loop.

2. In the **Pad** tab, note that the **BPM** field has a value, which is automatically detected.

   If the **Warp** button is not already on, tap it. The Warp function keeps the loop in time with the sequence tempo or the master tempo.

3. If you need to edit the loop’s tempo manually, do any of the following:
   - Tap the **BPM** field, and then use the data dial or +/- buttons to change the value.
   - Double-tap the **BPM** field, and then use the numeric keyboard that appears to enter a value.

4. Let’s shorten the loop to a two-bar loop by doing any of the following:
   - Tap and drag the start point (S) or end point (E) marker.
   - Tap the **beat**, **bar**, or **tick** value of the **Start** or **End** fields, and then use the data dial or +/- buttons to change the value.
   - Double-tap the **beat**, **bar**, or **tick** value of the **Start** or **End** fields, and then use the numeric keyboard that appears to enter a value.

   Set the locations properly to ensure the loop’s timing is correct—neither too short nor too long. When the loop repeats, it should feel seamless.

5. If the **Fade** button is not already on, tap it. This applies a very small fade-in and fade-out at the start and end of the clip to prevent “clicks” and glitches if start point or end point is not at a “zero-crossing.”

6. If you need to edit the loop’s pitch manually, do any of the following:
   - Tap the **Coarse** or **Fine** slider, and then use the data dial or +/- buttons to change the value.
   - Use **Q-Link Knobs 1 and 2** (Layer __ Semi Tune and Layer __ Fine Tune) to change the value of the **Coarse** or **Fine** sliders.
   - Double-tap the **Coarse** or **Fine** slider, and then use the numeric keyboard that appears to enter a value.

   The **Coarse** slider adjusts the pitch in semitones. The **Fine** value adjusts the pitch in cents. You will hear the pitch adjust in real time.
Tap **Warp** to lengthen or shorten the clip without changing its pitch, and use the **BPM** field to change the tempo. Use the **Coarse** and **Fine** sliders if you want to change the pitch.

Use the **Pad Play** field to determine how the clip is played.

- **One Shot:** When you press the pad, the entire clip will play from start to end and then stop.
- **Toggle:** When you press the pad, the entire clip will play from start to end and loop indefinitely. Pressing it again—or launching another in the same mute group—will stop its playback. This is the most common usage.

Use the **Pad Quantize** field to set the quantization of the pad in bars (or subdivisions of a bar). When set to **Program** so it uses the same quantization as the overall program (determined by the **Launch Quantize** field). When set to **Off**, the pad will not follow any quantization at all.

Tap **Reverse** to reverse the clip’s audio.

**Coarse** lets you transpose the pad up to 36 semitones up or down.

**Fine** provides fine-tuning of the pad up to 99 cents up or down.

Use the **Mute Group** field to assign the selected pad to one of the 32 available groups. When pads assigned to the same mute group receive MIDI notes, the last pad played will silence all other pads in that mute group. A mute group affects pads within that program only; mute groups do not affect pads in other programs.

By default, each column of pads is assigned to the same mute group. This means only one pad from each column can be playing its clip at a time. You can use the **Mute Group** field to configure this any way you like, though.

Use the **Fade** button to apply a very small fade-in and fade-out at the start and end of the clip. This can help prevent “clicks” and glitches that may occur if the start point or end point is not placed at the waveform’s “zero-crossings.”
Plugin Programs

For plugin programs, you will see a graphical representation of the plugin interface, or an overview of all available plugin parameters with a slider for each.

The automation button indicates the global automation state. This is shown in several modes. See General Features > Automation to learn about this.

Use the user interface or sliders to set the value of each parameter.

Use the six tabs at the bottom of the screen to access the available parameters.

To assign a parameter to one of the sliders, use the MPC software.

Note: To see the user guide in the MPC software and learn how to do this, click the Help menu, select MPC Help, and select MPC User Manual.
MIDI Programs

For MIDI programs, you will see an overview of all available MIDI CCs with a slider for each.

Use the sliders to set the value of each parameter.

Use the six tabs at the bottom of the screen to access the available parameters.

To assign a parameter to one of the sliders, use the MPC software.

Note: To see user guide in the MPC software and learn how to do this, click the Help menu, select MPC Help, and select MPC User Manual.
CV Programs

For CV programs, you will see an overview of all available CV outputs with a slider for each.

The automation button indicates the global automation state. This is shown in several modes. See General Features > Automation to learn about this.

Use the sliders to set the value of each parameter.

Use the six tabs at the bottom of the screen to access the available parameters.

To assign a parameter to one of the sliders, use the MPC software.

Note: To see user guide in the MPC software and learn how to do this, click the Help menu, select MPC Help, and select MPC User Manual.
Anatomy of an Envelope

An envelope creates a variable control signal. It can be used, for instance, to modulate the filter settings of a sound over a given period of time.

For drum programs, use the AD/AHDS selector to select an AD or AHDS envelope. When Sample Play is set to Note-On, it will use an ADSR envelope.

Keygroup programs always use AHDS envelopes. When Sample Play is set to Note-On, it will use an ADSR envelope.

With AHDS envelopes, the following happens when you trigger a sample:
1. Within the period of time you have defined with the attack (Atk), the sample volume rises to its maximum value.
2. The sample’s maximum volume will be maintained during the Hold phase.
3. During the Decay phase, the sample’s volume will gradually drop to the sustain level.
4. The sample’s volume will stay at the sustain level (Sust) until the pad is released.

With AD envelopes, the following happens when you trigger a sample:
1. Within the period of time you have defined with the attack (Atk), the sample volume rises to its maximum value.
2. The sample’s maximum volume will be maintained until its Decay phase, when the sample’s volume will gradually drop to zero over the set duration. Click the Type dropdown menu to select how the decay functions:
   - Decay From Start: The volume will start decreasing immediately after reaching its maximum level.
   - Decay From End: The maximum volume will be maintained for a hold phase until it reaches the decay phase.

With ADSR envelopes, the following happens when you trigger a sample:
1. Within the period of time defined by Attack, the sample volume rises to its maximum value.
2. During the Decay phase, the sample’s volume will gradually drop to the Sustain level.
3. The sample’s volume will stay at the Sustain level until the Release phrase begins.
4. The sample’s volume will drop to “zero” over the duration set by Release.
List Edit Mode has some of the features of the Grid View—as well as some additional ones—but with a different interface/workflow.

The time counter at the top of the screen indicates the current playhead position. This is shown in most of the modes. See **General Features > Time Counter/Locate** to learn about this.

The clock icon at the top of the screen opens the **Timing Correct** window. See **General Features > Timing Correct (TC)** to learn about this.

The **View** menu lets you select what type of events are shown in the list.

- **All**: Select this option to show all event types.
- **Notes**: Select this option to show only notes.
- **Aftertouch**: Select this option to show only aftertouch messages.
- **Track Automation**: Select this option to show only track automation events.
- **Program Automation**: Select this option to show only program automation events.
- **Pitch Bend**: Select this option to show only pitch bend events.
- **Control Change**: Select this option to show only MIDI CC messages.
- **Program Change**: Select this option to show only MIDI program change messages.
- **Ch Pressure**: Select this option to show only channel pressure messages.
- **Solo/Mute**: Select this option to show only solo and mute events for tracks, programs, and pads.
- **Other**: Select this option to show other types of events not listed above, such as pad or keygroup parameters.

The automation button indicates the global automation state. This is shown in several modes. See **General Features > Automation** to learn about this.
The **Settings** window lets you configure certain List Edit Mode settings.

**To view the Settings**, tap the **gear icon**.

Use the **Hitting Pad Selects All Events** selector to turn the feature on or off. When **On**, pressing a pad will automatically select all note events for that pad in the sequence on that track. When set to **Off**, pressing a pad will simply play its sound without selecting any note events.

Use the **Auto-Advance on Step Record** selector to turn the feature on or off. When set to **On**, pressing a pad when the track is record-armed will move the audio playhead forward by a length determined by the current **Time Division** setting in the **TC/Timing Correct** window. When set to **Off**, pressing a pad when the track is record-armed will not change the audio playhead position.

Use the **Auto-Scroll** selector to set how the screen behaves relative to the audio playhead.

- **Follow**: The list will scroll along in the background while keeping the audio playhead centered.
- **Page**: The list will move to the “next page” to follow the audio playhead.
- **Off**: The list will not move at all.

These functions also apply to the Grid View, Audio Edit Mode, and Sample Edit Mode.

<table>
<thead>
<tr>
<th>#</th>
<th>TIME</th>
<th>PAD/NOTE</th>
<th>LENGTH</th>
<th>VELOCITY</th>
<th>MOD TYPE</th>
<th>VALUE</th>
</tr>
</thead>
</table>

The sequence for the track will be shown as a list of events, with the following parameters:

- **#**: This is the number of the note event.
- **Time**: This is the position of the note event in bars, beats, and ticks. If multiple note events occur at the same time, additional note events will be listed immediately below, but their **Time** values will be grayed out.
- **Event Type**: This icon indicates the type of event (e.g., Note, Aftertouch, Track Automation, etc.). See the list of icons below showing the different types of events.
- **Pad/Note**: This is the pad and/or corresponding MIDI note number. For drum programs, you will see the pad number. For keygroup programs, plugin programs, and midi programs, you will see the note.
- **Length**: This is the length of the note event in ticks.
- **Velocity**: This is the velocity of the note event with its corresponding color.
- **Mod Type**: This is the type of modifier used on the note event via automation.
- **Value**: This is the value of the modifier automation.
The **red arrow** (▶) on the left side of the list represents the audio playhead's current position. If your sequence is playing, the arrow will move accordingly.

The following icons indicate the corresponding types of events:

<table>
<thead>
<tr>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>Track Mixer Automation (<em>Volume</em>, <em>Pan</em>, <em>Mute</em>, <em>Solo</em>)</td>
</tr>
<tr>
<td>Track MIDI CC Automation (0–127)</td>
</tr>
<tr>
<td>Track Parameter Automation (<em>Aftertouch</em>, <em>Pitchbend</em>, <em>Channel Pressure</em>, or <em>Program Change</em>)</td>
</tr>
<tr>
<td>Program Mixer Automation (<em>Volume</em>, <em>Pan</em>, <em>Mute</em>, <em>Solo</em>, or <em>Send 1–4</em>)</td>
</tr>
<tr>
<td>Program Parameter Automation (options vary based on the type of program)</td>
</tr>
<tr>
<td>Program Insert Effect Automation (options vary based on the effect)</td>
</tr>
<tr>
<td>Pad/Keygroup Mixer Automation (<em>Level</em>, <em>Pan</em>, <em>Pad Mute</em>, <em>Pad Solo</em>, or <em>Send 1–4</em>)</td>
</tr>
<tr>
<td>Pad/Keygroup Parameter Automation (options vary based on the type of program)</td>
</tr>
<tr>
<td>Pad/Keygroup Insert Effect Automation (options vary based on the effect)</td>
</tr>
</tbody>
</table>
To select an event, tap it.

To select multiple events, press and hold **Shift** and tap each event.

To insert a note event, press **Rec** or **Overdub** so the button is lit, and then press a **pad**. A note event will be created at the current location using the pad you pressed. You can keep pressing additional pads, which will continue to insert each press as a single note event in the order you pressed them (similar to a step sequencer). Press **Stop** to exit this function.

**Note:** Depending on the **Auto-Advance on Step Record** setting, the current time position will either advance each time you press a pad or remain in place. See the earlier description of **Auto-Advance on Step Record** to learn about this.

To edit the Pad/Note, Length, or Velocity or numeric Value of an event, tap the value to select it, and then use the **data dial** or –/+ buttons to change the value. Alternatively, double-tap it and use the numeric keypad that appears to enter a value (for **Length**, **Velocity**, or numeric **Value** only).

To edit the Length of an event according to your **Timing Correct** settings, tap the value to select it, and then press and hold **Shift** and use the **data dial** or –/+ buttons to change the value.

To shift the Pad/Note of an event by pad bank, tap the value to select it, and then press and hold **Shift** and use the **data dial** or –/+ buttons to change the pad bank.

To turn a Solo/Mute event on or off, tap the desired setting on the **On/Off** switch. Alternatively, tap the **On/Off** switch to select it, and then use the **data dial** or –/+ buttons to change the value.

To move an event, tap it to select it, tap **Nudge** at the bottom of the screen, and then use the **data dial** or –/+ buttons to shift the event up or down. Repeat this for other events, or tap **Nudge** again to turn the feature off.

To move an event according to your **Timing Correct** settings, tap the **Time** value to select it, and then press and hold **Shift** and use the **data dial** or –/+ buttons to change the value.

To play an event, tap it to select it, and then tap **Play (▶)** at the bottom of the screen. This works with note events only.

To delete an event, tap it to select it, and then tap **Delete** at the bottom of the screen.
The Browser lets you navigate your MPC hardware's internal and external hard disks to load samples, sequences, songs, etc. Using filter buttons and user-definable folders, you can easily adapt it to your preferred workflow. You can also audition (preview) your samples before loading them.

**Important**: You can install an additional SATA drive in your MPC hardware, allowing for even more storage space. See Appendix > SATA Drive Installation to learn more about this.

**Important**: MPC X and MPC Live support read and write capability for exFAT, FAT32, NTFS, and EXT4 file systems as well as read-only capability for HFS+ file systems. We recommend using an exFAT file system as it is the most robust one supported by both Windows and macOS.

To show the Browser, do any of the following:

- Press **Menu** and then tap **Browser**.
- Press **Browse** (MPC X) or **Shift+Menu/Browse** (MPC Live, MPC Touch).

To browse for files, tap **Browse** in the lower-left corner. See the **Browse** section to learn about this.

To view the project's sample pool and pads, tap **Sample Assign** in the lower-left corner. See the **Sample Assign** section to learn about this.

### Browse

When the **Browse** tab is selected, you can do any of the following:

**To browse your files by location**, tap **Places** on the left side of the screen.

- **Internal** is the internal drive of MPC X or MPC Live.
- **MPC Documents** is a shortcut to the **MPC Documents** folder on the internal drive of MPC X or MPC Live.
- If you have storage devices connected to USB ports or SD card slot of MPC X, MPC Live, or your computer (with MPC Touch), they will appear in this column, as well.

**To browse your files by content**, tap **Content** and then tap the type of file: **Drums**, **Instruments**, **Clips**, **Samples**, **Demos**, or **My Files** (see **below** to learn about these content buttons).

**To browse your MPC Expansions** (MPC X or MPC Live only), tap **Expansions** (see Addenda > Updates for MPC 2.1 > New Features > Exporting Expansions to learn how to export MPC Expansions from your computer to your MPC X or MPC Live).

**To move up one folder level**, tap the folder/'icon in the upper-left corner.

**To move through a list**, swipe up or down, turn the **data dial** or use the −/+ buttons.

**To select a file or folder**, tap it once.
To enter a folder, double-tap it or tap Open in the lower-right corner. Alternatively, press the center cursor or Enter (MPC X) or the data dial (MPC Live, MPC Touch) to enter a selected folder. You can also tap one of the folder buttons (1–5) in the upper-right corner to jump immediately to those pre-assigned file paths (see below to learn how to assign these file paths).

To load a selected file, double-tap it, tap Load, or press the center cursor or Enter (MPC X) or the data dial (MPC Live, MPC Touch). If the file is a sample, it will be loaded to the project’s sample pool. If the file is a project, it will be loaded in its entirety (you will be asked if you want to close your current project).

To load all files in a folder, select the folder (so it is highlighted in the list), press and hold Shift, and then tap Load All in the lower-right corner.

Important: Although you can load multiple files at once, any samples you load into a project will be automatically converted to full-quality uncompressed audio files, so they may use more storage space than they do on your external storage device. If you are unable to load multiple files at once due to this, select fewer files and try again.

To delete a selected file or folder, press and hold Shift and then tap Delete File at the bottom of the screen.

To preview a selected sound, tap and hold Play (▶) at the bottom of the screen.

To enable or disable the audition function and set its volume level, tap Audition at the bottom of the screen. In the screen that appears, tap Auto to enable or disable it, and tap and drag the level slider up or down to set the volume level. Use the Sync and Warp buttons to audition samples and loops in time with your sequence. See Addendum > Updates in MPC 2.5 for more information. Tap Audition once more to hide the window.

To show the information for the current storage device, press and hold Shift and then tap Drive Info at the bottom of the screen. The drive’s information will appear in a new window. Tap OK to return to the previous screen.

To format a storage device to use an exFAT file system, select it in the Browser, press and hold Shift and then tap Format Drive at the bottom of the screen. In the window that appears, tap OK and then Format in the next window to format the device, or tap Cancel to return to the previous screen without formatting. This formatting process will set the device to use the exFAT file system, remove any partitions from the drive, and erase all of its content. (Devices that are uninitialized or do not have a file system will not be recognized by the MPC hardware and consequently cannot be formatted.)

To get the most efficient use of the Browser, set the file paths to your favorite drive locations first. There are five folder buttons labeled 1–5 in the upper-right corner. You can set these to be shortcuts to five locations on your MPC hardware’s internal drive and/or any connected storage devices, giving you quick access to your files.

To assign the current location to a folder button, press and hold Shift, and then tap one of the folder buttons (1–5). Now, when you tap that folder button again, the Browser will show that folder’s content immediately.

Use the six filter buttons to show only specific types of files in the list below. Folders will still be shown in the list.

To show project files only, tap the P/page icon.

To show sequence files only, tap the bars icon.

To show program files only, tap the four-squares icon.

To show sample files only, tap the waveform icon.

To show all file types, tap the three-pages icon.

To show or hide MPC project folders, tap the MPC folder icon.
Use the six Content buttons to show specific locations in the internal drive of MPC X or MPC Live and filter them automatically by file type:

**Drums:** Tap this button to enter the Expansions/The Vault 2 folder on the internal drive, viewing program files only.

**Instruments:** Tap this button to enter the Expansions/Instruments folder on the internal drive, viewing program files only.

**Clips:** Tap this button to enter the Expansions/Clips folder on the internal drive, viewing program files only.

**Samples:** Tap this button to enter the Expansions/The Vault 2 folder on the internal drive, viewing sample files only.

**My Files:** Tap this button to enter the MPC Documents folder, viewing all files.

**Splice:** Tap this button to view samples synced from a paired Splice account. See Addendum > Updates in MPC 2.5 for more information.

---

**Sample Assign**

When the Sample Assign tab is selected, you can do any of the following:

**To select a program in the project,** double-tap the Program field at the top of the screen. In the list that appears, tap the desired program. Alternatively, tap the Program field and then use the data dial or the −/+ buttons to select a location.

**To move through the sample pool,** swipe up or down, turn the data dial, or use the −/+ buttons.

**To preview a selected sound,** tap and hold Play (▶) at the bottom of the screen.

**To enable or disable the audition function and set its volume level,** tap Audition at the bottom of the screen. In the screen that appears, tap Auto to enable or disable it, and tap and drag the level slider up or down to set the volume level. Tap Audition once more to hide the window.

**To assign a sample to a pad,** press it or tap it on the screen so it lights green. Then, in the Sample Pool list, tap the desired sample. Alternatively, use the data dial or −/+ buttons to select a sample, and press the center cursor or Enter (MPC X) or the data dial (MPC Live, MPC Touch) to assign it.

**To clear a sample from a pad,** press it or tap it on the screen so it lights green. Then, tap Clear Pad at the bottom of the screen.
The Sampler lets you record audio samples to use in your projects.

**Important:** To record any audio, you need to connect an audio source to your MPC hardware or to your computer’s audio interface.

To open the Sampler, do either of the following:

- Press **Menu** and then tap **Sampler**.
- Press **Sampler** (MPC X).

To set up the Sampler before recording:

1. Make sure to reduce the volume levels of your audio source and speakers, headphones, and/or monitors before you make any connections to avoid “pops” or feedback.
2. Connect a synthesizer or other line-level audio source to the input/inputs of your MPC hardware.
3. Turn the **3/4 Rec Gain** (MPC X) or **Rec Vol** (MPC Live, MPC Touch) knob to set the input level while playing your audio source. You should now see the level in the meter. Make sure it does not exceed the maximum level (the meter should not be “peaking” constantly).
4. Set the recording controls as desired (described in this chapter).
5. Tap the **Arm** button to record-arm the Sampler.

You can use the Sampler to record using four different methods: **Sample**, **Slice**, **Pad Tap**, or **Pad Hold**, all described later in this chapter. The following controls are present regardless of which method you use.

The Sampler page also contains the Auto Sampler, which lets you capture and convert any plugin preset or external instrument preset into a Keygroup sampler patch. See Addenda > Updates in MPC 2.3 > New Features > Auto Sampler for more information.

The time counter in the upper-right corner shows the current playhead position. This is shown in most of the modes. See General Features > Time Counter/Locate to learn about this.
The upper-left **Input Source** field defines whether you are going to record an external audio signal, which you can set to a pair of inputs (Input 1,2–3,4 in Standalone Mode, Input 1,2–31,32 in Controller Mode) or a single input (Input 1–4 in Standalone Mode, Input 1–32 in Controller Mode). You can also select an internal signal from within your MPC hardware (Resample L, Resample R, or Resample L+R).

Resampling does not require an audio connection because the source is internal and is therefore recorded without any loss in audio quality. You can, for example, use Resample to record two or more samples by pressing the corresponding pads simultaneously.

Use the second upper-left **Mono/Stereo** field to choose whether your recorded samples will be monaural (Mono) or binaural (Stereo).

The **Inserts** field shows any enabled or disabled effects for the Sampler. Tap the area under **Inserts** to open a window where you can load, change, and enable or disable the effects.

**Important**: These effects are applied to the audio as you record it. This means that the effects cannot be “removed” from the sound later. Learn more about how effects work in **General Features > Effects**.

Tap the **Monitor** button to enable or disable input monitoring. When on, the audio you hear in your headphones will be taken before it reaches the Sampler, ensuring zero latency. When off, the audio you hear in your headphones will be taken after it is processed in the Sampler, so there may be some latency, but you will hear the audio source as it sounds in the recording.

**Tip**: To avoid possible clicks or feedback while input monitoring, reduce the level of the audio sources.

Use the threshold slider to adjust the threshold. Alternatively, turn Q-Link Knob 1 (MPC X) or the first Q-Link knob in the fourth column (MPC Live, MPC Touch).

When the Sampler is record-armed, it automatically starts recording when the level of the incoming source exceeds this setting. If you set it too high, the recording may not start when you play the input source, or the start of the material you wanted to record may be missing. If you set it too low, the recording may start too early, before you play the external source. Set this parameter to an appropriate level using the level meter.

**To reset the “peak hold,”** which shows the highest level of your input signal in the level meter, tap it.
For reference, the **Sample Length** counter shows you the length of your sample during the recording procedure.

Tap **Arm** to record-arm the Sampler. The button will then change to **Record** and show **Waiting for signal**.

At that point, start recording by doing either of the following:

- Start performing so that the incoming audio level exceeds the level of the **threshold slider**.
- Tap **Record** under the **Sample Length** counter.

**To disarm the track instead**, tap **Cancel**.

Use the **Max Length** field to define the maximum sampling time. Alternatively, turn the **Q-Link Knobs 3 and 4** (MPC X) or the **third and fourth Q-Link knobs** in the **fourth column** (MPC Live, MPC Touch): **Minutes** and **Seconds**.

You can record up to 19 minutes and 59 seconds (19:59) per sample. We recommend setting these to values that roughly match your estimated recording duration.
Sample

Using this method, you can insert slice markers directly in your sample as you record it.

Slice markers divide the sample into multiple regions called slices, which you can adjust in the Chop Mode of Sample Edit Mode (see Sample Edit Mode > Chop Mode for more information). This is useful when working with a long sample with different sounds throughout (e.g., a drum loop or a long melodic or harmonic passage).

To start recording, do one of the following:

- Start performing so that the incoming audio level exceeds the level of the threshold slider.
- Tap Record under the Sample Length counter.

To insert a slice marker in a sample while recording, tap Slice+ (in the lower-right corner) as the sample records. Each time you tap it, a slice marker will be placed at that location.

To stop recording, tap Stop under the Sample Length counter.
After you stop your recording, the **Keep or Discard Sample** window will appear.

Use the **Edit Name** field to name the new sample. Tap it and use the virtual keyboard that appears.

Use the **Program** field to assign the new sample to a program. Select `<none>` if you want to save it to the project without assigning it to a program.

Use the **Assign to Pad** field to assign the sample to a pad in the program.

Use the **Root Note** field to set where the sample's original pitch will be on the keyboard.

If you recorded a sample while a sequence was playing, the **Keep or Discard Sample** window will show a few more options after you select a pad.

- Check the **Add Event** box to automatically add the sample to the currently playing sequence.
- Use the @ field to select where you want the event to start:
  - **Start**: The sample will be a note event at the start of the currently playing sequence.
  - **Trigger**: The sample will be a note event where you began recording it in the currently playing sequence.
- Use the **Track** field to set which track will contain the new event.

**To confirm your selections**, tap **Keep** at the bottom of the screen.

**To discard the recording and return to the Sampler**, tap **Discard** at the bottom of the screen.

**To play the recording**, tap **Play** at the bottom of the screen.

**Tip**: We recommend editing your recorded sample in **Sample Edit Mode** (see **Sample Edit Mode** for more information).
Slice

Using this method, the pads correspond to slices of the currently recorded sample. Slice markers divide the sample into multiple regions called slices, which you can adjust in the Chop Mode of Sample Edit Mode (see Sample Edit Mode > Chop Mode for more information). This is useful when working with a long sample with different sounds throughout (e.g., a drum loop or a long melodic or harmonic passage).

To start recording, do one of the following:

- Start performing so that the incoming audio level exceeds the level of the threshold slider.
- Tap Record under the Sample Length counter.

To insert a slice marker in a sample while recording, press any pad as the sample records. Each time you press it, a slice marker will be placed at that location.

The number of the pad that flashes red is the number of the slice marker that will be inserted next. The numbers of the pads that are lit yellow are the numbers of the slice markers that are already inserted.

When you are done recording, you can name the sample and create a new program using the slices.

To stop recording, tap the round Stop button.

After you stop your recording, the Keep or Discard Sample window will appear.

Use the Edit Name field to name the new sample. Tap it and use the virtual keyboard that appears. Otherwise, the process will add a consecutive number after the sample name.
Use the **Create New Program** field to assign the new sample to a new program:

- **Off**: No program will be created. The slices will still be added to your project’s sample pool.

- **With Non-Destructive Slices**: In the new program, each pad’s **Slice** setting will be set to the corresponding slice number. This is identical to how you can assign samples in Sample Edit Mode (as described in *Sample Edit Mode > Chop Mode > Converting or Assigning Slices*).

- **With Pad Parameters**: In the new program, each pad’s **Slice** setting will be set to **Pad**. The **Pad Start** and **Pad End** will be set to the slice’s start point and end point values, and the **Loop Position** will be set to the slice’s start point but with **Pad Loop** deactivated. This is identical to how you can assign samples in Sample Edit Mode (as described in *Sample Edit Mode > Chop Mode > Converting or Assigning Slices*).

To confirm your selections, tap **Create** or **Keep** at the bottom of the screen.

To discard the recording and return to the Sampler, tap **Discard** at the bottom of the screen.

To play the recording, tap **Play** at the bottom of the screen.

**Tip**: We recommend editing your recorded sample in *Sample Edit Mode* (see *Sample Edit Mode* for more information).

---

**Pad Tap**

**Important**: This mode works for **drum programs only**; you must select a drum program before using this mode. Otherwise, this feature will not do anything, even though it may appear to work.

With this method, pressing a pad immediately starts or continues recording directly to that pad (make sure you are using the desired program before you start recording). Pads with assigned samples are lit **bright yellow**. Pads without samples are lit **dim yellow**.

**To start recording to a pad**, press it. Recording will start immediately, and the pad will flash **red**. If you press a new pad, the recording will stop on the previous pad, which will turn **green**, and start on the new pad, which will flash **red**.

**Note**: If you start recording by tapping **Record** under the **Sample Length** counter—or if the volume exceeds the level of the **threshold slider**—the sample will record to your project’s sample pool, not to a pad.

**To stop recording to a pad**, press the currently recording **pad**, which is flashing **red**. The sample will continue recording. You can start recording on another **pad** at any time.

**To stop all recording**, tap **Stop** under the **Sample Length** counter.

When you are done recording, each pad that you have pressed during recording:

- will have its **Slice** setting set to **Pad**;
- will have its **Pad Start** and **Pad End** set to the slice’s start point and end point values; and
- will have its **Loop Position** set to the slice’s start point but with **Pad Loop** deactivated.

This is identical to how you can assign samples in Sample Edit Mode (as described in *Sample Edit Mode > Chop Mode > Converting or Assigning Slices*).

**Tip**: We recommend editing your recorded sample in *Sample Edit Mode* (see *Sample Edit Mode* for more information).
Pad Hold

**Important:** This mode works for drum programs only; you must select a drum program before using this mode. Otherwise, this feature will not do anything, even though it may appear to work.

With this method, pressing and holding a pad immediately starts or continues recording directly to that pad (make sure you are using the desired program before you start recording). Pads with assigned samples are lit **bright yellow**. Pads without samples are lit **dim yellow**.

To start recording to a pad, press and hold it. Recording will start immediately, and the pad will light **red**.

**Note:** If you start recording by tapping **Record** under the **Sample Length** counter—or if the volume exceeds the level of the **threshold slider**—the sample will record to your project's sample pool, not to a pad.

To stop recording, release the pad. The pad will light **green**, and the sample will continue recording. You can start recording on another pad at any time.

To stop all recording, tap **Stop** under the **Sample Length** counter.

When you are done recording, each pad that you have pressed during recording:

- will have its **Slice** setting set to **Pad**;
- will have its **Pad Start** and **Pad End** set to the slice's start point and end point values; and
- will have its **Loop Position** set to the slice's start point but with **Pad Loop** deactivated.

This is identical to how you can assign samples in Sample Edit Mode (as described in **Sample Edit Mode > Chop Mode > Converting or Assigning Slices**).

**Tip:** We recommend editing your recorded sample in **Sample Edit Mode** (see **Sample Edit Mode** for more information).

Auto Sampler

See **Addenda > Updates in MPC 2.3 > New Features > Auto Sampler** for more information.
Looper

The Looper lets you record and overdub audio in real time—a great tool for live performance as well as spontaneous moments in the studio. You can export the loop as a sample to use in your project.

To open the Looper, do either of the following:

- Press Menu, and then tap Looper.
- Press Shift+Sampler/Looper (MPC X).

Below is a brief step-by-step process so you can get started quickly. Continue reading the rest of this chapter to learn how to use the Looper in different cases.

To get started using the Looper:

1. Make sure to reduce the volume levels of your audio source and speakers/headphones/monitors before you make any connections to avoid “pops” or feedback.
2. Connect a synthesizer, audio player, etc. to the input/inputs of your MPC hardware.
3. Turn the 3/4 Rec Gain (MPC X) or Rec Vol (MPC Live, MPC Touch) knob to set the input level while playing your audio source. You should now see the level in the meter. Make sure it does not exceed the maximum level (the meter should not be “peaking” constantly).
4. Set the recording controls as desired (described in this chapter).
5. Tap the Record To selector so Overdub is selected.
6. Tap the Rec/Record button in the lower-right corner to record-arm the Looper.
7. Play your audio source. The Looper will start recording immediately when the input level reaches the threshold value. Alternatively, tap ▶/Play at the bottom of the screen to manually start recording.
   
   Each time the Looper repeats, its contents are being overdubbed—a new layer of audio will be added each time you let the Looper repeat as it records.
   
   **Tip:** You can record a loop while playing a sequence in the background for reference.
8. **To stop recording,** tap ▶/Play at the bottom of the screen.
   
   **To export your loop as a sample,** tap Export to open the Keep or Discard Sample window.
   
   **To clear the contents of the Looper,** tap Clear.
The time counter at the top of the screen indicates the current playhead position. This is shown in most of the modes. See General Features > Time Counter/Locate to learn about this.

The upper-left Input Source field defines whether you are going to record an external audio signal, which you can set to a pair of inputs (Input 1,2–3,4 in Standalone Mode, Input 1,2–31,32 in Controller Mode) or a single input (Input 1–4 in Standalone Mode, Input 1–32 in Controller Mode). You can also select an internal signal from within your MPC hardware (Resample L, Resample R, or Resample L+R).

Resampling does not require an audio connection because the source is internal and is therefore recorded without any loss in audio quality. You can, for example, use Resample to record two or more samples by pressing the corresponding pads simultaneously.

Use the second upper-left Mono/Stereo field to choose whether your recorded loop will be monaural (Mono) or binaural (Stereo).

The Inserts field shows any enabled or disabled effects for the Looper. Tap the area under Inserts to open a window where you can load, change, and enable or disable the effects.

Important: These effects are applied to the audio as you record it. This means that the effects cannot be “removed” from the sound later. Learn more about how effects work in General Features > Effects.

Tap the Monitor button to enable or disable input monitoring.

When on, the audio you hear in your headphones will be taken before it reaches the Looper, ensuring zero latency. You can turn input monitoring on only if the Input Source field is set to an input, not to a Resample setting.

When off, the audio you hear in your headphones will be taken after it is processed in the Looper, so there may be some latency, but you will hear the audio source as it sounds in the recording.

Tip: To avoid possible clicks or feedback while input monitoring, reduce the level of the audio sources.

Use the threshold slider to adjust the threshold. Alternatively, turn Q-Link Knob 1 (Threshold on MPC X) or the first Q-Link knob in the fourth column (MPC Live, MPC Touch). The threshold slider will work only when Sync is off (see below).

When the Looper is record-armed, it automatically starts recording when the level of the incoming source exceeds this setting. If you set it too high, the recording may not start when you play the input source, or the start of the material you wanted to record may be missing. If you set it too low, the recording may start too early, before you play the external source. Set this parameter to an appropriate level using the level meter.

To reset the “peak hold,” which shows the highest level of your input signal in the level meter, tap it.
Use the **Bars** field to define the length of your loop. Regardless of how much or how little audio you record, this is how long your loop will be.

Use the **Sync** button to sync or un-sync the looper with sequence playback. When on, the Looper will stay in step with your current sequence. When you play or record into the Looper, it will wait until the sequence starts playing Bar 1 to start.

Use the **Record To** selector to determine the loop recording behavior:

- **Play**: Before recording, you must first tap the ➤/Play button on the screen, which will start playing the Looper.
- **Overdub**: Before recording, you must first tap the Rec/Record button in the lower-right corner to record-arm the Looper.

Use the **Output Gain** slider to set the output signal level of the Looper.
To record with the Looper:

Important:

To record without erasing any audio you’ve already recorded in the loop, use the Overdub button. To overwrite the audio you’ve already recorded, use the Replace button.

If Record To is set to Play:

To start recording, tap the Replace or Overdub button as the loop is playing. The Looper will start recording immediately.

To stop recording, tap the Replace or Overdub button. The Looper will stop recording but continue playing.

To stop playback and recording, tap the ▶/Play button.

If Record To is set to Overdub:

To start recording, tap the ▶/Play button on the screen.

If Sync is off, you can also play your audio source so that the input level reaches the threshold value.

If Sync is on, you can also press the Play or Play Start button to start playing a sequence; recording will start when the sequence starts on Bar 1.

To stop recording, tap Overdub. The Looper will stop recording but continue playing.

To stop playback and recording, tap the ▶/Play button, or press Stop to stop sequence playback.

To play or stop the loop (without recording), tap the ▶/Play button on the screen.

To reverse loop playback, tap Reverse. If Sync is on, playback will reverse once the Looper’s playhead reaches the end of the loop. If Sync is off, playback will reverse immediately.

To erase the loop immediately, tap Clear.
To export the loop as a sample:

1. Tap Export to open the Export Loop as a Sample window.
2. Tap the Edit Name field and use the virtual keyboard that appears to enter a new name.
3. Optional: Use the Program field to assign it directly to a program. To ignore this feature, select <none>.
4. Optional: If you’re assigning the sample to a program, use the Assign to Pad field to assign it to a specific pad. Alternatively, just press the pad. To ignore this feature, select Off.
5. Use the Root Note field to select the sample’s root note.
6. Optional: Tap and hold your finger on Play to play the sample.
7. Tap Do It to confirm your choice, or Cancel to cancel.

When your loop is done exporting, it will be added to your project’s sample pool with the name you entered and will be assigned to the program and pad you selected (if any).
In the Pad Mixer, you can set a program’s levels, stereo panning, routing, and effects.

This mode appears differently for each type of program:

- For **drum programs**, this mode shows a pad with controls for each individual pad (of 128).
- For **keygroup programs**, this mode shows a pad with controls for each individual keygroup (up to 128).
- For **clip programs**, this mode shows a pad with controls for each individual clip (up to 16). Even though you can view other pad banks, only **Pad Bank A** is relevant for clip programs.
- For **MIDI programs**, **plugin programs**, and **CV programs**, this mode is unavailable.

For more information on how these programs differ, please see *General Features > Programs*.

**To enter the Pad Mixer**, do either of the following:

- Press **Menu**, and then tap **Pad Mixer**.
- Press **Pad Mixer** (MPC X).

The Pad Mixer works like an audio mixer with various settings for each pad, shown in a 4x4 array. All of their functionality is identical. If a sample has been assigned to a pad, its name is displayed at the top of it.

**To select a pad**, press its corresponding pad or tap it on the screen. Alternatively, use the numbered **Pad** field in the upper-left corner.

**To view more channels**, use the **Pad Bank** buttons.
Use the **Program** field in the upper-left corner to select the program whose pads you want to view. Remember that only drum programs, keygroup programs, or clip programs will display properly in the Pad Mixer.

Use the **Track** field at the top of the screen to select the desired track.

The time counter in the upper-right corner the current playhead position. This is shown in most of the modes. See *General Features > Time Counter/Locate* to learn about this.

The automation button indicates the global automation state. This is shown in several modes. See *General Features > Automation* to learn about this.

**To view a specific setting on all channels**, tap the **Level**, **Pan**, **Mute**, **Send**, **Insert**, or **Route** button at the bottom of the screen. You can tap the **Send** or **Insert** buttons multiple times to cycle through the four available slots for each.

When a pad is selected, you can view and adjust all of its settings in the left side of the screen rather than using the tab buttons at the bottom.

When viewing the channel strip:

- The first field shows the current pad number. Press a pad or double-tap the **field** to select a different pad.

- The second field shows where the pad is routed, which you can change: **Program** (the usual setting); **Out 1,2–7,8, Out 1–8 or Sub 1–8** in Standalone Mode; and **Out 1,2–31,32 or Out 1–32** in Controller Mode.

  **Note**: When set to a mono channel, the left and right channels are summed post-pan knob. If the pan knob is set to the center position, the left and right channels will be summed and padded. If the pan knob is set to the maximum left or right positions, only the respective channel will be sent to the output.

- The **Inserts** field shows any enabled or disabled effects for that pad. Tap the area under **Inserts** to open a window where you can load, change, and enable or disable the effects.

- Tap **Solo** or **Mute** to solo or mute the pad (respectively).

- Adjust the **pan knob** or **level slider** to change the panning or level of the pad.
Levels

When the **Level** tab is selected, use the **data dial** or −/+ buttons to adjust the level of the currently selected pad. The level sliders and meters in each pad show a visual representation of the level. Double-tap a **pad** on the screen to open a large version of the level slider and meter.

Panning

When the **Pan** tab is selected, use the **data dial** or −/+ buttons to adjust the panning of the currently selected pad. The pan sliders in each pad show a visual representation of the level. Double-tap a **pad** on the screen to open a large version of the **pan knob**.
Mute

When the **Mute** tab is selected, mute the currently selected pad by doing any of the following:

- Turn the **data dial**.
- Use the `-/+` buttons.
- Tap the **pad** on the screen.

When a pad is muted, its **M** button will light **red**.

Send Effects

When the **Send** tab is selected, use the **data dial** or `-/+` buttons to adjust the send level of the currently selected pad. The level sliders in each pad show a visual representation of the level. Double-tap a **pad** on the screen to open a large version of the level slider.

You can select up to **four send effects** for each pad. You can use various effects included in your MPC hardware as well as other VST and AU plugins installed on your computer. Tap the **Send** button to cycle through the four available slots for each.

To learn how to use send effects, please see **General Features > Effects > Send/Return Effects**.

**Important:** To use a send effect, you have to load an effect into the corresponding send effect slot in the Channel Mixer.
Insert Effects

When the Insert tab is selected, use the data dial or −/+ buttons to open a window where you can select an effect for the currently selected pad.

Instead of level sliders, there are fields that display 0–4 boxes to indicate which insert slots have a loaded effect.

The level meters in each pad show a visual representation of the level. Double-tap a pad on the screen to open a window where you can load, change, and enable or disable the effects for all four insert slots.

You can select up to four insert effects for each pad. You can use various effects included in your MPC hardware as well as other VST and AU plugins installed on your computer. Tap the Insert button to cycle through the four available slots for each.

To learn how to use insert effects, please see General Features > Effects > Insert Effects.

Important:

When using keygroup insert effects, they will be applied to that keygroup only. Keep this in mind if you load insert effects to multiple keygroups with overlapping note ranges—the effects will overlap in that range as well.

If a routing is set to anything other than Program, then a program insert effect will not be applied to that pad or keygroup.

Routing

When the Route tab is selected, use the data dial or −/+ buttons to select the output of the currently selected pad.

Usually, this is set to Program. Double-tap a pad on the screen to select a different destination: Out 1–8, Out 1–8 or Sub 1–8 in Standalone Mode; and Out 1,2–31,32 or Out 1–32 in Controller Mode.

Note: When set to a mono channel, the left and right channels are summed post-pan knob. If the pan knob is set to the center position, the left and right channels will be summed and padded. If the pan knob is set to the maximum left or right positions, only the respective channel will be sent to the output.
In the Channel Mixer, you can set levels, stereo panning, and other settings for your tracks, programs, returns, submixes and masters.

To open the Channel Mixer, do either of the following:
- Press Menu, and then tap Channel Mixer.
- Press Ch. Mixer (MPC X).

The Channel Mixer works like an audio mixer with various settings for each channel, shown in a 4x4 array. Their functionality is mostly identical. The name of the track, program, or channel is displayed at the top of each one.

Use the Mixer field at the top of the screen to select which mixer you want to view: MIDI Tracks, Audio Tracks, Programs, Returns, Submixes, or Masters. Each page has slight differences, described in each section.

The following controls and tabs are available for all of the mixers (or most of them, as indicated).

To select a channel, tap its corresponding pad on the screen. Alternatively, use the field in the upper-left corner.

To view more channels (while viewing tracks or programs), use the +/- buttons at the top of the screen.

The time counter in the upper-right corner the current playhead position. This is shown in most of the modes. See General Features > Time Counter/Locate to learn about this.

The automation button indicates the global automation state. This is shown in several modes. See General Features > Automation to learn about this.
Levels

When the Level tab is selected, use the data dial or +/ buttons to adjust the velocity level or volume level of the currently selected track, program, return, submix, or master.

The level sliders and meters in each pad show a visual representation of the level. Double-tap a pad on the screen to open a large version of the level slider and meter.

Panning

When the Pan tab is selected, use the data dial or +/ buttons to adjust the panning of the currently selected track, program, return, submix, or master.

The pan sliders in each pad show a visual representation of the level. Double-tap a pad on the screen to open a large version of a pan knob.

Mute/Solo/Rec Arm

Tap this tab to cycle it through Mute, Solo, and Rec Arm functions.

When Mute is selected, mute tracks, programs, returns, submixes, or masters by doing any of the following:

- Turn or press the center cursor or Enter (MPC X) or the data dial (MPC Live, MPC Touch).
- Use the +/ buttons.
- Tap the pad on the screen.
- Turn each of the Q-Link knobs to mute or unmute each of the pads.

When a track, program, return, submix, or master is muted, its M button will light red.

When Solo is selected, solo tracks, programs, returns, submixes, or masters by doing any of the following:

- Turn or press the center cursor or Enter (MPC X) or the data dial (MPC Live, MPC Touch).
- Use the +/ buttons.
- Tap the pad on the screen.
- Turn each of the Q-Link knobs to solo or unsolo each of the pads.

When a track, program, return, submix, or master is soloed, its S button will light green while other tracks are muted with their M buttons lit red.

The Solo tab is available for tracks and programs only.

When Rec Arm is selected, record-enable audio tracks by doing any of the following:

- Turn or press the center cursor or Enter (MPC X) or the data dial (MPC Live, MPC Touch).
- Use the +/ buttons.
- Tap the pad on the screen. Press and hold Shift while tapping a pad on the screen to record-enable multiple tracks at once.
- Turn each of the Q-Link knobs to record-arm or disarm each of the pads.

The Rec Arm tab is available for audio tracks only.
Send Levels (audio tracks, programs, and submixes only)

When the Send tab is selected, use the data dial or –/+ buttons to adjust the send level of audio tracks, programs, or submixes.

The level sliders in each pad show a visual representation of the level. Double-tap a pad on the screen to open a large version of the level slider.

You can use up to four send channels. Tap Send to cycle through the four available slots for each.

To learn how to use send effects, please see General Features > Effects > Send/Return Effects.

Important: When using send channels, make sure you have already loaded at least one effect to it using the return mixer. See Returns below to learn how to do this.

Insert Effects (audio tracks, programs, returns, submixes, and masters only)

When the Insert tab is selected, use the data dial or –/+ buttons to open a window where you can select an effect for the currently selected audio track, program, return, submix, or master.

Instead of level sliders, there are fields that display 0–4 boxes to indicate which insert slots have a loaded effect.

The level meters in each pad show a visual representation of the level. Double-tap a pad on the screen to open a large version of the level slider.

You can select up to four insert effects for each audio track, program, return, submix, or master. Tap the Insert button to cycle through the four available slots for each.

To learn how to use insert effects, please see General Features > Effects > Insert Effects.

Routing (audio tracks, programs, returns, and submixes only)

When the Route tab is selected, use the data dial or –/+ buttons to select the output of the currently selected program, return, or submix.
The MIDI Track Mixer shows levels, panning, and mute states for all used tracks.

**To view a specific setting on all tracks**, tap **Level**, **Pan**, or **Mute** at the bottom of the screen. Tap **Mute/Solo** to switch between them.

When a track is selected, you can view and adjust all of its settings in the left side of the screen rather than using the tab buttons at the bottom.

When viewing the MIDI track channel strip:

**Note:** This is the same as the MIDI track channel strip in Main Mode.

- The first field shows the current track (which you can change).
- The second field shows the current program the track is using (which you can change to a program of the same type).
- Tap **Solo** or **Mute** to solo or mute the track (respectively).
- Adjust the **pan knob** or **velocity slider** to change the panning or velocity of the track.
Audio Tracks

The Audio Track Mixer shows levels, mute/solo/record-arm states, send and insert effects, and routing for all used tracks.

To view a specific setting on all tracks, tap Level, Pan, Mute/Solo/Rec Arm, Send, Insert, or Route at the bottom of the screen. Tap Mute/Solo/Rec Arm to cycle through them.

When a track is selected, you can view and adjust all of its settings in the left side of the screen rather than using the tab buttons at the bottom.

When viewing the audio track channel strip:

**Note:** This is the same as the audio track channel strip in Main Mode.

The first field defines the input source of the external audio signal, which you can set to a pair of inputs (Input 1,2–3,4 in Standalone Mode, Input 1,2–31,32 in Controller Mode) or a single input (Input 1–4 in Standalone Mode, Input 1–32 in Controller Mode).

The second field shows where the track is routed, which you can change: Out 1,2–7,8, Out 1–8 or Sub 1–8 in Standalone Mode; and Out 1,2–31,32 or Out 1–32 in Controller Mode.

**Note:** When set to a mono channel, the left and right channels are summed post-pan knob. If the pan knob is set to the center position, the left and right channels will be summed and panned. If the pan knob is set to the maximum left or right positions, only the respective channel will be sent to the output.

The Inserts field shows any enabled or disabled effects for that audio track. Tap the area under Inserts to open a window where you can load, change, and enable or disable the effects for all four insert slots.

Tap Solo or Mute to solo or mute the track (respectively).

Tap the Monitor button to set how your audio track will be monitored. Tapping it will cycle through its three states:

- When set to Auto, you will hear incoming audio while the track is record-enabled only.
- When on, you will hear incoming audio whether or not the track is record-enabled.
- When off, you will never hear any incoming audio.
Tap the **automation button** or press **Read/Write** (MPC X) to cycle through its three states:

- **When off**, the audio track will ignore automation data. If you have already recorded or entered automation, tapping this will switch between Read (R) and Write (W) only, but you can override this and turn it off by pressing and holding **Shift** while pressing or tapping the button.

  **Important**: If you have already recorded automation and turn it off, the audio track will still use the effect and its parameter values at the point where you turned it off.

- **When set to Read (R)**, the audio track will read automation data but will not record any additional automation over it. (Think of this as a protective feature to prevent accidental changes to your automation while recording.)

- **When set to Write (W)**, the audio track can record automation. (If you have any Q-Link knobs assigned to automatable parameters, make sure not to touch any accidentally while you are recording.)

  **Tip**: You can quickly set all programs and audio tracks to the same automation by tapping the global automation button in the upper-right corner of the screen. See **General Features > Automation** to learn about this.

Adjust the **pan knob** or **level slider** to change the panning or level of the track.

Tap the **Record Arm** button or press **Rec Arm** (MPC X) to record-enable the track. When you begin audio recording, the audio signal will be recorded to this track.

**Tip**: You can select multiple tracks in the **Rec Arm** tab by pressing and holding **Shift** and tapping each **pad** on the screen. You can also do this in the Track View by pressing and holding **Shift** while tapping the **Arm** button to each track.
The Program Mixer shows levels, panning, mute states, send and insert effects, and routing for all programs.

To view a specific setting on all programs, tap Level, Pan, Mute/Solo, Send, Insert, or Route at the bottom of the screen. Tap Mute/Solo to switch between them. Tap Send or Insert to cycle through the four available slots for each.

When a program is selected, you can view and adjust all of its settings in the left side of the screen rather than using the tab buttons at the bottom.

When viewing the program channel strip:

**Note:** This is the same as the program channel strip in Main Mode.

The first field shows the current program number and name (which you can change).

The second field shows where the program is routed, which you can change: Out 1,2–7,8 or Out 1–8 in Standalone Mode, Out 1,2–31,32 or Out 1–32 in Controller Mode. You can also select a submix (Sub 1–8) in Controller Mode.

**Note:** When set to a mono channel, the left and right channels are summed post-pan knob. If the pan knob is set to the center position, the left and right channels will be summed and panned. If the pan knob is set to the maximum left or right positions, only the respective channel will be sent to the output.

The Inserts field shows any enabled or disabled effects for that program. Tap the area under Inserts to open a window where you can load, change, and enable or disable the effects for all four insert slots.

Tap Solo or Mute to solo or mute the program (respectively).
Tap the **program automation button** to change the program’s automation. Tapping it will cycle through its three states:

When **off**, the program will ignore automation data. If you have already recorded or entered automation, tapping this will switch between **Read (R)** and **Write (W)** only, but you can override this and turn it off by pressing and holding **Shift** while tapping the button.

**Important**: If you have already recorded automation and turn it off, the track will still use the effect and its parameter values at the point where you turned it off.

When set to **Read (R)**, the program will read automation data but will not record any additional automation over it. (Think of this as a protective feature to prevent accidental changes to your automation while recording.)

When set to **Write (W)**, the program can record automation. (If you have any Q-Link knobs assigned to automatable parameters, make sure not to touch any accidentally while you are recording.)

**Tip**: You can quickly set all programs and audio tracks to the same automation by tapping the global automation button in the upper-right corner of the screen. See **General Features > Automation** to learn about this.

Adjust the **pan knob** or **level slider** to change the panning or level of the program.
Pads, programs, and audio tracks can each be sent to up to four send channels. Their audio signals will be routed to the send channels at their designated send levels. After being processed by the effects on those channels, their signals are then sent to the assigned master output based on their return settings (levels, panning, etc.). This view displays the four return channels. The return mixer shows levels, panning, mute states, insert effects, and routing for all used tracks.

To view a specific setting on all returns, tap Level, Pan, Mute, Insert, or Route at the bottom of the screen. You can tap Insert multiple times to cycle through the four available slots.

When a return is selected, you can view and adjust all of its settings in the left side of the screen rather than using the tab buttons at the bottom. When viewing the return channel strip:

The first field shows the current return number (which you can change).

The second field shows where the return is routed, which you can change: Out 1,2–7,8 or Out 1–8 in Standalone Mode; Out 1,2–31,32 or Out 1–32 in Controller Mode (MPC Live does not use Out 7,8 in Standalone Mode but displays them to maintain compatibility with MPC X, which does use them).

Note: When set to a mono channel, the left and right channels are summed post-pan knob. If the pan knob is set to the center position, the left and right channels will be summed and panned. If the pan knob is set to the maximum left or right positions, only the respective channel will be sent to the output.

The inserts field shows any enabled or disabled effects for that return. Tap the area under inserts to open a window where you can load, change, and enable or disable the effects for all four insert slots.

Tap mute to mute the return.

Adjust the pan knob or level slider to change the panning or level of the return.
Submixes

The Submixer shows levels, panning, mute states, send and insert effects, and routing for the eight available submixes.

To view a specific setting on all submixes, tap Level, Pan, Mute, Send, Insert, or Route at the bottom of the screen. You can tap Send or Insert multiple times to cycle through the four available slots for each.

When a submix is selected, you can view and adjust all of its settings in the left side of the screen rather than using the tab buttons at the bottom.

When viewing the submixer channel strip:

The first field shows the current submix (which you can change).

The second field shows where the submix is routed, which you can change: Out 1,2–31,32 or Out 1–32.

Note: When set to a mono channel, the left and right channels are summed post-pan knob. If the pan knob is set to the center position, the left and right channels will be summed and panned. If the pan knob is set to the maximum left or right positions, only the respective channel will be sent to the output.

The Inserts field shows any enabled or disabled effects for that submix. Tap the area under Inserts to open a window where you can load, change, and enable or disable the effects for all four insert slots.

Tap Mute to mute the submix.

Adjust the pan knob or level slider to change the panning or level of the submix.
The Master Mixer shows levels, panning, mute states, and insert effects for all used stereo pairs of outputs (Out 1,2–7,8 in Standalone Mode, Out 1,2–31,32 in Controller Mode; MPC Live does not use Out 7,8 in Standalone Mode but displays them to maintain compatibility with MPC X, which does use them).

To view a specific setting on all outputs, tap Level, Pan, Mute, or Insert at the bottom of the screen. You can tap Insert multiple times to cycle through the four available slots.

When viewing the master channel strip:

**Note:** This is the same as the master channel strip in Main Mode.

- The first field shows the current master output (which you can change).
- The Inserts field shows any enabled or disabled effects for that master output. Tap the area under Inserts to open a window where you can load, change, and enable or disable the effects for all four insert slots.
- Tap Mute to mute that master output.
- Adjust the pan knob or level slider to change the panning or level of the master output.
Pad Mute Mode

Pad Mute Mode lets you easily mute pads within a program or set mute groups for each pad within a program.

**To enter Pad Mute Mode**, do either of the following:

- Press **Menu**, and then tap **Pad Mute**.
- Press **Shift + Track Mute/Pad Mute** (MPC X).

There are two tabs you can view in this mode: **Pad Mute** or **Pad Group**. Tap each button in the lower-left corner to select it. See the following **Pad Mute** and **Pad Group** sections to learn about each.

Use the **Program** field at the top of the screen to select a program.

The time counter in the upper-right corner the current playhead position. This is shown in most of the modes. See **General Features > Time Counter/Locate** to learn about this.

The automation button indicates the global automation state. This is shown in several modes. See **General Features > Automation** to learn about this.

**Time Correct** lets you quantize pad mutes. This is useful when you want your mutes to line up with a specific time division. For example, with **Time Division** set to **1 Bar**, your mutes will always align with the beginning of the measure immediately after you press the pad.

- Tap **Time Division** at the bottom of the screen, and select a value from **1/16** to **2 Bars** (**T** indicates a triplet-based time division).
- Tap **TC** at the bottom of the screen to enable or disable the Time Correct feature.
You can mute or unmute individual sounds (on a single track) in real time by pressing the pads. This is useful if you want to hear a track without a particular sound or if you want to isolate specific sounds or combinations of sounds.

**Tip:** This function is similar to muting pads one at a time in the grid—but more convenient.

**To mute pads in this mode:**

1. If the **Pad Mute** tab in the lower-left corner is not already selected, tap it.
2. Select the desired pad bank. Use the **Pad Bank Buttons** or tap a pad bank shown on the left side of the screen.
3. **To mute or unmute a pad’s sound,** press it or tap it on the screen. Muted pads are lit **red.** Unmuted pads are lit **yellow.** Unused pads do not show any sample names.

**To assign pads to pad groups within this tab,** turn each of the **Q-Link knobs** (when the **Screen Control** Q-Link button is selected) to assign each of the pads to a pad group. The number of each pad’s group is shown in its upper-right corner.
Pad Group

The pad group feature extends the concept of pad mutes: you can mute or unmute multiple pads (on a single track) by pressing one pad that you have assigned to a mute group. This is useful if you want to hear a track without a particular group of sounds or if you want to isolate specific sounds in various combinations. You can create up to 16 different pad groups.

To use pad groups:

1. If the Pad Group tab in the lower-left corner is not already selected, tap it.
2. Use the Pad Bank buttons to select the desired pad bank.
3. To select a pad to add to a mute group, press it or tap it on the screen. The selected pad is lit green. If there are other pads in the same mute group, they will flash yellow.
4. To add the pad to the mute group, tap the number of the desired mute group on the left side of the screen. To remove it from the mute group, tap Off.

Alternatively, turn each of the Q-Link knobs (when the Screen Control Q-Link button is selected) to assign each of the pads to a pad group. The number of each pad’s group is shown in its upper-right corner.
Track Mute Mode lets you easily mute tracks within a sequence or set track groups, enabling you to mute multiple tracks at once.

To enter Track Mute Mode, do either of the following:

- Press Menu, and then tap Track Mute.
- Press Track Mute (MPC X).

There are two tabs you can view in this mode: Track Mute or Track Group. Tap each button in the lower-left corner to select it. See the following Track Mute and Track Group sections to learn about each.

Use the Sequence field at the top of the screen to select a sequence.

The time counter in the upper-right corner the current playhead position. This is shown in most of the modes. See General Features > Time Counter/Locate to learn about this.

Time Correct lets you quantize track mutes. This is useful when you want your mutes to line up with a specific time division. For example, with Time Division set to 1 Bar, your mutes will always align with the beginning of the measure immediately after you press the pad.

- Tap Time Division at the bottom of the screen, and select a value from 1/16 to 2 Bars (T indicates a triplet-based time division).
- Tap TC at the bottom of the screen to enable or disable the Time Correct feature.

Tap Solo to turn track soloing on or off. When on, using Track Mute Mode will solo tracks instead of muting them.
Track Mute

This is useful if you want to hear a sequence without a particular track (e.g., muting your keyboard track to focus on the bass) or if you want to isolate specific sounds or combinations of sounds that are separated by track.

**Tip:** This function is similar to, but more convenient than, muting tracks one at a time in the Track View.

**To mute tracks in this mode:**
1. If the **Track Mute** tab in the lower-left corner is not already selected, tap it.
2. Select the desired pad bank. Use the **Pad Bank** buttons or tap a pad bank shown on the left side of the screen.
3. **To mute or unmute a track**, press the corresponding pad or tap it on the screen. Pads for muted tracks are lit **red**. Pads for unmuted tracks are lit **yellow**. Pads for unused tracks do not show any information.

**To assign tracks to track groups within this tab**, turn each of the **Q-Link knobs** (when the **Screen Control** Q-Link button is selected) to assign each of the pads to a track group. The number of each pad’s track group is shown in its upper-right corner.
Track Group

The track group feature extends the concept of track mutes: you can mute or unmute multiple tracks (in a single sequence) by pressing one pad that you have assigned to a track group. This is useful if you want to hear a track without a particular group of sounds or if you want to isolate specific sounds in various combinations. You can create up to 16 different track groups.

To assign tracks to track groups:

1. If the Track Group tab in the lower-left corner is not already selected, tap it.
2. Select the desired pad bank by using the Pad Bank buttons.
3. To select a track to add to a mute group, press the corresponding pad or tap it on the screen. The pad for the selected track is lit green. If there are other pads for tracks in the same mute group, they will flash yellow.
4. To add the track to a mute group, tap the number of the desired mute group.
   
   To remove the track from the mute group, tap Off.

Alternatively, turn each of the Q-Link knobs (when the Screen Control Q-Link button is selected) to assign each of the pads to a track group. The number of each pad’s track group is shown in its upper-right corner.
Next Sequence Mode lets you trigger different sequences simply by playing the pads. This is useful for live performances, letting you change a song’s structure in real time.

To enter Next Sequence Mode, do either of the following:

- Press Menu, and then tap Next Sequence.
- Press Next Seq (MPC X).

The time counter in the upper-right corner the current playhead position. This is shown in most of the modes. See General Features > Time Counter/Locate to learn about this.

The sequence playlist on the left side shows a list-style overview of all used sequences in your project:

- The Sequence column shows the name of the song's sequences.
- The Length column shows the bar length of a sequence.
- The BPM column shows the tempo of a sequence in beats per minute.

The currently selected sequence is highlighted in the list. Tap a sequence in the list to select it.
In Next Sequence Mode, every pad is assigned to a sequence, starting from Pad A01 with Sequence 1 and ascending from there. The pads will show the names of their corresponding sequences. Empty pads correspond to unused sequences. The currently selected pad will flash green.

During playback, change the next sequence that will play by pressing the corresponding pad or tapping it on the screen. If you do not select another sequence, the current sequence will repeat indefinitely.

As a sequence plays, you can use the buttons at the bottom of the screen to change how playback works:

To switch to the currently selected sequence at the beginning of the next bar, tap Next Bar. This is useful if you want to switch to another sequence before the current one ends without having to worry about timing issues.

To switch to the currently selected sequence immediately, tap Sudden. The new sequence will start playing whether or not the current sequence is done. This is useful in live performances if you need to switch to the next sequence instantly at a certain cue.

To delete the currently selected sequence from the sequence playlist, tap Clear. This option is available only if that sequence is not playing at that moment.

To repeat the current sequence indefinitely and temporarily ignore pad presses, tap Hold. To return to normal operation, tap it again. This is useful if you want to select other pads without selecting them to play next.

To copy the sequence playlist to a song, tap ➔ Song while playback is stopped. In the Copy to Song screen that appears, select a song, and then tap Do It to continue or Close to cancel.

To read more about Song Mode, please see the Song Mode chapter.
Song Mode

Song Mode lets you arrange sequences in a specific order and/or repetition to create songs. You can edit the structure of a song during playback for easy, on-the-fly composing.

A project can contain up to 32 songs, each consisting of up to 999 "steps." Each step can have an assigned sequence as well as the number of times that sequence will repeat.

To open Song Mode, do either of the following:

- Press Menu, and then tap Song Mode.
- Press Shift + Next Seq/Song (MPC X).

Important: If a sequence is currently playing, stop playback before entering Song Mode. You cannot enter Song Mode during playback.

Important: When creating a song, the program used by each track in the song’s first sequence will be used by all subsequent tracks. In other words, all identically numbered tracks (across sequences) will use the program used by the first sequence in the song—regardless of what programs each track uses while not in Song Mode.

For example, if you create a project in this way…:

- Track 1 of Sequence 1 uses a drum program.
- Track 1 of Sequence 2 uses a keygroup program.

A song uses Sequence 1 as its first sequence and then uses Sequence 2 any time after it.

…then, in that song, Track 1 in Sequence 2 will use the same drum program as Track 1, Sequence 1.

Because of this, we recommend trying to be consistent while creating tracks in sequences that you intend to use in a single song. Remember that you can copy one track to another if you ever need to reorder the tracks of a sequence (see Modes > Main Mode > Track Section to learn about this).

Use the Song field to select the song you want to show.

Use the BPM field to adjust the tempo of the sequence.

To set whether the sequence follows its own tempo (Seq) or a master tempo (Mst), tap the Seq/Mst button next to the BPM field. Alternatively, press Shift + Tap/Master.
The sequence playlist on the left lists the “steps” of a song. Each step has (in columns, left to right):

- the step number (each song can contain up to 999 steps)
- a sequence number and name
- how many times the sequence plays (each step can play up to 999 times; set it to Hold [the lowest/minimum value] to set the sequence to repeat indefinitely until you stop playback)
- the tempo of the sequence
- the number of bars the step occupies (based on how many times it plays)

Each used sequence is assigned to a pad. Empty pads correspond to unused sequences. Use the Pad Bank buttons to access the sequences assigned to pads in other banks.

To insert a step:
1. Tap a step in the sequence playlist after which you want to insert a step.
2. Tap Insert in the lower-right corner of the screen.

Alternatively, “record” a song using the pads:

**Note:** The sequences or song will not play back as you use the pads to create your song in this way. Pressing the pads just enters their corresponding sequences as steps.

1. Press Rec or Overdub to “record-arm” the song.
2. Press or tap the pad that corresponds to the first sequence you want to use. That sequence will appear in the sequence playlist as the first step.
3. Repeat Step 2 for each additional step you want to add to the sequence playlist. Press or tap a pad multiple times to add to the number of times it plays.
4. Press Stop to stop “recording.”
To change a step’s sequence:
1. In the desired step, tap the sequence name.
2. Use the data dial or +/- buttons to select another sequence.

To delete a step, tap it, and then tap Delete in the lower-right corner of the screen.

To clear the entire sequence playlist (delete all steps), tap Clear.

To switch to the next sequence at the beginning of the next bar during playback, tap Next. This is useful if you want to switch to another sequence before the current one ends without having to worry about timing issues.

To switch to the next sequence immediately during playback, tap Sudden. The new sequence will start playing whether or not the current sequence is done. This is useful in live performances if you need to switch to the next sequence instantly at a certain cue.

To convert the current song to a single sequence:
1. Tap Convert > Seq to open the Convert to Sequence window.
2. Use the To Sequence field to select which sequence you want the song to export to.
3. Use the Track Status field to select whether you want the song to Ignore Muted Tracks or Include Muted Tracks in the new sequence.
4. To confirm your selections, tap Do It.
   To cancel the process, tap Close.

To render/export your song as an audio file, tap Export to open the Audio Mixdown screen. See General Features > Audio Mixdown to learn how to use this screen to export your song.
Q-Link Edit Mode

Q-Link Edit Mode lets you determine what the Q-Link knobs control in other modes. This is helpful when you want to use the Q-Link knobs to control parameters that might not be shown in the current mode—or parameters that are shown across different modes.

To enter Q-Link Edit Mode, do any of the following:

- Press Menu, and then tap Q-Link Edit.
- Press Shift+Screen Control/Edit (MPC X).
- Press and hold one of the five Q-Link buttons above the Q-Link knobs, and then tap Q-Link Edit at the bottom of the window that appears (MPC X).

To select an edit mode for the Q-Link knobs, tap one of the five buttons at the bottom of the screen. If you are using MPC X, you can also press one of the five Q-Link buttons above the Q-Link knobs (Project, Program, Pad Scene, Pad Param, or Screen Control/Edit):

**Project:** In this edit mode, the Q-Link knobs can control 16 parameters within the current project overall. See the following Project section to learn about this specific Q-Link Edit Mode.

**Program/Audio Track:** In this edit mode, the Q-Link knobs can control 16 program or audio track parameters. See the following Program/Audio Track section to learn about this specific Q-Link Edit Mode.

**Pad Scene** (for drum programs only): In this edit mode, the Q-Link knobs can control 16 parameters for the currently selected pad. See the following Pad Scene section to learn about this specific Q-Link Edit Mode.

**Pad Parameter:** In this edit mode, the 16 Q-Link knobs correspond to the 16 pads, each one controlling the same parameter for each pad. This is useful if you need to adjust the same parameter on multiple pads at once rather than having to select and edit each pad individually. See the following Pad Parameter section to learn about this specific Q-Link Edit Mode.

**Screen:** In this edit mode, the Q-Link knobs will control a parameter or group of parameters in your currently selected mode (e.g., Main Mode, Sample Edit Mode, etc.).

Use the Track field to select a track that uses the desired program (and therefore pad/pads). The contents of the screen below will vary based on (1) the type of program each track uses and (2) the Q-Link Edit Mode you selected.
Tap the Learn button to turn Learn Mode on or off. When on, adjusting a control in the MPC software window will immediately assign it to the currently selected Q-Link knob.

This button is not available while in Screen Q-Link Edit Mode where the Q-Link knobs are unassignable.

**To assign a function to a Q-Link knob in Learn Mode:**
1. Tap Learn so the button is lit. (This will stop playback. Resuming playback will exit Learn Mode.)
2. Touch or turn the desired Q-Link knob.
3. In the MPC software on your computer, click and drag the slider or knob you want to assign to the Q-Link knob. The Q-Link knob will be able to control that parameter immediately.

   **To assign functions to other Q-Link knobs,** repeat Steps 2–3.

   **To exit Learn Mode,** tap Learn (or resume playback).

The automation button indicates the global automation state. This is shown in several modes. See General Features

At any time, in any mode, you can show the QLinks window over the touchscreen’s current contents. These are the same parameters and settings as what is shown in Q-Link Edit Mode.

   **To show the QLinks window,** press and hold any of the Q-Link buttons: Project, Program, Pad Scene, Pad Param, or Screen Control/Edit (MPC X) or the Q-Link button (MPC Live, MPC Touch).

   **To close the QLinks window,** release that Q-Link button.

While the QLinks window is shown:

   **To adjust the settings of the selected knobs,** turn the corresponding Q-Link knobs on your MPC hardware.

   **To select an edit mode for the Q-Link knobs,** tap one of the five buttons at the bottom of the screen. If you are using MPC X, you can also press one of the five Q-Link buttons above the Q-Link knobs: Project, Program, Pad Scene, Pad Parameter, or Screen.

   **To turn Learn Mode on or off,** tap Learn. (This button is not available while in Screen Q-Link Edit Mode where the Q-Link knobs are unassignable.)

   **To enter Q-Link Edit Mode immediately** (regardless of the current mode), tap Q-Link Edit at the bottom of the window.
In the **Project** Q-Link Edit Mode, the Q-Link knobs control 16 parameters within the current project.

Next to the top row of Q-Link knobs on the screen, tap one of these tabs to select the type of parameters you want to control with the Q-Link knobs:

- **MIDI Track**: MIDI track parameters. Use the **MIDI Track** field to select one of the MIDI tracks in your project.
- **Audio Track**: audio track parameters. Use the **Audio Track** field to select one of the audio tracks in your project.
- **Program**: program parameters. Use the **Program** field to select one of the programs in your project.
- **Return**: return parameters. Use the **Return** field to select one of **Returns 1–4**.
- **Submix**: submix parameters. Use the **Submix** field to select one of **Submixes 1–8**.
- **Master**: master parameters. Use the **Master** field to select one of the output pairs: **Outputs 1/2–7/8** in Standalone Mode or **Outputs 1/2–31/32** in Controller Mode (MPC Live does not use Out 7/8 in Standalone Mode but displays them to maintain compatibility with MPC X, which does use them).

Next to the second row of Q-Link knobs on the screen, tap one of these tabs to select the type of parameters you want to control with the Q-Link knobs:

- **Mixer**: general mixer parameters
- **Program** (in the **Program** tab if a drum program or clip program is selected): program parameters
- **Insert 1–4** (not available in the **MIDI Track** tab or **Program** tab if a MIDI program is selected): parameters for its program insert effects

If the **Program** tab is selected, use the **Type** selector to determine whether the Q-Link knobs will control the parameters of the entire program (**Program**) or for a single pad (**Pad**).

- **To select a program**, use the **Program** field next to the top row of Q-Link knobs on the screen.
- **To select a pad** (if **Type** is set to **Pad**), use the **Pad** field.
Use the Parameter field to select the parameter you want to control with the currently selected Q-Link knob.

When the **MIDI Track** tab is selected:
- **Mixer**: Off, Volume, Pan, Mute, Solo

When the **Audio Track** tab is selected:
- **Mixer**: Off, Volume, Pan, Mute, Solo, Send 1–4
- **Insert 1–4**: Off, other available parameters depend on the effect

When the **Program** tab is selected and **Type** is set to **Program**:
- **Mixer**: Off, Master Semi Tune, Master Fine Tune
- **Program**: Off, Master Semi Tune, Master Fine Tune
- **Insert 1–4**: Off, other available parameters depend on the effect

When the **Program** tab is selected and **Type** is set to **Pad**:
- **Mixer**: Off, Level, Pan, Pad Mute, Pad Solo, Send 1–4
- **Program**:
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Off</th>
<th>Amp Env Hold</th>
<th>Amp Env Sustain</th>
<th>Layer Sample Pan (1–4)</th>
<th>Layer Semi Tune (1–4)</th>
<th>Amp Env Attack</th>
<th>Amp Env Release</th>
<th>Amp Env Release Level (1–4)</th>
<th>LFO to Filter</th>
<th>LFO to Amp</th>
<th>LFO to Pan</th>
<th>LFO to Pitch</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tuning</td>
<td>Off</td>
<td>Amp Env Sustain</td>
<td>Amp Env Decay</td>
<td>Vel to Filter Attack</td>
<td>LFO Rate</td>
<td>Vel to Filter</td>
<td>Vel to Volume Attack</td>
<td>Layer Direction (1–4)</td>
<td>Layer Offset (1–4)</td>
<td>Velocity to Amp</td>
<td>Velocity to Pan</td>
<td>Velocity to Pan</td>
</tr>
<tr>
<td>Filter Cutoff</td>
<td>Off</td>
<td>Amp Env Attack</td>
<td>Filter Env Release</td>
<td>Velocity to Filter</td>
<td>LFO Sync</td>
<td>Vel to Filter Env Amount</td>
<td>Vel to Volume Attack</td>
<td>LFO to Filter</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Filter Resonance</td>
<td>Off</td>
<td>Filter Env Hold</td>
<td>Filter Env Sustain</td>
<td>Velocity to Envelope Amount</td>
<td>Filter Cutoff</td>
<td>Filter Cutoff</td>
<td>Filter Cutoff</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Filter Env Amount</td>
<td>Off</td>
<td>Filter Env Decay</td>
<td>Layer Fine Tune (1–4)</td>
<td>LFO Wave</td>
<td>Filter Cutoff</td>
<td>Filter Cutoff</td>
<td>Filter Cutoff</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Amp Env Attack</td>
<td>Off</td>
<td>Filter Env Sustain</td>
<td>Layer Level (1–4)</td>
<td>LFO to Pitch</td>
<td>Filter Cutoff</td>
<td>Filter Cutoff</td>
<td>Filter Cutoff</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Amp Env Decay</td>
<td>Off</td>
<td>Filter Env Release</td>
<td>Filter Cutoff</td>
<td>Velocity to Filter</td>
<td>Filter Cutoff</td>
<td>Filter Cutoff</td>
<td>Filter Cutoff</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Amp Env Release</td>
<td>Off</td>
<td>Layer Level (1–4)</td>
<td>LFO to Pitch</td>
<td>Filter Cutoff</td>
<td>Filter Cutoff</td>
<td>Filter Cutoff</td>
<td>Filter Cutoff</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
- **Insert 1–4**: Off, other available parameters depend on the effect

When the **Return** tab is selected:
- **Mixer**: Off, Volume, Pan, Mute
- **Insert 1–4**: Off, other available parameters depend on the effect

When the **Submix** tab is selected:
- **Mixer**: Off, Volume, Pan, Mute, Send 1–4
- **Insert 1–4**: Off, other available parameters depend on the effect

When the **Master** tab is selected:
- **Mixer**: Off, Volume, Pan, Mute
- **Insert 1–4**: Off, other available parameters depend on the effect

Tap the **Momentary** checkbox to turn momentary behavior on or off.

When **on**, moving the Q-Link knob will adjust its parameter, but the parameter will immediately return to its original position (when you turned Momentary on) when you release the Q-Link knob.

When **off**, moving the Q-Link knob will adjust its parameter, and the parameter will remain at its new setting when you release the Q-Link knob.
Program/Audio Track

In the Program/Audio Track Q-Link Edit Mode, the Q-Link knobs control 16 parameters within the currently selected program or audio track.

When a MIDI track is selected:

Next to the top row of Q-Link knobs on the screen, tap one of these tabs to select the type of parameters you want to control with the Q-Link knobs:

- **Mixer**: general mixer parameters
- **Program**: program parameters
- **Insert 1–4**: parameters for its program insert effects

Use the **Type** selector to determine whether the Q-Link knobs will control the parameters of the entire program (Program) or for a single pad (Pad).

To select a program, use the **Track** field at the top of the screen to select a track that uses it. The program name will appear in the **Program** field next to the top row of Q-Link knobs on the screen.

To select a pad (if Type is set to Pad), use the **Pad** field.

Use the **Parameter** field to select the parameter you want to control with the Q-Link knobs.

When Type is set to Program:

- **Mixer**: Off, Volume, Pan, Mute, Solo, Send 1–4
- **Program**: Off, Master Semi Tune, Master Fine Tune
- **Insert 1–4**: Off, other available parameters depend on the effect
When **Type** is set to **Pad**:

**Mixer**: Off, Level, Pan, Pad Mute, Pad Solo, Send 1–4

**Program**:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Mixer Parameters</th>
<th>Insert 1–4 Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>Amp Env Hold</td>
<td>Off</td>
</tr>
<tr>
<td>Tuning</td>
<td>Amp Env Sustain</td>
<td>Insert 1–4</td>
</tr>
<tr>
<td>Filter Cutoff</td>
<td>Filter Env Attack</td>
<td></td>
</tr>
<tr>
<td>Filter Resonance</td>
<td>Filter Env Hold</td>
<td></td>
</tr>
<tr>
<td>Filter Env Amount</td>
<td>Filter Env Hold</td>
<td></td>
</tr>
<tr>
<td>Amp Env Attack</td>
<td>Filter Env Hold</td>
<td></td>
</tr>
<tr>
<td>Amp Env Decay</td>
<td>Filter Env Release</td>
<td></td>
</tr>
<tr>
<td>Amp Env Release</td>
<td>Filter Env Hold</td>
<td></td>
</tr>
</tbody>
</table>

**Layer**: Pad to Filter, Velocity to Amp, Velocity to Pan, LFO to Pitch, LFO to Volume Attack

**Layer Level**: Layer 1–4

**Layer Direction**: Layer Direction 1–4

**Layer Offset**: Layer Offset 1–4

**Layer Amount**: Layer Amount 1–4

**Layer Cutoff**: Layer Cutoff 1–4

**Layer Pitch**: Layer Pitch 1–4

**Layer Pan**: Layer Pan 1–4

**Layer Send**: Layer Send 1–4

**Layer Sustain**: Layer Sustain 1–4

**Layer Release**: Layer Release 1–4

**Layer Release**: Layer Release 1–4

**Layer Velocity**: Layer Velocity 1–4

**Layer Velocity**: Layer Velocity 1–4

**Layer Velocity**: Layer Velocity 1–4

When an **audio track** is selected:

Next to the top row of Q-Link knobs on the screen, tap one of these tabs to select the type of parameters you want to control with the Q-Link knobs:

- **Mixer**: general mixer parameters
- **Insert 1–4**: parameters for its program insert effects

Use the **Parameter** field to select the parameter you want to control with the Q-Link knobs.

Tap the **Momentary** checkbox to turn momentary behavior on or off.

When **on**, moving the Q-Link knob will adjust its parameter, but the parameter will immediately return to its original position (when you turned Momentary on) when you release the Q-Link knob.

When **off**, moving the Q-Link knob will adjust its parameter, and the parameter will remain at its new setting when you release the Q-Link knob.
Pad Scene

In the Pad Scene Q-Link Edit Mode, the Q-Link knobs control your favorite 16 parameters for the currently selected pad. You can select another pad simply by pressing it, allowing you to adjust the same 16 parameters for that new pad. (These assignments are automatically saved with other user settings. Any project you load will use these assignments.)

To select a pad, press it.

Next to the top row of Q-Link knobs on the screen, tap one of these tabs to select the type of parameters you want to control with the Q-Link knobs:

Mixer: general mixer parameters
Program: pad parameters (i.e., parameters used in Program Edit Mode)

Use the Parameter field to select the parameter you want to control with the Q-Link knobs.

Mixer: Off, Level, Pan, Pad Mute, Pad Solo, Send 1–4
Program:

- Off
- Tuning
- Filter Cutoff
- Filter Resonance
- Filter Env Amount
- Amp Env Attack
- Amp Env Decay
- Amp Env Release
- Layer Sample Pan (1–4)
- Layer Semi Tune (1–4)
- Layer Fine Tune (1–4)
- Layer Env Hold
- Layer Env Decay
- Layer Env Release
- LFO to Filter
- LFO to Amp
- LFO to Pan
- LFO Wave
- LFO Rate
- LFO Sync
- Velocity to Filter
- Velocity to Pitch
- Velocity to Start
- Velocity to Amp
- Velocity to Pan
- Layer Direction (1–4)
- Layer Offset (1–4)
- Vel to Filter Attack
- Vel to Volume Attack

Tap the Momentary checkbox to turn momentary behavior on or off.

When on, moving the Q-Link knob will adjust its parameter, but the parameter will immediately return to its original position (when you turned Momentary on) when you release the Q-Link knob.

When off, moving the Q-Link knob will adjust its parameter, and the parameter will remain at its new setting when you release the Q-Link knob.
Pad Parameter

In the **Pad Parameter** Q-Link Edit Mode, the Q-Link knobs control the same pad parameter for each of the 16 pads in the current pad bank.

For example, if the **Parameter** is set to **Level**, the 16 Q-Link knobs will adjust the 16 independent **Level** settings for each pad in the current pad bank. You could then set the **Parameter** to **Pan** and use the Q-Link knobs to adjust the panning of all 16 pads.

Next to the top row of Q-Link knobs on the screen, tap one of these tabs to select the type of parameter you want to control with the Q-Link knobs:

- **Mixer**: general mixer parameters
- **Program**: pad parameters (i.e., parameters used in Program Edit Mode)

Use the **Parameter** field to select the parameter you want to control with the Q-Link knobs.

**Mixer**: Off, Level, Pan, Pad Mute, Pad Solo, Send 1–4

**Program**: Off, Amp Env Hold, Layer Sample Pan (1–4), LFO to Filter, Velocity to Amp

- **Tuning**: Amp Env Sustain, Layer Semi Tune (1–4), LFO to Amp, Velocity to Pan
- **Filter Cutoff**: Filter Env Attack, Layer Fine Tune (1–4), LFO to Pan, Layer Direction (1–4)
- **Filter Resonance**: Filter Env Hold, Velocity to Start, LFO Wave, Layer Offset (1–4)
- **Filter Env Amount**: Filter Env Decay, Vel to Filter Attack, LFO Rate
- **Amp Env Attack**: Filter Env Sustain, Velocity to Env Amount, LFO Sync
- **Amp Env Decay**: Filter Env Release, Velocity to Filter, Velocity to Pitch
- **Amp Env Release**: Layer Level (1–4), LFO to Pitch, Vel to Volume Attack

Tap the **Momentary** checkbox to turn momentary behavior on or off.

When **on**, moving the Q-Link knob will adjust its parameter, but the parameter will immediately return to its original position (when you turned Momentary on) when you release the Q-Link knob.

When **off**, moving the Q-Link knob will adjust its parameter, and the parameter will remain at its new setting when you release the Q-Link knob.
In the **Screen** Q-Link Edit Mode, the Q-Link knobs will control only the parameter or group of parameters in your currently selected mode (e.g., Main Mode, Sample Edit Mode, etc.).
Pad Color Mode lets you assign specific colors to your pads in each program.

**To enter Pad Color Mode**, make sure you have first selected a track that uses the desired program, and then press **Menu**, and tap **Pad Color**.

**Important**: If you are already in Pad Color Mode and want to assign pad colors for another program, exit Pad Color Mode first, and then select a track that uses the desired program in another mode.

Use the field in the upper-left corner to set how the pad lights will display:

- **Off**: The pads will be unlit whether you are playing them or not.
- **Classic Velocity**: The pads will be unlit while you are not playing them. When you press them, they will light with colors according to the velocity: red indicates a high velocity, yellow indicates a low velocity.
- **Fixed**: The pads will be lit with their assigned colors whether you are playing them or not.
- **Off->Velocity**: The pads will be unlit when you are not playing them. When you press them, they will light with their assigned color with a brightness that corresponds with the velocity.
- **Dim->Velocity**: The pads will be dimly lit when you are not playing them. When you press them, they will light with their assigned color with a brightness that corresponds with the velocity.
- **Bright->Velocity**: The pads will be brightly lit when you are not playing them. When you press them, they will light with their assigned color with a brightness that corresponds with the velocity.

Use the **Empty Pads** field in the upper-left corner to set how empty pads will display:

- **Empty pads off**: Pads without any sounds will remain off.
- **Empty pads dim**: Pads without any sounds will remain more dimly lit than pads with sounds assigned.
- **Empty pads normal**: Pads without any sounds will appear the same as pads with sounds assigned.
Use the **Single Pad/All Pads** select to determine whether you are setting the color for a **Single Pad** or **All Pads**.

**Tip:** To quickly assign that color to all pads in the program, press and hold **Shift** while tapping a color button.

Use the **color buttons** to select which color you are assigning.

**Tip:** To select the color button corresponding a specific pad’s color, press and hold **Shift**, and then press the pad or tap it on the screen.

Press a **pad** on your MPC hardware or tap it on the screen to assign the selected color to it.

**To make the current pad color settings the defaults for all programs on the same type** (e.g., drum programs, keygroup programs, etc.), tap **Make Default**. In the window that appears, tap **Do It** to confirm your choice or **Cancel** to cancel.
MIDI Control Mode

You can use MIDI Control Mode on your MPC hardware to customize what MIDI messages are sent from certain controls on your hardware. This custom “control map” will then work whenever you are in MIDI Control Mode. The edits you make in MIDI Control Mode will be retained with the current MPC project.

In Standalone Mode, this feature enables you to use your MPC X or MPC Live to control external MIDI devices connected to its MIDI out.

In Controller Mode, this is helpful when using MPC as a plugin: you can use MIDI Control Mode to use your MPC hardware to control your host software, and then switch back to any other mode to control the MPC plugin.

To enter MIDI Control Mode, press Menu, and then tap MIDI Control.

Important:
In Standalone Mode: Make sure your MPC hardware is using the correct MIDI output. You can set this in the Preferences (see General Features > Menu > Preferences > Hardware).
In Controller Mode: In your host software, make sure your MPC hardware is selected as a MIDI controller device.

In the touchscreen, use the fields and selectors to set each control’s parameters to your preference. The available parameters depend on its type: a pad, or button, a Q-Link knob, or each axis of the XY pad. When you have set all of the parameters as desired, you can select another control or enter another mode.

To select a control to edit, do any of the following:

- Press or turn it. In the lower-left corner, tap the Hardware tab to edit a pad, button, or Q-Link knob, or tap the XY tab to edit the XY pad.
- Tap the Control field in the upper-left corner, and then turn the data dial to select one.
- Double-tap the Control field, and then tap a control name in the menu that appears.

Note: The Control field menu will show many more hardware controls than are actually available on your MPC hardware. This is because the list includes all possible controls from all current MPC models (MPC X, MPC Live, MPC Touch, etc.). You can edit only the controls that are described in this chapter.

Note: The software window will also display a graphical interface resembling your MPC hardware. Editable controls show their current MIDI message. Pads and Q-Link knobs show their current MIDI channels.
These are the MIDI parameters you can edit for each pad:

**Control:** This is the hardware control you are currently editing (Pad 1–Pad 16).

**Bank:** This is the pad bank the pad belongs to. If you check the **Set All** box, the pad’s messages and parameters will be identical across all eight banks.

**Set All:** When this box is checked, the pad’s messages and parameters will be identical across all eight banks. When this box is unchecked, the pad’s messages and parameters will apply to the current pad only.

**Light LED:** This determines how the pad’s LEDs will behave.

  - When set to **Never**, the LEDs will always be off.
  - When set to **MIDI Input**, the LEDs will light up when the software receives a MIDI message that matches the pad.
  - When set to **Local**, the LEDs will light up when you press the pad and/or MIDI input is received.

**MIDI Channel:** This determines which MIDI channel (1–16) the pad will use to send its message to the software.

**Note:** This is the MIDI note number the pad will send to the software when you press it (0–127 or C-2 to G8).

**Velocity:** This determines whether the pad will be velocity-sensitive (On) or not (Off). When set to Off, pressing the pad will send a note at full-level (127) always.

**Aftertouch:** This determines how the pad’s aftertouch (pressure applied to the pad after the initial press) behaves.

  - **Off:** The pad will not send any aftertouch messages.
  - **Channel:** If you press multiple pads that have this setting, the aftertouch messages they send will be identical.
  - **Poly:** If you press multiple pads, the aftertouch message each pad sends will be independent from the others.
Buttons

These are the MIDI parameters you can edit for each button. You can edit the **Erase**, **Tap**, **Undo/Redo**, or **Copy/Delete** buttons:

- **Control**: This is the hardware control you are currently editing (**Erase**, **Tap**, **Undo**, or **Copy**).

- **Light LED**: This determines how the button’s LED (or multiple LEDs) will behave.
  - When set to **Never**, the LEDs will always be off.
  - When set to **MIDI Input**, the LEDs will light up when the software receives a MIDI message that matches the button.
  - When set to **Local**, the LEDs will light up when you press the button and/or MIDI input is received.

- **MIDI Channel**: This determines which MIDI channel (1–16) the button will use to send its message to the software.

- **CC Number**: This determines what MIDI Control Change number the button will send to the software.

- **Type**: This determines whether the button will behave as a **Momentary** switch or **Toggle** (latching) switch.
These are the MIDI parameters you can edit for each Q-Link knob:

- **Control**: This is the hardware control you are currently editing (QLink 1–4).
- **Light LED**: Although you can edit this parameter, it does not actually have a function on your MPC hardware.
  - When set to **Never**, the LEDs will always be off.
  - When set to **MIDI Input**, the LEDs will light up when the software receives a MIDI message that matches the Q-Link knob.
  - When set to **Local**, the LEDs will light up when you touch or turn the Q-Link knob and/or MIDI input is received.
- **MIDI Channel**: This determines which MIDI channel (1–16) the Q-Link knob will use to send its message to the software.
- **CC Number**: This determines what MIDI Control Change number the Q-Link knob will send to the software.
- **Mode**: This determines how the Q-Link knob will control its parameter.
  - **Absolute**: The Q-Link knob’s current position determines its parameter’s value; moving it may cause its parameter to “snap” to a new position if you’re using it to control different parameters in different modes.
  - **Relative**: Moving the Q-Link knob will increase or decrease its parameter regardless of its physical position.
- **Low Range**: This is the Q-Link knob’s lowest possible value (0–127).
- **High Range**: This is the Q-Link knob’s highest possible value (0–127).
- **Touch Sense**: This activates or deactivates the Q-Link knob’s touch-capacitive circuitry.
  - **On**: You can touch the Q-Link knob to send a Note On message to the software (this is how your MPC hardware normally works).
  - **Off**: The Q-Link knob will not send any Note On messages; it will only send CC messages when you turn it.
- **Note**: This is the MIDI note number the Q-Link knob will send to the software when you touch it (0–127 or C-2 to G8). **Touch Sense** must be set to **On** for this to work.
### XY Pad

These are the MIDI parameters you can edit for each axis of the XY pad:

- **Control**: This is the axis you are currently editing (XYFX X-Axis or XYFX Y-Axis). This field will be hidden if you tapped the XY tab to show the XY pad’s parameters. You can tap the Hardware tab to show this field.
- **Mute**: This button determines whether the axis is muted or not. When muted, its MIDI output is disabled. You must be viewing the Settings to do this.
- **MIDI Channel**: This determines which MIDI channel (1–16) the axis will use to send its message to the software.
- **CC Number**: This determines what MIDI Control Change number the axis will send to the software.
- **Low Range**: This is the axis’s lowest possible value (0–127).
- **High Range**: This is the axis’s highest possible value (0–127).

### MIDI Learn

You can use the MIDI Learn function to assign external MIDI controllers to various parameters in your specific MPC project:

- Mixer parameters such as volume, pan, mute, and solo for MIDI or audio tracks, programs, returns, submixes, and master outputs
- Pad parameters (for drum programs and clip programs only) such as tuning, filter and amp envelopes, layer settings, LFO settings, and velocity
- Program parameters, which depend on the program type
- Insert effects parameters, which depend on the effect type

These assignments will be saved with your MPC project.

See Addenda > Updates in MPC 2.2 > New Features > MIDI Control Mode: MIDI Learn for more information.
Pad Perform Mode

Pad Perform Mode lets you assign musical scales/modes, chords, or progressions to the pads for more creative performance.

To enter Pad Perform Mode, do either of the following while using a keygroup program, MIDI program, plugin program, or CV program:

- Press **Menu**, and then tap **Pad Perform**.
- Press **Pad Perform** (MPC X).

Although you can enter Pad Perform Mode while using a drum program or clip program, it does not work with these programs.

The touchscreen will show the current pad bank’s mapping of notes or chords.
Use the type selector in the top-left to determine what will be mapped over the pads:

**Chromatic**: Each pad is assigned a note, ascending by one semitone with each pad. Pads with notes in the key determined by the **Scale** will be lit, while pads with notes between the scale degrees will be unlit.

**Notes**: Each pad is assigned a note, ascending by one scale degree with each pad.

**Chords**: Each pad is assigned a chord, the root note ascending by one scale degree with each pad. All available chords will play in the key determined by the **Scale**.

**Chromatic Chords**: Each pad is assigned a chord, the root note ascending by one scale degree with each pad. You can play any chord type regardless of the key determined by the **Scale**. Essentially, this is like the Chords setting but with more options to play chords out of the set key.

**Progressions**: Each pad is assigned a chord in a chord progression. You can play the pads in (or out of) order to construct songs quickly. The available chords are determined by the **Chord** field.

**Tip**: You can use your own progressions (created in the desktop version of the MPC software) on your MPC X or MPC Live. See **Addenda > Updates in MPC 2.1 > New Features > Pad Perform Mode: User Progressions** to learn more about this.
Use the **Scale & Octave** fields to determine the root note and the scale type.

**Root Note** (pitch and register): This is the starting point of the scale. The available notes are all chromatic notes across the range of the pads. The pad that’s assigned the root note will be lit differently (and highlighted on the screen) to indicate where the scale starts in each octave.

**Scale Type**: This is the scale or mode based on the root note (this is disabled when **Type** is set to **Progressions**). The available scales are:

- Major
- Blues (minor)
- Major Bebop
- Lydian
- Natural Minor
- Flamenco
- Whole Tone
- Mixolydian
- Harmonic Minor
- Gypsy
- Chromatic
- Aeolian
- Pentatonic Major
- Hungarian Gypsy
- Dorian
- Locrian
- Pentatonic Minor
- Persian
- Phrygian

Use the **Chord** fields to determine what chord type will play when pressing a pad. The chord will use those scale degrees based off of the pad’s root note. You can use this only when the **Type** is set to **Chords** or **Chromatic Chords**.

When set to **Chords**, the available chords are:

- 1-3-5 (major/minor)  
- 1-3-5-7 (major7/minor7)  
- 1-4-5 (sus4)  
- 1-3-5-7b (dominant)  
- 1-2-5 (sus2)

When set to **Chromatic Chords**, the available chords are:

- Major
- Major7
- Augmented
- Minor
- Minor7
- Diminished
- Sus2
- Major9
- Sus4
- Minor9

Use the **Banks** field to determine how the notes are mapped across the pad banks.

**Continuous**: Pad 01 of one bank is always one scale degree higher than Pad 16 of the previous bank.

**Start on Root**: Pad 01 will always be the root note of the scale in every pad bank.

You can use the buttons at the bottom of the screen to quickly select different Types and Chords:

- Tap **Notes** to automatically set the **Type** to **Notes**.
- Tap **1-3-5** to automatically set the **Type** to **Chords** and set the **Chord** to **1-3-5** (major/minor).
- Tap **1-3-5-7** to automatically set the **Type** to **Chords** and set the **Chord** to **1-3-5-7** (major7/minor7).
- Tap **Progressions** to automatically set the **Type** to **Progressions**.
- Tap **Octave */+** to shift the pad assignments down or up by an octave.
- Press **Shift+1-4-5** to automatically set the **Type** to **Chords** and set the **Chord** to **1-4-5** (sus4).
- Press **Shift+1-3-5-7b** to automatically set the **Type** to **Chords** and set the **Chord** to **1-3-5-7b** (dominant).
- Press **Shift+Note */+** to shift the pad assignments down or up by a semitone, essentially raising or lowering the **Root Note** field by a half-step.
Appendix

Effects & Parameters

This chapter lists the available effects. To learn more about how effects work with MPC, please see General Features > Effects.

Note: Some of these effects have a “sync” version (e.g., Flanger Sync, Autopan Sync, etc.) whose rates will be affected by the current tempo. While viewing the rate of these effects, a “.” next to the time division indicates a triplet-based rate.

Reverbs

Options: Reverb Small, Reverb Medium, Reverb Large, Reverb Large 2, Reverb In Gate, Reverb Out Gate

Reverb Small

This is a spatial effect, designed to emulate a small room.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>50</td>
</tr>
<tr>
<td>Pre-Delay</td>
<td>1–100</td>
<td>50</td>
</tr>
<tr>
<td>Early Reflection</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>Density</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>Diffuse</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>Decay</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>Lo-Cut</td>
<td>0–100</td>
<td>15</td>
</tr>
<tr>
<td>Hi-Cut</td>
<td>0–100</td>
<td>10</td>
</tr>
</tbody>
</table>

Reverb Medium

This is a spatial effect, designed to emulate a medium room.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>50</td>
</tr>
<tr>
<td>Pre-Delay</td>
<td>1–100</td>
<td>50</td>
</tr>
<tr>
<td>Early Reflection</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>Density</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>Diffuse</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>Decay</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>Lo-Cut</td>
<td>0–100</td>
<td>15</td>
</tr>
<tr>
<td>Hi-Cut</td>
<td>0–100</td>
<td>10</td>
</tr>
</tbody>
</table>
### Reverb Large

This is a spatial effect, designed to emulate the sound of a large hall.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>50</td>
</tr>
<tr>
<td>Pre-Delay</td>
<td>1–100</td>
<td>50</td>
</tr>
<tr>
<td>Early Reflection</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>Density</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>Diffuse</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>Decay</td>
<td>0–100</td>
<td>75</td>
</tr>
<tr>
<td>Lo-Cut</td>
<td>0–100</td>
<td>10</td>
</tr>
<tr>
<td>Hi-Cut</td>
<td>0–100</td>
<td>10</td>
</tr>
</tbody>
</table>

### Reverb Large 2

This is a less CPU-intensive spatial effect, emulating the sound of a large hall.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>50</td>
</tr>
<tr>
<td>Pre-Delay</td>
<td>1–100</td>
<td>50</td>
</tr>
<tr>
<td>Early Reflection</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>Density</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>Diffuse</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>Decay</td>
<td>0–100</td>
<td>75</td>
</tr>
<tr>
<td>Lo-Cut</td>
<td>0–100</td>
<td>10</td>
</tr>
<tr>
<td>Hi-Cut</td>
<td>0–100</td>
<td>10</td>
</tr>
</tbody>
</table>

### Reverb In Gate

This is a hall reverb with an additional control. The reverb effect is cut off when the input drops below the level set in the Gate In parameter.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>50</td>
</tr>
<tr>
<td>Pre-Delay</td>
<td>1–100</td>
<td>50</td>
</tr>
<tr>
<td>Early Reflection</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>Density</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>Diffuse</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>Decay</td>
<td>0–100</td>
<td>75</td>
</tr>
<tr>
<td>Lo-Cut</td>
<td>0–100</td>
<td>10</td>
</tr>
<tr>
<td>Hi-Cut</td>
<td>0–100</td>
<td>10</td>
</tr>
<tr>
<td>Gate In</td>
<td>0–100</td>
<td>0</td>
</tr>
</tbody>
</table>
Reverb Out Gate

This is a hall reverb that has an additional control. The reverb effect is cut off when the output drops below the level set in the Gate Out parameter.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>50</td>
</tr>
<tr>
<td>Pre-Delay</td>
<td>1–100</td>
<td>50</td>
</tr>
<tr>
<td>Early Reflection</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>Density</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>Diffuse</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>Decay</td>
<td>0–100</td>
<td>75</td>
</tr>
<tr>
<td>Lo-Cut</td>
<td>0–100</td>
<td>10</td>
</tr>
<tr>
<td>Hi-Cut</td>
<td>0–100</td>
<td>10</td>
</tr>
<tr>
<td>Gate Out</td>
<td>0–100</td>
<td>0</td>
</tr>
</tbody>
</table>

Delays

Delays the original signal for a specified period of time and plays it back over an adjustable period of time.

Options: Delay Mono, Delay Mono Sync, Delay Stereo, Delay Sync (Stereo), Delay LP, Delay HP, Delay Analog, Delay Analog Sync, Delay Tape Sync, Delay Ping Pong, Delay Multi-Tap

Delay Mono

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>50</td>
</tr>
<tr>
<td>Time</td>
<td>2–2000 ms</td>
<td>100</td>
</tr>
<tr>
<td>Feedback</td>
<td>0–100</td>
<td>25</td>
</tr>
<tr>
<td>Damping</td>
<td>0–100</td>
<td>100</td>
</tr>
</tbody>
</table>

Delay Mono Sync

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>50</td>
</tr>
<tr>
<td>Time</td>
<td>1 bar – 1/16 triplets</td>
<td>1/4</td>
</tr>
<tr>
<td>Feedback</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>Damping</td>
<td>0–100</td>
<td>100</td>
</tr>
</tbody>
</table>
**Delay Stereo**

Stereo Delay operates similarly to Mono Delay but in true stereo.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>50</td>
</tr>
<tr>
<td>Time</td>
<td>2–2000 ms</td>
<td>100</td>
</tr>
<tr>
<td>Feedback</td>
<td>0–100</td>
<td>25</td>
</tr>
<tr>
<td>Damping</td>
<td>0–100</td>
<td>100</td>
</tr>
</tbody>
</table>

**Delay Sync (Stereo)**

Stereo Delay operates similarly to Mono Delay but in true stereo.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>50</td>
</tr>
<tr>
<td>Time</td>
<td>1 bar – 1/16 triplets</td>
<td>1/4</td>
</tr>
<tr>
<td>Feedback</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>Damping</td>
<td>0–100</td>
<td>100</td>
</tr>
</tbody>
</table>

**Delay LP**

LP Delay is identical to the Mono Delay, but it uses a resonant low-pass filter in the delay line.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>50</td>
</tr>
<tr>
<td>Time</td>
<td>2–2000 ms</td>
<td>500</td>
</tr>
<tr>
<td>Feedback</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>Cutoff</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>Resonance</td>
<td>0–100</td>
<td>20</td>
</tr>
</tbody>
</table>

**Delay HP**

HP Delay is identical to the Mono Delay, but it uses a resonant high-pass filter in the delay line.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>50</td>
</tr>
<tr>
<td>Time</td>
<td>2–2000 ms</td>
<td>100</td>
</tr>
<tr>
<td>Feedback</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>Cutoff</td>
<td>0–100</td>
<td>33</td>
</tr>
<tr>
<td>Resonance</td>
<td>0–100</td>
<td>33</td>
</tr>
</tbody>
</table>
Delay Analog

Analog Delay is similar to the Mono Delay, except that it’s designed to emulate an analog “Bucket Brigade”-style delay. This delay has a unique character to it that gives a warmer sound by adding subtle inaccuracies in phase and timing.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>50</td>
</tr>
<tr>
<td>Time</td>
<td>2–2000 ms</td>
<td>100</td>
</tr>
<tr>
<td>Feedback</td>
<td>0–100</td>
<td>25</td>
</tr>
</tbody>
</table>

Delay Analog Sync

Analog Delay is similar to Mono Delay, except that it’s designed to emulate an analog “Bucket Brigade”-style delay. This delay has a unique character to it that gives a warmer sound by adding subtle inaccuracies in phase and timing.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>50</td>
</tr>
<tr>
<td>Time</td>
<td>1 bar – 1/16 triplets</td>
<td>1/4</td>
</tr>
<tr>
<td>Feedback</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>Ramp</td>
<td>0–100</td>
<td>50</td>
</tr>
</tbody>
</table>

Delay Tape Sync

Tape Delay emulates a delay system using an analog tape loop and a series of tape heads to produce an echo effect. This delay type yields a very distinct echo sound often heard in reggae and dub-style music.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>50</td>
</tr>
<tr>
<td>Time</td>
<td>1 bar – 1/16 triplets</td>
<td>1/4</td>
</tr>
<tr>
<td>Feedback</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>Ramp</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>Head 1</td>
<td>0–100</td>
<td>100</td>
</tr>
<tr>
<td>Head 2</td>
<td>0–100</td>
<td>0</td>
</tr>
<tr>
<td>Head 3</td>
<td>0–100</td>
<td>0</td>
</tr>
<tr>
<td>Head 4</td>
<td>0–100</td>
<td>0</td>
</tr>
<tr>
<td>Tone</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>Spread</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>Wow &amp; Flutter</td>
<td>0–100</td>
<td>50</td>
</tr>
</tbody>
</table>

Delay Ping Pong

This stereo delay allows you to set different delay times for its left and right repeats.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>50</td>
</tr>
<tr>
<td>Time, Left</td>
<td>2–2000 ms</td>
<td>100</td>
</tr>
<tr>
<td>Time, Right</td>
<td>2–2000 ms</td>
<td>100</td>
</tr>
<tr>
<td>Feedback</td>
<td>0–100</td>
<td>25</td>
</tr>
<tr>
<td>Damping</td>
<td>0–100</td>
<td>100</td>
</tr>
</tbody>
</table>
Delay Multi-Tap

This delay is a mono delay which has three delay generators with independently adjustable delay times and stereo position.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>50</td>
</tr>
<tr>
<td>Time 1</td>
<td>2–2000 ms</td>
<td>100</td>
</tr>
<tr>
<td>Time 2</td>
<td>2–2000 ms</td>
<td>100</td>
</tr>
<tr>
<td>Time 3</td>
<td>2–2000 ms</td>
<td>100</td>
</tr>
<tr>
<td>Feedback</td>
<td>0–100</td>
<td>25</td>
</tr>
<tr>
<td>Pan 1</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>Pan 2</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>Pan 3</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>Damping</td>
<td>0–100</td>
<td>100</td>
</tr>
<tr>
<td>Gain 1</td>
<td>0–100</td>
<td>25</td>
</tr>
<tr>
<td>Gain 2</td>
<td>0–100</td>
<td>25</td>
</tr>
<tr>
<td>Gain 3</td>
<td>0–100</td>
<td>25</td>
</tr>
</tbody>
</table>

Flangers

A flanger is a modulated delay to emulate the sound created when running two analog tape machines in parallel with a slight time misalignment. Slow Rate settings can produce a “whooshing” jet engine sound, while faster rates result in more of a “warble.”

**Options:** Flanger, Flanger Sync

**Flanger**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>100</td>
</tr>
<tr>
<td>Rate</td>
<td>0–100</td>
<td>10</td>
</tr>
<tr>
<td>Feedback</td>
<td>-100 – 100</td>
<td>0</td>
</tr>
<tr>
<td>Delay</td>
<td>0–100</td>
<td>20</td>
</tr>
<tr>
<td>Width</td>
<td>0–100</td>
<td>80</td>
</tr>
</tbody>
</table>

**Flanger Sync**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>100</td>
</tr>
<tr>
<td>Rate</td>
<td>8 bars – 1/16 triplets</td>
<td>1/4</td>
</tr>
<tr>
<td>Feedback</td>
<td>-100 – 100</td>
<td>0</td>
</tr>
<tr>
<td>Delay</td>
<td>0–100</td>
<td>20</td>
</tr>
<tr>
<td>Width</td>
<td>0–100</td>
<td>80</td>
</tr>
</tbody>
</table>
Chorus

A chorus effect uses an LFO to modulate the pitch and a delay of the input signal, which are then added to the dry signal. In small amounts, this creates the illusion of multiple voices playing at once. Turn up the Feedback and Depth for more pronounced “shimmering” and “watery” sounds.

Options: Chorus 2-Voice, Chorus 4-Voice

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>100</td>
</tr>
<tr>
<td>Delay</td>
<td>0–100</td>
<td>20</td>
</tr>
<tr>
<td>Amount</td>
<td>0–100</td>
<td>80</td>
</tr>
<tr>
<td>Width</td>
<td>0–100</td>
<td>80</td>
</tr>
<tr>
<td>Feedback</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>Rate</td>
<td>0–100</td>
<td>10</td>
</tr>
</tbody>
</table>

Autopans

This effect uses an LFO to move the incoming signal back and forth across the stereo field, creating a rotary effect.

Options: Autopan, Autopan Sync

Autopan

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>100</td>
</tr>
<tr>
<td>Rate</td>
<td>0–100</td>
<td>10</td>
</tr>
</tbody>
</table>

Autopan Sync

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>100</td>
</tr>
<tr>
<td>Rate</td>
<td>8 bars – 1/32</td>
<td>1/4</td>
</tr>
</tbody>
</table>
Tremolos

This effect uses an LFO to increase and decrease the volume of the signal. Depending on the LFO shape, this can produce a smooth wave effect (sine wave) or a stuttering “on-off” effect (square wave).

Options: **Tremolo, Tremolo Sync**

### Tremolo

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>100</td>
</tr>
<tr>
<td>Rate</td>
<td>0–100</td>
<td>10</td>
</tr>
<tr>
<td>Sine to Square</td>
<td>0–100 (sine–square)</td>
<td>0</td>
</tr>
</tbody>
</table>

### Tremolo Sync

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>100</td>
</tr>
<tr>
<td>Rate</td>
<td>1 bar – 1/16 triplets</td>
<td>1/4</td>
</tr>
<tr>
<td>Sine to Square</td>
<td>0–100 (sine–square)</td>
<td>0</td>
</tr>
</tbody>
</table>

Phasers

The phaser is a classic effect, created by multiple ganged all-pass filters to create “notches,” or sharp spikes, in the frequency spectrum. The frequencies of these all-pass filters are usually modulated by an LFO to create a sweeping sound.

Options: **Phaser 1, Phaser 2, Phaser Sync**

### Phaser 1

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>100</td>
</tr>
<tr>
<td>Rate</td>
<td>0–100</td>
<td>10</td>
</tr>
</tbody>
</table>

### Phaser 2

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>100</td>
</tr>
<tr>
<td>Rate</td>
<td>0–100</td>
<td>10</td>
</tr>
</tbody>
</table>

### Phaser Sync

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>100</td>
</tr>
<tr>
<td>Rate</td>
<td>1 bar – 1/16 triplets</td>
<td>1/4</td>
</tr>
</tbody>
</table>
## HP (High-Pass) Filters

Options: **HP Filter, HP Filter Sweep, HP Filter Sync, HP Shelving Filter**

### HP Filter
This effect is a static filter without modulation.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Frequency</td>
<td>10–19999 Hz</td>
<td>1500</td>
</tr>
<tr>
<td>Resonance</td>
<td>0–100</td>
<td>0</td>
</tr>
</tbody>
</table>

### HP Filter Sweep
This effect is a high-pass filter with its cutoff frequency modulated by an LFO.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>80</td>
</tr>
<tr>
<td>Low Frequency</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>High Frequency</td>
<td>0–100</td>
<td>100</td>
</tr>
<tr>
<td>Resonance</td>
<td>0–100</td>
<td>33</td>
</tr>
<tr>
<td>Rate</td>
<td>0–100</td>
<td>10</td>
</tr>
</tbody>
</table>

### HP Filter Sync
This effect is a high-pass filter with its cutoff frequency modulated by an LFO.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>100</td>
</tr>
<tr>
<td>Low Frequency</td>
<td>0–100</td>
<td>0</td>
</tr>
<tr>
<td>High Frequency</td>
<td>0–100</td>
<td>100</td>
</tr>
<tr>
<td>Resonance</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>Rate</td>
<td>8 bars – 1/32</td>
<td>1/4</td>
</tr>
</tbody>
</table>

### HP Shelving Filter
This filter differs from the standard filter type, as it attenuates all frequencies after the cutoff point equally.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Frequency</td>
<td>10–19999 Hz</td>
<td>1500</td>
</tr>
<tr>
<td>Resonance</td>
<td>0–100</td>
<td>0</td>
</tr>
<tr>
<td>Gain</td>
<td>-18.0 – 18.0 dB</td>
<td>0.0</td>
</tr>
</tbody>
</table>
**LP (Low-Pass) Filters**

Options: LP Filter, LP Filter Sweep, LP Filter Sync, LP Shelving Filter

**LP Filter**
This effect is a static filter without modulation.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Frequency</td>
<td>10–19999 Hz</td>
<td>1500</td>
</tr>
<tr>
<td>Resonance</td>
<td>0–100</td>
<td>0</td>
</tr>
</tbody>
</table>

**LP Filter Sweep**
This effect is a low-pass filter with its cutoff frequency modulated by an LFO.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>80</td>
</tr>
<tr>
<td>Low Frequency</td>
<td>0–100</td>
<td>0</td>
</tr>
<tr>
<td>High Frequency</td>
<td>0–100</td>
<td>100</td>
</tr>
<tr>
<td>Resonance</td>
<td>0–100</td>
<td>33</td>
</tr>
<tr>
<td>Rate</td>
<td>0–100</td>
<td>10</td>
</tr>
</tbody>
</table>

**LP Filter Sync**
This effect is a low-pass filter with its cutoff frequency modulated by an LFO.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>100</td>
</tr>
<tr>
<td>Low Frequency</td>
<td>0–100</td>
<td>0</td>
</tr>
<tr>
<td>High Frequency</td>
<td>0–100</td>
<td>100</td>
</tr>
<tr>
<td>Resonance</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>Rate</td>
<td>8 bars – 1/32</td>
<td>1/4</td>
</tr>
</tbody>
</table>

**LP Shelving Filter**
This filter differs from the standard filter type, as it attenuates all frequencies after the cutoff point equally.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Frequency</td>
<td>10–19999 Hz</td>
<td>1500</td>
</tr>
<tr>
<td>Resonance</td>
<td>0–100</td>
<td>0</td>
</tr>
<tr>
<td>Gain</td>
<td>-18.0 – 18.0 dB</td>
<td>0.0</td>
</tr>
</tbody>
</table>
**Parametric EQs**

**Options: PEQ 2-Band, 2-Shelf, PEQ 4-Band**

**PEQ 2-Band, 2-Shelf**
This effect is a combination of one two-band parametric equalizer and two shelving filters.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Low Frequency</td>
<td>22–1000 Hz</td>
<td>220</td>
</tr>
<tr>
<td>Frequency 1</td>
<td>82–3900 Hz</td>
<td>820</td>
</tr>
<tr>
<td>Frequency 2</td>
<td>220–10000 Hz</td>
<td>2200</td>
</tr>
<tr>
<td>High Frequency</td>
<td>560–19999 Hz</td>
<td>5600</td>
</tr>
<tr>
<td>Q1</td>
<td>0–100</td>
<td>0</td>
</tr>
<tr>
<td>Q2</td>
<td>0–100</td>
<td>0</td>
</tr>
<tr>
<td>Low Gain</td>
<td>-18.0 – 18.0 dB</td>
<td>0.0</td>
</tr>
<tr>
<td>Gain 1</td>
<td>-18.0 – 18.0 dB</td>
<td>0.0</td>
</tr>
<tr>
<td>Gain 2</td>
<td>-18.0 – 18.0 dB</td>
<td>0.0</td>
</tr>
<tr>
<td>High Gain</td>
<td>-18.0 – 18.0 dB</td>
<td>0.0</td>
</tr>
</tbody>
</table>

**PEQ 4-Band**
This effect is a powerful four-band parametric equalizer with four independent EQ ranges.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Low Frequency</td>
<td>22–1000 Hz</td>
<td>220</td>
</tr>
<tr>
<td>Frequency 1</td>
<td>82–3900 Hz</td>
<td>820</td>
</tr>
<tr>
<td>Frequency 2</td>
<td>220–10000 Hz</td>
<td>2200</td>
</tr>
<tr>
<td>High Frequency</td>
<td>560–19999 Hz</td>
<td>5600</td>
</tr>
<tr>
<td>Q1</td>
<td>0–100</td>
<td>5</td>
</tr>
<tr>
<td>Q2</td>
<td>0–100</td>
<td>5</td>
</tr>
<tr>
<td>Q3</td>
<td>0–100</td>
<td>5</td>
</tr>
<tr>
<td>Q4</td>
<td>0–100</td>
<td>5</td>
</tr>
<tr>
<td>Gain 1</td>
<td>-18.0 – 18.0 dB</td>
<td>0.0</td>
</tr>
<tr>
<td>Gain 2</td>
<td>-18.0 – 18.0 dB</td>
<td>0.0</td>
</tr>
<tr>
<td>Gain 3</td>
<td>-18.0 – 18.0 dB</td>
<td>0.0</td>
</tr>
<tr>
<td>Gain 4</td>
<td>-18.0 – 18.0 dB</td>
<td>0.0</td>
</tr>
</tbody>
</table>
Distortions

Options: Distortion Amp, Distortion Fuzz, Distortion Grimey, Distortion Overdrive, Distortion Custom

Distortion Amp

This effect is designed to reproduce the sound of a tube amplifier at high volumes.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>100</td>
</tr>
<tr>
<td>Drive</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>Tone</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>Dynamics</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>Output</td>
<td>0–100</td>
<td>50</td>
</tr>
</tbody>
</table>

Distortion Fuzz

This popular effect uses hard clipping of the audio signal, which, at extreme settings, can turn a standard waveform into a square wave, producing a “razor” effect.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>100</td>
</tr>
<tr>
<td>Drive</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>Output</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>Low</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>Low-Mid</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>High-Mid</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>High</td>
<td>0–100</td>
<td>50</td>
</tr>
</tbody>
</table>

Distortion Grimey

This is a unique distortion effect that distorts a frequency range in a selectable band.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>100</td>
</tr>
<tr>
<td>Drive</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>Grime</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>Center</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>Width</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>Resonance</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>Output</td>
<td>0–100</td>
<td>50</td>
</tr>
</tbody>
</table>

Distortion Overdrive

This distortion is designed to sound like a mildly distorting amplifier at medium volumes. It is the smoothest distortion type available.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>100</td>
</tr>
<tr>
<td>Drive</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>Tone</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>Output</td>
<td>0–100</td>
<td>50</td>
</tr>
</tbody>
</table>
Distortion Custom

This effect is a highly customized distortion, capable of a wide range of usable sounds.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>100</td>
</tr>
<tr>
<td>Drive</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>+Soft</td>
<td>5–75</td>
<td>2</td>
</tr>
<tr>
<td>+Clip</td>
<td>5–50</td>
<td>25</td>
</tr>
<tr>
<td>–Soft</td>
<td>5–75</td>
<td>2</td>
</tr>
<tr>
<td>–Clip</td>
<td>5–50</td>
<td>25</td>
</tr>
<tr>
<td>Low</td>
<td>-18.0 – 18.0 dB</td>
<td>0.0</td>
</tr>
<tr>
<td>Mid</td>
<td>-18.0 – 18.0 dB</td>
<td>0.0</td>
</tr>
<tr>
<td>High</td>
<td>-18.0 – 18.0 dB</td>
<td>0.0</td>
</tr>
<tr>
<td>Output</td>
<td>-18.0 – 18.0 dB</td>
<td>50</td>
</tr>
</tbody>
</table>

Compressors

A compressor is an effect that changes the dynamic range of a signal by automatically reducing its gain.

Options: Compressor Master, Compressor Opto, Compressor VCA, Compressor Vintage

Compressor Master

This is the most transparent compressor, able to perform substantial volume adjustments without artifacts.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>100</td>
</tr>
<tr>
<td>Attack</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>Release</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>Threshold</td>
<td>-50 – 0 dB</td>
<td>0</td>
</tr>
<tr>
<td>Ratio</td>
<td>1–20</td>
<td>1</td>
</tr>
<tr>
<td>Oldskool</td>
<td>Off, On</td>
<td>Off</td>
</tr>
<tr>
<td>Output</td>
<td>-6 – 24 dB</td>
<td>0</td>
</tr>
</tbody>
</table>

Compressor Opto

The Opto Compressor is modeled after a vintage compressor type using an optical circuit to control the volume reduction of the input signal. These compressors are usually associated with soft and unobtrusive attack and release characteristics.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>100</td>
</tr>
<tr>
<td>Input</td>
<td>-6 – 18 dB</td>
<td>0</td>
</tr>
<tr>
<td>Attack</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>Release</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>Threshold</td>
<td>-50 – 0 dB</td>
<td>0</td>
</tr>
<tr>
<td>Ratio</td>
<td>1–20</td>
<td>1</td>
</tr>
<tr>
<td>Knee</td>
<td>1–100</td>
<td>1</td>
</tr>
<tr>
<td>Output</td>
<td>-6 – 24 dB</td>
<td>0</td>
</tr>
</tbody>
</table>
Compressor VCA

This compressor is more modern-sounding, with a slightly more transparent sound. A VCA Compressor tends to have quicker attack and release times than an Opto Compressor.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>100</td>
</tr>
<tr>
<td>Input</td>
<td>-6 – 18 dB</td>
<td>0</td>
</tr>
<tr>
<td>Attack</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>Release</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>Threshold</td>
<td>-50 – 0 dB</td>
<td>0</td>
</tr>
<tr>
<td>Ratio</td>
<td>1–20</td>
<td>1</td>
</tr>
<tr>
<td>Knee</td>
<td>1–100</td>
<td>1</td>
</tr>
<tr>
<td>Output</td>
<td>-6 – 24 dB</td>
<td>0</td>
</tr>
</tbody>
</table>

Compressor Vintage

This compressor has a sound similar to classic tube compressors, with their gentle yet pumping response and a dash of tube saturation.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>100</td>
</tr>
<tr>
<td>Input</td>
<td>-6 – 18 dB</td>
<td>0</td>
</tr>
<tr>
<td>Attack</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>Release</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>Threshold</td>
<td>-50 – 0 dB</td>
<td>0</td>
</tr>
<tr>
<td>Ratio</td>
<td>1–20</td>
<td>1</td>
</tr>
<tr>
<td>Knee</td>
<td>1–100</td>
<td>1</td>
</tr>
<tr>
<td>Output</td>
<td>-6 – 24 dB</td>
<td>0</td>
</tr>
</tbody>
</table>

Bit Reducers

Options: Decimator, Resampler

Decimator

Decimator down-samples the incoming signal by removing bits from the digital signal. The difference between decimation and resampling is that Decimator does not use any filtering to mask or correct digital artifacts. The result is an effect ranging from mild to almost completely pure digital distortion, depending on the setting and the source material.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>100</td>
</tr>
<tr>
<td>Decimate</td>
<td>0–100</td>
<td>0</td>
</tr>
<tr>
<td>Bit Reducer</td>
<td>4–32</td>
<td>32</td>
</tr>
</tbody>
</table>

Resampler

Resampler is similar to Decimator in that it removes bits from an incoming signal. The difference is that Resampler applies a complex suite of filters and anti-aliasing to attempt to retain the original sound quality. This is a method used by popular vintage samplers and sampling drum machines from the 1980s. Resampler can be used to achieve a “dirty” sound on drum loops, without the harshness of distortion.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>100</td>
</tr>
<tr>
<td>Rate</td>
<td>0–100</td>
<td>0</td>
</tr>
<tr>
<td>Decimate</td>
<td>0–100</td>
<td>0</td>
</tr>
</tbody>
</table>
Options: *Auto Wah*, *Frequency Shifter*, *Transient Shaper*

**Auto Wah**

This effect is a low-pass filter modulated by an envelope that yields a classic funky “wah-wah”-like sound. The envelope is triggered by the incoming signal’s amplitude. The amount of the envelope on the cutoff frequency is user-definable.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>100</td>
</tr>
<tr>
<td>Resonance</td>
<td>0–100</td>
<td>75</td>
</tr>
<tr>
<td>Attack</td>
<td>0–100</td>
<td>30</td>
</tr>
<tr>
<td>Release</td>
<td>0–100</td>
<td>30</td>
</tr>
<tr>
<td>Center</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>Sensitivity</td>
<td>0–100</td>
<td>50</td>
</tr>
</tbody>
</table>

**Frequency Shifter**

A frequency shifter changes the frequencies of an input signal by a fixed amount and alters the relationship of the original harmonics. This can produce a chorus-like effect as well as very crazy artificial timbres.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>100</td>
</tr>
<tr>
<td>Frequency</td>
<td>-1000 – 1000</td>
<td>0</td>
</tr>
<tr>
<td>Asynchrony</td>
<td>0–1000</td>
<td>0</td>
</tr>
<tr>
<td>A Pan</td>
<td>0–100</td>
<td>0</td>
</tr>
<tr>
<td>B Pan</td>
<td>0–100</td>
<td>100</td>
</tr>
<tr>
<td>A Gain</td>
<td>0–100</td>
<td>75</td>
</tr>
<tr>
<td>B Gain</td>
<td>0–100</td>
<td>75</td>
</tr>
</tbody>
</table>

**Transient Shaper**

A transient shaper can be used to enhance or soften the Attack and Release phases of audio material.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry/Wet</td>
<td>0–100 (dry–wet)</td>
<td>100</td>
</tr>
<tr>
<td>Attack</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>Release</td>
<td>0–100</td>
<td>50</td>
</tr>
<tr>
<td>Output</td>
<td>0–100</td>
<td>50</td>
</tr>
</tbody>
</table>
## Glossary

This glossary briefly defines and explains many of the technical terms used throughout this manual.

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Aftertouch</strong></td>
<td>The majority of contemporary keyboards are capable of generating aftertouch messages. On this type of keyboard, when you press harder on a key you are already holding down, a MIDI aftertouch message is generated. This feature makes sounds even more expressive (e.g., through vibrato).</td>
</tr>
<tr>
<td><strong>Aliasing</strong></td>
<td>Aliasing is an audible side effect arising in digital systems as soon as a signal contains harmonics higher than half the sampling frequency.</td>
</tr>
<tr>
<td><strong>Amount</strong></td>
<td>Describes to which extent a modulation source influences a given parameter.</td>
</tr>
<tr>
<td><strong>Amplifier</strong></td>
<td>An amplifier is a component that influences the volume level of a sound via a control signal. It can be modulated by a control signal (e.g., generated by an <em>envelope</em> or an <em>LFO</em>).</td>
</tr>
<tr>
<td><strong>Attack</strong></td>
<td>An <em>envelope</em> parameter. This term describes the ascent rate of a time-relevant process (e.g., an envelope from its starting point to the point where it reaches its highest value). The attack phase is initiated immediately after a trigger signal is received (e.g., after you play a note on a trigger pad or a keyboard).</td>
</tr>
<tr>
<td><strong>Bit Rate</strong></td>
<td>Bit rate (also known as <em>word length</em>), is the number of bits used to store the level information of each single sample slice within a whole sample. The higher the bit rate, the more precise the information about a sample (i.e., its dynamics’ resolution). Normal audio CDs are 16-bit. The MPC hardware supports full 24-bit resolution.</td>
</tr>
<tr>
<td><strong>Bounce</strong></td>
<td>When you “bounce” a sequence, track, or program, you are rendering that part of your project as an audio file (as opposed to a MIDI file). The MPC hardware lets you bounce sequences, tracks, or programs as <em>samples</em> (saved to your project’s sample pool) or as full <em>audio tracks</em> (saved to your project’s sample pool and added directly to the current sequence).</td>
</tr>
<tr>
<td><strong>Clipping</strong></td>
<td>Clipping is a sort of distortion that occurs when a signal exceeds the maximum value that can be handled by a signal processing system it is fed into. The curve of a clipped signal is dependent on the system where the clipping occurs. In the analog domain, clipping effectively limits the signal to a given maximum level. In the digital domain, clipping is similar to a numerical overflow, resulting in negative polarity of the signal’s portions exceeding the maximum level.</td>
</tr>
<tr>
<td><strong>Control Change</strong></td>
<td>MIDI messages enable you to manipulate the behavior of a sound generator to a significant degree. This message essentially consists of two components:</td>
</tr>
<tr>
<td><strong>Cutoff</strong></td>
<td>The cutoff frequency is a significant factor for a <em>filter</em>. A low-pass filter for example dampens the portion of the signal that lies above this frequency. Frequencies below this value are allowed to pass through without being processed.</td>
</tr>
</tbody>
</table>

### Control Change (Controllers)

- The controller number, which defines the parameter to be influenced. It can range from 0 to 127.
- The controller value, which determines the extent of the modification.

Controllers can be used for effects such as slowly swelling vibrato, changing the stereo panning position and influencing filter frequency.
CV stands for control voltage, an analog method of sending control messages to external synthesizers, drum machines, etc. CV messages are typically used in conjunction with Gate messages (CV messages determine the pitch of notes while Gate messages determine note activation and length). CV messages are sent from the CV out ports of your MPC hardware and to the CV in ports of your external MIDI device.

Please note that each external MIDI device uses a specific control voltage range, which determines how many volts are used in each octave (e.g., 1V/oct). Be mindful of this when setting it up with the MPC software and/or controller hardware—mismatched voltage ranges can produce unusual/undesirable “re-scaling” of the octaves.

Decay describes the descent rate of an envelope once the attack phase has reached its maximum and the envelope drops to the level defined by the sustain value.

An envelope is used to modulate a sound-shaping component within a given time. For instance, an envelope that modulates the cutoff frequency of a filter opens and closes this filter over a period of time. An envelope is started via a trigger, usually a MIDI note.

The classic ADSR envelope consists of four individually variable phases: attack, decay, sustain, and release. Attack, decay and release are time or slope values, while sustain is an adjustable level. Once an incoming trigger is received, the envelope runs through the attack and decay phases until it reaches the programmed sustain level. This level remains constant until the trigger is terminated. The envelope then initiates the release phase until it reaches the minimum value.

You can see and read about the envelopes used in MPC Live in **Operation > Modes > Program Edit Mode > Anatomy of an Envelope.**

A filter is a component that allows some of a signal’s frequencies to pass through it and dampens other frequencies. The most important aspect of a filter is the filter cutoff frequency. Filters generally come in four categories: low-pass, high-pass, band-pass, and band-stop. These are the available filters:

- A **low-pass** filter (the most common type) dampens all frequencies above the cutoff frequency.
- A **high-pass** filter in turn dampens the frequencies below the cutoff.
- A **band-pass** filter allows only those frequencies around the cutoff frequency to pass. All others are dampened.
- A **band-stop** filter does the opposite of a band-pass: it dampens only the frequencies around the cutoff frequency.

A **band-boost** filter boosts the frequencies around the cutoff frequency, similar to what a band on an equalizer would do. All other frequencies pass through normally.

The number of **poles** in a filter’s “slope” determines how extreme or subtle the effect of the filter will be. Filters with one or two poles produce a subtler sound while filters with six or eight poles are much more pronounced.

The **Model** filters are analog-style emulations of famous vintage synth filters. **Model1** is a four-pole filter that distorts at high input levels. **Model2** uses a mellow resonance with a “fattening” distortion in the lower frequencies. **Model3** can produce howling, piercing resonances and extreme sub frequencies—watch your speakers!

The **Vocal** filters are formant filters that emulate the human voice. **Vocal1** produces “ah” and “ooh” vowel sounds. **Vocal2** uses three bands to produce “oh” and “ee” vowel sounds. **Vocal3** uses five bands to emulate an idealized model of the vocal tract.

**MPC3000 LPF** is a dynamic, resonant low-pass filter (12 dB/oct) that was used on the original MPC3000, released in 1994.

Please also see the entry for **Resonance**, an essential characteristic of a filter’s sound.

Gate messages are analog messages sent to external synthesizers, drum machines, etc. Gate messages are typically used in conjunction with CV messages (CV messages determine the pitch of notes while Gate messages determine note activation and length). Gate messages are sent from the CV out ports of your MPC hardware and to the CV/Gate in ports of your external MIDI device.
LFO

LFO is an acronym for **low-frequency oscillator**. The LFO generates a periodic oscillation at a low frequency and features variable waveshapes. Similar to an envelope, an LFO can be used to modulate a sound-shaping component.

MIDI

MIDI stands for **musical instrument digital interface**. Developed in the early 1980s, MIDI enables interaction between various types of electronic music instruments from different manufacturers. At the time a communications standard for heterogeneous devices did not exist, so MIDI was a significant advance. It made it possible to link various devices with one another through simple, standardized connectors.

Essentially, this is how MIDI works: One sender is connected to one or several receivers. For instance, if you want to use a computer to play a MIDI synthesizer, the computer is the sender and the synthesizer acts as the receiver. With a few exceptions, the majority of MIDI devices are equipped with two or three ports for this purpose: MIDI In, MIDI Out and in some cases MIDI Thru. The sender transfers data to the receiver via the MIDI Out jack. Data are sent via a cable to the receiver’s MIDI In jack.

MIDI Thru has a special function. It allows the sender to transmit to several receivers. It routes the incoming signal to the next device without modifying it. Another device is simply connected to this jack, thus creating a chain through which the sender can address a number of receivers. Of course, it is desirable for the sender to be able to address each device individually. To achieve this, a MIDI channel message is sent with each MIDI event.

MIDI Channel

This is a very important element of most messages. A receiver can only respond to incoming messages if its receive channel is set to the same channel as the one the sender is using to transmit data. Subsequently, the sender can address specific receivers individually. MIDI Channels 1–16 are available for this purpose.

MIDI Clock

The MIDI clock message transmits real-time tempo information to synchronize processes among several connected devices (e.g., a sound generator’s delay time to a MIDI sequencer).

Modulation

A modulation influences or changes a sound-shaping component via a modulation source. Modulation sources include envelopes, LFOs or MIDI messages. The modulation destination is a sound-shaping component such as a filter or a VCA.

Note On & Note Off

This is the most important MIDI message. It determines the pitch and velocity of a generated note. A note-on message will start a note. Its pitch is derived from the note number, which can range from 0 to 127. The velocity ranges from 1 to 127. A velocity value of 0 is equivalent to a note-off message.

Normalize

Normalization is a function to raise the level of a sample to its maximum (0 dB) without causing distortion. This function automatically searches a sample for its maximum level and consequently raises the entire sample’s level until the previously determined maximum level reaches 0 dB. In general, this results in a higher overall volume of the sample.

Panning

The process or the result of changing a signal’s position within the stereo panorama.

Pitch-Bend

Pitch-bend is a MIDI message. Although pitch-bend messages are similar in function to control change messages, they are a distinct type of message. The resolution of a pitch-bend message is substantially higher than that of a conventional controller message. The human ear is exceptionally sensitive to deviations in pitch, so the higher resolution is used because it relays pitch-bend information more accurately.
Program

A program is a file that contains a list of all samples to be used, and settings for each sample (e.g., pad assignments, loop points, pitch tuning, effects, etc.) Program Edit Mode is where you can edit and assign samples (read more about this in Operation > Modes > Program Edit Mode). You can have a total of 128 programs in a project.

There are three kinds of programs that use samples for their sound source. Drum programs are mostly used for creating drum programs and easy and quick assigning of samples to a pad. With keygroup programs, you can use one sample (or more) and spread it across two or more keys and play the sample chromatically over a keyboard. That way, there is no need to sample every key of, for instance, a piano. Clip programs use several samples that can be looped (clips), each of which can assigned to a pad; launching different combinations of clips together lets you create intriguing, layered performances.

Program Change

These are MIDI messages that select sound programs. Programs 1–128 can be changed via program change messages.

Release

An envelope parameter. This term describes the descent rate of an envelope to its minimum value after a trigger is terminated. The release phase begins immediately after the trigger is terminated, regardless of the envelope’s current status. For instance, the release phase may be initiated during the attack phase.

Resonance

Resonance or emphasis is an important filter parameter. It emphasizes the frequencies around the filter cutoff frequency by amplifying them with a narrow bandwidth. This is one of the most popular methods of manipulating sounds. If you increase the emphasis to a level where the filter enters a state of self-oscillation, it will generate a relatively pure sine waveform.

Root Key

The root key defines the original pitch of a recorded instrument or of a sample. Samples in MPC contain the dedicated root key information. This information will be created automatically during recording or importing.

Sample

When you tap the pads on your MPC hardware, you can trigger sounds that we call samples. Samples are digitized snippets of audio that can be recorded using the recording (sampling) function of your MPC hardware or loaded from the Browser.

You can edit and process a sample in different ways. For example, a sample can be trimmed, looped, pitch-shifted or processed, using various effects. When you have finished editing your sample, you can assign it to one or more drum pads to play it. Samples can be either mono or stereo.

Sample Rate

This is the frequency representing the amount of individual digital sample scans per second that are taken to capture an analog signal digitally. For normal CD audio recordings, 44100 samples per second are used, also written as 44.1 kHz.

You can export audio using sampling rates up to 96 kHz (see Operation > General Features > Audio Mixdown) and play audio using 44.1 kHz.

Sequence

A sequence is the most basic “building block” of music you can create within an MPC project. MIDI information from your MPC hardware pads, buttons, and Q-Link knobs are recorded to the tracks of a sequence. Each sequence on your MPC hardware can contain 128 MIDI tracks and 8 audio tracks. Each project can store up to 128 separate sequences.

The length of a sequence can be set from 1 to 999 bars, which would be enough to create an entire song using only one sequence. However, MPC Live has a dedicated Song Mode that lets you chain sequences together to create a song.

Song

Song Mode that allows you to arrange different sections (verse, chorus, hook, etc.) in order to build a song. Each song can have up to 999 “steps” (stages in which a sequence may play one or more times). Each project can store up to 32 songs.
**Stretch Factor**

The stretch factor is a value generated by the *Warp* algorithm in the software. When you record an audio file, the current sequence tempo will be embedded with it. This information is stored within the sample file when you save the project. When you warp an audio track region, the warping algorithm uses this sequence tempo and the current value in the *BPM* field to generate the stretch factor.

**Sustain**

This term describes the level of an *envelope* remaining constant after it has passed the attack and decay phases. Once reached, the sustain level is kept until the trigger is terminated.

**Time-Stretch**

See *Warp* below.

**Track**

A sequence on your MPC hardware can contain **128** MIDI tracks and **8** audio tracks.

Each **MIDI track** contains MIDI note events and controller data. In this case, the track contains no audio information—only MIDI information that uses the samples in a program (or an external MIDI sound module) to generate its audio. You can edit your performance in many different ways once the performance has been captured.

Each **audio track** contains an audio signal that has been recorded or imported into your project. You can edit this audio within the software and incorporate it into your sequences alongside your MIDI tracks.

**Trigger**

A trigger is a signal that initiates events. Trigger signals are very diverse. For instance, a MIDI note or an audio signal can be used as a trigger. The events a trigger can initiate are also very diverse. A common application for a trigger is its use to start an envelope.

**Warp**

The Warp feature lengthens or shortens a region of an audio track or sample without changing its pitch. This enables you to fit the length of an audio track or sample to the length of a sequence, a bar in your sequence, etc. while maintaining its original key.

Please note that the Warp algorithms are very CPU-intensive and can result in audio drop-outs during playback if used too freely. Be mindful of how (and how often) you use the warp function. You can reduce the CPU resources required by doing any/all of the following:

- Minimize the amount of pitch adjustment of warped audio.
- In Program Edit Mode, avoid using extreme *Stretch* values.
- Avoid warping very small audio regions.
- Warp as few tracks or track regions as possible (i.e., reduce the number of total number of voices of the polyphonic limit that use the Warp algorithm at a given time), especially instances where the warped regions start at the same time.
- Avoid rapidly triggering samples that are warped.

If you have warped samples used in a drum program, consider using the *Flatten Pad* function to consolidate the affected pad’s layers into one audio sample (see *here* to learn about this). After you flatten the pad, its sample/samples no longer need to be warped.
To create more internal storage space on your MPC hardware, you can purchase a SATA (Serial ATA) drive and install it yourself, but read this chapter first.

Your MPC X or MPC Live can support nearly any standard 2.5” SATA drive on the market—either a solid-state drive (SSD) or hard-disk drive (HDD). Make sure it uses a 2.5” (63.5 mm) form factor and uses (or can use) one of these file systems: exFAT, FAT32, NTFS, or EXT4 (for read and write capability) or HFS+ (for read-only capability).

**Note:** We recommend using an exFAT file system as it is the most robust one supported by both Windows and macOS.

**Note:** Alternatively, you could install an mSATA (mini-SATA) drive, but make sure you also purchase an adapter that enables it to fit into a typical 2.5” SATA interface.

1. Make sure your MPC hardware is powered off.
2. Locate the SATA drive panel in the center of the bottom panel of your MPC hardware. Use a Phillips-head screwdriver to remove the screws (don’t lose them!), and remove the SATA drive panel.
3. Gently pull the SATA connector and cable out from inside your MPC hardware. Be careful not to disturb anything inside—handle just the SATA connector and cable.
4. Connect your SATA drive to the SATA connector. Make sure the connection is secure.
5. Use four 3x5mm mounting screws (included with MPC hardware or with your SATA drive) to secure the SATA drive to the SATA drive panel. Do not overtighten the screws, but make sure the drive is secure and does not shake.
6. Place the SATA drive panel back onto the bottom panel of your MPC hardware, and use the original screws to secure it in place.

You can now access this drive while using your MPC hardware!

In Standalone Mode, this drive will appear as a second internal drive.

In Controller Mode, this drive will appear as another drive connected to your computer (just as a USB drive or SD card connected does when connected to your MPC hardware).
MIDI Machine Control (MMC)

Your MPC hardware can send and receive MIDI Machine Control (MMC) messages, a standard protocol for transport controls.

The MPC hardware can send these messages:

<table>
<thead>
<tr>
<th>MPC Button</th>
<th>MMC Command Sent</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rec</td>
<td>MMC Record Strobe (when recording starts), then MMC Record Exit</td>
</tr>
<tr>
<td>Overdub</td>
<td>MMC Record Strobe (when recording starts), then MMC Record Exit</td>
</tr>
<tr>
<td>Stop</td>
<td>MMC Stop</td>
</tr>
<tr>
<td>Play</td>
<td>MMC Deferred Play</td>
</tr>
<tr>
<td>Play Start</td>
<td>MMC Locate Zero, then Deferred Play</td>
</tr>
<tr>
<td>Data Dial, –/+</td>
<td>MMC Locate values</td>
</tr>
<tr>
<td>Step &lt;/&gt;, Bar &lt;&lt;/&gt;</td>
<td></td>
</tr>
</tbody>
</table>

To set up your MPC hardware to send MMC messages to an external device:

1. Use a standard 5-pin MIDI cable to connect your MPC hardware's MIDI Out A to the MIDI input of your external device.
2. Press Menu to show the menu, and tap the gear icon to enter the Preferences.
3. Tap the Sync tab.
4. Tap the Send Port 1 field, and use the data dial or –/+ buttons to select Midi Out A.
5. Tap the Send MMC box so it is enabled (checked).
6. Exit the Preferences.
7. Configure your other device properly so it can receive MMC messages.

The MPC hardware can receive these messages:

<table>
<thead>
<tr>
<th>MPC Command Received</th>
<th>MPC Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>MMC Deferred Play</td>
<td>Play</td>
</tr>
<tr>
<td>MMC Locate Zero, then Deferred Play</td>
<td>Play Start</td>
</tr>
<tr>
<td>MMC Stop</td>
<td>Stop</td>
</tr>
<tr>
<td>MMC Record Strobe</td>
<td>Record (Rec)</td>
</tr>
<tr>
<td>MMC Pause</td>
<td>Stop</td>
</tr>
<tr>
<td>MMC Locate values</td>
<td>Change location in sequence</td>
</tr>
</tbody>
</table>

To set up your MPC hardware to receive MMC messages from an external device:

1. Use a standard 5-pin MIDI cable to connect your MPC hardware’s MIDI In A to the MIDI output of your external device.
2. Press Menu to show the menu, and tap the gear icon to enter the Preferences.
3. Tap the Sync tab.
4. Tap the Receive MMC box so it is enabled (checked).
5. Exit the Preferences.
6. Configure your other device properly so it can send MMC messages.
# Technical Specifications

Specifications are subject to change without notice.

## MPC X

<table>
<thead>
<tr>
<th>Digital Audio System</th>
<th>ADCs</th>
<th>24-bit @ 44.1, 48, or 96 kHz</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>DACs</td>
<td>24-bit @ 44.1, 48, or 96 kHz</td>
</tr>
<tr>
<td></td>
<td>Digital Signal Processing</td>
<td>32-bit floating point</td>
</tr>
</tbody>
</table>

### Mic Inputs 1–2

(2) balanced XLR+1/4” (6.35 mm) TRS

<table>
<thead>
<tr>
<th>Dynamic Range</th>
<th>112 dB (A-weighted)</th>
</tr>
</thead>
<tbody>
<tr>
<td>SNR</td>
<td>111 dB (1 kHz, +4 dBu, A-weighted)</td>
</tr>
<tr>
<td>THD+N</td>
<td>0.003% (1 kHz, +4 dBu, -1 dBFS)</td>
</tr>
<tr>
<td>Preamp EIN</td>
<td>-135 dBu (max gain, 40 Ω source, A-weighted)</td>
</tr>
<tr>
<td></td>
<td>-129.5 dBu (max gain, 150 Ω source, unweighted)</td>
</tr>
<tr>
<td>Frequency Response</td>
<td>20 Hz – 20 kHz (+0.2 / -0.2 dB)</td>
</tr>
<tr>
<td>Maximum Input Level</td>
<td>+12.5 dBu</td>
</tr>
<tr>
<td>Sensitivity</td>
<td>-46 dBu</td>
</tr>
<tr>
<td>Gain Range</td>
<td>58 dB</td>
</tr>
</tbody>
</table>

### Line Inputs 1–2

(2) balanced XLR+1/4” (6.35 mm) TRS

<table>
<thead>
<tr>
<th>Dynamic Range</th>
<th>114 dB (A-weighted)</th>
</tr>
</thead>
<tbody>
<tr>
<td>SNR</td>
<td>112 dB (1 kHz, +4 dBu, A-weighted)</td>
</tr>
<tr>
<td>THD+N</td>
<td>0.003% (1 kHz, +4 dBu, -1 dBFS)</td>
</tr>
<tr>
<td>Frequency Response</td>
<td>20 Hz – 20 kHz (+0.1 / -0.1 dB)</td>
</tr>
<tr>
<td>Maximum Input Level</td>
<td>+20 dBu</td>
</tr>
<tr>
<td>Sensitivity</td>
<td>-9.5 dBu</td>
</tr>
<tr>
<td>Gain Range</td>
<td>29.5 dB</td>
</tr>
</tbody>
</table>

### Line Inputs 3–4

(2) balanced 1/4” (6.35 mm) TRS

<table>
<thead>
<tr>
<th>Dynamic Range</th>
<th>114.5 dB (A-weighted)</th>
</tr>
</thead>
<tbody>
<tr>
<td>SNR</td>
<td>112.5 dB (1 kHz, +4 dBu, A-weighted)</td>
</tr>
<tr>
<td>THD+N</td>
<td>0.003% (1 kHz, +4 dBu, -1 dBFS)</td>
</tr>
<tr>
<td>Frequency Response</td>
<td>20 Hz – 20 kHz (+0.1 / -0.1 dB)</td>
</tr>
<tr>
<td>Maximum Input Level</td>
<td>+20 dBu</td>
</tr>
<tr>
<td>Sensitivity</td>
<td>-10 dBu</td>
</tr>
<tr>
<td>Gain Range</td>
<td>30 dB</td>
</tr>
</tbody>
</table>

### Inst Inputs 1–2

(2) unbalanced 1/4” (6.35 mm) TS

<table>
<thead>
<tr>
<th>Dynamic Range</th>
<th>113.5 dB (A-weighted)</th>
</tr>
</thead>
<tbody>
<tr>
<td>SNR</td>
<td>111.5 dB (1 kHz, +4 dBu, A-weighted)</td>
</tr>
<tr>
<td>THD+N</td>
<td>0.003% (1 kHz, +4 dBu, -1 dBFS)</td>
</tr>
<tr>
<td>Frequency Response</td>
<td>20 Hz – 20 kHz (+0.1 / -0.2 dB)</td>
</tr>
<tr>
<td>Maximum Input Level</td>
<td>+10 dBu</td>
</tr>
<tr>
<td>Sensitivity</td>
<td>-20 dBu</td>
</tr>
<tr>
<td>Gain Range</td>
<td>30 dB</td>
</tr>
<tr>
<td>Input Impedance</td>
<td>~ 1 MΩ</td>
</tr>
<tr>
<td><strong>Phono Inputs</strong></td>
<td><strong>Dynamic Range</strong></td>
</tr>
<tr>
<td>------------------</td>
<td>-------------------</td>
</tr>
<tr>
<td>(2) unbalanced RCA</td>
<td><strong>SNR</strong></td>
</tr>
<tr>
<td></td>
<td><strong>THD+N</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Maximum Input Level</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Sensitivity</strong></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Master Outputs 1–2</strong></th>
<th><strong>Dynamic Range</strong></th>
<th>114 dB (A-weighted)</th>
</tr>
</thead>
<tbody>
<tr>
<td>(2) impedance-balanced 1/4&quot; (6.35 mm) TRS</td>
<td><strong>THD+N</strong></td>
<td>0.006% (1 kHz, -1 dBFS)</td>
</tr>
<tr>
<td></td>
<td><strong>Frequency Response</strong></td>
<td>20 Hz – 20 kHz (+0.0 / -0.2 dB)</td>
</tr>
<tr>
<td></td>
<td><strong>Maximum Input Level</strong></td>
<td>+20 dBu</td>
</tr>
<tr>
<td></td>
<td><strong>Sensitivity</strong></td>
<td>51 Ω</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Outputs 3–4</strong></th>
<th><strong>Dynamic Range</strong></th>
<th>114 dB (A-weighted)</th>
</tr>
</thead>
<tbody>
<tr>
<td>(2) impedance-balanced 1/4&quot; (6.35 mm) TRS</td>
<td><strong>THD+N</strong></td>
<td>0.006% (1 kHz, -1 dBFS)</td>
</tr>
<tr>
<td></td>
<td><strong>Frequency Response</strong></td>
<td>20 Hz – 20 kHz (+0.0 / -0.2 dB)</td>
</tr>
<tr>
<td></td>
<td><strong>Maximum Input Level</strong></td>
<td>+20 dBu</td>
</tr>
<tr>
<td></td>
<td><strong>Sensitivity</strong></td>
<td>51 Ω</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Outputs 5–8</strong></th>
<th><strong>Dynamic Range</strong></th>
<th>118.5 dB (A-weighted)</th>
</tr>
</thead>
<tbody>
<tr>
<td>(4) impedance-balanced 1/4&quot; (6.35 mm) TRS</td>
<td><strong>THD+N</strong></td>
<td>0.001% (1 kHz, -1 dBFS)</td>
</tr>
<tr>
<td></td>
<td><strong>Frequency Response</strong></td>
<td>20 Hz – 20 kHz (+0.1 / -0.0 dB)</td>
</tr>
<tr>
<td></td>
<td><strong>Maximum Input Level</strong></td>
<td>+20 dBu</td>
</tr>
<tr>
<td></td>
<td><strong>Sensitivity</strong></td>
<td>51 Ω</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Headphone Outputs</strong></th>
<th><strong>Dynamic Range</strong></th>
<th>111 dB (A-weighted)</th>
</tr>
</thead>
<tbody>
<tr>
<td>(1) 1/4&quot; (6.35 mm) stereo headphone</td>
<td><strong>THD+N</strong></td>
<td>0.007% (1 kHz, -1 dBFS, 10 mW/channel into 32 Ω headphones)</td>
</tr>
<tr>
<td>(1) 1/8&quot; (3.5 mm) stereo headphone</td>
<td><strong>Frequency Response</strong></td>
<td>20 Hz – 20 kHz (+0.0 / -0.2 dB)</td>
</tr>
<tr>
<td></td>
<td><strong>Maximum Power Delivered</strong></td>
<td>360 mW (&lt;1% THD)</td>
</tr>
<tr>
<td></td>
<td><strong>Maximum Output Level</strong></td>
<td>+20 dBu</td>
</tr>
</tbody>
</table>
## Mechanical

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Pads</strong></td>
<td>(16) velocity- and pressure-sensitive pads, RGB-backlit</td>
</tr>
<tr>
<td></td>
<td>(8) banks accessible via Pad Bank buttons</td>
</tr>
<tr>
<td><strong>Knobs</strong></td>
<td>(16) 360° touch-sensitive Q-Link knobs for parameter adjustment</td>
</tr>
<tr>
<td></td>
<td>(7) 270° knobs for gain, mix &amp; level adjustment</td>
</tr>
<tr>
<td></td>
<td>(1) 360° encoder for value/data adjustment</td>
</tr>
<tr>
<td><strong>Display</strong></td>
<td>10.1” (25.6 cm) full-color 1280x800 display with capacitive multi-touch</td>
</tr>
</tbody>
</table>

## Memory

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>RAM</strong></td>
<td>2 GB</td>
</tr>
<tr>
<td><strong>Internal Storage</strong></td>
<td>16 GB (6 GB user storage + 10 GB pre-installed content)</td>
</tr>
<tr>
<td><strong>Expandable</strong></td>
<td>via SATA connections</td>
</tr>
</tbody>
</table>

## File System Compatibility

- exFAT (read & write) (recommended)
- FAT32 (read & write)
- NTFS (read & write)
- EXT4 (read & write)
- HFS+ (read only)
- Audio Files: AIF/AIFF, FLAC, MP3, OGG, WAV

## Connections

- (2) XLR+1/4” (6.35 mm) TRS inputs (Input 1/2)
- (2) 1/4” (6.35 mm) TRS inputs (Input 3/4: 1 stereo pair)
- (2) 1/4” (6.35 mm) TS instrument inputs (Inst 1/2)
- (2) RCA inputs (Input 3/4: 1 stereo pair, phono- or line-level)
- (2) 1/4” (6.35 mm) TS footswitch inputs (FS 1/2)
- (2) 5-pin MIDI inputs
- (8) 1/4” (6.35 mm) TRS outputs (Main L/R, Outputs 3/4–7/8: 4 stereo pairs)
- (4) 5-pin MIDI outputs
- (8) 1/8” (3.5 mm) CV/Gate outputs
- (1) 1/4” (6.35 mm) stereo headphone output
- (1) 1/8” (3.5 mm) stereo headphone output
- (2) USB Type-A ports
- (1) USB Type-B port
- (1) SD card slot
- (1) power adapter input

## Power

- via power adapter: 19 V, 3.42 A, center-positive, included

## Dimensions

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Width x Depth x Height</strong></td>
<td>19.9” x 16.7” x 3.4” / 50.5 x 42.4 x 8.7 cm (display flat)</td>
</tr>
<tr>
<td></td>
<td>19.9” x 15.3” x 8.4” / 50.5 x 38.8 x 21.4 cm (display upright)</td>
</tr>
</tbody>
</table>

## Weight

- 12.57 lb.
- 5.66 kg
## MPC Live

<table>
<thead>
<tr>
<th>Digital Audio System</th>
<th>ADCs</th>
<th>24-bit @ 44.1, 48, or 96 kHz</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>DACs</td>
<td>24-bit @ 44.1, 48, or 96 kHz</td>
</tr>
<tr>
<td></td>
<td>Digital Signal Processing</td>
<td>32-bit floating point</td>
</tr>
<tr>
<td>Line Inputs</td>
<td>Dynamic Range</td>
<td>113.5 dB (A-weighted)</td>
</tr>
<tr>
<td>(2) balanced</td>
<td>SNR</td>
<td>108 dB (1 kHz, +4 dBu, A-weighted)</td>
</tr>
<tr>
<td>1/4” (6.35 mm) TRS</td>
<td>THD+N</td>
<td>0.001% (1 kHz, +4 dBu, -1 dBFS)</td>
</tr>
<tr>
<td></td>
<td>Frequency Response</td>
<td>20 Hz – 20 kHz (+0.0 / -0.1 dB)</td>
</tr>
<tr>
<td></td>
<td>Maximum Input Level</td>
<td>+11 dBu</td>
</tr>
<tr>
<td></td>
<td>Sensitivity</td>
<td>-13.5 dBu</td>
</tr>
<tr>
<td></td>
<td>Gain Range</td>
<td>24.5 dB</td>
</tr>
<tr>
<td>Phono Inputs</td>
<td>Dynamic Range</td>
<td>107 dB (A-weighted, 63 mVrms @ 1 kHz, -1 dBFS, 20 Ω source)</td>
</tr>
<tr>
<td>(2) unbalanced RCA</td>
<td>SNR</td>
<td>86 dB (A-weighted, 4 mVrms @ 1 kHz, 20 Ω source)</td>
</tr>
<tr>
<td></td>
<td>THD+N</td>
<td>0.009% (1 kHz, -46 dBu, -1 dBFS)</td>
</tr>
<tr>
<td></td>
<td>Maximum Input Level</td>
<td>63 mVrms (1 kHz)</td>
</tr>
<tr>
<td></td>
<td>Sensitivity</td>
<td>2 mVrms (1 kHz)</td>
</tr>
<tr>
<td>Master Outputs 1–2</td>
<td>Dynamic Range</td>
<td>113 dB (A-weighted)</td>
</tr>
<tr>
<td>(2) impedance-balanced</td>
<td>THD+N</td>
<td>0.002% (1 kHz, -1 dBFS)</td>
</tr>
<tr>
<td>1/4” (6.35 mm) TRS</td>
<td>Frequency Response</td>
<td>20 Hz – 20 kHz (+0.0 / -0.5 dB)</td>
</tr>
<tr>
<td></td>
<td>Maximum Input Level</td>
<td>+9 dBu</td>
</tr>
<tr>
<td></td>
<td>Sensitivity</td>
<td>51 Ω</td>
</tr>
<tr>
<td>Outputs 3–6</td>
<td>Dynamic Range</td>
<td>116 dB (A-weighted)</td>
</tr>
<tr>
<td>(4) impedance-balanced</td>
<td>THD+N</td>
<td>0.001% (1 kHz, -1 dBFS)</td>
</tr>
<tr>
<td>1/4” (6.35 mm) TRS</td>
<td>Frequency Response</td>
<td>20 Hz – 20 kHz (+0.0 / -0.1 dB)</td>
</tr>
<tr>
<td></td>
<td>Maximum Input Level</td>
<td>+9 dBu</td>
</tr>
<tr>
<td></td>
<td>Sensitivity</td>
<td>51 Ω</td>
</tr>
<tr>
<td>Headphone Output</td>
<td>Dynamic Range</td>
<td>112 dB (A-weighted)</td>
</tr>
<tr>
<td>(1) 1/8” (3.5 mm)</td>
<td>THD+N</td>
<td>0.005% (1 kHz, -1 dBFS, 10 mW/channel into 32 Ω headphones)</td>
</tr>
<tr>
<td>stereo headphone</td>
<td>Frequency Response</td>
<td>20 Hz – 20 kHz (+0.0 / -0.2 dB)</td>
</tr>
<tr>
<td></td>
<td>Maximum Power Delivered</td>
<td>+35 mW (&lt;1% THD, 32 Ω headphones)</td>
</tr>
<tr>
<td></td>
<td>Maximum Output Level</td>
<td>+10 dBu</td>
</tr>
<tr>
<td><strong>Mechanical</strong></td>
<td><strong>Pads</strong></td>
<td>(16) velocity- and pressure-sensitive pads, RGB-backlit</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(8) banks accessible via Pad Bank buttons</td>
</tr>
<tr>
<td></td>
<td><strong>Knobs</strong></td>
<td>(4) 360° touch-sensitive Q-Link knobs</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(4) Q-Link knob columns accessible via Q-Link button</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(1) 360° encoder for value/data adjustment and selection via push</td>
</tr>
<tr>
<td></td>
<td><strong>Display</strong></td>
<td>7” (17.8 cm) full-color 1280x800 display with capacitive multi-touch</td>
</tr>
<tr>
<td><strong>Memory</strong></td>
<td><strong>RAM</strong></td>
<td>2 GB</td>
</tr>
<tr>
<td></td>
<td><strong>Internal Storage</strong></td>
<td>16 GB (6 GB user storage + 10 GB pre-installed content)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Expandable via SATA connections</td>
</tr>
<tr>
<td><strong>File System Compatibility</strong></td>
<td><strong>exFAT</strong> (read &amp; write) (recommended)</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>FAT32</strong> (read &amp; write)</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>NTFS</strong> (read &amp; write)</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>EXT4</strong> (read &amp; write)</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>HFS+</strong> (read only)</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Audio Files</strong>: AIF/AIFF, FLAC, MP3, OGG, WAV</td>
<td></td>
</tr>
<tr>
<td><strong>Connections</strong></td>
<td><strong>(2) 1/4” (6.35 mm) TRS inputs (1 stereo pair)</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>(6) 1/4” (6.35 mm) TRS outputs (3 stereo pairs)</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>(1) 1/8” (3.5 mm) stereo headphone output</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>(2) RCA inputs (1 stereo pair)</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>(2) 5-pin MIDI inputs</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>(2) 5-pin MIDI outputs</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>(2) USB Type-A ports</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>(1) USB Type-B port</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>(1) SD card slot</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>(1) power adapter input</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Power</strong></td>
<td>via power adapter: 19 V, 3.42 A, center-positive, included</td>
<td></td>
</tr>
<tr>
<td></td>
<td>via battery: lithium-ion, rechargeable, up to 6 hours of battery life</td>
<td></td>
</tr>
<tr>
<td><strong>Dimensions</strong></td>
<td><strong>(width x depth x height)</strong></td>
<td>16.7” x 8.8” x 2.7”</td>
</tr>
<tr>
<td></td>
<td></td>
<td>42.4 x 22.4 x 6.9 cm</td>
</tr>
<tr>
<td><strong>Weight</strong></td>
<td>5.9 lb.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>2.7 kg</td>
<td></td>
</tr>
</tbody>
</table>
### MPC Touch

#### Line Inputs
- **(2) balanced** 1/4" (6.35 mm) TRS

<table>
<thead>
<tr>
<th>Specification</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dynamic Range</td>
<td>102 dB (A-weighted)</td>
</tr>
<tr>
<td>SNR</td>
<td>99 dB (1 kHz, +4 dBu, A-weighted)</td>
</tr>
<tr>
<td>THD+N</td>
<td>0.002% (1 kHz, +4 dBu, -1 dBFS)</td>
</tr>
<tr>
<td>Frequency Response</td>
<td>20 Hz – 20 kHz (+0.1 / -0.1 dB)</td>
</tr>
<tr>
<td>Maximum Input Level</td>
<td>+15 dBu</td>
</tr>
<tr>
<td>Input Impedance</td>
<td>12 KΩ (balanced), 5 KΩ (unbalanced)</td>
</tr>
<tr>
<td>Sensitivity</td>
<td>-16 dBu</td>
</tr>
</tbody>
</table>

#### Main Outputs
- **(2) impedance-balanced 1/4" (6.35 mm) TRS**

<table>
<thead>
<tr>
<th>Specification</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dynamic Range</td>
<td>100 dB (A-weighted)</td>
</tr>
<tr>
<td>THD+N</td>
<td>0.006% (1 kHz, -1 dBFS)</td>
</tr>
<tr>
<td>Frequency Response</td>
<td>20 Hz – 20 kHz (+0.25 / -0.25 dB)</td>
</tr>
<tr>
<td>Maximum Input Level</td>
<td>+8 dBu</td>
</tr>
<tr>
<td>Output Impedance</td>
<td>100 Ω</td>
</tr>
</tbody>
</table>

#### Headphone Output
- **(1) 1/8" (3.5 mm) stereo headphone**

<table>
<thead>
<tr>
<th>Specification</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>THD+N</td>
<td>0.009% (1 kHz, -1 dBFS, 10 mW/channel into 32 Ω headphones)</td>
</tr>
<tr>
<td>Frequency Response</td>
<td>20 Hz – 20 kHz (+0.3 / -0.3 dB)</td>
</tr>
<tr>
<td>Maximum Output Level</td>
<td>+6 dBu</td>
</tr>
<tr>
<td>Maximum Power Delivered</td>
<td>12 mW/channel</td>
</tr>
<tr>
<td>Output Impedance</td>
<td>33 Ω</td>
</tr>
</tbody>
</table>

#### Mechanical

<table>
<thead>
<tr>
<th>Specification</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pads</td>
<td>(16) velocity- and pressure-sensitive pads, RGB-backlit (8) banks accessible via Pad Bank buttons</td>
</tr>
<tr>
<td>Knobs</td>
<td>(4) 360° touch-sensitive Q-Link knobs (4) Q-Link knob columns accessible via Q-Link button (1) 360° encoder for value/data adjustment and selection via push</td>
</tr>
<tr>
<td>Display</td>
<td>7.0” (17.8 cm) full-color 1280x800 display with capacitive multi-touch</td>
</tr>
</tbody>
</table>

#### Connections
- **(2) 1/4" (6.35 mm) TRS inputs (1 stereo pair)**
- **(2) 1/4" (6.35 mm) TRS outputs (1 stereo pair)**
- **(1) 1/8" (3.5 mm) stereo headphone output**
- **(1) 1/8" (3.5 mm) MIDI input (1/8"-to-5-pin adapter included)**
- **(1) 1/8" (3.5 mm) MIDI output (1/8"-to-5-pin adapter included)**
- **(1) USB Type-B port**
- **(1) power adapter input**

#### Power
- via power adapter: 6 VDC, 3 A, center-positive, included

#### Dimensions
- **(width x depth x height)** 16.2” x 8.6” x 1.9”
  41.1 x 21.8 x 4.8 cm

#### Weight
- 4.6 lb.
- 2.1 kg
Akai Professional and MPC are trademarks of inMusic Brands, Inc., registered in the U.S. and other countries.
Ableton is a trademark of Ableton AG.
ASIO and VST are trademarks of Steinberg Media Technologies GmbH.
The Bluetooth word mark and logos are registered trademarks owned by Bluetooth SIG, Inc. and any use of such marks by Akai Professional is under license.
MPC software incorporates élastique Pro V3 by zplane.development.
Apple and macOS are trademarks of Apple Inc., registered in the U.S. and other countries.
SD and SDHC are registered trademarks of SD-3C, LLC.
Windows is a registered trademark of Microsoft Corporation in the United States and other countries.
Pro Tools is a trademark of Avid Technology, Inc. in the U.S. and other countries.
All other product names, company names, trademarks, or trade names are those of their respective owners.
For complete legal information, visit akaipro.com/product-legal
Addenda

Updates in MPC 2.1

New Features

Exporting Expansions

You can export MPC Expansion Packs (installed on your computer) to your MPC X or MPC Live for use in its Standalone Mode. (This has been added to Operation > Modes > Browser > Browse.)

To export MPC Expansions:
1. Connect your MPC X or MPC Live to your computer. Make sure both are powered on.
2. On your computer, open the MPC software.
3. On your MPC X or MPC Live, enter Controller Mode.
4. In the MPC software window, click the menu icon (≡), select File > Export, and then click Expansion....
5. In the Export Expansion to Standalone MPC window that appears, click the Drive menu and select a storage device that you will use with your MPC X or MPC Live: the internal SATA drive (if you have installed one in your MPC X or MPC Live), an SD card, or a USB flash drive.
6. In the Expansions list, click the box next to each one to select or deselect it. Only the selected ones will be exported. Click Select all to select all of them or Select none to deselect all of them.
7. Click Export to start exporting, or click Cancel to close the window and not export anything.

The exporting process creates an Expansions folder at the root level of your storage device and copies your MPC Expansions into it.

To use your expansions, restart your MPC X or MPC Live in Standalone Mode, enter the Browser, and tap Expansion.
Snap: Absolute & Relative

While editing a MIDI or audio track, you can now use the Grid View or Audio Edit Mode to move or copy events using two different ways of “snapping” note events to the grid: Absolute or Relative. (This has been added to Operation > Modes > Grid View and Audio Edit Mode.)

To view the Settings, tap the gear icon.

Use the Snap Mode selector to set how events “snap” to the grid.

Absolute: Events will “snap” to the nearest time division on the grid (as determined by the TC field or Time Correct window). This is the typical and traditional method of using the snap/quantization feature.

Relative: Events will “snap” to the nearest time division on the grid (as determined by the TC field or Time Correct window) plus the original time position of the event (e.g., an event that is originally three ticks past a time division on the grid will snap only to positions that are three ticks past every time division).

List Edit Settings: Auto-Advance

The Settings window now has some additional lets you configure certain List Edit Mode settings. (This has been added to Operation > Modes > List Edit Mode.)

To view the Settings, tap the gear icon.

Use the Auto-Advance on Step Record selector to turn the feature on or off.

When set to On, pressing a pad when the track is record-armed will move the audio playhead forward by a length determined by the current Time Division setting in the TC/Timing Correct window.

When set to Off, pressing a pad when the track is record-armed will not change the audio playhead position.
Pitch Quantization

In a MIDI track, you can now force the pitches of note events into a specific scale. This quantization process is available with other track editing processes. (This has been added to Operation > Modes > Main Mode > Track Section.)

To edit the track, tap the pencil icon on the right edge of the section. The Track Edit window will open. To open the Pitch Quantize window, tap Pitch Quantize.

To select the desired root note of the scale, use the Root Note field.

To select a type of scale, use the Scale field.

To determine which note events will be quantized, tap the Only apply to selected events checkbox.

When on, only the currently selected note events will be quantized.

When off, all pitches in the current track will be quantized.

To set lowest-possible and highest-possible pitches where the quantized note events will be placed, use the Start Note and End Note fields (respectively). If a note event is originally outside of this range, it will be forced to the nearest pitch (within the scale) inside the range.

To continue and quantize the note events, tap Do It.

To cancel, tap Close.
Step Sequencer: Velocity Adjustment via Q-Links

While using the Step Sequencer, you can now use the Q-Link knobs to adjust the velocity of the note event at each step (the Q-Link knobs must be in the Screen edit mode). On MPC X, the number of each step will be shown under the corresponding Q-Link knob. (This has been added to Operation > Modes > Step Sequencer).

To adjust the velocity of each note event, use the corresponding Q-Link knob to select a value (1–127).

To enter a note event at a step, use the corresponding Q-Link knob to change its velocity from 0 (Off) to a value of 1 or greater.

To delete a note event from a step, set the corresponding Q-Link knob to its minimum position, 0 (Off).

Pad Perform Mode: User Progressions

You can now use your own progressions (created in the desktop version of the MPC software) on your MPC X or MPC Live.

To transfer progressions to your MPC X or MPC Live:
1. Connect the storage device that you will use with your MPC X or MPC Live (e.g., the internal drive, an SD card, a USB drive) to your computer.
2. On your computer, access the storage device and create a folder named Progressions on its root level.
3. Copy your progression files (.progression) from your computer to that Progressions folder.
   By default, progressions are saved here:
   Windows: C:\Program Files\Akai Pro\MPC\Progressions and/or C:\ProgramData\Akai\MPC\Progressions
   macOS: ~/Library/Application Support/Akai/MPC/Progressions
4. Eject and disconnect the storage device from your computer, and connect it to your MPC X or MPC Live.

To use your progressions, start your MPC X or MPC Live in Standalone Mode, enter Pad Perform Mode, and tap Progressions. Your MPC X or MPC Live will scan the Progressions folder you created and add them to the list of available progressions.

Faster Attack for Amp Envelopes

In the amp envelope of a drum program or keygroup program, an attack value of 0 now produces a much faster response, thus making your drum hits even punchier than before. (You can set the attack value in Program Edit Mode. See Operation > Modes > Program Edit Mode > Drum Programs > Filter/Envelope and Keygroup Programs > Filter/Envelope to learn more.)

Important: Any drum or keygroup programs that you created and saved before this update will load in MPC 2.1 with an attack value of 1 to ensure backwards compatibility.
Updates in MPC 2.2

New Features

MIDI Control Mode: MIDI Learn

You can now use the MIDI Learn function to assign external MIDI controllers to various parameters in your specific MPC project:

- Mixer parameters such as volume, pan, mute, and solo for MIDI or audio tracks, programs, returns, submixes, and master outputs
- Pad parameters (for drum programs and clip programs only) such as tuning, filter and amp envelopes, layer settings, LFO settings, and velocity
- Program parameters, which depend on the program type
- Insert effects parameters, which depend on the effect type

These assignments will be saved with your MPC project.

Tip: Because these MIDI assignments are saved within a project, you can use them while working with a project on both the desktop version of the MPC software or on your MPC hardware in Standalone Mode. You can also include them with a user template.

To display the MIDI Learn window, press Menu, tap MIDI Control to enter MIDI Control Mode, and then tap the MIDI Learn tab.

Each assignment has the following settings:

**Source**: This is the name or number of the track, program, return, submix, or master output.

**Target**: This is the name of the assigned command or parameter.

**Type**: This is the type of message:

- **Toggle Button**: When the control is a button, pressing it will activate or deactivate its command or parameter. It will remain in that state until you press it again.
- **Momentary Button**: When the control is a button, pressing and holding it down will activate its command or parameter. Releasing the button will deactivate it.
- **Fixed Button**: When the control is a button, pressing it will send its command.
- **Note**: When the control is a button, pressing it will send the MIDI note (determined by the Data field).
- **Abs CC**: When the control is a knob, turning it will send its CC message (determined by the Data field) according to the precise physical position of the knob. (When you start turning it, the value may “jump” from its current value to the one corresponding to the knob’s position.) This is for use with knobs that have a maximum and minimum position.
- **Rel CC Offset**: When the control is a knob, turning it will send the CC message (determined by the Data field), starting from the current value. This is for use with 360° knobs controlling parameters that have a maximum and minimum position.
- **Rel CC 2’s Complement**: When the control is a knob, turning it will send the CC message (determined by the Data field), starting from the current value. This is for use with 360° knobs controlling bipolar parameters where there is a center (12:00) position (e.g., panning).

This is automatically detected based on the **Source** and **Target** fields, though you can use this field to assign it manually if it does not detect it properly.
Ch: This is the MIDI channel the control is using.
Data: This is the MIDI note number or CC number.
Flip: Tap this box to select or deselect it. When selected, the control’s polarity will be reversed (e.g., a button’s “off” state will become its “on” state and vice versa).

To assign a parameter to a hardware control:
1. Tap Learn in the upper-left corner so it is on. (The Enable Mapping button will also activate if it is not already on.)
2. Tap + in the lower-left corner to create an “empty” assignment (its Target menus will be set to None and Off).
   Alternatively, tap an assignment that is already in the list if you want to change it.
3. Move or press the desired control on your MIDI controller. The Type, Ch, and Data fields will be automatically assigned.
4. Use the Source field to select a MIDI or audio track, program, return, submix, or master output (for drum programs and clip programs, you can select the entire program or a single pad within it). The Target menu will indicate the source you selected.
5. Use the Target menu to select the parameter. Your selection will be shown under Target in the list, as well.
   The control on your MIDI controller will now control the Target parameter.
   To assign more controls, repeat Steps 2–5.
   To stop assigning controls, tap Learn again so it turns off.

To clear an assignment, follow the steps above to reassign its Source field to None and assign its Target field to Off.

To delete an assignment (the entire slot), tap it in the list, and then tap the trash-can icon in the lower-right corner.
To delete all assignments, press and hold Shift, and then tap the trash-can icon in the lower-right corner. In the window that appears, tap Remove All to continue or tap Cancel to not delete any assignments.

Humanize

You can now apply randomization to the timing, length, and/or velocity of MIDI events. This process is available with other track editing processes. (This has been added to Operation > Modes > Main Mode > Track Section).

To edit the track, tap the pencil icon on the right edge of the section. The Track Edit window will open.
To open the Humanize window, tap Humanize.
The **Humanize** function applies randomization to the timing, length, and/or velocity of MIDI note events.

To select whether or not humanization will be applied to the timing of MIDI events, tap the **Humanize Time** checkbox.

To select the maximum number of pulses by which the timing of an event will be adjusted, use the **Amount (Pulses)** slider.

To set how dramatically the humanization effect is applied to the timing, use the **Eagerness** slider. Negative values correspond to playing “ahead of the beat” while positive values correspond to playing “behind the beat.”

To set whether or not humanization will be applied to the duration of MIDI note events, tap the **Humanize Note Length** checkbox.

To set how dramatically the humanization effect is applied to note lengths, use the **Length (%)** slider.

To set whether or not humanization will be applied to the velocities of MIDI note events, tap the **Humanize Velocity** checkbox.

To set how dramatically the humanization effect is applied to note velocities, use the **Strength (%)** slider.

To determine which notes will use these humanization values, tap the **Only Apply to Selected Events** checkbox.

When **on**, just the currently selected notes will be humanized.

When **off**, all notes in the track will be humanized.

To apply humanization and keep this window open, tap **Apply**.

To apply humanization and close the window, tap **Do It**.

To close the window without making any changes, tap **Close**.
Generate Random Events

You now create random melodic or drum patterns on the current MIDI track. This process is available with other track editing processes. (This has been added to Operation > Modes > Main Mode > Track Section).

To edit the track, tap the pencil icon on the right edge of the section. The Track Edit window will open.

To open the Generate Random Events window, tap Generate Random Events.

The Generate Random Events function creates random melodic or drum patterns on the current MIDI track.

To select the type of events you want to create, use the Event Type field to select Drum Events or Melodic Events.

To select how the events will be created relative to the existing events on the track, use the Replace field:

Replace All Events: Select this option to replace all events on the track with the randomly generated ones.

Replace Events in Note Range: Select this option to replace all events in the designated note range on the track with the randomly generated ones. Use the Bank or Start Pad and End Pad menus to set the note range for drum events or the Start Note and End Note menus to set the note range for melodic events.

Add to Existing Events: Select this option to add the randomly generated events to the track without replacing or overwriting the existing ones.

To set how many bars the events will use, use the Pattern Size (Bars) field. The highest possible value is the number of bars in the current sequence.

To select the duration of the events, use the Note Length field. (This feature is nonfunctional if Legato is enabled while generating melodic events.)

To generate the events and keep this window open, tap Apply.

To generate the events and close the window, tap Do It.

To close the window without generating any events, tap Close.
If Event Type is set to Drum Events:

To select the pad bank that will be used to generate the events, use the Bank field or select Range to use the Start Pad and End Pad menus to define a specific pad range instead.

To define a specific pad range over which the events will be generated, use the Start Pad or End Pad fields. You can use these fields only if the Bank menu is set to Range.

To set how closely together the events will be placed in the track, use the Density (%) slider.

To set how widely or narrowly the rhythmic patterns of the generated notes vary, use the Rhythm Variation slider.

If Event Type is set to Melodic Events:

To define a specific note range over which the events will be generated, use the Start Note or End Note fields.

To enable or disable legato, tap the Legato checkbox.

When on, the generated notes will be extended or shortened to create a long, unbroken phrase from the first note event’s start point to the last note event’s end point. Each note event will sustain until another note event starts. If multiple note events start at the same time (and are not the last note events), their lengths will become identical.

When off, the generated notes will use the duration set by the Note Length menu.
To set the maximum number of note events that can be sounding simultaneously in the track, use the Polyphony field to select 1–8.

To determine whether or not the notes will use a scale, tap the Constrain Notes to Scale checkbox.

  When on, the notes will be within the scale determined by the Scale menu.
  When off, the notes will be chromatic.

To set how closely together the events will be placed in the track, use the Density (%) slider.

To set the root note of the scale that the notes will use, use the Root Note field.

To select the scale or mode that the generated notes will use, use the Scale field.

Project Template

You can now select a project file to use as a template for new projects. (This has been added to Operation > General Features > Menu > Save and Menu > Preferences > Project Load/Save.)

To select a project template file, do either of the following:

1. Tap the icon in the upper-left corner to enter the Menu.
2. Tap the gear icon to enter the Preferences.
3. Tap Project Load/Save.
4. Tap the magnifying-glass icon next to the Template File field to select the project you want to use as a template.

   1. In Main Mode, tap the Project field in the upper-left corner.
   2. Tap Save As… at the bottom of the screen.
   3. Tap the Save as Template checkbox to check it.
   4. Name and select a location for the project, as usual.
   5. Tap Save. (The file will now be shown in the Template File field in the Preferences’ Project Load/Save tab.)

To load the project template from the startup screen (when you power on your MPC hardware), tap User Template at the bottom of the screen. In order for this option to be available, New Project Dialog (in the Project Defaults tab) in the Preferences must be set to Demo or Demo/Template/Recent.
Updates in MPC 2.3

New Features

Arpeggiator

MPC now includes a full-featured arpeggiator and phrase player for melodic program types.

To open the Arpeggiator settings:

1. Set the current track type to Plugin, Keygroup, MIDI, or CV.
2. Open the Arpeggiator window by doing either of the following:
   - Press and hold the Note Repeat button, then tap Arp at the bottom-right of the screen.
   - Alternatively, press the Arpeggiator F-Key (MPC X).

To activate the Arpeggiator, tap Enable so it is checked. Tap again to Disable the Arpeggiator.

To latch the Arpeggiator, tap Latch so it is checked. Tap again to Disable Latch.

The Setup section of the Arpeggiator window sets what kind of arpeggiator will be used and its functions:

- Use the Action field to set the type: Arp, Note Repeat, Rhythm and Pattern. See below for more details about these types and their additional parameters.
- Use the Step Size field to set the note value of each arpeggiator step from 1/1–1/64 beats, including T (triplet) variations. This field is not used in Pattern mode.
- Use the Note Length slider to set the length of the played note in each step, from 1–100%.
- Use the Velocity field to set the velocity of the arpeggiator notes. Choose As played, From first note, Accented, Full, 3/4, Half or 1/4.
- Use the Swing field to set the amount of swing in the arpeggiator from 50% to 75%. Swing lets you "shuffle" your beats—from subtle to extreme.

The Arp mode section of the Arpeggiator window is available when the Action is set to Arp. When this action is selected, hold down a chord and the arpeggiator will play a pattern based on the notes held.

- Use the Pattern field to set how the arpeggiator triggers the held notes.
- Use the Octaves field to set how many octaves of the held notes the arpeggiator will cycle through.
- Use the Variation field to apply rhythmic variation to the set pattern.
The **Rhythm** section of the Arpeggiator window is available when **Action** is set to **Note Repeat** or **Rhythm**. The Note Repeat action provides traditional MPC Note Repeat behavior. When the Rhythm arpeggiator action is selected, hold down a chord and the arpeggiator will play the held notes in a rhythmic pattern.

Use the **Spread** field to spread the timing of the held notes, creating a glissando effect.

Use the **Rhythm Pattern** field to choose the pattern played when notes are held. This is only available for the **Rhythm** action.

The **Pattern** section of the Arpeggiator window is available when the **Action** is set to **Pattern**. When this arpeggiator action is selected, hold down a single note to trigger a melodic phrase. As you change what note is held, the melodic phrase will be transposed.

Use the **Pattern** field to choose the pattern.

The **Settings** section of the Arpeggiator window offers additional options to control the arpeggiator.

If you have a sustain pedal connected, you can enable **Sustain Pedal Latches** to use it to control latching.

Use the **Latch Mode** setting to set the latch behavior. When set to **Reset**, adding a new note(s) will reset the currently latched note(s). When set to **Add**, new notes will be added to currently latched notes.

Tap **Close** to close the Arpeggiator window.
Auto Sampler

You can now capture and convert any plugin preset or external instrument preset into a Keygroup sampler patch.

To open the Auto Sampler:
1. Open the Sampler mode by doing either of the following:
   • Press Menu and then tap Sampler.
   • Press Sampler (MPC X).
2. Press the Auto Sampler icon in the toolbar.

Sample Source Information

The Track name and Program name fields show the target track and program that will be sampled. This will be automatically selected as the active track and program when Auto Sampler is opened.

Use the Record from field to select an external or resample input to record from:

To capture the output of a plugin, simply select a Plugin track before opening Auto Sampler.

Note: When a plugin track is selected, the Auto Sampler will only sample the plugin track, regardless of the setting in the Record From field.

To capture a preset from an external instrument such as a sound module, select the Input that the external instrument is connected to.

Note Range

Use the Min note and Max note settings to determine the lowest and highest notes used to create the sampler patch.

Use the Note stride to determine the range of notes that each sample will cover. For instance, a note stride of 5 means that every 5 notes will utilize a different sample.

Check the Extend min/max notes box to sample all the way to the lowest and highest notes, regardless of the Min Note and Max Note settings.

Velocity

Tap the boxes next to Layers 1–4 to select how many layers will be used to create the sampler patch.

Use the Velocity value sliders to set the velocity of each layer.
Sampling

Use the Note length slider to set the length of the sampled note in seconds.

Use Tail slider to set the length of the Audio Tail in seconds. This will add extra seconds to the end of the resulting audio file. This is useful if you are capturing samples whose sounds exceed the defined audio length (e.g., long reverb or delay, one-shot samples with long decays, etc.). We recommend using an audio tail of at least a couple of seconds.

Use Base name to set the naming convention for the samples that will be created by the Auto Sampler.

Looping

Use the Enable looping field to select how the resulting samples can or cannot be looped:

- Off: The sample will not loop.
- Forward: You can hold down the pad to cause that sample to repeat from the Loop Position to the end of the sample. Release the pad to stop the repeating playback.
- Reverse: You can hold down the pad to cause that sample to play in reverse, repeating from the end of the sample to the Loop Position. Release the pad to stop the repeating playback.
- Alternating: You can hold down the pad to cause that sample to play from the Loop Position to the end of the sample and then play in reverse until it reaches the Loop Position again. This will repeat as long as you are holding the pad down. Release the pad to stop the repeating playback.

Use the Loop start and Loop end sliders to set the starting and ending points in the sample where the loop will occur.

Use the Crossfade field to set the amount of crossfade between the loop end and loop start in seconds.

Use the Crossfade Type field to select Equal Power or Linear crossfade.

Under On completion, check Make current program to load the completed sampler patch as the current program.

Under Info, the Session Duration field provides an estimate of how long the auto sampling process will take.

Tap OK to initiate the auto sampling process. A Progress window will appear. Click Cancel to stop the auto sampling process. Any samples already created will be retained.

Tap Cancel to close the Auto Sampler window without continuing.
Crossfade Looping

You can now add real time crossfade looping to sample playback.

To apply crossfade looping to a sample:
1. Open Sample Edit mode by doing either of the following:
   - Press Menu, and then tap Sample Edit.
   - Press Sample Edit (MPC X).
2. Make sure the loop Lock setting is set to Off.
3. Tap the Loop button to select the Forward (FWD) loop mode.
4. Make sure there is at least 10 samples of space between the Start point and Loop point.
5. Tap the X-Fade button to open the X-Fade window:

   To set the length of the crossfade in samples, use the Length field.
   To set the type of crossfade, use the Type field. Select Equal Power or Linear.
   To close the window and return to Trim Mode, tap the X or tap Close.

When you are finished, press Pad A16 – Play Continuous Loop in Sample Edit Trim Mode to hear the crossfade applied to the sample.
Mode Selection Shortcut

You can now press and hold the **Menu** button on your MPC X, MPC Live or MPC Touch and press a pad to select a menu mode. The pads follow the 4x4 layout of the Mode Menu.

Pad Perform Mode: Chromatic Type

You can now use Pad Perform Mode to set the pads to follow a chromatic layout. When the **Chromatic** type is selected, each pad is assigned a note, ascending by one semitone with each pad. Pads with notes in the key determined by the **Scale** will be lit, while pads with notes between the scale degrees will be unlit.

Q-Link Navigation Enhancements

Q-Link functionality has been enhanced in the following modes: Main Mode, Track View, Next Sequence, Grid Editor, and Audio Edit Mode.

Set the **Q-Link Mode** to **Screen** in these pages to access the following controls:

- Use **Q-Link Knob 2** to adjust the playhead position.
- Use **Q-Link Knob 3** to scroll through the waveform in the large waveform display.
- Use **Q-Link Knob 4** to zoom in or zoom out at the playhead position.

**Note:** For MPC Live and MPC X in standalone mode, the **Zoom** and **Scroll** Q-Links are only available in the Grid Editor and Audio Edit Mode.
Split Events

You can now easily split note events, useful for creating intricate hi-hat parts or quintuplet/sextuplet motifs or drum beats. (This has been added to Operation > Modes > Main Mode > Track Section.)

To edit the track, tap the pencil icon on the right edge of the Main Mode screen. The Track Edit window will open.

To open the Split Events window, tap Split Events.

To set how many events notes will be divided into, use the Into slider.

To determine which notes will be divided, tap the Only selected events checkbox.

To split the events and close the window, tap Do It.

To close the window without making any changes, tap Close.
AIR Instrument Plugins

MPC now includes three new plugin instruments: AIR TubeSynth, AIR Bassline, and AIR Electric.

AIR Bassline

The AIR Bassline plugin emulates the sound of classic mono synths, with a contemporary twist. Bassline also comes packaged with four integrated AIR effects (Chorus, Delay, Compressor and Hype), as well as two built-in distortion algorithms (Overdrive and Clip).

Osc/Filter/Envelope

Use this tab to adjust the settings for the oscillators, as well as their filter and envelope settings.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Value Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>Oscillator</td>
<td>Waveform</td>
<td>Continuously variable waveshape for the oscillator.</td>
</tr>
<tr>
<td></td>
<td>Sub-Octave</td>
<td>Amount of sub-octave oscillator.</td>
</tr>
<tr>
<td></td>
<td>Fifth</td>
<td>Amount of fifth-oscillator.</td>
</tr>
<tr>
<td></td>
<td>Start Phase</td>
<td>Position of the waveform when a note is triggered.</td>
</tr>
<tr>
<td></td>
<td>Glide Time</td>
<td>Amount of time to slide from the pitch of one note to the next note played.</td>
</tr>
<tr>
<td></td>
<td>Boost</td>
<td>Boosts the signal of the oscillator.</td>
</tr>
<tr>
<td></td>
<td>Boost Freq.</td>
<td>Center frequency of the boost.</td>
</tr>
<tr>
<td></td>
<td>Boost Envelope</td>
<td>Amount of effect of the envelope on the Boost section.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Adjust Gain to control the amount of boost.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Adjust Frequency to control the center frequency of the boost.</td>
</tr>
<tr>
<td>Filter</td>
<td>LP Cutoff</td>
<td>Cutoff frequency for the low-pass filter.</td>
</tr>
<tr>
<td></td>
<td>Reso</td>
<td>Resonance of the filter.</td>
</tr>
<tr>
<td></td>
<td>Filter Env</td>
<td>Envelope of the filter.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>At negative values, decreases the cutoff value based on the decay value.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>At positive values, increases the cutoff value based on the decay value.</td>
</tr>
<tr>
<td></td>
<td>HP Cutoff</td>
<td>Cutoff frequency for the high-pass filter.</td>
</tr>
<tr>
<td>Envelope</td>
<td>Amp Attack</td>
<td>Length of time for the note to reach full volume.</td>
</tr>
<tr>
<td></td>
<td>Amp Decay</td>
<td>Length of time for the note to reach the sustained volume.</td>
</tr>
<tr>
<td></td>
<td>Filter Decay</td>
<td>Length of time for the filter to reset after being released.</td>
</tr>
<tr>
<td></td>
<td>Pitch Mod</td>
<td>Amount of pitch modulation applied to the envelope.</td>
</tr>
</tbody>
</table>
**Velocity/Master/Chorus**

Use this tab to adjust the Velocity Control settings, Master volume. You can also apply and adjust the settings for the built-in Chorus effect.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Value Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>Velocity</td>
<td>Amp Control The amount of effect velocity has on amplitude control.</td>
<td>0–100%</td>
</tr>
<tr>
<td>Filter Control</td>
<td>The amount of effect velocity has on filter control.</td>
<td>0–100%</td>
</tr>
<tr>
<td>Boost Control</td>
<td>The amount of effect velocity has on boost control.</td>
<td>0–100%</td>
</tr>
<tr>
<td>Env Retrigger</td>
<td>Sets whether the envelope will retrigger when a note is played while another note is being held.</td>
<td>Off, On</td>
</tr>
<tr>
<td>Master</td>
<td>Master Volume Sets the volume level.</td>
<td>-Inf dB – +6.0 dB</td>
</tr>
<tr>
<td>Drive Type</td>
<td>Choose one of two drive algorithms.</td>
<td>Overdrive, Clip</td>
</tr>
<tr>
<td>Drive Amount</td>
<td>Amount of drive applied.</td>
<td>0–100%</td>
</tr>
<tr>
<td>Bend Range</td>
<td>Number of semitones up or down controlled by MIDI pitch bend messages.</td>
<td>0–12</td>
</tr>
<tr>
<td>Chorus</td>
<td>Rate Modulation speed of the chorus effect.</td>
<td>20.0 Hz – 20.0 kHz</td>
</tr>
<tr>
<td></td>
<td>Depth Modulation depth of the chorus effect.</td>
<td>0–100%</td>
</tr>
<tr>
<td></td>
<td>Mix Wet/dry amount of the chorus effect.</td>
<td>-100% – 0 – 100%</td>
</tr>
<tr>
<td></td>
<td>On/Off Enables or disables the effect.</td>
<td>Off, On</td>
</tr>
</tbody>
</table>

**Delay**

Use this tab to apply and adjust the settings for the built-in delay effect.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Value Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time</td>
<td>Length of time of the delayed signal.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>When Sync is set to <strong>Free</strong>: 1 ms – 2.00 s</td>
<td></td>
</tr>
<tr>
<td></td>
<td>When Sync is set to <strong>Sync</strong>: 1/32 – 8/4</td>
<td></td>
</tr>
<tr>
<td>Sync</td>
<td>Sync the Delay Time to the Global Tempo or set to Free to adjust Time by milliseconds.</td>
<td>Free, Sync</td>
</tr>
<tr>
<td>Mix</td>
<td>Wet/dry amount of the delay effect.</td>
<td>0–100%</td>
</tr>
<tr>
<td>Feedback</td>
<td>Amount of signal fed back into the delay line.</td>
<td>0–100%</td>
</tr>
<tr>
<td>Damp</td>
<td>Center frequency of where the delay signal will be dampened.</td>
<td>1.00 – 20.0 kHz</td>
</tr>
<tr>
<td>Reso</td>
<td>Amount of resonance of the feedback signal.</td>
<td>0–100%</td>
</tr>
<tr>
<td>Reso Freq</td>
<td>Center frequency for feedback resonance.</td>
<td>100 Hz – 10.0 kHz</td>
</tr>
<tr>
<td>Ratio</td>
<td>Reduces the delay Time in either the Left or Right stereo field. This is useful for creating offset, panned delays.</td>
<td>L 50:100, R 50:100</td>
</tr>
<tr>
<td>HPF</td>
<td>Center frequency for delay signal high-pass filter.</td>
<td>20.0 Hz – 1.0 kHz</td>
</tr>
<tr>
<td>Width</td>
<td>Stereo width of delay signal. Higher values give wider stereo separation.</td>
<td>0–100%</td>
</tr>
<tr>
<td>On/Off</td>
<td>Enables or disables the effect.</td>
<td>Off, On</td>
</tr>
</tbody>
</table>
**Compressor/Hype**

Use this tab to apply and adjust the settings for the built-in Compressor and Hype effects.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Value Range</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Compressor</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Threshold</td>
<td>Signal level after which the compressor will be applied.</td>
<td>0.0 – -60. dB</td>
</tr>
<tr>
<td>Ratio</td>
<td>Amount of compression applied.</td>
<td>1.0:1 – 100.0:1</td>
</tr>
<tr>
<td>Output</td>
<td>Amount of additional output gain for the compressed signal.</td>
<td>0.0 – 30.0 dB</td>
</tr>
<tr>
<td>Mix</td>
<td>Wet/dry mix of the compressor effect.</td>
<td>0–100%</td>
</tr>
<tr>
<td>Knee</td>
<td>How gradually the compressor reacts as the threshold is reached.</td>
<td>0–100%</td>
</tr>
<tr>
<td></td>
<td>Lower values apply a &quot;soft&quot; knee (compression is applied more slowly as signal approaches the threshold), and higher values apply a &quot;hard&quot; knee (compression is immediately applied when the threshold is reached).</td>
<td></td>
</tr>
<tr>
<td>Attack</td>
<td>Length of time to apply the compression.</td>
<td>100 us – 300 ms</td>
</tr>
<tr>
<td>Release</td>
<td>Length of time for compressed signal to return to original level.</td>
<td>10 ms – 4.00 s</td>
</tr>
<tr>
<td>On/Off</td>
<td>Enables or disables the effect.</td>
<td>Off, On</td>
</tr>
<tr>
<td><strong>Hype</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>High</td>
<td>Dampens or maximizes high end frequencies.</td>
<td>-100 – 0 – +100%</td>
</tr>
<tr>
<td>Low</td>
<td>Dampens or maximizes low end frequencies.</td>
<td>-100 – 0 – +100%</td>
</tr>
<tr>
<td>On/Off</td>
<td>Enables or disables the effect.</td>
<td>Off, On</td>
</tr>
</tbody>
</table>
AIR Electric

The AIR Electric plugin emulates the sound of classic electric pianos. Dedicated Pickup, Envelope, Bell and Noise parameter sections provide a huge amount of flexibility to configure the timbre of the electric piano sound. Electric also includes five AIR effects: Tremolo, Tube Distortion, Chorus, Delay and Spring Reverb.

While viewing any of the tabs listed below, you can quickly enable or disable the Bell and Noise sounds, as well as the built-in effects (Tremolo, Tube, Chorus, Delay and Spring Reverb).

When viewing a specific tab, you can enable or disable the sound or effect by pressing the circle in the upper-right corner of each section.

### Pickup/Env

Use this tab to edit the settings for the emulated pickup and the sound envelope.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Value Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pickup</td>
<td>Type</td>
<td>Pickup, 0–100%</td>
</tr>
<tr>
<td></td>
<td>Type of pickup emulated.</td>
<td>Electro-Static,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>0–100% Electro-Magnetic</td>
</tr>
<tr>
<td>Height</td>
<td>Height of the pickup to the tines.</td>
<td>0.0 – 5.0 mm</td>
</tr>
<tr>
<td>Distance</td>
<td>Distance of the pickup to the tines.</td>
<td>0.1 – 10.0 mm</td>
</tr>
<tr>
<td>Clip</td>
<td>Amount of clipping applied to the signal.</td>
<td>0–100%</td>
</tr>
<tr>
<td>Keytrack</td>
<td>Ties the pickup parameters to the pitch being played.</td>
<td>0–100%</td>
</tr>
<tr>
<td></td>
<td>At higher values, the Distance is increased as the pitch is increased.</td>
<td></td>
</tr>
<tr>
<td>Envelope</td>
<td>Attack</td>
<td>100–0% Hard,</td>
</tr>
<tr>
<td></td>
<td>Length of time for the note to reach full volume.</td>
<td>0–100% Soft</td>
</tr>
<tr>
<td>Decay</td>
<td>Length of time for the note to reach the sustained volume.</td>
<td>100 ms – 20.0 s</td>
</tr>
<tr>
<td>Release</td>
<td>Length of time for the note to become silent after being released.</td>
<td>100 ms – 5.0 s</td>
</tr>
<tr>
<td>Peak Length</td>
<td>Length of time full volume is held before decaying.</td>
<td>3–50 ms</td>
</tr>
<tr>
<td>Keytrack</td>
<td>Ties the envelope parameters to the pitch being played.</td>
<td>0–100%</td>
</tr>
<tr>
<td></td>
<td>At higher values, the envelope time is decreased as the pitch is increased.</td>
<td></td>
</tr>
</tbody>
</table>
### Bell/Noise

Use this tab to apply and adjust the settings for the Bell and Noise sounds.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Value Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bell</td>
<td>Tune Pitch of the bell sound, in semitones above the root pitch.</td>
<td>0– 60 semitones</td>
</tr>
<tr>
<td>Dry/PU</td>
<td>Mix of Dry versus Pickup signal for the bell sound.</td>
<td>-100% – 0% – +100%</td>
</tr>
<tr>
<td>Volume</td>
<td>Level of the bell sound.</td>
<td>-Inf dB – 0.0 – +6.0 dB</td>
</tr>
<tr>
<td>Tune Keytrack</td>
<td>Ties the tuning of the bell sound to the pitch being played.</td>
<td>0–100%</td>
</tr>
<tr>
<td>Decay</td>
<td>How long it takes for the bell sound to dissipate.</td>
<td>100 ms – 7.0 s</td>
</tr>
<tr>
<td>Keytrack</td>
<td>Ties the amount of bell sound to the pitch being played.</td>
<td>-100% – 0% – +100%</td>
</tr>
<tr>
<td></td>
<td>At negative values, the bell sound is increased as the pitch increases.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>At positive values, the bell sound is increased as the pitch decreases.</td>
<td></td>
</tr>
<tr>
<td>Noise</td>
<td>Freq Center frequency of the noise effect.</td>
<td>200 Hz – 16.0 kHz</td>
</tr>
<tr>
<td>Random</td>
<td>Amount of randomization applied to the noise effect.</td>
<td>0–100%</td>
</tr>
<tr>
<td>Mix</td>
<td>Level of noise effect present.</td>
<td>-Inf dB – 0.0 – +6.0 dB</td>
</tr>
<tr>
<td>Attack</td>
<td>Length of time for the noise effect to reach full level.</td>
<td>1–50 ms</td>
</tr>
<tr>
<td>Decay</td>
<td>Length of time for the noise effect to dissipate.</td>
<td>100 ms – 3.00 s</td>
</tr>
<tr>
<td>Keytrack</td>
<td>Ties the Freq to the pitch being played.</td>
<td>0–100%</td>
</tr>
</tbody>
</table>

### Setup

Use this tab to adjust general settings for the plugin.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Value Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>Polyphony</td>
<td>Number of voices available.</td>
<td>1–16 Voices</td>
</tr>
<tr>
<td>Master Volume</td>
<td>Overall level of the plugin.</td>
<td>-Inf dB – 0.0 – +6.0 dB</td>
</tr>
<tr>
<td>Velo Level</td>
<td>Adjusts how much incoming velocity is applied.</td>
<td>0–100%</td>
</tr>
<tr>
<td>Velo Tone</td>
<td>Ties the incoming velocity to tone. At higher values, increased velocity increases tone brightness.</td>
<td>0–100%</td>
</tr>
<tr>
<td>Velo Attack</td>
<td>Ties the incoming velocity to the attack envelope. At higher values, lower velocities feature longer attack times.</td>
<td>0–100%</td>
</tr>
</tbody>
</table>
**Trem/Tube/Chorus**

Use this tab to apply and adjust the settings for the built-in Tremolo, Tube (Overdrive), and Chorus effects.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Value Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tremolo</td>
<td>Rate</td>
<td>Modulation speed of the effect.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>When Sync is set to <strong>Free</strong>: 0.25 – 13.00 Hz</td>
</tr>
<tr>
<td></td>
<td></td>
<td>When Sync is set to <strong>Sync</strong>: 8/4 – 1/16</td>
</tr>
<tr>
<td>Sync</td>
<td>Sync the Tremolo Rate to the <strong>Global Tempo</strong> or let it run <strong>Free</strong>.</td>
<td>Free, Sync</td>
</tr>
<tr>
<td>Mode</td>
<td>Select <strong>Pan</strong> for stereo field modulation, or <strong>Tremolo</strong> for amplitude modulation.</td>
<td>Pan, Tremolo</td>
</tr>
<tr>
<td>Depth</td>
<td>Amount of modulation applied.</td>
<td>0–100%</td>
</tr>
<tr>
<td>Tube</td>
<td>Drive</td>
<td>Amount of drive applied.</td>
</tr>
<tr>
<td></td>
<td>Headroom</td>
<td>Amount of gain reduction between the clean signal and the driven signal.</td>
</tr>
<tr>
<td></td>
<td>Saturation</td>
<td>Amount of saturation applied.</td>
</tr>
<tr>
<td></td>
<td>Output</td>
<td>Output level of the tube driven signal.</td>
</tr>
<tr>
<td>Chorus</td>
<td>Rate</td>
<td>Modulation speed of the effect.</td>
</tr>
<tr>
<td>Depth</td>
<td>Amount of pitch modulation of the effect.</td>
<td>0–100%</td>
</tr>
<tr>
<td>Mix</td>
<td>Wet/dry amount of the chorus effect.</td>
<td>0–100%</td>
</tr>
</tbody>
</table>

**Delay**

Use this tab to apply and adjust the settings for the built-in Delay effect.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Value Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time</td>
<td>Amount of time between the dry signal and the delayed signal.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>When Sync is set to <strong>Free</strong>: 1 ms – 2.00 s</td>
<td></td>
</tr>
<tr>
<td></td>
<td>When Sync is set to <strong>Sync</strong>: 1/32 – 8/4</td>
<td></td>
</tr>
<tr>
<td>Sync</td>
<td>Sync the Delay Time to the <strong>Global Tempo</strong> or set to <strong>Free</strong> to adjust Time by milliseconds.</td>
<td>Free, Sync</td>
</tr>
<tr>
<td>Mix</td>
<td>Wet/dry amount of the delay effect.</td>
<td>0–100%</td>
</tr>
<tr>
<td>Feedback</td>
<td>Amount of signal fed back into the delay line.</td>
<td>0–100%</td>
</tr>
<tr>
<td>Damp</td>
<td>Center frequency of where the delay signal will be dampened.</td>
<td>1.00–20.0 kHz</td>
</tr>
<tr>
<td>Reso</td>
<td>Amount of resonance of the feedback signal.</td>
<td>0–100%</td>
</tr>
<tr>
<td>Reso Freq</td>
<td>Center frequency for feedback resonance.</td>
<td>100 Hz – 10.0 kHz</td>
</tr>
<tr>
<td>Ratio</td>
<td>Reduces the delay <strong>Time</strong> in either the <strong>Left</strong> or <strong>Right</strong> stereo field. This is useful for creating offset, panned delays.</td>
<td>L 50:100, R 50:100</td>
</tr>
<tr>
<td>HPF</td>
<td>Center frequency for delay signal high-pass filter.</td>
<td>20.0 Hz – 1.0 kHz</td>
</tr>
<tr>
<td>Width</td>
<td>Stereo width of delay signal. Higher values give wider stereo separation.</td>
<td>0–100%</td>
</tr>
</tbody>
</table>
Spring Reverb

Use this tab to apply and adjust the settings for the built-in Spring Reverb effect.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Value Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pre-Delay</td>
<td>Length of time between dry signal and reverberated signal.</td>
<td>0–250 ms</td>
</tr>
<tr>
<td>Time</td>
<td>Length of reverb tail.</td>
<td>1.0 – 10.0 s</td>
</tr>
<tr>
<td>Mix</td>
<td>Wet/dry amount of the reverb effect.</td>
<td>0–100%</td>
</tr>
<tr>
<td>Diffusion</td>
<td>Rate of increasing density of reverb reflections.</td>
<td>0–100%</td>
</tr>
<tr>
<td></td>
<td>At lower settings, the sound of individual reflections is more present.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>At higher settings, reflections are more uniform.</td>
<td></td>
</tr>
<tr>
<td>Width</td>
<td>Stereo width of reverb signal. Higher values give wider stereo separation.</td>
<td>0–100%</td>
</tr>
<tr>
<td>Low Cut</td>
<td>Center frequency for reverb signal low-cut filter.</td>
<td>20.0 Hz – 1.00 kHz</td>
</tr>
</tbody>
</table>
**AIR TubeSynth**

The AIR TubeSynth plugin emulates the sound of classic vintage analog polysynths. TubeSynth is based on the highly acclaimed AIR Vacuum Pro desktop synth plugin and also includes 5 integrated AIR effects.

### Oscillator

Use this tab to adjust the settings for the two variable Oscillators and the Sub Oscillator.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Value Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>Oscillator 1 Octave</td>
<td>Coarse tuning of the oscillator by octaves.</td>
<td>Wide, 32', 16', 8', 4', 2'</td>
</tr>
<tr>
<td></td>
<td>The <strong>Wide</strong> setting provides additional <strong>Fine</strong> tuning controls.</td>
<td></td>
</tr>
<tr>
<td>Fine</td>
<td>Fine tuning of the oscillator by semitones.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>When <strong>Octave</strong> is set to <strong>Wide</strong>: -70.00 – 0.00 – +70.00</td>
<td></td>
</tr>
<tr>
<td></td>
<td>When <strong>Octave</strong> is set to <strong>32'–2'</strong>: -12.00 – 0.00 – +12.00</td>
<td></td>
</tr>
<tr>
<td>Shape</td>
<td>Waveshape of Oscillator 1 (continuously variable).</td>
<td>Triangle, Saw, Square, Pulse</td>
</tr>
<tr>
<td>F-Env ➔ Shape</td>
<td>Amount of Filter Envelope output subtracted from or added to the value defined by the Osc 1 Shape parameter.</td>
<td>-100 – 0 – +100%</td>
</tr>
<tr>
<td>Quad</td>
<td>Enables or disables four-voice emulation for the oscillator.</td>
<td>Off, On</td>
</tr>
<tr>
<td>Detune</td>
<td>Adjusts tuning of the additional Quad voices.</td>
<td>0–100%</td>
</tr>
<tr>
<td>Oscillator 2 Octave</td>
<td>Coarse tuning of the oscillator by octaves all the way down to LFO speed.</td>
<td>LFO, 32', 16', 8', 4', 2'</td>
</tr>
<tr>
<td>Fine</td>
<td>Fine tuning of the oscillator.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>When <strong>Octave</strong> is set to <strong>LFO</strong>: 0.01 – 20.00 Hz</td>
<td></td>
</tr>
<tr>
<td></td>
<td>When <strong>Octave</strong> is set to <strong>32'–2'</strong>: -12.00 – 0.00 – +12.00 semitones</td>
<td></td>
</tr>
<tr>
<td>Shape</td>
<td>Waveshape of Oscillator 2 (continuously variable).</td>
<td>Noise, Saw, Square, Pulse</td>
</tr>
<tr>
<td>F-Env ➔ Shape</td>
<td>Amount of Filter Envelope output subtracted from or added to the value defined by the Osc 2 Shape parameter.</td>
<td>-100 – 0 – +100%</td>
</tr>
<tr>
<td>Sync</td>
<td>Enables or disables syncing of Oscillator 2 to Oscillator 1.</td>
<td>Off, On</td>
</tr>
<tr>
<td>Micro Detune</td>
<td>Additional detuning of Oscillator 2.</td>
<td>0–100%</td>
</tr>
<tr>
<td>Phase</td>
<td>Position of the waveshape when the sound is triggered.</td>
<td>0–360 degrees</td>
</tr>
<tr>
<td>Sub Oscillator Shape</td>
<td>Waveshape of the sub oscillator (continuously variable).</td>
<td>Triangle, Saw, Square, Pulse</td>
</tr>
</tbody>
</table>
**Mixer / Filter**

Use this tab to control EQ for Oscillator 2, set the levels of the oscillators and effects, and edit the low-pass filter.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Value Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>Osc 2 EQ</td>
<td>Gain</td>
<td>Amount of gain applied to the selected <strong>Frequency</strong>.</td>
</tr>
<tr>
<td></td>
<td>Frequency</td>
<td>Center frequency for the equalization band.</td>
</tr>
<tr>
<td></td>
<td>Drive</td>
<td>Amount of drive added to the EQ signal.</td>
</tr>
<tr>
<td></td>
<td>Keytrack</td>
<td>Ties the EQ settings to the pitch being played</td>
</tr>
<tr>
<td>Mixer</td>
<td>Osc 1</td>
<td>Level of Oscillator 1.</td>
</tr>
<tr>
<td></td>
<td>Osc 2</td>
<td>Level of Oscillator 2.</td>
</tr>
<tr>
<td></td>
<td>Sub Osc</td>
<td>Level of the Sub Oscillator.</td>
</tr>
<tr>
<td></td>
<td>Ring Mod</td>
<td>Level of Ring Modulation effect.</td>
</tr>
<tr>
<td></td>
<td>Drive</td>
<td>Level of Drive effect.</td>
</tr>
<tr>
<td>LP Filter</td>
<td>Cutoff</td>
<td>Center frequency of the low-pass filter cutoff.</td>
</tr>
<tr>
<td></td>
<td>Reso</td>
<td>Amount of resonance of the low-pass filter.</td>
</tr>
<tr>
<td></td>
<td>Slope</td>
<td>Amount of attenuation applied above the cutoff frequency.</td>
</tr>
<tr>
<td></td>
<td>Saturation</td>
<td>Amount of saturation applied to the low-pass filter.</td>
</tr>
<tr>
<td></td>
<td>Env</td>
<td>Percentage of the envelope output subtracted from or added to the LP Filter <strong>Cutoff</strong>.</td>
</tr>
<tr>
<td></td>
<td>Keytrack</td>
<td>Ties the LP Filter Cutoff to the pitch being played.</td>
</tr>
</tbody>
</table>
### Envelope

Use this tab to adjust the various envelope settings.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Value Range</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Filter Envelope</strong></td>
<td>Attack Length of time for the filter to reach full level.</td>
<td>1.00 ms – 100 s</td>
</tr>
<tr>
<td></td>
<td>Decay Length of time for the filter to reach sustain level.</td>
<td>1.00 ms – 100 s</td>
</tr>
<tr>
<td></td>
<td>Sustain Length of time for the filter to hold sustain level.</td>
<td>0–100%</td>
</tr>
<tr>
<td></td>
<td>Release Length of time for the filter to dissipate when released.</td>
<td>1.00 ms – 100 s</td>
</tr>
<tr>
<td><strong>Amp Envelope</strong></td>
<td>Attack Length of time for the note to reach full level.</td>
<td>1.00 ms – 100 s</td>
</tr>
<tr>
<td></td>
<td>Decay Length of time for the note to reach sustain level.</td>
<td>1.00 ms – 100 s</td>
</tr>
<tr>
<td></td>
<td>Sustain Length of time for the note to hold sustain level.</td>
<td>0–100%</td>
</tr>
<tr>
<td></td>
<td>Release Length of time for the note to dissipate when released.</td>
<td>1.00 ms – 100 s</td>
</tr>
<tr>
<td><strong>Envelope 3</strong></td>
<td>Start Level Initial velocity level of the envelope.</td>
<td>0–100%</td>
</tr>
<tr>
<td></td>
<td>Start Time Length of time for the envelope to start.</td>
<td>0–5000 ms</td>
</tr>
<tr>
<td></td>
<td>Slope Hold Percentage of Envelope subtracted from or added to the Destination when a note is held.</td>
<td>-100 – 0 – +100%</td>
</tr>
<tr>
<td></td>
<td>Slope Rel Percentage of Envelope subtracted from or added to the Destination when a note is released.</td>
<td>-100 – 0 – +100%</td>
</tr>
<tr>
<td></td>
<td>Destination Where the envelope will be applied to.</td>
<td>Off, Pitch, Osc 2 Pitch, LFO 1/2 Rate, Osc1 Quad Det., Osc 1/2 Shape, Osc 1/2 Level, Ring Level</td>
</tr>
</tbody>
</table>
LFO

Use this tab to adjust the settings for the low-frequency oscillators.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Value Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>LFO 1/LFO 2</td>
<td>Shape</td>
<td>Waveshape of the low-frequency oscillator.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Sine, Square, Saw Up, Saw Down, Pump, S&amp;H, Drift</td>
</tr>
<tr>
<td>Destination</td>
<td></td>
<td>Where the low-frequency oscillator is sent.</td>
</tr>
<tr>
<td>LFO1:</td>
<td></td>
<td>Off, Pitch, Filter, Level, Pan</td>
</tr>
<tr>
<td>LFO2:</td>
<td></td>
<td>Pitch, Osc 1/2 Shape, Osc 1/2 Pitch, LPF, Quad Detune, Osc EQ Freq, Osc 2 EQ</td>
</tr>
<tr>
<td>Rate</td>
<td></td>
<td>Speed of modulation.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>When Sync is Off: 0.01 – 20.00 Hz</td>
</tr>
<tr>
<td></td>
<td></td>
<td>When Sync is On: 8/4 – 1/32</td>
</tr>
<tr>
<td>Depth</td>
<td></td>
<td>Amount of modulation applied.</td>
</tr>
<tr>
<td>Fade</td>
<td></td>
<td>0–100%</td>
</tr>
<tr>
<td></td>
<td></td>
<td>0.00 – 20.00 s out, No fade, 0.00 – 20.00 s in</td>
</tr>
<tr>
<td>Sync</td>
<td></td>
<td>Sync the LFO Rate to the <strong>Global Tempo</strong> or turn Off to adjust Rate by Hertz.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Off, On</td>
</tr>
<tr>
<td>Modulation</td>
<td>Source</td>
<td>Where the modulation signal is sent from.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Filter Env, Amp Env, Osc 1, Osc 2</td>
</tr>
<tr>
<td>Destination</td>
<td></td>
<td>Where the modulated signal is received.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Pitch, Osc 1/2 Shape, Osc 1/2 Pitch, LPF, Quad Detune, Osc EQ Freq, Osc 2 EQ</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Gain, Ring Level</td>
</tr>
<tr>
<td>Depth</td>
<td></td>
<td>Amount of modulation applied.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>0–100%</td>
</tr>
</tbody>
</table>
**Setup**

Use this tab to adjust plugin setup parameters.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Value Range</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Controller Destinations</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Velocity 1</td>
<td>Send Velocity data to one of the following control destinations.</td>
<td>Amp, Cutoff, Osc1 Shape, Osc2 Shape, Osc1&amp;2 Shape</td>
</tr>
<tr>
<td>Depth</td>
<td>Amount of modulation applied.</td>
<td>0–100%</td>
</tr>
<tr>
<td>Velocity 2</td>
<td>Send Velocity data to one of the following control destinations.</td>
<td>Amp, Cutoff, Osc1 Shape, Osc2 Shape, Osc1&amp;2 Shape</td>
</tr>
<tr>
<td>Depth</td>
<td>Amount of modulation applied.</td>
<td>0–100%</td>
</tr>
<tr>
<td>Modwheel</td>
<td>Send Modwheel data to one of the following control destinations.</td>
<td>Amp, Cutoff, Osc1 Shape, Osc2 Shape, Osc1&amp;2 Shape</td>
</tr>
<tr>
<td>Depth</td>
<td>Amount of modulation applied.</td>
<td>-100 – 0 – 100%</td>
</tr>
<tr>
<td>Aftertouch</td>
<td>Send Aftertouch data to one of the following control destinations.</td>
<td>LFO 1 Depth, Cutoff, Osc1 Shape, Osc2 Shape, Osc1&amp;2 Shape</td>
</tr>
<tr>
<td>Depth</td>
<td>Amount of modulation applied.</td>
<td>-100 – 0 – 100%</td>
</tr>
<tr>
<td><strong>Setup</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Polyphony</td>
<td>Number of allowable voices, and how voices are triggered.</td>
<td>Legato, Retrigger, 2, 3, 4</td>
</tr>
<tr>
<td>Bend Range</td>
<td>Number of semitones up or down controlled by MIDI pitch bend messages.</td>
<td>0–12 (semitones)</td>
</tr>
<tr>
<td>Glide Time</td>
<td>Amount of time to slide from the pitch of one note to the next note played.</td>
<td>1.00 ms – 100 s</td>
</tr>
<tr>
<td>Glide All</td>
<td>Enables or disables pitch gliding for all triggered notes, not just legato notes.</td>
<td>Off, On</td>
</tr>
<tr>
<td>Detune</td>
<td>Amount of detuning applied. This setting is only applied when Doubling is enabled.</td>
<td>0–100%</td>
</tr>
<tr>
<td>Doubling</td>
<td>Enables or disables voice doubling.</td>
<td>Off, On</td>
</tr>
<tr>
<td><strong>Output</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Shape</td>
<td>Amount of signal sent to a Tube Drive.</td>
<td>0–100%</td>
</tr>
<tr>
<td>Width</td>
<td>Stereo width of the audio signal. Higher values give wider stereo separation.</td>
<td>0–100%</td>
</tr>
<tr>
<td>Level</td>
<td>Overall output volume of the plugin.</td>
<td>-Inf dB – +12.0 dB</td>
</tr>
</tbody>
</table>
**Chorus**
Use this tab to apply and adjust the settings for the built-in Chorus effect.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Value Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rate</td>
<td>Modulation speed of the effect.</td>
<td>0.01 – 10.0 Hz</td>
</tr>
<tr>
<td>Delay</td>
<td>Length of time the wet signal is offset from the dry signal.</td>
<td>0.00 – 24.00 ms</td>
</tr>
<tr>
<td>Voices</td>
<td>Number of voices used in the chorus effect.</td>
<td>3, 4, 6</td>
</tr>
<tr>
<td>LFO Wave</td>
<td>Waveshape of the low-frequency oscillator for the chorus effect.</td>
<td>Tri, Sine</td>
</tr>
<tr>
<td>Depth</td>
<td>Amount of pitch modulation of the effect.</td>
<td>0.00 – 24.00 ms</td>
</tr>
<tr>
<td>Width</td>
<td>Stereo width of the chorus effect. Higher values give wider stereo separation.</td>
<td>0–100%</td>
</tr>
<tr>
<td>Lo Cut</td>
<td>Center frequency for the chorus low-cut filter.</td>
<td>20.0 Hz – 1.0 kHz</td>
</tr>
<tr>
<td>Mix</td>
<td>Wet/dry amount of the chorus effect.</td>
<td>0–100%</td>
</tr>
</tbody>
</table>

**Delay**
Use this tab to apply and adjust the settings for the built-in delay effect.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Value Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time</td>
<td>Length of time between the dry signal and the delayed signal.</td>
<td>When Sync is set to Free: 1 ms – 2.00 s When Sync is set to Sync: 1/32 – 8/4</td>
</tr>
<tr>
<td>Sync</td>
<td>Enable to sync the Delay Time to the Global Tempo, disable to set the Time in milliseconds.</td>
<td>Off, On</td>
</tr>
<tr>
<td>Feedback</td>
<td>Amount of delay signal fed back into the delay line.</td>
<td>0–100%</td>
</tr>
<tr>
<td>Mix</td>
<td>Wet/dry amount of the delay effect.</td>
<td>0–100%</td>
</tr>
<tr>
<td>Damp</td>
<td>Center frequency of where the delayed signal will be dampened.</td>
<td>1.00 – 20.0 kHz</td>
</tr>
<tr>
<td>Reso</td>
<td>Amount of resonance of the feedback signal.</td>
<td>0–100%</td>
</tr>
<tr>
<td>Reso Freq</td>
<td>Center frequency for feedback resonance.</td>
<td>100 Hz – 10.0 kHz</td>
</tr>
<tr>
<td>Ratio</td>
<td>Reduces the delay Time in either the Left or Right stereo field. This is useful for creating offset, panned delays.</td>
<td>L 100:50, R 50:100</td>
</tr>
<tr>
<td>HPF</td>
<td>Center frequency for delay signal high-pass filter.</td>
<td>20.0 Hz – 1.0 kHz</td>
</tr>
<tr>
<td>Width</td>
<td>Stereo width of delay signal. Higher values give wider stereo separation.</td>
<td>0–100%</td>
</tr>
</tbody>
</table>
**Reverb / Compressor / Hype**

Use this tab to apply and adjust the settings for the built-in Reverb, Compressor and Hype effects.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Value Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reverb</td>
<td>Mode</td>
<td>Hall, Stadium, Room, Abstract</td>
</tr>
<tr>
<td></td>
<td>Time</td>
<td>0.4 s – +Inf s</td>
</tr>
<tr>
<td></td>
<td>Lo Cut</td>
<td>1 – 1000 Hz</td>
</tr>
<tr>
<td></td>
<td>Hi Cut</td>
<td>1.0 – 20.0 kHz</td>
</tr>
<tr>
<td></td>
<td>Mix</td>
<td>0–100%</td>
</tr>
<tr>
<td>Compressor</td>
<td>Threshold</td>
<td>0.0 – -60. dB</td>
</tr>
<tr>
<td></td>
<td>Output</td>
<td>0.0 – +30.0 dB</td>
</tr>
<tr>
<td></td>
<td>Mix</td>
<td>0–100%</td>
</tr>
<tr>
<td></td>
<td>Ratio</td>
<td>1.0:1 – 100.0:1</td>
</tr>
<tr>
<td></td>
<td>Knee</td>
<td>0–100%</td>
</tr>
<tr>
<td></td>
<td></td>
<td>How gradually the compressor reacts as the threshold is reached. Lower values apply a &quot;soft&quot; knee (compression is applied more slowly as signal approaches the threshold), and higher values apply a &quot;hard&quot; knee (compression is immediately applied when the threshold is reached).</td>
</tr>
<tr>
<td></td>
<td>Attack</td>
<td>100 us – 300 ms</td>
</tr>
<tr>
<td></td>
<td>Release</td>
<td>10 ms – 4.00 s</td>
</tr>
<tr>
<td>Hype</td>
<td>High</td>
<td>-100 – 0 – +100%</td>
</tr>
<tr>
<td></td>
<td>Low</td>
<td>-100 – 0 – +100%</td>
</tr>
</tbody>
</table>
Plugin Preset Support

Internal Akai effects now include all new plugin editors and factory presets.

To load a plugin preset:
1. Open a plugin instrument or effects plugin editor.
2. At the top of the instrument or effect editing window will be a dropdown menu for selecting presets. Double-tap the menu to open it, and tap a preset to select it.
   A number of third-party VST plugins will also display a bank of presets when used with MPC.

Additionally, you can now save and load plugin presets.

To save or load a plugin preset:
1. Open a plugin instrument or effects plugin.
2. To the right of the dropdown menu for selecting presets are Folder and Disc icons.
   Tap the Folder icon to load a plugin preset saved on your MPC or any connected drive. Use the window that opens to select the location where the preset is saved.
   Tap the Disc icon to save your plugin settings as a new preset. Use the window that opens to select where you would like to save the preset.
Updates in MPC 2.4

New Features

AIR FX Bundle

Your MPC now includes the AIR FX Bundle—a collection of 28 effects designed with ease of use in mind with all new touch-interface layouts. These effects include the legendary AIR Creative FX collection that has been used by countless professionals as part of Pro Tools® software since Version 8. They also include 10 new plugins that have been expertly designed by the DSP gurus at AIR Music Technology.

16 classic effects from Pro Tools® now available include the following:

AIR Distortion

This effect is a multi-type distortion that adds color to your audio signal with varying types and amounts of distortion.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mode</td>
<td>Hard, Soft, Wrap</td>
<td>Hard</td>
</tr>
<tr>
<td>Drive</td>
<td>0 – 60 dB</td>
<td>15 dB</td>
</tr>
<tr>
<td>Output</td>
<td>0–100%</td>
<td>100%</td>
</tr>
<tr>
<td>Mix</td>
<td>0–100% (dry-wet)</td>
<td>100%</td>
</tr>
<tr>
<td>Tone Pre-Shape</td>
<td>-100 – 0 – +100%</td>
<td>0%</td>
</tr>
<tr>
<td>Tone High Cut</td>
<td>1.00 – 20.0 kHz</td>
<td>20.0 kHz</td>
</tr>
<tr>
<td>Stereo</td>
<td>On, Off</td>
<td>Off</td>
</tr>
<tr>
<td>Clipping Thresh.</td>
<td>-20.0 – 0.0 dB FS</td>
<td>-10.0 dB FS</td>
</tr>
<tr>
<td>Clipping Edge</td>
<td>0–100%</td>
<td>0%</td>
</tr>
</tbody>
</table>

AIR Enhancer

This effect enhances the low and high broadband frequencies of the audio signal.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>High Gain</td>
<td>0.0 – 12.0 dB</td>
<td>0.0 dB</td>
</tr>
<tr>
<td>Low Gain</td>
<td>0.0 – 12.0 dB</td>
<td>0.0 dB</td>
</tr>
<tr>
<td>Output</td>
<td>- Inf – 0.0 dB</td>
<td>0.0 dB</td>
</tr>
<tr>
<td>Freq. High</td>
<td>1.0 – 10.0 kHz</td>
<td>3.16 kHz</td>
</tr>
<tr>
<td>Freq. Low</td>
<td>40.0 – 640 Hz</td>
<td>160 Hz</td>
</tr>
<tr>
<td>Harmonics</td>
<td>0.0 – 12.0 dB</td>
<td>0.0 dB</td>
</tr>
<tr>
<td>Phase</td>
<td>+ (positive), - (negative)</td>
<td>+</td>
</tr>
</tbody>
</table>
**AIR Ensemble**

This effect applies fluid, shimmering modulation effects to the audio signal.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rate</td>
<td>0.01 – 10.0 Hz</td>
<td>1.00 Hz</td>
</tr>
<tr>
<td>Depth</td>
<td>0.00 – 24.00 ms</td>
<td>6.00 ms</td>
</tr>
<tr>
<td>Width</td>
<td>0–100%</td>
<td>100%</td>
</tr>
<tr>
<td>Mix</td>
<td>0–100% (dry–wet)</td>
<td>75%</td>
</tr>
<tr>
<td>Mod. Delay</td>
<td>0.00 – 24.00 ms</td>
<td>0.00 ms</td>
</tr>
<tr>
<td>Mod. Shimmer</td>
<td>0–100%</td>
<td>50%</td>
</tr>
</tbody>
</table>

**AIR Filter Gate**

This effect chops your audio signal into rhythmic patterns with variable filtering, amplitude and panning.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pattern</td>
<td>Straight, Pulse, Pumper, Marching, Fader, Offbeats, Off+Pan, L/R Pan, LL/RR Pan, Slow Pan, Rand Pan, Shorter, Longer, Reverse, Random, Keyed 1–2, Half Time, 12-Step, Ducked, Trance 1–6, Tech 1–6</td>
<td>Straight</td>
</tr>
<tr>
<td>Rate</td>
<td>1/2–1/32, including Dotted and Triplet</td>
<td>1/16</td>
</tr>
<tr>
<td>Swing</td>
<td>50.0–66.7%</td>
<td>50.0%</td>
</tr>
<tr>
<td>Mix</td>
<td>0–100%</td>
<td>100%</td>
</tr>
<tr>
<td>Filter Mode</td>
<td>Off, LP, BP, HP, Phaser</td>
<td>LP</td>
</tr>
<tr>
<td>Filter Cutoff</td>
<td>-100 – 0 – 100%</td>
<td>0%</td>
</tr>
<tr>
<td>Filter Reso</td>
<td>-100 – 0 – 100%</td>
<td>0%</td>
</tr>
<tr>
<td>Gate Attack</td>
<td>0–100%</td>
<td>25%</td>
</tr>
<tr>
<td>Gate Hold</td>
<td>0–100%</td>
<td>50%</td>
</tr>
<tr>
<td>Gate Release</td>
<td>0–100%</td>
<td>25%</td>
</tr>
<tr>
<td>Mod LFO Wave</td>
<td>Random; 2–12, 16, 24, 32, 48, 64, 96, 128, 192, 256 Steps</td>
<td>Random</td>
</tr>
<tr>
<td>Mod Env</td>
<td>-100 – 0 – 100%</td>
<td>0%</td>
</tr>
<tr>
<td>Mod LFO</td>
<td>0–100%</td>
<td>0%</td>
</tr>
</tbody>
</table>

**AIR Flanger**

This effect applies a short, modulating delay to the audio signal.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rate</td>
<td>0.02 – 10.00 Hz</td>
<td>0.40 Hz</td>
</tr>
<tr>
<td>Depth</td>
<td>0–100%</td>
<td>50%</td>
</tr>
<tr>
<td>Feedback</td>
<td>0–100%</td>
<td>50%</td>
</tr>
<tr>
<td>Mix</td>
<td>0–100% (dry–wet)</td>
<td>50%</td>
</tr>
<tr>
<td>Headroom</td>
<td>-20.0 – 0.0 dB FS</td>
<td>-10.0 dB FS</td>
</tr>
</tbody>
</table>
**AIR Freq Shift**

This effect shifts the audio signal’s individual frequencies for unique effects.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mode</td>
<td>Up, Down, Up &amp; Down, Stereo</td>
<td>Up</td>
</tr>
<tr>
<td>Frequency</td>
<td>10.0 mHz – 10.0 kHz</td>
<td>316 mHz</td>
</tr>
<tr>
<td>Feedback</td>
<td>0–100%</td>
<td>0%</td>
</tr>
<tr>
<td>Mix</td>
<td>0–100% (dry–wet)</td>
<td>100%</td>
</tr>
</tbody>
</table>

**AIR Fuzz Wah**

This is a multi-effect that combines transistor-like distortion and wah.

<table>
<thead>
<tr>
<th>Tab</th>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fuzz-Wah</td>
<td>Mix</td>
<td>0–100% (dry–wet)</td>
<td>100%</td>
</tr>
<tr>
<td></td>
<td>Order</td>
<td>Fuzz&gt;Wah, Wah&gt;Fuzz</td>
<td>Fuzz&gt;Wah</td>
</tr>
<tr>
<td></td>
<td>Fuzz Mix</td>
<td>0–100% (dry–wet)</td>
<td>100%</td>
</tr>
<tr>
<td></td>
<td>Wah Mix</td>
<td>0–100% (dry–wet)</td>
<td>100%</td>
</tr>
<tr>
<td></td>
<td>Fuzz Drive</td>
<td>0 – 40 dB</td>
<td>20 dB</td>
</tr>
<tr>
<td></td>
<td>Fuzz Tone</td>
<td>1.00 – 10.0 kHz</td>
<td>3.16 kHz</td>
</tr>
<tr>
<td></td>
<td>Fuzz Output</td>
<td>-Inf – 0.0 dB</td>
<td>0.0 dB</td>
</tr>
<tr>
<td></td>
<td>Fuzz Enable</td>
<td>Off, On</td>
<td>Off</td>
</tr>
<tr>
<td></td>
<td>Wah Pedal</td>
<td>0–100%</td>
<td>50%</td>
</tr>
<tr>
<td></td>
<td>Wah Filter Mode</td>
<td>Lowpass, Bandpass, Highpass</td>
<td>Bandpass</td>
</tr>
<tr>
<td></td>
<td>Min. Freq.</td>
<td>50.0 Hz – 4.00 kHz</td>
<td>428 Hz</td>
</tr>
<tr>
<td></td>
<td>Max Freq.</td>
<td>50.0 Hz – 4.00 kHz</td>
<td>2.07 kHz</td>
</tr>
<tr>
<td></td>
<td>Min. Resonance</td>
<td>0–100%</td>
<td>55%</td>
</tr>
<tr>
<td></td>
<td>Max Resonance</td>
<td>0–100%</td>
<td>33%</td>
</tr>
<tr>
<td></td>
<td>Wah Enable</td>
<td>Off, On</td>
<td>On</td>
</tr>
<tr>
<td>Modulation</td>
<td>Mode</td>
<td>LFO, Env</td>
<td>LFO</td>
</tr>
<tr>
<td></td>
<td>Rate</td>
<td>8/4 – 16</td>
<td>4T</td>
</tr>
<tr>
<td></td>
<td>LFO</td>
<td>0–100%</td>
<td>75%</td>
</tr>
<tr>
<td></td>
<td>Env</td>
<td>-100 – 0 – 100%</td>
<td>0%</td>
</tr>
</tbody>
</table>
AIR Kill EQ

This effect can zap out the Low, Mid or High broadband frequency from an audio signal.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>High Thru, Kill</td>
<td>-20.0 – +20.0 dB</td>
<td>0.0 dB</td>
</tr>
<tr>
<td>Mid Thru, Kill</td>
<td>-Inf – +12.0 dB</td>
<td>0.0 dB</td>
</tr>
<tr>
<td>Low Thru, Kill</td>
<td>-Inf – +12.0 dB</td>
<td>0.0 dB</td>
</tr>
<tr>
<td>Output</td>
<td>500 Hz – 8.00 kHz</td>
<td>2.00 kHz</td>
</tr>
<tr>
<td>Offset</td>
<td>-100 – +100%</td>
<td>0%</td>
</tr>
<tr>
<td>Low Freq.</td>
<td>50.0 – 800 Hz</td>
<td>200 Hz</td>
</tr>
</tbody>
</table>

AIR Lo-Fi

This effect is used to bit-crush, down-sampling, clip, rectify and mangle an audio signal.

<table>
<thead>
<tr>
<th>Tab</th>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lo-Fi</td>
<td>Bit Depth</td>
<td>1.0 – 16.0 bit</td>
<td>16.0 bit</td>
</tr>
<tr>
<td></td>
<td>Sample Rate</td>
<td>500 Hz – 50.0 kHz</td>
<td>50.0 kHz</td>
</tr>
<tr>
<td></td>
<td>Mix</td>
<td>0–100%</td>
<td>100%</td>
</tr>
<tr>
<td></td>
<td>Clip</td>
<td>0.0 – 40.0 dB</td>
<td>0.0 dB</td>
</tr>
<tr>
<td></td>
<td>Rectify</td>
<td>0–100%</td>
<td>0%</td>
</tr>
<tr>
<td></td>
<td>Noise Mod</td>
<td>0–100%</td>
<td>0%</td>
</tr>
<tr>
<td></td>
<td>Pre</td>
<td>0.125 – 2.000 Fs</td>
<td>0.5000 Fs</td>
</tr>
<tr>
<td></td>
<td>Post</td>
<td>0.125 – 2.000 Fs</td>
<td>1.000 Fs</td>
</tr>
<tr>
<td></td>
<td>Enable</td>
<td>On, Off</td>
<td>Off</td>
</tr>
<tr>
<td>LFO / Env</td>
<td>Wave</td>
<td>Sine, Tri, Saw,</td>
<td>Sine</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Square, Morse, S&amp;H, Random</td>
<td></td>
</tr>
<tr>
<td>Rate</td>
<td>Sync Off:</td>
<td>0.01 – 10.0 Hz</td>
<td>1.00 Hz</td>
</tr>
<tr>
<td></td>
<td>Sync On:</td>
<td>8/4 – 16</td>
<td>2T</td>
</tr>
<tr>
<td></td>
<td>Sync</td>
<td>On, Off</td>
<td>Off</td>
</tr>
<tr>
<td></td>
<td>Depth</td>
<td>-100 – 0 – 100%</td>
<td>0%</td>
</tr>
<tr>
<td></td>
<td>Attack</td>
<td>0.1 – 10.0 s</td>
<td>0.5 s</td>
</tr>
<tr>
<td></td>
<td>Release</td>
<td>0.1 – 10.0 s</td>
<td>0.5 s</td>
</tr>
<tr>
<td></td>
<td>Depth</td>
<td>-100 – 0 – 100%</td>
<td>0%</td>
</tr>
</tbody>
</table>
**AIR Multi-Chorus**

This effect applies a thick, complex chorus effect to your audio signal.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rate</td>
<td>0.01 – 10.0 Hz</td>
<td>1.00 Hz</td>
</tr>
<tr>
<td>Depth</td>
<td>0.00 – 24.00 ms</td>
<td>6.00 ms</td>
</tr>
<tr>
<td>Voices</td>
<td>3, 4, 6</td>
<td>4</td>
</tr>
<tr>
<td>Mix</td>
<td>0–100% (dry–wet)</td>
<td>50%</td>
</tr>
<tr>
<td>Chorus Low Cut</td>
<td>20.0 Hz – 1.00 kHz</td>
<td>20.0 Hz</td>
</tr>
<tr>
<td>Chorus Width</td>
<td>0–100%</td>
<td>100%</td>
</tr>
<tr>
<td>Mod Wave</td>
<td>Sine, Tri</td>
<td>Tri</td>
</tr>
<tr>
<td>Mod Delay</td>
<td>0.00 – 24.00 ms</td>
<td>6.0 ms</td>
</tr>
</tbody>
</table>

**AIR Non-Lin Reverb**

This is a spatial effect, designed to produce synthetic, processed ambience with special gated and reversed reverb effects.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pre-Delay</td>
<td>0–250 ms</td>
<td>0 ms</td>
</tr>
<tr>
<td>Dry Delay</td>
<td>0–1500 ms</td>
<td>0 ms</td>
</tr>
<tr>
<td>Time</td>
<td>0–1000 ms</td>
<td>250 ms</td>
</tr>
<tr>
<td>Mix</td>
<td>0–100% (dry–wet)</td>
<td>50%</td>
</tr>
<tr>
<td>Diffusion</td>
<td>0–100%</td>
<td>100%</td>
</tr>
<tr>
<td>Width</td>
<td>0–100%</td>
<td>50%</td>
</tr>
<tr>
<td>Shape</td>
<td>Gated, Reverse</td>
<td>Gated</td>
</tr>
<tr>
<td>Low-Cut</td>
<td>20.0 Hz – 1.00 kHz</td>
<td>141 Hz</td>
</tr>
<tr>
<td>High-Cut</td>
<td>1.00–20.0 kHz</td>
<td>9.46 kHz</td>
</tr>
</tbody>
</table>

**AIR Phaser**

This effect applies a phaser to your audio signal, for that wonderful "wooshy," "squishy" sound.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rate</td>
<td>0.10 – 10.0 Hz</td>
<td>1.00 Hz</td>
</tr>
<tr>
<td>Depth</td>
<td>0–100%</td>
<td>50%</td>
</tr>
<tr>
<td>Feedback</td>
<td>0–100%</td>
<td>0%</td>
</tr>
<tr>
<td>Mix</td>
<td>0–100% (dry–wet)</td>
<td>50%</td>
</tr>
<tr>
<td>Phaser Model</td>
<td>Vibe, Stone, Ninety, Tron</td>
<td>Ninety</td>
</tr>
<tr>
<td>Offset Phase</td>
<td>-180 – +180 deg.</td>
<td>0 deg.</td>
</tr>
<tr>
<td>Offset Rate</td>
<td>25–400%</td>
<td>100%</td>
</tr>
<tr>
<td>Type</td>
<td>Phase, Rate</td>
<td>Phase</td>
</tr>
</tbody>
</table>
**AIR Reverb**

This is a spatial effect, with a wide range of reverb types to add space or room to your audio signal.

<table>
<thead>
<tr>
<th>Tab</th>
<th>Parameter</th>
<th>Values</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reverb</td>
<td>Pre-Delay</td>
<td>0–250 ms</td>
<td>0 ms</td>
</tr>
<tr>
<td></td>
<td>Room Size</td>
<td>0–100%</td>
<td>100%</td>
</tr>
<tr>
<td></td>
<td>Time</td>
<td>0.4 ms – +inf s</td>
<td>1.9 s</td>
</tr>
<tr>
<td>Early Reflection</td>
<td>Mix</td>
<td>0–100%</td>
<td>50%</td>
</tr>
<tr>
<td></td>
<td>Type</td>
<td>Off, Booth, Club, Room, Small Chamber, Medium Chamber, Large Chamber, Small Studio, Large Studio, Scoring Stage, Philharmonic, Concert Hall, Church, Opera House, Vintage 1, Vintage 2</td>
<td>Off</td>
</tr>
<tr>
<td></td>
<td>Length</td>
<td>0–100%</td>
<td>100%</td>
</tr>
<tr>
<td></td>
<td>ER / Tail Mix</td>
<td>0–100%</td>
<td>50%</td>
</tr>
<tr>
<td></td>
<td>Input Width</td>
<td>0–100%</td>
<td>0%</td>
</tr>
<tr>
<td></td>
<td>Output Width</td>
<td>0–100%</td>
<td>0%</td>
</tr>
<tr>
<td>Room</td>
<td>Delay</td>
<td>0–250 ms</td>
<td>0 ms</td>
</tr>
<tr>
<td></td>
<td>Ambience</td>
<td>0–100%</td>
<td>0%</td>
</tr>
<tr>
<td></td>
<td>Density</td>
<td>0–100%</td>
<td>100%</td>
</tr>
<tr>
<td>Hi/Lo Freq</td>
<td>Time</td>
<td>-100 – 0 – 100%</td>
<td>0%</td>
</tr>
<tr>
<td></td>
<td>Freq</td>
<td>2.00 – 20.0 kHz</td>
<td>6.32 kHz</td>
</tr>
<tr>
<td>Hi Freq</td>
<td>Cut</td>
<td>1.0 – 20.0 kHz</td>
<td>9.46 kHz</td>
</tr>
<tr>
<td>Lo Freq</td>
<td>Time</td>
<td>-100 – 0 – 100%</td>
<td>0%</td>
</tr>
<tr>
<td></td>
<td>Freq</td>
<td>20.0 Hz – 2.00 kHz</td>
<td>200 Hz</td>
</tr>
<tr>
<td></td>
<td>Cut</td>
<td>1 – 1000 Hz</td>
<td>1 Hz</td>
</tr>
</tbody>
</table>

**AIR Spring Reverb**

This is a spatial effect, designed to emulate the sound of a spring reverb tank.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pre-Delay</td>
<td>0–250 ms</td>
<td>3 ms</td>
</tr>
<tr>
<td>Time</td>
<td>1.0–10.0 s</td>
<td>4.0 s</td>
</tr>
<tr>
<td>Mix</td>
<td>0–100 (dry–wet)</td>
<td>50%</td>
</tr>
<tr>
<td>Diffusion</td>
<td>0–100%</td>
<td>100%</td>
</tr>
<tr>
<td>Width</td>
<td>0–100%</td>
<td>0%</td>
</tr>
<tr>
<td>Low Cut</td>
<td>20.0 Hz –1.0 kHz</td>
<td>141 Hz</td>
</tr>
</tbody>
</table>
AIR Stereo Width

This effect creates a wider stereo presence in an audio signal.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Width</td>
<td>0–200%</td>
<td>100%</td>
</tr>
<tr>
<td>Delay</td>
<td>0.0 – 8.0 ms</td>
<td>0.0 ms</td>
</tr>
<tr>
<td>Level Trim</td>
<td>-Inf – +12.0 dB</td>
<td>0.0 dB</td>
</tr>
<tr>
<td>Pan Trim</td>
<td>L100 – &lt;C&gt; – R100</td>
<td>&lt;C&gt;</td>
</tr>
<tr>
<td>High</td>
<td>0–200%</td>
<td>100%</td>
</tr>
<tr>
<td>Mid</td>
<td>0–200%</td>
<td>100%</td>
</tr>
<tr>
<td>Low</td>
<td>0–200%</td>
<td>100%</td>
</tr>
</tbody>
</table>

AIR Talk Box

This effect adds voice-like resonances to audio signals.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vowel</td>
<td>OO, OU, AU, AH,</td>
<td>AH</td>
</tr>
<tr>
<td></td>
<td>AA, AE, EA, EE,</td>
<td></td>
</tr>
<tr>
<td></td>
<td>EH, ER, UH, OH,</td>
<td></td>
</tr>
<tr>
<td></td>
<td>OO</td>
<td></td>
</tr>
<tr>
<td>Env Depth</td>
<td>-100 – 0 – +100%</td>
<td>0%</td>
</tr>
<tr>
<td>Formant</td>
<td>-12.00 – +12.00</td>
<td>0.00</td>
</tr>
<tr>
<td>Mix</td>
<td>0–100%</td>
<td>100%</td>
</tr>
<tr>
<td>LFO Wave</td>
<td>Sine, Tri, Saw,</td>
<td>Sine</td>
</tr>
<tr>
<td></td>
<td>Square, S&amp;H,</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Random</td>
<td></td>
</tr>
<tr>
<td>LFO Rate</td>
<td>0.01 – 10.0 Hz</td>
<td>1.00 Hz</td>
</tr>
<tr>
<td></td>
<td>8/4 – 16</td>
<td>2T</td>
</tr>
<tr>
<td>LFO Sync</td>
<td>Off, On</td>
<td>Off</td>
</tr>
<tr>
<td>LFO Depth</td>
<td>-100 – 0 – +100%</td>
<td>0%</td>
</tr>
<tr>
<td>Env Thresh</td>
<td>-60.0 – 0.0 dB</td>
<td>-30.0 dB</td>
</tr>
<tr>
<td>Env Attack</td>
<td>0.1 – 10.0 s</td>
<td>0.5 s</td>
</tr>
<tr>
<td>Env Release</td>
<td>0.1 – 10.0 s</td>
<td>0.5 s</td>
</tr>
</tbody>
</table>
12 all new plugins from AIR include the following:

**AIR Channel Strip**

This specially-designed plugin combines multiple effects with a fast interface. The EQ section provides a highpass filter, low and high shelves, and a fully parametric mid-band. For dynamics, the AIR Compressor and Gate algorithms are perfect for achieving hard-hitting drum sounds.

<table>
<thead>
<tr>
<th>Tab</th>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>EQ</td>
<td>EQ Enable</td>
<td>Enabled, Bypass</td>
<td>Enabled</td>
</tr>
<tr>
<td></td>
<td>Gate Enable</td>
<td>Enabled, Bypass</td>
<td>Enabled</td>
</tr>
<tr>
<td></td>
<td>Comp Enable</td>
<td>Enabled, Bypass</td>
<td>Enabled</td>
</tr>
<tr>
<td></td>
<td>Output</td>
<td>-Inf – +24.00 dB</td>
<td>0.00 dB</td>
</tr>
<tr>
<td>EQ</td>
<td>High Shelf Gain</td>
<td>-12.0 – +12.0 dB</td>
<td>0.0 dB</td>
</tr>
<tr>
<td></td>
<td>High Shelf Freq</td>
<td>1.20 – 20.0 kHz</td>
<td>6.00 kHz</td>
</tr>
<tr>
<td></td>
<td>Mid Gain</td>
<td>-18.0 – +18.0 dB</td>
<td>0.0 dB</td>
</tr>
<tr>
<td></td>
<td>Mid Freq</td>
<td>40.0 Hz – 16.0 kHz</td>
<td>247 Hz</td>
</tr>
<tr>
<td></td>
<td>Mid Q</td>
<td>0.40 – 10.00</td>
<td>1.00</td>
</tr>
<tr>
<td></td>
<td>Low Shelf Gain</td>
<td>-12.0 – +12.0 dB</td>
<td>0.0 dB</td>
</tr>
<tr>
<td></td>
<td>Low Shelf Freq</td>
<td>20.0 Hz – 1.00 kHz</td>
<td>100 Hz</td>
</tr>
<tr>
<td></td>
<td>HP Filter</td>
<td>0 – 1000 Hz</td>
<td>0 Hz</td>
</tr>
<tr>
<td>Gate/Comp</td>
<td>Gate Thresh</td>
<td>-120.0 – 0.0 dB</td>
<td>-120.0 dB</td>
</tr>
<tr>
<td></td>
<td>Gate Depth</td>
<td>0 – -120.0 dB</td>
<td>-120.0 dB</td>
</tr>
<tr>
<td></td>
<td>Gate Attack</td>
<td>0.01 – 1000.00 ms</td>
<td>0.18 ms</td>
</tr>
<tr>
<td></td>
<td>Gate Release</td>
<td>1.00 – 3000.00 ms</td>
<td>7.40 ms</td>
</tr>
<tr>
<td></td>
<td>Comp Thresh</td>
<td>0.0 – -60.0 dB</td>
<td>0.0 dB</td>
</tr>
<tr>
<td></td>
<td>Comp Ratio</td>
<td>1.0:1 – 100.0:1</td>
<td>3.9:1</td>
</tr>
<tr>
<td></td>
<td>Comp Attack</td>
<td>100 us – 300 ms</td>
<td>5.48 ms</td>
</tr>
<tr>
<td></td>
<td>Comp Release</td>
<td>10.0 ms – 4.00 s</td>
<td>200 ms</td>
</tr>
</tbody>
</table>

**AIR Compressor**

This basic compressor effect changes the dynamic range of a signal by automatically reducing its gain if it exceeds a certain level (the threshold).

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threshold</td>
<td>-60.0 – 0 dB</td>
<td>-48.0 dB</td>
</tr>
<tr>
<td>Ratio</td>
<td>1.0:1 – 100.0:1</td>
<td>3.9:1</td>
</tr>
<tr>
<td>Output</td>
<td>0.0 – 30.0 dB</td>
<td>15.0 dB</td>
</tr>
<tr>
<td>Mix</td>
<td>0–100% (dry-wet)</td>
<td>100%</td>
</tr>
<tr>
<td>Knee</td>
<td>0–100%</td>
<td>50%</td>
</tr>
<tr>
<td>Attack</td>
<td>100 us – 300 ms</td>
<td>5.48 ms</td>
</tr>
<tr>
<td>Release</td>
<td>10.0 ms – 4.00 s</td>
<td>200 ms</td>
</tr>
</tbody>
</table>
AIR Delay

This is a classic delay line effect with a variable feedback filter. Additional Ratio and Width parameters enable you to achieve a wide range of stereo delay effects.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sync Off</td>
<td>1 ms – 2.00 s</td>
<td>388 ms</td>
</tr>
<tr>
<td>Sync On</td>
<td>1/32 – 8/4</td>
<td>1/8D</td>
</tr>
<tr>
<td>Sync</td>
<td>Off, On</td>
<td>Off</td>
</tr>
<tr>
<td>Feedback</td>
<td>0–100%</td>
<td>40%</td>
</tr>
<tr>
<td>Mix</td>
<td>0–100% (dry–wet)</td>
<td>50%</td>
</tr>
<tr>
<td>Delay Ratio</td>
<td>50:100 – 100:50</td>
<td>100:100</td>
</tr>
<tr>
<td>Delay HPF</td>
<td>20.0 Hz – 1.0 kHz</td>
<td>20.0 Hz</td>
</tr>
<tr>
<td>Delay Width</td>
<td>0–100%</td>
<td>100%</td>
</tr>
<tr>
<td>Feedback Damp</td>
<td>1.0 – 20.0 kHz</td>
<td>20.0 kHz</td>
</tr>
<tr>
<td>Feedback Reso</td>
<td>0–100%</td>
<td>0%</td>
</tr>
<tr>
<td>Fdbk. Reso Freq</td>
<td>100 Hz – 10.0 kHz</td>
<td>1.0 kHz</td>
</tr>
</tbody>
</table>

AIR Diff Delay

This is a delay line effect that is synchronized to your session tempo and uses an adjustable amount of diffusion to emulate the dissipation of echoes in reverberant space.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time</td>
<td>1/64 – 4/4 (including Triplet and Dotted variations)</td>
<td>1/16D</td>
</tr>
<tr>
<td>Mix</td>
<td>0–100% (dry–wet)</td>
<td>40%</td>
</tr>
<tr>
<td>Feedback</td>
<td>0–100%</td>
<td>50%</td>
</tr>
<tr>
<td>Fdbk. Diffusion</td>
<td>0–100%</td>
<td>40%</td>
</tr>
<tr>
<td>Fdbk. High Damp</td>
<td>0–100%</td>
<td>35%</td>
</tr>
</tbody>
</table>

AIR Filter

This effect applies a filter to the audio signal and then applies selectable saturation or reduction to the filtered signal.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cutoff Freq</td>
<td>55.0 Hz – 20.0 kHz</td>
<td>20.0 kHz</td>
</tr>
<tr>
<td>Reso Factor</td>
<td>0.7 – 20.0</td>
<td>1.0</td>
</tr>
<tr>
<td>Type</td>
<td>LP4–1, BP2, BP4, HP2_LP1, HP3_LP1, HP4–1, BR2, BR4, BR2_LP1, BR2_LP2, HP1_BR2, BP2_BR2, HP1_LP2, HP1_LP3, AP3, AP3_LP1, HP1_AP3</td>
<td>LP4</td>
</tr>
<tr>
<td>Output Gain</td>
<td>-Inf dB – 0.0 dB</td>
<td>0.0 dB</td>
</tr>
<tr>
<td>Saturation Type</td>
<td>Resample, Bit Crush, Rectify, Hard Clip, Distort, Overdrive</td>
<td>Overdrive</td>
</tr>
<tr>
<td>Saturation Drive</td>
<td>0.0 – 12.0 dB</td>
<td>0.0 dB</td>
</tr>
<tr>
<td>Saturation Mode</td>
<td>DCF, CVF</td>
<td>DCF</td>
</tr>
</tbody>
</table>
AIR Maximizer
This effect is a limiter optimized for professional mastering.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threshold</td>
<td>-40.0 – 0.0 dB</td>
<td>-20.0 dB</td>
</tr>
<tr>
<td>Ceiling</td>
<td>-20.0 – 0.0 dB FS</td>
<td>-5.0 dB FS</td>
</tr>
<tr>
<td>Look Ahead</td>
<td>0.0 – 20.0 ms</td>
<td>0.0 ms</td>
</tr>
<tr>
<td>Knee</td>
<td>Hard, Soft</td>
<td>Hard</td>
</tr>
<tr>
<td>Release</td>
<td>10.0 ms – 10.0 s</td>
<td>316 ms</td>
</tr>
<tr>
<td>LF Mono</td>
<td>10.0 Hz – 1.00 kHz</td>
<td>10.0 Hz</td>
</tr>
</tbody>
</table>

AIR Noise Gate
This effect is similar to a compressor, but instead of attenuating audio signal that rises above a threshold, a noise gate attenuates audio signal that falls below a threshold by a set amount. This can help reduce background noise in your audio signal.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threshold</td>
<td>-120.0 – 0.0 dB</td>
<td>-48.0 dB</td>
</tr>
<tr>
<td>Depth</td>
<td>0 dB – -120.0 dB</td>
<td>-120 dB</td>
</tr>
<tr>
<td>Denoise Filter</td>
<td>Off, On</td>
<td>Off</td>
</tr>
<tr>
<td>Denoise Thresh</td>
<td>-120.0 – 0.0 dB</td>
<td>-60.0 dB</td>
</tr>
<tr>
<td>Attack</td>
<td>0.01 – 1000.00 ms</td>
<td>0.18 ms</td>
</tr>
<tr>
<td>Hold</td>
<td>0 – 1000 ms</td>
<td>250 ms</td>
</tr>
<tr>
<td>Release</td>
<td>1.00 – 3000.00 ms</td>
<td>7.40 ms</td>
</tr>
</tbody>
</table>
AIR Para EQ

This effect is a powerful four-band parametric equalizer with four independent EQ ranges, adjustable Low and High EQ filter types, and dedicated Low Cut and High Cut.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>High Freq</td>
<td>1.2 – 20.0 kHz</td>
<td>6.00 kHz</td>
</tr>
<tr>
<td>High Q</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Shelf 0.40 – 2.00</td>
<td>1.00</td>
</tr>
<tr>
<td></td>
<td>Bell 0.40 – 10.00</td>
<td>1.00</td>
</tr>
<tr>
<td>High Gain</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Shelf -12.0 – +12.0 dB</td>
<td>0.0 dB</td>
</tr>
<tr>
<td></td>
<td>Bell -18.0 – 18.0 dB</td>
<td>0.0 dB</td>
</tr>
<tr>
<td>High Type</td>
<td>Shelf, Bell</td>
<td>Shelf</td>
</tr>
<tr>
<td>High Out/In</td>
<td>Out, In</td>
<td></td>
</tr>
<tr>
<td>High Mid Freq</td>
<td>120 Hz – 16.0 kHz</td>
<td>2.00 kHz</td>
</tr>
<tr>
<td>High Mid Q</td>
<td>0.40 – 10.00</td>
<td>1.00</td>
</tr>
<tr>
<td>High Mid Gain</td>
<td>-18.0 – 18.0 dB</td>
<td>0.0 dB</td>
</tr>
<tr>
<td>High Mid Out/In</td>
<td>Out, In</td>
<td></td>
</tr>
<tr>
<td>Low Mid Freq</td>
<td>40.0 Hz – 16.00 kHz</td>
<td>247 Hz</td>
</tr>
<tr>
<td>Low Mid Q</td>
<td>0.40 – 10.00</td>
<td>1.00</td>
</tr>
<tr>
<td>Low Mid Gain</td>
<td>-18.0 – 18.0 dB</td>
<td>0.0 dB</td>
</tr>
<tr>
<td>Low Mid Out/In</td>
<td>Out, In</td>
<td></td>
</tr>
<tr>
<td>Low Freq</td>
<td>20.0 Hz – 1.00 kHz</td>
<td>100 Hz</td>
</tr>
<tr>
<td>Low Q</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Shelf 0.40 – 2.00</td>
<td>1.00</td>
</tr>
<tr>
<td></td>
<td>Bell 0.40 – 10.00</td>
<td>1.00</td>
</tr>
<tr>
<td>Low Gain</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Shelf -12.0 – +12.0 dB</td>
<td>0.0 dB</td>
</tr>
<tr>
<td></td>
<td>Bell -18.0 – 18.0 dB</td>
<td>0.0 dB</td>
</tr>
<tr>
<td>Low Type</td>
<td>Shelf, Bell</td>
<td>Shelf</td>
</tr>
<tr>
<td>Low Out/In</td>
<td>Out, In</td>
<td></td>
</tr>
<tr>
<td>Output</td>
<td>-20.0 – +20.0 dB</td>
<td>0.0 dB</td>
</tr>
<tr>
<td>High Cut Freq</td>
<td>120 Hz – 20.0 kHz</td>
<td>20.0 kHz</td>
</tr>
<tr>
<td>High Cut Type</td>
<td>6, 12, 18, 24 dB</td>
<td>12 dB</td>
</tr>
<tr>
<td>High Cut Out/In</td>
<td>Out, In</td>
<td></td>
</tr>
<tr>
<td>Low Cut Freq</td>
<td>20.0 Hz – 8.00 kHz</td>
<td>100 Hz</td>
</tr>
<tr>
<td>Low Cut Type</td>
<td>6, 12, 18, 24 dB</td>
<td>12 dB</td>
</tr>
<tr>
<td>Low Cut Out/In</td>
<td>Out, In</td>
<td></td>
</tr>
</tbody>
</table>
AIR Pitch Shifter
This effect alters the pitch of the audio signal and can be adjusted based on the source or style of the signal.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mode</td>
<td>Vocal, Bass, Beats, Chords, Textures</td>
<td>Vocal</td>
</tr>
<tr>
<td>Shift</td>
<td>-24.0 – 0 – 24.0</td>
<td>0.0</td>
</tr>
<tr>
<td>Mix</td>
<td>0–100%</td>
<td>100%</td>
</tr>
</tbody>
</table>

AIR Pumper
This effect creates a rhythmic pumping effect, similar to that of sidechain compression.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Depth</td>
<td>0–100%</td>
<td>80%</td>
</tr>
<tr>
<td>Speed</td>
<td>Bar, 1/2 – 1/32T</td>
<td>1/4</td>
</tr>
<tr>
<td>Release Shape</td>
<td>0–100%</td>
<td>10%</td>
</tr>
<tr>
<td>Trigger Offset</td>
<td>-100.0 – +100.0 ms</td>
<td>0.0 ms</td>
</tr>
<tr>
<td>Attack</td>
<td>0–100%</td>
<td>5%</td>
</tr>
<tr>
<td>Hold</td>
<td>0–100%</td>
<td>10%</td>
</tr>
<tr>
<td>Release</td>
<td>0–100%</td>
<td>60%</td>
</tr>
</tbody>
</table>

AIR Transient
This effect is used to enhance or soften the Attack and Release phases of audio material.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attack</td>
<td>-100 – 0 – +100%</td>
<td>0%</td>
</tr>
<tr>
<td>Attack Shape</td>
<td>0–100%</td>
<td>50%</td>
</tr>
<tr>
<td>Sustain</td>
<td>-100 – 0 – +100%</td>
<td>0%</td>
</tr>
<tr>
<td>Output</td>
<td>-20.0 – +20.0 dB</td>
<td>0.0 dB</td>
</tr>
<tr>
<td>Limit</td>
<td>Off, On</td>
<td>On</td>
</tr>
</tbody>
</table>

AIR Tube Drive
This effect is designed to reproduce the sound of an overdriven tube amplifier.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drive</td>
<td>0–100%</td>
<td>0%</td>
</tr>
<tr>
<td>Headroom</td>
<td>-30.0 – 0.0 dB</td>
<td>-15.0 dB</td>
</tr>
<tr>
<td>Saturation</td>
<td>0–100%</td>
<td>50%</td>
</tr>
<tr>
<td>Output</td>
<td>-20.0 – +20.0 dB</td>
<td>0.0 dB</td>
</tr>
</tbody>
</table>

AIR Instrument Layouts
MPC now contains stunning new touch-interface layouts for the following AIR Music Technology instrument plugins: Hybrid, Loom, Vacuum Pro, Velvet, Xpand!2 and theRiser.
Clip Program Improvements

Internal Clip Program architecture has been significantly improved, allowing you to play up to 16 clip programs at the same time. Clips will continue to play when changing tracks or sequences, allowing you to seamlessly integrate them into live performance.

FLAC and OGG Support

You can now load and export FLAC and OGG files with MPC.

Mother Ducker

You can now apply sidechain ducking effects in MPC using the new Mother Ducker and Mother Ducker Input insert effects.

Mother Ducker

Add this effect as an insert to the track you want to have the ducking effect applied to. Use the meters to monitor the level from your trigger input and tweak the Threshold and Ratio parameters to adjust the amount of ducking. The Attack and Release parameters can be used to sculpt the envelope of the gain reduction to achieve exactly the pumping effect you are after. Mother Ducker has eight internal buses so you can set up multiple channel strips with ducking effects from different sources.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ratio</td>
<td>1.00:1 – 60.00:1</td>
<td>6.00:1</td>
</tr>
<tr>
<td>Knee</td>
<td>0.000 – 6.000 dB</td>
<td>0.000 dB</td>
</tr>
<tr>
<td>Attack</td>
<td>1.0 – 1000.0 ms</td>
<td>10.0 ms</td>
</tr>
<tr>
<td>Release</td>
<td>1.0 – 1000.0 ms</td>
<td>100.0 ms</td>
</tr>
<tr>
<td>Threshold</td>
<td>-100.000 – 0.000 dB</td>
<td>-6.021 dB</td>
</tr>
<tr>
<td>Gain</td>
<td>-100.000 – +12.000 dB</td>
<td>-0.000 dB</td>
</tr>
<tr>
<td>Auto Gain</td>
<td>On, Off</td>
<td>On</td>
</tr>
<tr>
<td>From</td>
<td>Bus 1–8</td>
<td>Bus 1</td>
</tr>
</tbody>
</table>

Mother Ducker Input

Add this effect as an insert to the track you want to use as a trigger input, such as a kick drum track.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value Range</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>To</td>
<td>Bus 1–8</td>
<td>Bus 1</td>
</tr>
</tbody>
</table>
Next Sequence Mode

Next Sequence Mode now remembers the next sequence change when switching to another mode.

Additional Transport Controls

You can now hold Shift and press Stop to return the playhead to the beginning of the timeline.
Updates in MPC 2.5

New Features

Splice Integration

Your standalone MPC hardware now integrates with the Splice platform, allowing you to download and browse your Splice sample library on your standalone device.

To access Splice:
1. First, make sure your MPC hardware is connected to a Wi-Fi network. See Preferences > Wi-Fi to learn how to connect to a wireless network. You will also need access to a web browser.
2. On your MPC, press Menu and tap the gear icon at the top of the screen to open the Preferences page.
3. Navigate to the Splice tab.
4. Tap the Get Login Code button. (If you are not connected to a network, you will be prompted to do so before the Get Login Code button appears.)
5. Follow the on-screen instructions to link your MPC to your Splice account via a web browser. It may take your MPC a few moments to successfully link.
6. A message will appear on screen when the link has been successfully established. Tap OK to continue and return to the Splice Preferences page.
7. Once the process is complete and your MPC has been paired to your Splice account, tap the Sync Files button to download samples from your Splice account via Wi-Fi to a drive of your choice.
   By default, files will be stored on the Internal drive. You can change the selected drive by tapping the Change button under Sync Files To Drive.

To browse samples imported from Splice:
1. Open the Browser.
2. Under the Content tab, tap the Splice shortcut icon to view samples downloaded from your Splice account.
   If nothing appears, make sure that you have connected your Splice account and synced your files by following the directions above.
3. The right-side of the browser will display your Splice samples organized into a series of top level folders, allowing you to easily browse your sample library by BPM, Instrument, Key, Pack or Tag. The All Your Samples folder will show a list of all samples you have downloaded.

Note: The original sample files are stored in the By Pack folder on your drive. Other folders such as By Instrument contain internal links to help sort the samples by various tags. If the By Pack folder on your drive is deleted, the files in the remaining folders will become unusable. To fully remove all files, the entire Splice directory should be deleted.

IMPORTANT: Drives formatted using the FAT32 system do not support these internal links. For these drives, and on the internal storage drives of some earlier MPCs, samples will only be sorted in the By Pack folder. We recommend using an exFAT file system on external drives used with MPC, as it is the most robust one supported by both Windows and macOS.

To view the number of samples available to download from your account, tap the Check For Update button.

To log out of a Splice account, tap the Log Out button.
Browser Audition Warp and Sync

In the Browser, you can now audition samples that have an MPC-embedded tempo in sync with the project tempo.

1. Open the Browser by doing either of the following:
   - Press Menu and then tap Browser.
   - Press Browse (MPC X) or Shift+Menu/Browse (MPC Live, MPC Touch)

2. Tap Audition at the bottom of the screen, or press the respective F-Key (MPC X only).

3. In the options that appear, enable Sync to set samples to be auditioned at the beginning of the next bar of the sequence when playback is active.

   Enable Warp to set samples with an embedded tempo to be warped to the project tempo. Samples with no embedded tempo or externally-embedded tempo will not be affected by this setting.

4. Select a sample, loop, program or project to preview, then tap the Play button to audition. If Auto Audition is turned on, samples will audition when selected.
Updates in MPC 2.6

New Features

Ableton Live Set Export

You can now export MPC sequences as an Ableton Live Set (.ALS) file.

To export the current sequence as an Ableton Live Set:

1. Open Main Mode by pressing Main, or by pressing Menu and then tapping Main.
2. Tap the Project field at the top of the display to open the Project window.
3. Tap ALS Export.
4. In the window that appears, you can adjust the following settings for your export:

   Use the Export MIDI As settings to choose how MIDI programs and sequences are exported, either as Audio files or MIDI files. When using Plugin, Drum or Keygroup programs, you can render sequences as Audio to preserve the sound of the instruments, or render sequences as MIDI data.

   Check the Include Program Volume/Pan Settings box to include these settings in the export. When disabled, the volume and pan settings will be set to 0 dB and center (C), respectively.

   Check the Bypass Program Effects Plugins box to deactivate any third-party effect plugins used with the program for the export. When disabled, those effects will be activated.

   Use the Audio Tail field to set the amount, in seconds, of extra time added to the end of the resulting audio files.

   Use the Bit Depth field to set the bit depth to 8, 16 or 24.

   Use the Sample Rate field to set the sample rate to 44.1, 48, 88.2 or 96 kHz. In most cases, we recommend selecting 44.1 kHz.

5. Tap Export to begin the export, or tap Close to cancel and return to the previous page.

Erase Parameters

From the Erase window, you can now erase selected automation parameters.

1. While the sequence is stopped, press the Erase button to open the Erase window.
2. Tap Automation to select it.
3. By default, the Parameter field is set to All. Double-tap this field to display a list of all parameters that have been automated on the current track.
4. Select the parameter you would like to erase, and then tap Do It to erase the automation.
Grid Automation Lanes

You can now input, view and edit automation in Grid View and Audio Edit Mode.

To add automation to a sequence:
1. Select a **MIDI program** or **Audio program**.
2. For MIDI programs, tap the **grid icon** to open **Grid View**. For Audio programs, tap the **waveform-and-box icon** to open **Audio Edit Mode**.
3. Tap the **up arrow** on the parameter bar to expand the velocity/automation lane.
4. By default, **Velocity** is shown in this lane for MIDI programs and **PRG: Volume** is shown for Audio programs. Double-tap this field to open the **Parameter** drop-down menu.
5. In the menu that appears, tap **Add New** to add an automation parameter. You can choose from a variety of parameters depending on the type of program, insert effects added and other options.

To edit automation, do any of the following in Grid View or Audio Edit View:
- Use the **pencil** tool to draw your automation in the automation lane.
- Use the **eraser** tool to erase automation points. If you erase all automation points, the parameter will be removed.
- Tap the **trash can icon** to delete all automation for the selected parameter at once (Grid View only).

You can also edit automation using the **Step Sequencer** (see below).
Step Automation

You can now input, view and edit automation in the Step Sequencer.

To add a step automation parameter:
1. Open the Step Sequencer by doing either of the following:
   • Press Menu, and then tap Step Sequencer.
   • Press Step Seq (MPC X).
2. By default, the Parameter field of the Step Sequencer displays Velocity for MIDI programs and PRG: Volume for audio programs. Double-tap this field to open the drop-down menu.
3. In the menu that appears, tap Add New to add an automation parameter. You can choose from a variety of parameters depending on the type of program, insert effects added and other options.

To edit step automation, do any of the following:
• Tap and drag your finger in the step area to freely draw step values.
• Press and hold the Q-Link button, and then tap Screen to set the Q-Link knobs to Screen Mode. While viewing the step sequencer, you can use the Q-Link knobs for tactile control of each step’s automation value, emulating traditional knob-based step sequencers. While it is being adjusted, the current automation value will be shown next to the Parameter field, as well as in the display strip above the knobs (MPC X only).
   For MPC Live and MPC Touch, use Bank 1 of the knobs to control Steps 1–4, Bank 2 to control Steps 5–8, Bank 3 to control Steps 9–12 and Bank 2 to control Steps 13–16.
• Press and hold Shift and tap Clear to clear all automation for the selected parameter in the selected sequence.
• Press and hold Shift and tap Clear Bar to clear all automation for the selected parameter in the current bar of the selected sequence.
• Use the Nudge < and > buttons to shift the current automation parameter to the left or right at the current Timing Correct value.
• Use the slider on the right edge of the screen to increase or decrease the parameter values of all automation steps in the visible time range.
• Tap Presets and use the buttons to apply the presets to the step automation (See Operation > Modes > Step Sequencer for more information).

Note: When editing step automation, if a step is not activated, a darkened step bar will indicate the current parameter value at that step, based on the last active step.
Submixes

MPC X and MPC Live now contain 8 submixes in Standalone Mode for additional track and program routing options.

To assign an audio track or program to a submix:
1. Press Menu, and then tap Channel Mixer. Alternatively, press Ch. Mixer (MPC X only).
2. Set the Mixer field at the top of the display to Audio Tracks or Programs.
3. Double-tap the Output field of the audio track or program channel strip.
4. In the drop-down menu, scroll to the top of the list and tap to select Sub 1–8. The audio track or program's audio will now be routed to the selected submix.

To edit a submix:
1. Press Menu, and then tap Channel Mixer. Alternatively, press Ch. Mixer (MPC X only).
2. Set the Mixer field at the top of the screen to Submixes.
3. Use the mixer grid to select a submix, and then use the channel strip on the left side of the screen to add effects or adjust level, pan and other parameters.

Workflow Enhancements

The Keep or Discard window in Sample Record Mode and the Export Loop as Sample window in Looper Mode now have easy-access buttons to Save or Edit the recorded sample or loop.

In Sequence Edit Mode, you can now copy events from individual or multiple pads or notes from the Copy Events window.

In the Sequence Edit > Copy Sequence and Track Edit > Copy Track windows, you can now rename the destination sequence or track.

The FX list can now be sorted by type of effect for easier navigation.

Timing Correct can now be applied to all tracks by pressing the All Track button in the Timing Correct window.